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1 Installing KISSsoft  

1.1 Basic installation 

After you have inserted the KISSsoft CD in the appropriate disk drive, the setup program starts 

automatically. If it does not, you can run the setup.exe file directly in the CD root directory by double-

clicking on it. 

The setup program guides you through the installation process step by step. All you need to do is 

select an installation folder and the required language for the installation. If you change the default 

installation folder, it is advisable to include the version descriptor as part of the directory name of the 

new installation folder (e.g. C:/Programs/KISSsoft xx-20xx). 

At the end of installation, we recommend that you install the latest Service Pack (patch). Download 

the latest patch from our website. You can choose between an installation program (.exe) and zipped 

files (.zip). The installation program automatically copies the necessary files after you specify which 

installation folder it is to use. However, not all companies permit .exe files to be downloaded. If not, 

you must unpack the ZIP file and manually copy the files it contains into your installation folder. Any 

files that are already present must be overwritten by the ones contained in the patch. 

Once you have installed KISSsoft, you will need a license for it (see chapter 1.3, Licensing). If 

KISSsoft is not licensed, it will only run as a demo version. 

Ʒ Note:  

If you are installing KISSsoft on a server, we recommend that you perform the installation from a 

client (workstation computer). This means that all the necessary directory entries will automatically 

be added to the KISS.ini file (see chapter 2.6.1, Definitions in [PATH]) correctly. Otherwise, you will 

have to change these directory entries from the local drive name (e.g. C:/...) to the appropriate share 

name in the network, later, manually, using an editor. 

1.2 Downloading a license file 

Go to the KISSsoft website at www.KISSsoft.com. 

Register in the MyKISSsoft  area there, and inform your commercial contact representative 

or send an email to info@KISSsoft.com. 

After you have been assigned the required rights by KISSsoft AG, select the menu at the 

top of the Customer area  and then download your license file. 

http://www.kisssoft.ch/patches.php
http://www.kisssoft.ch/
mailto:info@KISSsoft.ch
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Ʒ Note:  

You will see license files for different KISSsoft versions in your personal download area. Ensure that 

you download the appropriate license file for the version you have just installed. 

1.3 Licensing 

After you have completed the KISSsoft installation (see chapter 1.1, Basic installation), you must 

license the software either by downloading a license file or activating the program's license. Please 

read the relevant section for your license type. 

1.3.1 Test version 

If you run KISSsoft from the client (workstation computer), the user account for the test 

version will become active. 

Select License tool  in the Extras  menu, and then click on the Activate license tab. 

Activating the license online:  If your computer has Internet access, and you have received 

an online code from us, enter this code under the Activate Test or Student version  

option and then click on the Activate license  tab. 

Activating the license directly:  Under the Activate test version by phone  option, you see 

a question code. Call the telephone number you see there and tell us this code. We will 

then give you the appropriate answer code. Input this in the appropriate field, and then 

click on the Activate license  tab. 

1.3.2 Student version 

Copy your license file (which you will usually be given by the place you are studying for your 

qualification) to your License directory (see chapter 2.6.2, Definitions in [SETUP]). 

Select License tool  in the Extras  menu, and then click on the Activate license tab. 

To input your online code (which you will usually be given by the place you are studying for 

your qualification), select the Activate test or student version (online code required)  

option and then click on Activate license . 

1.3.3 Single user version with dongle (protection key) 

Copy your license file (see chapter 1.2, Downloading a license file) to your License directory 

(see chapter 2.6.2, Definitions in [SETUP])) 

Now, simply plug in the dongle supplied with the system. 
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Ʒ Note  

The single user version of KISSsoft can also be installed on a central server. Local clients 

(workstation computers) can then run the software directly from this server. Please note that, in this 

case, the dongle must always be plugged into the particular client on which you want to use 

KISSsoft. 

1.3.4 Single user version with license code 

Start KISSsoft from the client (workstation computer) for which the software is to be 

licensed. 

Select License tool  in the Extras  menu, and then click on the Activate license tab. 

Enter your contact data under the Request license file  option and click on Send  to send 

your computer-specific access data directly to us. Alternatively, you can first save this 

access data in a file and then send us this file by email. 

You will receive an email as soon as we have created your license file. 

Download your License file (see chapter 1.2, Downloading a license file) and copy it to your 

License directory (see chapter 2.6.2, Definitions in [SETUP]). 

1.3.5 Network version with dongle (protection key) 

For the network version with dongle a server program has to be installed in addition to the licensing 

of the KISSsoft installation. 

1.3.5.1 Installation on the server 

Copy the KISSsoft dongle/MxNet installation directory onto a server. 

Start MxNet32 on the server. You will see a dongle icon in the task bar. 

Double-click this icon to start the user interface. 

Now enter Application : KISSsoft and any file with the file extension .mx as the server file . 

The clients must have both read and write access to this file. Now click New Entry  to 

add this entry. 

Then click the Active Users  button to check who is using KISSsoft. You can also reactivate 

a license that has already been used. 

1.3.5.2 Licensing the KISSsoft system 

Copy your license file (see chapter 1.2, Downloading a license file) to your License directory 

(see chapter 2.6.2, Definitions in [SETUP]). 
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Complete the necessary details in the "ServerFile: serverfilepath" line after the checksum 

line in the license file. The "serverfilepath" is the path to the server file that is defined in 

the server program. 

Ʒ Note  

The KISSsoft installation will also run if the client is not connected to the network and if the dongle is 

inserted in the client instead of in the server. You can also "check out" the license if you remove the 

dongle. 

1.3.6 Network version with a license code 

Start KISSsoft from a client (workstation computer). 

Select License tool  in the Extras  menu and go to the General tab. 

Select an access directory on a server. Please note: If you change this, you will need a new 

license. 

Open the Activate license tab. 

Enter your contact data under the Request license file  option and click on Send  to send 

your computer-specific access data directly to us. Alternatively, you can first save this 

access data in a file and then send us this file by email. 

You will receive an email as soon as we have created your license file. 

Download your License file (see chapter 1.2, Downloading a license file) and copy it to your 

License directory (see chapter 2.6.1, Definitions in [PATH]). 
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2 Setting Up KISSsoft  

2.1 Directory structure 

If there are several users, it is advisable to store shared data (databases , user-defined report 

templates  and standard files ) on a server. This ensures that, if there are changes and upgrades, all 

users will be able to work with one uniform set of data. To set this up, put the UDB, EXT and 

TEMPLATE directories on a server that can be accessed by all users, and then set the 

corresponding variables, UDBDIR, EXTDIR and TEMPLATEDIR, in the KISS.ini (see chapter 2.6.1, 

Definitions in [PATH]) file. 

In contrast, if there are several users, the temporary directories should be defined locally on their 

workstations. Otherwise, the interim results generated for individual users might overwrite each 

other. For each installation, KISSsoft uses the temporary user directory set in the operating system. 

The CADDIR and TEMPDIR variables can, however, be tailored in the KISS.ini (see chapter 2.6.1, 

Definitions in [PATH]) file. 

If you want to open or save a calculation file or report, KISSsoft displays your own personal user 

directory  as the first choice storage location. This saves you frequent searches in the directories on 

your system. You can define this user directory via the USERDIR variable in the KISS.ini (see 

chapter 2.6.1, Definitions in [PATH]) file. The user directory will be ignored if you have selected an 

Active working project (see chapter 6.3, The active working project). In this case, KISSsoft offers you 

the project directory as the first choice storage location. 

2.2 Language settings 

KISSsoft is available in nine languages: German, English, French, Italian, Spanish, Russian, 

Portuguese, Chinese and Japanese. When you select a language, the program differentiates 

between the language used for the user interface and the language used for the reports. This makes 

it possible to operate KISSsoft in one language and simultaneously display reports in a different 

language. Messages will be displayed either in the same language as the user interface or as the 

reports. 

In the program, select Extras > Language  to change between the languages available in your 

license. To make global language settings, you need to edit the KISS.ini (see chapter 2.6.2, 

Definitions in [SETUP]) file. The user can change the language used for reports by selecting Report 

> Settings . 
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2.3 Systems of units 

KISSsoft recognizes two systems of units: the metric system and the US Customary Units system. 

For global settings, you need to edit the KISS.ini (see chapter 2.6.2, Definitions in [SETUP]) file. You 

can also quickly toggle between systems of units in the program by selecting Extras > System of 

units . In addition to changing the system of units, it is possible to switch the unit used for a particular 

value input field (see chapter 5.2.1, Value input fields). 

2.4 Defining your own template files 

Anyone who frequently carries out the same, or at least similar, calculations has to repeatedly select 

or enter the same values in selection lists and value input fields. Thanks to template files, KISSsoft 

makes it much easier to do this. For each calculation module, there is an internal default setting for 

all values. If, however, you have defined your own template file, this template file will be used when 

you open a calculation module or load a new file. 

To define a template file, you open a new file in the appropriate calculation module and enter your 

default settings. Click on File >  Save as template  to transfer your values to the template file. All 

template files will be saved in the directory that has been defined as TEMPLATEDIR (see chapter 

2.6.1, Definitions in [PATH]). 

Project-specific template files can also be created. To define special standards for a project (see 

chapter 6, Project Management), select this project in the Project Tree (see chapter 4.2.2, The 

project tree) and open its properties by selecting Project > Properties . There, select Use own 

templates for this project  and specify a directory for the template files. To define the template files, 

first select this project as the active working project (see chapter 6.3, The active working project). 

2.5 Rights 

You can restrict the rights for selected areas of KISSsoft for some users. 

Right  Implementation  

Change general settings Write-protect the KISS.ini: (see chapter 2.6, Global 

settings - KISS.ini) file 

Change or add data to databases Write-protect databases (files of the type .udb), and the 

DAT and EXT/DAT directories (write rights for UDBDIR 

(see chapter 2.6.1, Definitions in [PATH]) should be 

retained). 

Change report templates Write protect RPT, EXT/RPT and EXT/RPU directories 

Change template files Write protect the TEMPLATE directory 
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2.6 Global settings - KISS.ini 

Global settings for KISSsoft are defined in the KISS.ini file, which is located directly in the installation 

folder. Most of these settings can also be defined directly in the software and are then saved to the 

KISS.ini file. 

2.6.1 Definitions in [PATH] 

Variable name  Description  Note  

KISSDIR=<INIDIR> The KISSsoft installation folder 

path is generally defined with the 

INIDIR variable. 

 

HELPDIR Directory for user manual and 

help figures 

 

DATADIR  Directory for .dat files Attention:  You should not carry out any 

upgrades or make any changes in this 

directory. Save your own files in the DAT 

subdirectory in the EXTDIR directory. 

RPTDIR Directory for report templates 

(*.rpt) 

Attention:  You should not carry out any 

upgrades or make any changes in this 

directory. Save your own files in the RPT 

subdirectory in the EXTDIR directory. 

USERDIR Default directory for opening and 

saving 

 

CADDIR  Default directory for CAD export Should be located locally on a 

workstation. 

%TEMP% sets the temporary directory to 

the operating system default. 

TMPDIR  Directory for temporary files Should be located locally on a 

workstation. 

%TEMP% sets the temporary directory to 

the operating system default. 

UDBDIR Directory for user-defined 

databases (*.udb) 

If several users are using the system, we 

recommend you store the databases on a 

server to ensure data uniformity if there 

are changes and upgrades. 

KDBDIR  Directory for KISSsoft's 

databases (*.kdb) 

KISSsoft datasets containing data that 

cannot be modified. 
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EXTDIR Directory for user-defined report 

templates and additional DAT 

files 

If there are several users, it is advisable to 

store this directory on a server. 

TEMPLATEDIR  Directory for template files 

(STANDARD.*). 

If there are several users, it is advisable to 

store this directory on a server. 

LICDIR Directory for the license files You can install this directory on a server 

so that all users can access the new 

license files. 

Table 2.1: Table of variables used in the PATH environment 

Ʒ Note  

You should have write permission for the directories set in these variables: TMPDIR, CADDIR, 

USERDIR and UDBDIR. 

Depending on the configuration, you might not have write permission in these directories: C:\ 

Program Files \ KISSsoft directory name  or C:\ Programs \ KISSsoft directory name . Any files 

you create are then diverted to the operating system's internal directories. In this case, select 

directories with write permission. 

The UDBDIR, TMPDIR, CADDIR, USERDIR and EXTDIR directories can also be defined in the 

óDirectoriesô tab in the óProgram settingsô dialog (Extras >Settings ). 

2.6.2 Definitions in [SETUP] 

Variable name  Description  Values  

USCUSTOMARYUNITS Sets the system of units 0: Metric, 1: US 

Customary 

Units 

MATERIALSSTANDARD  Specifies the standard according to which 

the materials are defined (configuration 

tool) 

0: DIN, 1: BS, 

2: AISI, 3: UNI, 

4: AFNOR, 5: 

JIS, 6: CN 

REPORTLANGUAGE  Sets the language in which reports are 

displayed 

0: German, 1: 

English, 2: 

French, 3: 

Italian, 4: 

Spanish, 5: 

Russian, 6: 

Portuguese, 7: 

Chinese, 8: 

Japanese, 11: 

English with 
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US Customary 

Units 

SHOWCALCTIME  Displays the amount of time taken to 

perform a calculation 

0: No, 1: Yes 

SHOWPROGRESSBAR  Shows the progress bar for time-intensive 

calculations 

0: No, 1: Yes 

DISPLAYLANGUAGE  Sets the language in which the user 

interface is displayed 

0: German, 1: 

English, 2: 

French, 3: 

Italian, 4: 

Spanish, 5: 

Russian, 6: 

Portuguese, 7: 

Chinese, 8: 

Japanese 

DISPLAYFONTSIZE  Sets the font size in KISSsoft (FONT) 0: System size 

or else the 

direct font size 

MESSAGESINREPORTLANGUAGE  Sets the language in which messages are 

displayed 

0: as interface, 

1: as reports 

MESSAGESSHOWSTATE  Defines which messages are to be 

displayed in a message box. 

0: all, 1: 

Information 

only in 

message 

window, 2: 

Information and 

warnings only 

in message 

window 

EDITOR Path to the external editor 
 

USEEXTERNALEDITOR  Defines whether the external editor is to be 

used. 

0: No, 1: Yes 

DATEFORMAT  Date format, e.g. DD.MM.YYYY 
 

TIMEFORMAT Time format, e.g. hh.mm.ss 
 

ENABLENETWORKING  Defines whether the network/internet can 

be accessed (for example, to display 

product news). 

0: No, 1: Yes 

CHECKFORUPDATES  Defines whether the system is to search for 

updates when the program starts. 

0: No, 1: Yes 



I Setting Up KISSsoft 54 
 

USETEMPORARYDATABASE  Defines whether the databases are to be 

copied to a temporary directory when the 

program starts 

0: No, 1: Yes 

RECENTFILESCOUNT Set number of most recently used files in 

the File menu displayed. 

 

FORCEEXCLUSIVEOPEN Defines whether files can only be opened 

exclusively. 

0: No, 1: Yes 

CALCONOPEN  Defines whether calculations are to be 

performed on a file immediately, when it is 

loaded. 

0: No, 1: Yes, 

2: no if 

KISSsoft is 

started from 

KISSsys, 

otherwise yes 

CALCINTERFACEOUT  Defines whether temporary reports for 

manufacturing data are to be written during 

a calculation. 

0: No, 1: Yes 

STORELICENSELOCATION  

Defines whether the path to the license file 

is to be read from the registry, and also 

stores this path to the license file in the 

registry. 

0: No, 1: Yes 

(default) 

ENABLEUSERSETTINGS  Defines whether the settings in kiss.ini can 

be overwritten by local settings. 

0: No, 1: Yes 

USEFILEEXPLORER  Defines whether the Explorer is to be 

displayed in the "View" menu list. This 

process will slow down KISSsoft 

considerably. 

0: No, 1: Yes 

USEHIGHDPIICONS Uses scaled icons for high-resolution 

screens 

0: No, 1: Yes 

Table 2.2: Table of variables used in the SETUP environment 

2.6.3 Definitions in [REPORT] 

Variable name  Description  

SIZE A number, 0-9, that specifies the scope of the report. 

INCLUDEWARNINGS 0/1: Warnings are contained in the report 

FONTSIZE Number that sets the font size in the report. 

PAPERFORMAT Paper format: A3, A4, A5, Letter, Legal 

PAPERORIENTATION 0/1: Portrait/Landscape 

PAPERMARGINLEFT Distance from the left-hand page margin [mm]. 
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PAPERMARGINRIGHT Distance from the right-hand page margin [mm]. 

PAPERMARGINTOP Distance from the top page margin [mm]. 

PAPERMARGINBOTTOM Distance from the bottom page margin [mm]. 

COMPARE 0/1: Adds date/time to the report in comparison mode. 

LOGO Sets the picture file displayed in the header and footer. 

HEADER Contains the header usage definition. 

USEHEADERFORALLPAGES 0/1: Header only on first page/on all pages 

FOOTER Contains the footer usage definition. 

USEFOOTERFORALLPAGES 0/1: Footer only on first page/on all pages 

READONLY 

0: Reports can be edited and saved as editable text 

documents 

1: Reports cannot be edited and can only be exported as PDF 

documents 

Table 2.3: Table of variables used in the REPORT environment 

2.6.4 Definitions in [REPORTEDITOR] 

Variable name  Description  

SAVEFORMAT 0-5:DOCX, PDF, ODT, TXT, HTM, MD 

SYNCHSCROLL 
0: Synchronous scrolling is disabled. 

1: Synchronous scrolling is enabled. 

KEEPZOOMFACTOR 
0: The zoom factor is reset to 100% when you open a new report. 

1: The zoom factor is retained when you open a new report. 

KEEPSCROLLPOSITION 
0: The scroll position is reset when you open a new report. 

1: The scroll position is retained when you open a new report. 

SPLITONOPEN 

0: When you open a file with KISSedit, it is displayed in full screen 

mode. 

1: When you open a file with KISSedit, it is displayed in split view. 

TABBED 
0: is not in a tab 

1: is in a tab 

LOCKED 
0: Reports are unlocked for editing. 

1: Reports are locked for editing. 

PLAINTEXTFONT Font (e.g. Consolas) 

PLAINTEXTFONTSIZE Font size (by default: 12) 
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PLAINTEXTENCODEUTF8 
0: Text in ASCII format 

1: Text in UTF8 format 

TITLECONFLICTRESOLUTION 

Adds a number or date to the file name when opening multiple 

reports with the same name. 

0: Adds a number 

1: Adds a date 

DRAWFRAME 
0: Report frame is not displayed. 

1: Report frame is displayed. 

Table 2.4: Table of variables used in the REPORTEDITOR environment 

2.6.5 Definitions in [GRAPHICS] 

Variable name  Description  

BACKGROUND 0: black, 15: white 

CLIPDIAGRAMCURVES 0: Display complete curve progression in diagrams, 1: Limit curves 

in diagrams to current axis range 

PERSPECTIVEPROJECTION 0: 3D graphics in parallel projection, 1: 3D graphics in perspective 

projection 

USESETTINGS 0: Don't save graphics settings, 1: Save graphics settings for 

specific users 

Table 2.5: Table of variables used in the GRAPHICS environment 

Other variables are described in (see chapter 23.9, Settings). 

2.6.6 Definitions in [LICENSE] 

Variable name  Description  

LOGGING  Number used to configure the logging of license usage. 

0: no log file 

1: Log in, Log out, No license, Used and Missing rights 

2: Log in, Log out, No license 

3: Log in, Log out, No license, Missing rights 

In network versions, the user's uptime is also displayed , in 

seconds. 

LICENSELOGFILE  .log  file for generating reports of license usage. 
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TIMEOUT Time [min] until an unused floating license is activated on the 

network again. 

LICENSEMANAGEMENTSTATE  

If this parameter is set to 1, the License dialog is displayed 

immediately, when KISSsoft is started, and the "General" tab is 

active. This enables the user to select the license with which 

KISSsoft is to be used. 

Table 2.6: Table of variables used in the LICENSE environment 

2.6.7 Definitions in [CADEXPORT] 

Variable name  Description  

USEDXFHEADER 0/1: Use DXF header for DXF export. 

DXFVERSION 0/1: Version 12/15 

INPUTLAYER  Name of the layer for import. 

OUTPUTLAYER  Name of the layer for export. 

DXFPOLYLINE  0/1/2: Use polygonal course, lines or points for the export. 

2.7 table: Table of variables used in the CADEXPORT environment 

2.6.8 Definitions in [INTERFACES] 

Variable name  Description  

DEFAULT  Name of the CAD system: 
 

Solid Edge 
 

SolidWorks 
 

Inventor 
 

CATIA 
 

Creo 
 

HiCAD 

GEAREXPORT3D Displays the CAD system name in lists (see DEFAULT ). 

SYMMETRIC 0/1: Full tooth space/half tooth space mirrored (symmetrical) 

(default = 0) 

SAVEFILENAME  0/1: Saves the entire file contents/Saves only the file name and 

the path. 

(Default = 1) 
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MESSAGECADVERSION  0/1: You see a message/no message if the CAD version is no 

longer supported by the interface. 

(Default = 1) 

2.8 table: Table of variables used in the INTERFACES environment 

2.6.9 Definitions in [SOLIDEDGE] 

Variable name  Description  

LIBRARY  Interface dll (kSoftSolidEdge.dll ) directory 

SIMPLIFIEDPRESENTATION  0/1: Set the variable to 1 to also generate a simplified gear 

SMARTPATTERN  0/1: Fastpattern/Smartpattern 

APPROXIMATION  1/2/3/4: Polygonal course (supported)/Arcs of circle 

(supported)/Quadratic splines (supported)/Cubic splines (default) 

USERPARTTEMPLATE  Template file directory (e.g. C:\Template\metric.par) or just the 

template file name (e.g. metric.par): the path is then taken from the 

settings in Solid Edge 

USERDRAFTTEMPLATE  Template file directory (e.g. C:\Template\metric.dft) or just the 

template file name (e.g. metric.dft), in which case the path is then 

taken from the settings in Solid Edge. 

Table 2.9: Table of variables used in the SOLIDEDGE environment 

2.6.10 Definitions in [SOLIDWORKS] 

Variable name  Description  

LIBRARY  Interface dll (kSoftSolidWorks.dll ) directory 

SIMPLIFIEDPRESENTATIONNAME  Setting this variable generates a simplified gear with this 

name 

APPROXIMATION  1/2/3/4: Polygonal course (supported)/Arcs of circle 

(supported)/Quadratic splines (supported)/Cubic splines 

(default) 

2.10 table: Table of variables used in the SOLIDWORKS environment 

2.6.11 Definitions in [INVENTOR] 

Variable name  Description  

LIBRARY  Interface dll (kSoftInventor.dll ) directory 
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APPROXIMATION  1/2/3/4: Polygonal course (supported)/Arcs of circle 

(supported)/Quadratic splines (supported)/Cubic splines 

(default) 

2.11 table: Table of variables used in the INVENTOR environment 

2.6.12 Definitions in [CATIA] 

Variable name  Description  

LIBRARY  Interface dll (kSoftCatia.dll ) directory 

LIBRARYSWMS  Directory containing the interface manufacturer's .dll  file 

LANGUAGEFILE  Directory containing the interface manufacturer's .ini  file 

DEBUG Interface manufacturer's variable 

DEBUGPATH  Interface manufacturer's variable 

HELPFILE  Interface manufacturer's variable 

LASTSETTING_CONSTRUCTION  Interface manufacturer's variable 

LASTSETTING_GEARNAME  Interface manufacturer's variable 

LASTSETTING_PRODUCTIONINFO  Interface manufacturer's variable 

LASTSETTING_CALCINFO  Interface manufacturer's variable 

LASTSETTING_FLAGINFO  Interface manufacturer's variable 

APPROXIMATION  1/2/3/4: Polygonal course (not supported)/Arcs of circle 

(not supported)/Quadratic splines (default)/Cubic splines 

(not supported) 

2.12 table: Table of variables used in the CATIA environment 

2.6.13 Definitions in [PROENGINEER] 

The ProEngineer interface has an individual subsection/menu for each version (for example, Wildfire 

5, 32bit). However, the definitions in "kiss.ini" are the same in every 3D interface to Creo Parametric 

(ProEngineer) chapters. 

Variable name  Description  

LIBRARY  Interface dll directory (kSoftProEngineer.dll ) 

INTERFACECOMMAND  Directory containing the interface manufacturer's .exe file 

USCUSTOMARYUNITS 0/1: System of units used in the metric or US Customary Units model 
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APPROXIMATION  1/2/3/4: Polygonal course (not supported)/Arcs of circle 

(default)/Quadratic splines (not supported)/Cubic splines (not 

supported) 

2.13 table: Table of variables used in the PROENGINEER environment 

2.6.14 Definitions in [HICAD] 

Variable name  Description  

LIBRARY  Interface dll directory (kSoftHiCAD.dll ) 

APPROXIMATION  1/2/3/4: Polygonal course (not supported)/Arcs of circle 

(default)/Quadratic splines (not supported)/Cubic splines (not 

supported) 

2.14 table: Table of variables used in the HICAD environment 

2.6.15 Definitions in [VIDEOENCODING] 

Variable name  Description  Values  

CODEC 

Specifies the video codec which is to be used 

to encode videos. 

Not all operating systems support all possible 

values. 

0: H.264, 1: H.265 

(default = 0) 

HARDWAREENCODING 
Specifies whether hardware video encoding is 

to be used, if available. 

0: No, 1: Yes (default = 

1) 

MODE 

Specifies the encoding mode. In some 

circumstances, a different mode will be used if 

the hardware, operating system or selected 

codec do not support the initially selected 

mode. 

0: CBR (fixed bitrate) 

1: Unconstrained VBR 

(variable bitrate without 

maximum) 

2: Constrained VBR 

(variable bitrate with 

maximum) 

3: Quality level (target 

quality, without 

specifying the bitrate) 

(Default = 3) 
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Variable name  Description  Values  

WIDTH 

Specifies the video width. The width can be 

either defined automatically or fixed. 

However, very small or very large values may 

cause the video recording to fail. 

0: Use the current width 

of the graphic in the 

Graphics window 

1-32767: Use this width 

(in pixels) 

(Default = 0) 

HEIGHT 

Specifies the video height. The height can be 

either defined automatically or fixed. 

However, very small or very large values may 

cause the video recording to fail. 

0: Use the current 

height of the graphic in 

the Graphics window 

1-32767: Use this height 

(in pixels) 

(Default = 0) 

QUALITY # 

Specifies the quality level to be used if 

MODE=3 is set. 

Not all codecs or operating systems support 

all possible values. 

0-51: The quality level 

to be used (default = 24) 

AVGBITRATE 

The video's target bitrate in bit/s. 

If MODE=0, this specifies the video's constant 

bitrate. 

If MODE=1/2, this specifies the video's 

average bitrate. 

However, very small or very large values may 

cause the video recording to fail. 

0: The bitrate is 

calculated automatically 

using the Kush gauge 

Other values: The 

bitrate to be used 

(Default = 0) 

MAXBITRATE 

The video's maximum bitrate in bit/s, if 

MODE=2. 

This value should be greater than 

AVGBITRATE. However, very small or very 

large values may cause the video recording to 

fail. 

0: The bitrate is 

calculated automatically 

using the Kush gauge 

Other values: The 

bitrate to be used  

FPS 

Specifies the number of images per second in 

the recorded video. 
Recommended values: 

30 or 60 (default = 30) 
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Variable name  Description  Values  

However, very small or very large values may 

cause the video recording to fail. 

2.7 User-defined settings 

User-defined settings can be reset via Extras > Configuration  tool. 

2.7.1 Configuration tool 

In the General  tab, you can select the older version's "kdb" database directory (prior to 03-2017. 

After that, it is called "udb".) by selecting the Update database  option. Click "Run" to transfer the 

datasets you defined yourself in the older version to the current version, to ensure these datasets are 

available in the current version. 

Click Update external data  to select the older version's "ext" directory. This then automatically 

copies the "dat", "rpt" and "rpu" subdirectories to the current Release. 

Click Update settings  to transfer your personal settings from the previous version to the current 

Release. 

Select Connect file extensions  to link all the KISSsoft files with the current version so that you can 

double-click on any file to open it in the current Release. 
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Figure 2.1: General tab in the Configuration tool window 

In the Materials  tab, you can specify the standard with which the material descriptions in the 

database are to comply. 
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Figure 2.2: Materials tab in the Configuration tool window 

In the Settings  tab, you can delete the user-defined settings (divided into groups). This reloads the 

default values. 
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Figure 2.3: Settings tab in the Configuration tool window 

2.8 Rules 

Rules are used to ensure that in-house guidelines for the ranges of validity of parameters are applied 

and complied with. This typically concerns the maximum and minimum limits of input values, 

calculated values and the relationships between these values i.e. length/width ratios, length/diameter 

relationships or even the relationship between the module and the center distance. 

These rules are defined by being stored in a module .rls file, where module  stands for the calculation 

module's in-house label, e.g. Z012 for cylindrical gear pairs. 
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These rules are subdivided into those that must be fulfilled before the calculation is performed and 

those that must be checked afterwards. If a rule is infringed, the appropriate messages can be 

displayed. In the case of rules that must be checked before the calculation, variables can also be set 

to constant or calculated values. 

The following statements are possible: 

precalc : marks the beginning of the rules that must be checked before a calculation is performed. 

postcalc : marks the beginning of the rules that must be checked after a calculation. 

assert( Condition ): The condition  is ensured. In this case, the condition  usually represents a 

comparison in which both the right-hand and left-hand side of the comparison can also be calculated. 

action msg Message : If the condition  of the previous assert has not been fulfilled, the message  is 

output. Here the message  can include variables, in the same way as report templates. 

action set Assignment : If the condition  of the previous assert has not been fulfilled, the assignment 

is performed. The assigned value can be a constant, or can be calculated from variables, in the same 

way as for the report templates. 

Defining an assignment is only really useful in the precalc section because changing the contents of 

variables after the calculation merely leads to inconsistent results and has no other effects. 

Here is an example file for a helical gear calculation: 

precalc  

assert (ZR[0].x.nul < 1)  

action msg "Profilverschiebung Rad 1 zu gross, Ist {ZR[0].x.nul}, Maximum 

1. Wird auf 1 gesetzt."  

action set ZR[0].x.nul = 1  

assert (ZR[1].x.nul < 1)  

action msg "Profilverschiebung Rad 2 zu gross, Ist {ZR[1].x.nul}, Maximum 

1. Wird auf 1 gesetzt."  

action set ZR[1].x.nul = 1  

postcalc  

assert ((ZP[0].a/ZS.Geo.mn) < 200)  

action msg "Center distance too big for module (a={ZP[0].a}, mn={ZS.Geo.mn}, 

a/mn={ZP[0].a/ZS.Geo.mn})." 
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Explanations:  

The "precalc" statement opens the section of the rules that must be executed before the calculation. 

The first "assert" statement checks whether the nominal profile shift of gear 1 is less than 1.0. 

If this "assert" is not fulfilled, the "action msg" statement outputs the message that the profile shift is 

too big, displays the current value and tells you that the profile shift has been set to 1.0. 

The "action set" then sets the profile shift to 1.0. 

The second "assert" statement checks the same values for gear 2. 

The "postcalc" statement signifies the end of the set of rules to be executed before the calculation 

and opens the section containing the rules that are to be checked after the calculation. The example 

shows a definition of an "assert" statement. This checks the ratio between the center distance to the 

module. If the rule is infringed, the "action msg" statement triggers a message to the user. However, 

there is no point in changing one of these two values after the calculation, and this is why the "action 

set" statement is not present here. 

Permitted operators and functions in the formulae (see chapter 8.5.3.3, Calculation variables). 

The file containing the rules is stored in the template directory (TEMPLATEDIR, usually the 

"template" (see chapter 2.1, Directory structure) subdirectory). As the template directory can also be 

project-specific, you can also define project-specific rules. 

2.9 FEM related settings 

By default, KISSsoft uses CM2 FEM®/CM2 MeshTools® (referred to below as the CM2 Library). 

This CM2 Library is integrated in KISSsoft, so no further action is required by the user. 



I Running KISSsoft 68 
 

3 Running KISSsoft  

3.1 Start parameters 

You can run KISSsoft from the input prompt with the following start parameters: 

Parameter  Description  

INI=directory  The KISS.ini (see chapter 2.6, Global settings - KISS.ini) file will be 

loaded from the specified location. You can transfer a file name, with its 

directory path, or only a directory name. 

START=module  The specified calculation module will be started. The module descriptor 

is, for example, M040 for bolt calculation or Z012 for cylindrical gear pair 

calculation. 

LOAD=file name  The calculation module belonging to the file is started and the file is 

loaded. If the supplied file name does not include a path, the system 

looks for the file in the User directory (see chapter 2.6.1, Definitions in 

[PATH]). 

LANGUAGE=number  KISSsoft starts with the language specified for the interface and reports. 

(0: German, 1: English, 2: French, 3: Italian, 4: Spanish, 5: Russian, 6: 

Portuguese, 7: Chinese, 11: English with US Customary Units) 

DEBUG=file name  A log file containing debug information will be written. It can be very 

helpful for error-tracking. It is advisable to define the file name with a 

complete path, so that you can find the log file easily later. 

LIC=license file   If a license file is specified here, KISSsoft starts with that license file 

instead of the specified default license file. 

File name  The calculation module belonging to the file is started and the file is 

loaded. This also provides a way to associate KISSsoft with the 

appropriate file name extensions in Windows. 

3.2 Disconnect license from the network 

If KISSsoft has not been properly shut down, users may remain registered if a network version is in 

use. This may lead to licenses being blocked even though some users are no longer working with 

KISSsoft. You can disconnect a license from the network by selecting the required license (the user 

and start time are also displayed). To do so, select the Extras > License tool  option in the Network  

tab. The system then also deletes the appropriate cookie file and activates the blocked license on the 

network again. 
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Unused licenses will be activated after a certain time, as soon as the next user logs on. This time-

span can be predefined via the TIMEOUT (see chapter 2.6.6, Definitions in [LICENSE]) variable in 

the KISS.ini (see chapter 2.6, Global settings - KISS.ini) file. 

Ʒ Note  

A user who has been disconnected from KISSsoft can no longer carry out calculations in the current 

session. The user must restart KISSsoft. However, they can still save data. 
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4 Elements in the KISSsoft user interface  

KISSsoft is a Windows-compliant software application. Regular Windows users will recognize user 

interface elements, such as the menus and context menus, docking window, dialogs, tooltips and 

status bar, from other applications. Because the internationally valid Windows Style Guides are 

applied during development, Windows users will quickly become familiar with how to use KISSsoft. 

 

Figure 4.1: Elements in the KISSsoft user interface 

4.1 Menus, context menus and the tool bar 

In the File  main menu, you can open and save calculation files, and send them as e-mail 

attachments, restore previous calculation stages, view file properties and exit KISSsoft. Click File > 

Save as template  to retain user-defined default values (see chapter 2.4, Defining your own template 

files). 

You can use the KISSsoft Project Management (see chapter 6, Project Management) functionality 

from both the Project  main menu and the Project Tree (see chapter 4.2.2, The project tree). You can 

open, close and activate projects, insert files into a project, or delete them, and also view project 

properties. 

Each individual docking window (see chapter 4.2, Docking window) in the user interface can be 

hidden or displayed in the View  main menu. If you are in the report or helptext viewer, select View > 

Input window  to return to the calculation module input dialog. 
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In the Calculation  main menu, you can run the current calculation (see chapter 5, KISSsoft 

Calculation Modules), add more calculations to the calculation module as default tabs or special tabs 

and call subcalculations as dialogs. Select Calculation > Settings  to change the Module specific 

settings. 

In the Report main menu you will find actions for generating and opening a report. The system 

always generates a report for the current calculation. Click Report > Drawing data  to display 

drawing data (see chapter 8.3, Drawing data) for the element currently selected in the Report Viewer 

(see chapter 4.4.1, Report Viewer). Click Report > Settings  to change the report's font size, page 

margins and scope. The options for saving, sending and printing are only active if a report is open. 

You can open and close the Graphics window (see chapter 4.3, Graphics window) of a calculation 

module in the Graphics  main menu. Select 3D export  to access KISSsoft's CAD interfaces. Select 

Graphics > Settings  to choose the CAD system into which you want to export the selected element. 

In the Extras  menu, you will find the license tool, the configuration tool and the database tool. In this 

main menu, you can start the Windows calculator and change the language (see chapter 2.2, 

Language settings) and system of units (see chapter 2.3, Systems of units). In Extras > Settings , 

you can change general program settings such as the formats for time and date values. 

In accordance with Windows conventions, at the end of the menu bar you will find the Help  icon, 

which you can use to navigate in the KISSsoft manual. In Help > Info  you will find information on the 

program version and on the support provided by KISSsoft. 

In addition to the main menu, KISSsoft uses context menus  in many locations. Context menus give 

you access to actions for a particular area or element of the software. Normally, you click the right-

hand mouse button to display context menus. 

The tool bar  gives you faster access to actions from the menus that are used particularly frequently. 

You should also read the tool tips: they display information about the actions in the tool bar and also 

the more detailed explanations in the status bar (see chapter 4.5, Tooltips and status bar). 

Ʒ Note  

The Calculation , Report  and Graphics  main menus are only active if a calculation module is open. 

The actions available in these menus may vary depending on the current calculation module. 

4.2 Docking window 

Beside the menu bar, tool bar and status bar, the docking windows are important elements in the 

KISSsoft user interface. Docking windows are windows that can either be moved freely on the 

desktop, like a dialog, or docked on the program pages in any arrangement that suits you. Several 

docking windows can be placed on top of each other and be displayed as tabs. 
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You can release a docking window by double-clicking in its title bar. To move a docking window, click 

the left-hand mouse button in the title bar and move the mouse while holding down the mouse 

button. If you move the mouse close to the edge of the main window, a new position for the docking 

window will be displayed. Docking windows can be arranged in several lines and columns around the 

main window. Release the mouse button to place the window.If you press and then hold down the 

Ctrl button while moving a docking window, the docking window then becomes free-floating. 

 

Docking windows can be displayed and hidden via the View menu (see chapter 4.1, Menus, context 

menus and the tool bar) . 

 

The individual arrangement of docking windows in each calculation module is saved in the user-

defined settings. As a result, every calculation module always starts in the same place as when it 

was last used. 

4.2.1 The module tree 

The module tree shows all KISSsoft calculation modules in an easy to understand and logically 

structured list. Any calculation modules for which you have not purchased a license are grayed out. 

To open a module, double-click on it with the left mouse button. The current calculation module will 

be shown in bold. 
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Figure 4.2: KISSsoft calculation modules 

4.2.2 The project tree 

The Project Tree gives you an overview of the open projects, and the files belonging to these 

projects, and highlights the active working project (see chapter 6.3, The active working project) in 

bold. You use project management functions (see chapter 6, Project Management) via the Project  

menu or from a context menu (see chapter 4.1, Menus, context menus and the tool bar). 

4.2.3 The Results window 

The KISSsoft results window displays the results of the last calculation. For each calculation module, 

the basic calculation results and the results for the current special calculation are displayed in two 

results windows. The results can be saved and printed via the context menu. 
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Figure 4.3: The KISSsoft results window 

4.2.4 The Messages window 

The messages window displays all information messages, warnings and errors. Generally, all 

additional messages are not only displayed, but also appear in a message box. You can change the 

way information and warnings are displayed in a message box by selecting Extras >  Settings . 

4.2.5 The info window 

The Info window displays information that is displayed when you click on an Info button (see chapter 

5.2.1, Value input fields) in the calculation module. You zoom and print the information via a context 

menu (see chapter 4.1, Menus, context menus and the tool bar). 

4.2.6 Manual and Search 

The manual's Table of Contents and search function are also available as docking windows. When 

you select an entry, by double-clicking on it, the Helptext viewer (see chapter 4.4.2, Helptext Viewer) 

opens and the relevant section in the manual is displayed. 

4.3 Graphics window 

In KISSsoft, you can open as many graphics windows as you need at the same time and arrange 

them in the same way as the other docking windows (see chapter 4.2, Docking window). This means 

you can see all the graphics and diagrams you require for your calculations at a glance. To make 

working with graphics more effective, you can use the tool bar (see chapter 4.3.1, Tool bar and 

context menu), the Comment field, the context menu (see chapter 4.3.3, Context menu) and the 

Properties (see chapter 4.3.4, Properties). 
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Figure 4.4: Components of the graphics window 

4.3.1 Tool bar and context menu 

Use the selection list in the tool bar to switch from one graphic to another in a group. You will also 

see various icons for saving, printing and locking a graphic, and also functions for displaying or 

graying out its properties. 

 

Save graphic as  

This saves the graphic as a DXF, IGES or other image or text format, with the name you enter here. 

Saving diagrams in a DXF file usually creates a conflict between the diagram axis units and the unit 

used in the DXF file. For this reason, when you save a diagram, the program opens a dialog in which 

you can specify the drawing area to which the diagram is to be projected, in the file. 

 

Print graphic  

Prints the current section of the graphic. The information underneath the graphic is defined by 

graph*.rpt report templates (see chapter 8.5). 
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Lock  

This is useful for comparing two calculation results. In this way, you can, for example, generate a 

Specific sliding  graphic for a toothing scenario, lock this graphic and then, after having changed the 

gear parameters, open a new graphics window that shows the new calculation results. The locked 

window will no longer be updated. 

 

Figure 4.5: Locking graphics windows (a) Locked window and (b) Window with new calculation results 

When you lock a graphics window, a dialog will open, in which you can enter a title for the window. 

This makes it easier for you to compare different graphics. 

 

Figure 4.6: Dialog window for inputting the window title 

 

Properties  

This opens a list with the Properties (see chapter 4.3.4, Properties) of the current graphic in the same 

window. 
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Video recording  

Starts recording a video of the 3D graphic. All of the graphic's animations and movements are 

recorded when video recording is enabled. Click again to stop recording. You can then either save or 

delete the video file. 

The size of the graphic cannot be changed while video recording is active. 

4.3.2 Comment field 

In the Comment information is displayed about the graphic. You can change the Comment to suit 

your needs and it is included in the print output. 

4.3.3 Context menu 

Here, use the left-hand mouse button to select, move, zoom and measure elements in a graphic. You 

can permanently select which action is to be performed in the context menu. You can access this 

more quickly by using these combinations: Move: Shift, Zoom: Ctrl and Measure: You can select 

multiple single items by pressing the Alt key while holding down the left-hand mouse button. 

Other actions in the context menu are: Zoom In (plus), Zoom out (minus) and Fit window (Pos1 or 

Home). Use the direction keys to move the current section of the graphic. 

4.3.4 Properties 

In Properties, you can display or hide elements in a graphic and change its colors and line styles. 

You can make different modifications, depending on the graphic: for diagrams and such like, you can 

modify the value ranges and units to match the axes, or, for a meshing, you can change the center 

distance. 
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Figure 4.7: Graphic properties 

If the properties are displayed, you will see three other icons in the tool bar. You use them to store 

curves in a graphic as text, or in the graphic itself. 

 

Save curve as text  

Stores the coordinates of the curve selected in Properties in a text file. This makes it easy to transfer 

curves to, for example, an Excel file. 

 

Save curve  

Stores the curve selected in Properties in the graphic. This function is ideal for comparing the 

graphical outputs of a calculation while you change its parameters. 
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Delete memory  

Deletes the curve from the memory. 

 

Figure 4.8: Graphics with saved and different curves 

4.3.5 Toothing 

If you select Toothing, additional icons are displayed for generating the gear pair and creating the 

flanks when you open the Geometry  graphics window. 

 

Rotate to the left  

Generates the gear pair to the left. 

Key combination: Ctrl + left direction key 
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Rotate to the right  

Generates the gear pair to the right. 

Key combination: Ctrl + right direction key 

 

Rotate one gear independently to the left  

One gear remains static while the other is rotated to the left. The profiles overlap. 

Key combination: Alt + left direction key 

 

Rotate one gear independently to the right  

One gear remains static while the other is rotated to the right. The profiles overlap. 

Key combination: Alt + right direction key 

 

Make flank contact left  

The gears are rotated until the flanks of both gears touch on the left. 

 

Make flank contact right  

The gears are rotated until the flanks of both gears touch on the right. 

Ʒ Note:  

If you press and hold down a button, to rotate it, the gears rotate continuously (movie). 

Ʒ Note:  

Click Properties (see chapter 4.3.4, Properties) to specify the number of rotation steps for the 

rotation. The number of rotation steps here refers to the pitch. 
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4.4 Main input area 

The main input area shows a calculation module's input window. In addition, it is used to display the 

internal report viewer or the internal help viewer. 

4.4.1 Report Viewer 

When you generate a report in KISSsoft, the report viewer opens in the main input area, the entries 

in the Report  menu are activated and the report viewer tool bar is displayed. The report viewer is a 

text editor that supports the usual functions for saving and printing a text file. In KISSsoft, you can 

save reports in portable document format (.pdf), in Microsoft Word format (.doc) or as ANSII text 

(.txt). 

The report viewer's other functions are Undo/Redo, Copy, Cut and Paste, and Search, with the usual 

shortcuts. You can zoom in on the view and edit the report later on by changing the font size, bold, 

italics and underlining style. To change the general appearance of the report, select Report  > 

Settings . 

4.4.2 Helptext Viewer 

The KISSsoft manual is displayed in the Helptext viewer in HTML format. To open the manual, select 

something in the Table of Contents or the Search function. If you press function key F1, the system 

displays more information about where the cursor is currently located in KISSsoft. 

4.5 Tooltips and status bar 

Whenever it is useful, tool tips are provided in KISSsoft, to give you additional information about 

program elements. Tooltips appear automatically if you slowly move the mouse over a program 

element. 

If you position the mouse over a particular menu option, the system will display detailed information 

on all actions available in that menu, in the left-hand area of the Status bar. If the mouse is 

positioned over a selection list, the currently selected list entry will be displayed in the status bar. 

This is especially helpful if the display is restricted by the width of the selection list. 

In the right-hand area of the status bar, the system will display the current status of the calculation. 

The flag is set to CONSISTENT if the results are current. INCONSISTENT shows that a new 

calculation needs to be carried out. 
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5 KISSsoft Calculation Modules  

5.1 Standard and special tabs 

The input window for most calculation modules is subdivided into different tabs. This ensures that 

inputs are separated logically. The system does not automatically display all the existing tabs for 

more complex calculations, such as for a cylindrical gear pair. When you open a new calculation, you 

only see the tabs that contain the absolutely essential inputs. (For example, for a cylindrical gear 

pair, this would be the Basic data, Reference profile, Manufacturing  and Tolerances  tabs.) In the 

Calculation  menu, you can add more tabs if needed (e.g. for a cylindrical gear pair, you would need 

to add the Modifications  tab if you wanted to modify the gears). 

KISSsoft calculation modules use two types of tabs: Standard tabs and special tabs (see Figure 5.1). 

 

Figure 5.1: Standard and special tabs 

If a standard tab (e.g. Basic data ) is active when the calculation is run, then the basic calculation will 

be performed and the results for this basic calculation will be displayed in the (basic calculation) 

Results window (see chapter 4.2.3, The Results window). The basic calculation report is created 

when a report for this data is generated. 

Special tabs are marked with the icon. If this type of special tab is active when the calculation is 
run, then a special calculation will be performed in addition to the basic calculation. (For example, for 
a cylindrical gear pair, the path of contact under load is calculated.) The (special calculation) Results 
window then displays the results for the additional calculation along with the results for the basic 
calculation,. When a report is generated, the results for the additional calculation are also output. 

5.2 Input elements 

All KISSsoft calculation modules use the same input elements for input. These input elements are 

described in more detail in the sections that follow. 
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5.2.1 Value input fields 

In general, a value input field always includes the variable label, a formula character, the edit field 

and a unit. If the edit field is grayed out, this variable cannot be predefined. Instead it will be 

determined during the calculation. One or more of the following buttons can follow a value input field: 

 

You can retain a value by selecting the Check button. 

 

You can set a radio button to specify which values in a group should be calculated and which should 

be retained. 

 

Click the Sizing button to calculate the value using calculation methods. 

 

Click the Convert button to calculate the value using conversion formulae. 

 

Click the Plus button to display additional data for a value. 

 

Click the Settings button to display additional setting options for a value. 

 

Click the Info button to display information in the Info window (see chapter 4.2.5, The info window). 

5.2.2 Formula entry and angle input 

In some cases it is advisable to use a small auxiliary calculation to determine a value. Right-click in a 

value input field's edit field (see chapter 5.2.1, Value input fields) to open a formula editor. In it, you 

can enter a formula, which must be one of the four basic calculation types: +, -, * and /. Additionally, 

you can use all the functions that are supported by the report generator (see Table 8.2). Confirm the 

formula by pressing Enter. The system will evaluate the formula. The formula itself will be lost: if you 

return to the formula entry dialog, the calculated value will be shown there instead of the formula. 

In value input fields (see chapter 5.2.1, Value input fields) that display an angle, a dialog in which you 

can input degrees, minutes and seconds will be displayed instead of the formula editor. 
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5.2.3 Unit switch 

In KISSsoft, you can switch all the units in the value input fields (see chapter 5.2.1, Value input fields) 

and in the tables (see chapter 5.2.1, Value input fields). To do this, right-click on a unit. This opens a 

context menu in which you see all the possible units for the value. If you select a different unit from 

the one that is currently in use, KISSsoft converts the current value in the value input field to the new 

unit. 

To switch between metric and US customary units globally, select Extras > Systems of units . 

5.2.4 Tables 

In some modules, data is displayed or entered in a table. You select a row by double-clicking, just 

like when you select a field for input. For tables, additional information is often displayed in a tooltip 

(see chapter 4.5, Tooltips and status bar). In general, the following buttons come after tables so that 

you can input data: 

 

Click the Add button to add a row to the table. 

 

Click the Remove button to delete the selected row from the table 

 

Click the Clear button to delete all entries in the table 

5.3 Calculating and generating a report 

Click Calculation >Run  to perform the current calculation. In addition, the tool bar and the F5 

function key give you quick, convenient access to this action. Here, please note that a calculation 

module can contain other special calculations, in addition to the basic calculation. These special 

calculations are only performed if the appropriate special tab (see chapter 5.1, Standard and special 

tabs) is active. 

Select Report > Generate  to generate a report about the current calculation. Also note that the 

default report and the reports about the special calculations are displayed separately in the special 

tabs (see chapter 5.1, Standard and special tabs). 

The status of a calculation is consistent if it was possible to perform it without error. As soon as you 

change data in the input window, the calculation becomes inconsistent, which means the results of 
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the calculation in the Results window and the graphics no longer match the data in the interface. The 

current status of the calculation is displayed in the status bar (see chapter 4.5, Tooltips and status 

bar). 

5.4 Messages 

A calculation sends different types of messages to the input window: information, warnings and 

errors. Information and warnings should always be taken note of to ensure accurate results. If an 

error has occurred, the calculation is interrupted. 

Normally, all the messages are displayed in a message box and in the Messages window (see 

chapter 4.2.4, The Messages window). You can change the way information and warnings are 

displayed in a message box by selecting Extras  > Settings , and clicking on the Messages tab. 
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6 Project Management  

KISSsoft has its own project management system, which you can use to organize your calculation 

files and external files. The most important area in the project management system is the KISSsoft 

Project Tree (see chapter 4.2.2, The project tree). In it, you can see which projects are currently open 

or active, and you can see all the information about the files that belong to the individual projects. 

 

Figure 6.1: The KISSsoft project tree 

6.1 Generating, opening and closing projects 

Select Project >  New ... to create a new project. A dialog opens in which you enter the name of the 

project, the project directory, descriptions and comments, and also the directory for the template files 

(see chapter 2.4, Defining your own template files) that are to be used. The newly created project is 

inserted into the Project Tree and defined as the Active working project (see chapter 5.2.3, Unit 

switch). 

If you open an existing project (Project >  Open... ) this will also be inserted into the project tree and 

defined as the Active working project (see chapter 6.3, The active working project). 



I Project Management 87 
 

You close a project by selecting it and then selecting Project > Close . You will also find this action in 

the context menu (see chapter 4.1, Menus, context menus and the tool bar) in the Project Tree. The 

project will still be retained, and you can open it again at any time. 

6.2 Adding and deleting files 

Files can be added and deleted either via the Project properties (see chapter 6.5, Project properties) 

or the context menu (see chapter 4.1, Menus, context menus and the tool bar). As well as calculation 

files from KISSsoft, you can insert any external files in a project. 

6.3 The active working project 

The project tree shows all the open projects. It is not absolutely necessary to define an active 

working project. If you have defined an active working project, it is highlighted in bold. You can also 

set a project as an active working project by selecting Project >  Set as working project  or by 

activating it via the context menu. If you select Project > Work without project , this deactivates the 

active working project. 

The current calculation file does not have to belong to the active working project. 

6.4 Storage locations 

Files that belong to a particular project do not have to be stored in that project's directory. This 

means files can belong to several projects at the same time. However, if you have defined an active 

working project (see chapter 6.3, The active working project), KISSsoft will prompt you with its project 

directory as the first choice storage location whenever you want to open or save a calculation file or a 

report. If you are working without a project, the system will display your personal user directory (see 

chapter 2.6.1, Definitions in [PATH]) as a default storage location. 

6.5 Project properties 

To display the project properties for the selected project, either select Project >  Properties , or use 

the Project Tree's context menu (see chapter 4.1, Menus, context menus and the tool bar). 
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7 Dynamic User Interface  

The KISSsoft interface is defined by its editable text files (descriptive data). The elements it contains 

are fixed components of the software. However, any user can decide how these elements are divided 

up and arranged. Frequently used entries can be given priority in the tabs and dialog and less 

commonly used entries can be either hidden or write-protected. KISSsoft can therefore easily be 

adapted to suit the requirements of individual users. 

7.1 Modified tabs and dialogs supplied with the 

system 

The description files for the tabs and dialogs supplied with the system are stored in the kui (kisssoft 

user interface) directory. These files should never, under any circumstances, be modified by the 

user. This is because interface upgrades, which are supplied with a patch, always overwrite any user 

modifications. To modify the interface to suit your own requirements, copy the appropriate description 

file to the ext/kui directory and change it there. KISSsoft evaluates the files in this directory first. The 

description files are assigned to the appropriate calculation module by their file name and the file 

extension .kui. This is why the file name must not be changed. 

7.2 Adding additional tabs and dialogs 

The description files for additional tabs and dialogs are stored in the ext/dui (dynamic user interface) 

directory. KISSsoft evaluates the files in this directory every time a module is started. You can give 

these files any name you want, although the file extension must always be *.dui. 

 

The <module>  tag tells KISSsoft which calculation module the description file was defined for. This 

entry is mandatory for tabs. The titles of the tabs or dialogs are defined by the <title>  tab. The tag 

can contain either an actual text or the ID (number) of a text from the KISSsoft Glossary 

(wpoolUi_.txt). 

 

Use the <before>  tag to define the position of the additional tabs. If you do not see the <before>  

tag, the additional tab is placed after the standard system tabs. An additional tab can also be used to 

replace a standard tab. To exclude a tab, set the <exclude>  tag. 

 

Example of an additional tab: 

<KISSsoft filetype="userinterface">  

<module>Z012</module>  

<title>My own title</title>  
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<before>Z012_Tolerances</before>  

<exclude>Z012_BasicData</exclude>  

<element>a</element>  

<element>Q</element>  

</KISSsoft>  

 

An additional tab is always displayed. Set the <permanent> tag to define that the tab can be enabled 

via the Calculations  menu. 

<permanent>false</permanent>  

 

Additional tabs always work in the same way as the standard tabs supplied with the system. Insert 

the <calculation> , <report>  and <results>  tags to represent the behavior of a special tab. 

The <calculation>  tag executes a COM function. All the functions that are available via the COM 

interface are also available here. The name of the corresponding template is set for the report and 

the results (see chapter 8, Results and Reports). 

Use the <setup>  tag to assign a COM function to additional dialogs. This function is executed when 

those dialogs run. 

 

Examples of additional description files can be requested from KISSsoft AG. 

7.3 Formatting 

7.3.1 Elements 

Set the <element>element name</element> to add an element. The elements in the description file 

appear in the same sequence as they appear in the interface. 

 

The following element types are available: 

Value input fields For entering whole number values or floating values 

Selection lists (drop-down 

lists) 

For selecting list entries, database entries, materials, lubricants or 

load spectra 

Checkboxes For selecting/deselecting calculation options 

Titles and texts For structuring the interface 
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Click on kui in the Help directory to display lists of available elements. 

7.3.2 Columns 

Set the <column > tag to add a column. The columns in the description file appear in the same 

sequence as they appear in the interface. You will not usually need more than two columns. 

 

Example of a two-column layout: 

<column>  

<element>Element1</element>  

<element>Element2</element>  

</column>  

<column>  

<element>Element3</element>  

<element>Element4</element>  

</column>  

 

 

7.3.3 Groups 

Set the <group>  tag to add a group. The groups in the description file appear in the same sequence 

as they appear in the interface. Groups can also contain columns. Groups cannot be nested. 

 

Set the <title > tag to define a group's title. The tag can contain either an actual text or the ID 

(number) of a text from the KISSsoft Glossary (wpoolUi_.txt). 

 

Example of a group: 

<group>  

<title>145</title>  

<element>Element1</element>  
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<element>Element2</element>  

</group>  

7.3.4 Tabs 

Dialogs can also have tabs. Set the <tab>  tag to add a tab. The tabs in the description file appear in 

the same sequence as they appear in the dialog. Each tab includes elements that are arranged in 

groups or columns. Sub-tabs are not supported in the tabs in a calculation module. 

 

Set the <title>  tag to define the title of a tab. The tag can contain either an actual text or the ID 

(number) of a text from the KISSsoft Glossary (wpoolUi_.txt). 

7.3.5 Attributes 

The following attributes can be set for an element: 

Attribute  Value  Description  Usage  

de, en, fr, it, es, 

pt, ru (all: 

obsolete!) 

Actual text or the ID 

(number) of a text in the 

KISSsoft Glossary 

(wpoolUi_.txt) 

Overwrites the element's label for a 

language. Use this option to create 

company-specific or regional glossaries. 

element, 

title 

prompt ID (number) of a text in 

the KISSsoft Glossary 

(wpoolUi_.txt) 

Overwrites the element's label. Use this 

option to create company-specific or 

regional glossaries. 

element 

showPrompt false The label is not displayed. element 

(type 

selection 

list) 

ignoreTitle true The group is displayed without a label. group 

dynamic true The label is determined using a function. title 

readOnly true Set this attribute to write-protect the 

associated element. Use this option to 

predefine values (see "Defining your own 

default files" in the manual) and prevent 

other users from changing them. 

element 

decimals 2 The set unit of decimal places is then 

used as the default in the interface. 

element 

(value 

input type) 



I Dynamic User Interface 92 
 

unit DEGREE, 

MILLIMETER, INCH, 

etc. 

The set unit is then used as the default in 

the interface. 

element 

index 1, 2, 3, etc. Elements with multiple entries are 

reduced to a fixed index. 

element 

count 1, 2, 3, etc. 

Function, for example, 

GetGearCount 

Sets the number to be used for elements 

with multiple entries. 

element 

visibleCondition Function, for example, 

IsOwnInput 

If this attribute is set, the associated 

element is only displayed if this function 

returns "true". 

element, 

group, tab 

shrink true The element can be narrower than its 

contents. 

element 

(type 

selection 

list) 

layout table The table fills the entire range (including 

label, formula symbol, unit). 

element 

(type 

table) 

joinLayout off The group or tab is not linked to the 

automatic layout. 

group, tab 

alignment left, right, center The input elements are left-justified, right-

justified, or centered. 

element, 

text, 

button 

hSpacer skip The automatic horizontal placeholder is 

not set. 

group 

vSpacer skip The automatic vertical placeholder is not 

set. 

dlg, tab, 

column 

geometry 1000x450, etc. The dialog is displayed in the predefined 

size. 

dlg 

editButton no 

 

 

 

 

Function e.g. 

IsOwnInput 

 

 

dummy 

The element is not provided with an 

EditButton, even if one is present (a 

Checkbox or RadioButton is not 

displayed). 

 

The element is not provided with an 

EditButton if the function is not fulfilled, 

even if this button is present. 

 

The element is given a placeholder. 

element 
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button KUI file The element is provided with a button 

that displays a dialog as defined in the 

KUI file. 

element 

Table 7.1: <element attribute1="wert" attribute2="wert">Name</element> 

7.3.6 Comments 

Comments in a description file are a useful way of explaining how the file is structured. Comments 

start with //. 

 

<title>32</title>  // Basic data 

7.3.7 Special elements 

7.3.7.1 Separator 

A (horizontal) separator can be added like this 

<line></line>  

7.3.7.2 Text 

To insert a (horizontal) text: 

<text>975</text>  // ID (number) of a text in the KISSsoft glossary (wpoolUi_.txt) 

<text>My own text</text>  // actual text 

7.3.7.3 Button 

A button can be added in this way: 

<button prompt="1799">MyDialog.kui</button> // Name of a KUI file for opening a dialog. 

<button prompt="1799">MyFunction</button> // Name of a function that is to be executed by clicking 

the button.<accept>MyFunction</accept> // Name of a function that is to be executed by clicking the 

OK button in a dialog. 

<action prompt="2053">ExportToothForm</action> // Name of a function that is to be executed by 

clicking an additional action button in the button area in a dialog. 
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<report>MyReportFile.rpt</report> // Name of a report template that is to be executed by clicking the 

report button in the button area in a dialog. 
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8 Results and Reports  

8.1 Results of a calculation 

KISSsoft displays the results of a calculation in the Results window (see chapter 4.2.3, The Results 

window). If no results are displayed, an error has occurred during the calculation. If this happens, a 

system message appears in a message box to alert you to the error. An indicator in the status bar 

(see chapter 4.5, Tooltips and status bar) shows whether the results are consistent, i.e. whether the 

results match up with the data in the user interface. 

8.1.1 Add your own texts in the results window 

To enable this, define a new file in the KISSsoft installation folder in "é\ext\.rpt\". This file must then 

be named using this convention: "Modulname + result.RPT" (e.g. for a cylindrical gear pair 

Z012result.RPT). 

Then define the new parameters or values that are to be added. These values then also appear at 

the end of the "Results" window. 

The syntax corresponds exactly to the entries for the report templates. 

8.2 Calculation reports 

Select Report > Generate  to generate reports about your calculations. In addition, the tool bar and 

the F6 function key give you quick, convenient access to this action. The report contents depend on 

which tab is currently active (see chapter 5.1, Standard and special tabs). The Length (see chapter 

8.5.2, Scope of a report) and Appearance (see chapter 8.5.3, Formatting) of standard reports can be 

influenced by user-defined report templates (see chapter 8.5, Report templates). 

A calculation module can contain further reports which you can access via the Report  menu. 

Reports are usually displayed in the KISSsoft Report Viewer (see chapter 4.4.1, Report Viewer). 

Important : The report is not saved when you return from the report viewer to the input window. To 

make it permanently available, you must save it with a new name! 

Ʒ Note  

In general, a report should only be created if the calculation is consistent (see chapter 5.3, 

Calculating and generating a report). If this is not the case, you can still generate the report, but the 

status of the calculation will then be noted in the report. 
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Ʒ Note  

When you generate a standard report, the system generates a report file with the module's label as 

its file name. The file is saved in the directory defined as the TEMPDIR (see chapter 2.6, Global 

settings - KISS.ini) in the KISS.ini file (see chapter 2.6.1, Definitions in [PATH]). 

8.3 Drawing data 

Depending on the calculation module, you can select Report >  Drawing data  to generate a report 

which can be used to output drawings. 

8.4 Report settings 

Select the Report >Settings  menu option to tailor the automatic generation of reports. All the 

settings can also be defined globally in the KISS.ini (see chapter 2.6.3, Definitions in [REPORT]) file. 

8.4.1 General 

Here you define the scope of the report (see chapter 8.5.2, Scope of a report) and whether warnings 

from the calculation are to be included in it. You can also set the font size, language and the 

standard format used to save reports. 

The report can be viewed in two different modes: "overwrite" or "compare". 

If a report is generated, and a previous report is still open, the data will be updated. The cursor in the 

editor will remain in the same line it was in before this. This feature will help you analyze specific 

values using different inputs. 

In the report settings, change the report mode to "compare" if you need to compare two or more 

reports at a time. This mode can only by set if you are using KISSedit as the editor. You can also 

synchronize the reports and scroll through them all at the same time. 

You can also set these report settings directly in the KISS.ini file. 

8.4.2 Page layout 

Here you can define the paper size and the page margins used to generate reports automatically. 
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8.4.3 Header and footer 

In KISSsoft, reports are usually generated with headers and footers. You can define your own header 

and footer lines. There are a number of placeholders available for this. 

Placeholder  Description  

%logo Picture file 

%date Dated 

%time Time 

%pn Number of pages 

%pc Number of pages 

%t Tab 

The %logo placeholder uses the selected graphics file to integrate a user-defined logo (company 

label). The date and time are output in accordance with the details specified under Extras > 

Settings . 

8.4.4 Start and end block 

Reports in KISSsoft are usually generated with a start block and an end block. You can define these 

start and end blocks yourself. The start and end blocks are defined in template files which are stored 

in the rpt  directory in the installation folder. 

  

Language  Start block file  End block file  

German kissd.rpt kissfd.rpt 

English kisse.rpt kissfe.rpt 

French kissf.rpt kissff.rpt 

Italian kissi.rpt kissfi.rpt 

Spanish kisss.rpt kissfs.rpt 

Russian kissr.rpt kissfr.rpt 

Portuguese kissp.rpt kissfp.rpt 

Chinese kissc.rpt kissfc.rpt 

Commands that can be used in these templates and what they mean: 
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Command  Description  

DATE Date (select "Extras > Settings" and then set your preferred output 

format.) 

TIME Time (select "Extras > Settings" and then set your preferred output 

format.) 

PROJECT Project name 

PROJECTDESCRIPTION Description of the project 

FILENAME/DESCRIPTION File name 

FILENAME.EXT File name with extension (e.g. "Example1.Z12") 

FILEPATH Path with file name (e.g. "C:\Temp\GearPair.Z12") 

DESCRIPTION Description of the file 

COMMENT Comment for the file 

CUSTOMER Customer name as defined in the project 

USER User name (Windows user name) 

RELEASE Version number (e.g. "04-2010") 

COMPANY Company name (as defined in the license file) 

NLINES Number of lines in the report 

IMPERIALUNITS Whether US customary units are specified for IF statements 

METRICUNITS Whether metric units are specified for IF statements 

PROJECTUSED Whether projects are used for IF statements 

  

8.5 Report templates 

For each calculation module, KISSsoft provides report templates to define the form and content of 

the reports. You can use these supplied templates as the basis for generating user-defined templates 

for producing reports that meet your requirements. However, you must ensure the Formatting (see 

chapter 8.5.3, Formatting) and Storage locations (see chapter 8.5.1, Storage locations and 

descriptions) remain the same. 

8.5.1 Storage locations and descriptions 

The report templates supplied by KISSsoft are stored in the directory that has been set as RPTDIR 

(see chapter 2.6, Global settings - KISS.ini) in the KISS.ini (see chapter 2.6.1, Definitions in [PATH]) 
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file. If RPTDIR (see chapter 2.6.1, Definitions in [PATH]) was not defined in KISS.ini (see chapter 

2.6, Global settings - KISS.ini), you will find the templates in the installation folder under rpt. It is 

essential that user-defined report templates are stored in the RPT subdirectory, in the EXTDIR (see 

chapter 2.6.1, Definitions in [PATH]) directory. This is the only way to prevent your templates from 

being overwritten if a patch is installed. When the system generates a report, it uses the user-defined 

template from the EXTDIR directory, if present. Otherwise it uses the template from the RPTDIR to 

create the report. 

The report template labels have this structure: MMMMlsz.rptIt is made up of: 

MMMM Module descriptor e.g. M040 

l For historical reasons, always = l 

s Language of the report s = d, e, f, i, s or a 

z For historical reasons, always = 0 

.rpt File type 
 

Ʒ Examples  

Bolt calculation:  

M040LD0.RPT Bolt calculation, German printout 

M040USER.RPT Default printout via the interface, 

results in the M040USER.OUT file 

Cylindrical gear calculation:  

Z012LD0.RPT Cylindrical gear pair, German printout 

Z012USER.RPT Default printout via the interface, 

results in the Z012USER.OUT file 

Z10GEAR1.RPT Output via interface, contains only data 
 

for gear 1, results in file Z10GEAR1.OUT 

Z10GEAR2.RPT Output via interface, contains only data 
 

for gear 2, results in file Z10GEAR2.OUT 

Z011LD0.RPT Single gear, German printout 

Z013LD0.RPT Rack, German printout 

Z014LD0.RPT Planetary gear, German printout 

Z015LD0.RPT 3 gears, German printout 

Z016LD0.RPT 4 gears, German printout 

Spring calculation:  
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F10SPRING.RPT Default printout for drawing data results in the F10SPRING.OUT 

file 

English printout:  

M040LE0.RPT Bolt calculation, English printout 

American printout:  

M040LA0.RPT Bolt calculation, American printout 

8.5.2 Scope of a report 

To preset the scope or length of a report, on a scale of 1 to 9, select the Report > Settings  menu 

option. 9 will produce a complete report, and 1 will produce a short report. In the report template, you 

see a number between 1 and 9 at the beginning of every row. This number works together with the 

setting described above to determine whether or not the row is to be read. 

Example: If you entered 5 (medium) as the report length, all the lines in the report template that start 

with 1, 2, 3, 4 or 5 are read. Rows with 6, 7, 8 and 9 will be not read. 

8.5.3 Formatting 

Both the report template and the report generated from this are text files that are created with the 

Microsoft Windows font. You should always edit text in MS Windows, otherwise accented characters 

such as ä, ö, ü, as well as some special characters, may be represented incorrectly. 

The following statements and key words are defined in the report format: 

Texts that are to be output 

Comments that are not to be output 

Descriptions and formatting of calculation variables 

Limited branchings (IF ELSE END) 

Iterations (FOR-loops) 

8.5.3.1 Text formatting features 

You can use these text formatting features in RPT: 

Description  Start  End 

Underline <UL> </UL> 

Cross out <STRIKE> </STRIKE> 
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Grease <BF> </BF> 

Italic <IT> </IT> 

Superscript <SUPER> </SUPER> 

Subscript <SUB> </SUB> 

Font size <FONTSIZE=xx> 
 

Enlarge font size <INCFONTSIZE> </INCFONTSIZE> 

Reduce font size <DECFONTSIZE> </DECFONTSIZE> 

Page break <NEWPAGE> 
 

Line break <BR> 
 

Text color red <RED> <BLACK> 

Text color green <GREEN> <BLACK> 

Text color blue <BLUE> <BLACK> 

Http link or e-mail address <LINK=destination> </LINK> 

Blank space <SPACE> 
 

Insert figure <IMAGE=name,WIDTH=xx,HEIGHT=yy> 

Insert image <INCLUDEGRAPHIC=name,WIDTH=xx,HEIGHT=yy> 

Adding a report template <EXECUTE=name.rpt> 

8.5.3.2 Comments 

Comment lines begin with //. Comments are ignored when a report is created. 

Ʒ Example  

// Hier habe ich am 13.12.95 die Protokollvorlage geändert, hm  

Aussendurchmesser mm : %10.2f {sheave[0].da}  

In this case, only the second line will be output. 

8.5.3.3 Calculation variables 

You cannot define your own variables (apart from the number variables used for FOR loops (see 

chapter 8.5.3.5, FOR loop), which you (as the user) specify, and which can output a value. 

Placeholder  
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Use placeholders to specify the file type and formatting for a variable: 

%i stands for a whole number 

%f stands for a floating point number 

%n1.v2f stands for a formatted floating point number with v1 places in total (including sign 

and decimal point) and v2 decimal places 

%s stands for a left-justified character string (text) 

%ns stands for a right-justified character string in a field with length n characters (n is a 

whole number). 

The data types must match the definition in the program. The value is returned in exactly the place 

where the placeholder is positioned. The syntax of the formatting corresponds to the C/C++ standard. 

Ʒ Examples  

%10.2f returns a floating point number in a field that is 10 characters long and has 2 decimal 

places. In this case, the decimal point is in the position of the "%" character. 

%i returns a whole number that is right-justified to the left of the percentage sign. This 

number is therefore positioned directly underneath the whole number part of a floating 

point number and in the same position. 

%30s stands for a right-justified character string in a field with length 30 characters. If the 

number 30 is omitted, the numbers are left-justified when they are output. 

Ʒ Counter -examples  

%8.2i is an invalid formatting because a whole number has no decimal places. 

%10f2 outputs a right-justified 10-digit floating point number. However, the 2 decimal places 

are ignored and output as text 2. The default setting is to output floating point numbers 

to 6 decimal places. 

Variables  

The variable to be displayed must stand after the placeholder in the same row. The variable is 

identified by being enclosed in curly brackets. If these brackets are left out, the variable name will be 

displayed as normal text. 

Important: It is essential that the number of placeholders exactly matches the number of pairs of 

brackets {}. 

Ʒ Example  

%f {sheave[0].d} returns the value of the variable sheave[0].d in the location %f as a floating point 

number with 6 decimal places. 
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Basic calculation types - output of changed variables  

You can output changed variables in the report. They can be multiplied or divided with a coefficient. 

You can also add or subtract a number. This functionality is also available in the arguments used in 

the IF or FOR statements (see below). 

Value of the variable multiplied %3.2f {Var*2.0} 

Value of the variable divided %3.2f  {Var/2.0} 

Value of the variable added %3.2f  {Var+1.0} 

Value of the variable subtracted %3.2f  {Var-2} 

The two Degree and Gear functions are also available for converting variables to degrees or radians: 

Angle %3.2f {degrees(angle)} 

Variables can also be linked with each other directly, e.g. in the form {sheave[0].d- sheave[1].d}. More 

than two numbers can be linked. Numbers that have signs must be enclosed in brackets, for example 

{ZR[0].NL*(1e-6)}. 

The available functions are listed in Table 8.2. 

Function  Meaning  

sin(angle) sine of angle in the radian measure 

cos(angle) cosine of angle in the radian measure 

tan(angle) tangent of angle in the radian measure 

asin(val) arcsine of val, returns radian measure 

acos(val) arccosine of val, returns radian measure 

atan(val) arctangent of val, returns radian measure 

abs(val) |val| 

exp(val) eval 

log(val) Return value x in ex = val 

log10(val) Return value x in 10x = val 

sqr(val) Return value val2 

sqrt(val) Return value  

int(val) Whole number of val 

pow(x;y) Return value xy 
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sgn(val) 

Return value  

sgn2(val) 

Return value  

grad(angle) Converting from the radian measure to degrees 

rad(angle) Converting from degrees to radian measure 

DegMinSec(angle) Return angle as string (10°5'55'') 

mm_in(val) Return value val/25.4 

celsius_f(val) 

Return value val + 32 

min(ɜ1; ...; ɜ5) The return value is the minimum of ɜ1,...,ɜ5 

max(ɜ1; ...; ɜ5) The return value is the maximum of v1,...,ɜ5 

and(ɜ1; ɜ2) binary and function 

or(ɜ1; ɜ2) binary or function 

xor(ɜ1; ɜ2) binary exclusive or function 

AND(ɜ1; ...; ɜ5) logical and function 

OR(ɜ1; ...,ɜ5) logical or function 

NOT(val) 

Return value  

LESS(ɜ1; ɜ2) 

Return value  

EQUAL(ɜ1; ɜ2) 

Return value  

GREATER(ɜ1; ɜ2) 

Return value  

ROUND(x;n) Rounds off x to n places 

strlen(str) Length of character string 

strcmp(str1;str2) Compare character string 

Return value: 

1 if str1 = str2 

0 otherwise 

Table 8.1: Functions available for calculations in the report 
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8.5.3.4 Condition query IF ELSE END 

The condition query or branching enables you to output certain values and texts only if a particular 

condition has been fulfilled. The following conditions are supported: 

Combination of characters  Meaning  

== equal to 

>= greater than or equal to 

<= less than or equal to 

!= not equal to 

< less than 

> greater than 

Table 8.2: Boolean functions available in the report 

This condition is entered as follows: 

IF (condition) {Var}  

Case 1 

ELSE  

Case 2 

END; 

Ʒ Example  

IF (%i=0) {Zst.kXmnFlag}  

Addendum modified no 

ELSE  

Addendum modified yes 

END; 

If the Zst.kXmnFlag variable is 0, the first text is output. If not, the second text is output. There can be 

any number of rows between IF, ELSE and END. For each branching opened with IF you must use 

END; to close it again (do not forget the semicolon after END). The key word ELSE is optional. It 

reverses the condition. Branchings can be nested within each other up to a depth of 9. 

Ʒ Example of a simple branching  

IF (%i=1) {ZP[0].Fuss.ZFFmeth}  

Calculation of tooth form coefficient according to method: B 

END; 

If the ZP[0].Fuss.ZFFmeth variable is 1, the text is output. If not, no text is output. 



I Results and Reports 106 
 

Ʒ Example of encapsulated branchings  

IF (%fÒ 2.7) {z092k.vp} 
 

 
Regular manual lubrication (Text1 ) 

ELSE 
    

 
IF (%f<12) {z092k.vp} 

 

  
Lubrication with drop dispenser (2 to 6 drops per minute) (Text 2) 

 
ELSE 

   

  
IF (%f<34) {z092k.vp} 

 

   
Lubrication with oil bath lubrication (Text 3) 

  
ELSE 

  

   
Lubrication with circulation system lubrication (Text4) 

  
END; 

  

 
END; 

   

END; 
    

If the z092k.vp variable is less or equal to 2.7, text 1 is output. Otherwise you are prompted to confirm 

that z092k.vp is less than 12. If yes, text 2 is output. Otherwise you are prompted to confirm that 

z092k.vp is less than 34. If yes, text 3 is output, otherwise text 4 is output. 

8.5.3.5 FOR loop 

In KISSsoft you can also use FORloops in the report generator. A numerical variable will be 

incremented (or decremented) within a FOR loop. You can use constructs that are nested down to 10 

levels. 

This loop is specified as follows: 

FOR varname=%i TO %i BY %i DO {initial value}{final value} {step} 

// access to variable with #varname or $varname 

... 

END FOR; 

Instead of %i or %f you can also use fixed figures (static FORloop): 

 

FOR varname=0 TO 10 BY 1 DO 

... 

END FOR; 
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or a mixture: 

 

FOR varname=5 TO %i BY -1 DO {final value} 

... 

END FOR; 

Each FORloop must end with the statement END FOR; (including semicolon). Each defined 

numerical variable (varname) within the loop can be addressed with the statement 

#varname . 

The increment can also be selected as a negative value (for example -1). However, it must 

never be 0. You must always specify the intervals. 

The #varnamestatement can be used to define a variable. For example: 

Number of teeth: %3.2f {ZR[#varname].z} 

The $varnamestatement can be used to output the variable value as a letter. The value 0 

corresponds to A, 1 corresponds to B etc. For example: 

 

FOR quer=0 TO 3 BY 1 DO 

Cross section $quer-$quer: %8.2f {Qu[#quer].sStatisch} 

END FOR; 

Ʒ EXAMPLE OF A SIMPLE LOOP  

FOR i=0 TO 10 BY 1 DO 

Run number #i $i  

END FOR; 

Results in the following output: 

Run number 0 A  

Run number 1 B  

Run number 2 C  

Run number 3 D  

Run number 4 E  

Run number 5 F  

Run number 6 G  

Run number 7 H  

Run number 8 I  

Run number 9 J  

Run number 10 K 

The numerical variable can be used anywhere within the loop, even for arrays. 
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8.5.3.6 Meta data in a report template 

Meta data can be applied to make a range of settings for report generation, using a report template. 

Where applicable, these settings overwrite the values set in the Report > Settings  menu. 

The meta data is defined in a comment block at the beginning of the main report template. If report 

templates are loaded later by clicking on <EXECUTE>, no changes to existing settings can be made. 

The comment block must be coherent. Any meta data that is entered after the first line not starting 

with the comment markers ó//ôwill be ignored. The format for defining meta data is 

//NAME=value  

The following settings can be made: 

Name Value Comment  

NOTABSTOPS  

Changes to font with fixed spacing (Courier 

font). Indents are created using blank spaces 

instead of tabs. 

Primarily intended for old format templates. It 

should not be used for new templates. 

TITLE 

The title is written out or 

fetched using the 

GETSTRING() function 

Only evaluated in RPS files. 

To display the title, click on Report > Special 

reports . If the title is not set, the templateôs file 

name is used instead. 

MODULE 

Module description, e.g. 

Z012, Z010 or Z000. 

ALL for all 

Only evaluated in RPS files. Specifies the 

calculation modules in which the template is 

displayed in the Report > Special reports  

menu. 

LANDSCAPE  Changes page orientation to landscape. 

FORMAT TEXT Changes to text format. 

LANGUAGE 

 

  

GERMAN 

ENGLISH 

FRENCH 

ITALIAN 

SPANISH 

PORTUGUESE RUSSIAN 

CHINESE 

JAPANESE 

Only evaluated in RPS files. Specifies the 

language setting in which the template is 

displayed. 
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Name Value Comment  

UNITS US 
Changes to US customary units. At present, this 

only works in English. 

SIZE 

 

 

 

  

A5 

A4 

A3 

LETTER 

LEGAL  

Sets the paper format. 

 

ENCODING 

ASCII 

LATIN1 

UTF8 

UTF8BOM 

UTF16 

Sets the encoding for the result file. In most 

cases, this is only useful when FORMAT=TEXT. 

MARGINTOP Length in mm Top margin 

MARGINBOTTOM Length in mm Bottom margin 

MARGINLEFT Length in mm Left margin 

MARGINRIGHT Length in mm Right margin 

HEADER NONE 
Hides the header and prevents KISS?.RPT from 

loading 

FOOTER NONE 
Hides the footer and prevents KISSF?.RPT from 

loading 
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9 Database Tool and External Tables  

In addition to the unique data you input for calculations, you may also encounter recurring data such 

as a material's characteristics. KISSsoft will store these characteristics in databases. You view and 

change them with the database tool , whose use will be explained in the following sections. Tables 

form the elements of the databases and are contained in your program package as editable ASCII 

files. The External tables (see chapter 9.4, External tables) section deals with the setting up and 

handling of external tables (also called "look-up tables). 

In KISSsoft there are four databases: 

KMAT  - Materials 

M000 - Shaft-Hub Connection and Bolts 

W000 - Shafts and Bearings 

Z000 - Gears 

This table (see Table 9.1) uses the M000 database as an example to show how data is organized in 

KISSsoft. As shown there, the F040NORM and M090MAT tables belong to the group of shaft-hub 

connections. 

KMAT  

M000 

W000 

Z000 

(a) Databases 

9.1 table: Table: How data is organized in KISSsoft (1 of 2) 

KMAT  

M000 

F040NORM 

... 

M090MAT 

W000 
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Z000 

(b) tables 

9.2 table: Table: How data is organized in KISSsoft (2 of 2) 

Up to now, the following tables have been created in the databases: Center distance tolerances, 

Reference profiles, Bore standard, Thread type bolt, Production process for hypoid bevel gears, 

Manufacturing process for bevel gears, V-belt standard, Spline standard, Chain type DIN 8154, 

Chain type DIN 8187, Chain type DIN 8188, Glue materials, Load spectra, Soldering materials, Key 

standard, Polygon standard, Woodruff key standard, Lubricants, Bolt type, Washer standard, Multi-

spline standard, Rolling bearing, Materials for glued and soldered joint, Material, Tooth thickness 

tolerances, Toothed belt standard. 

9.1 Viewing database entries 

To open the database, select the Extras  > Database tool  menu option, as shown in (Figure 9.5, ). 
A dialog window appears with the question whether you want to open the database with write 

authorization ( ). If you click on Yes, you can edit the database entries, otherwise they are write 

protected. If you select No, the actual database tool window ( ) opens, but in read-only mode. 
There, you can select a table from a list that is assigned to a particular database. The row of a table 
contains the values that set the parameters for the database entry. The columns contain the 
parameters for the database entries, i.e. values for the yield point of different materials. This section 
describes how to edit database entries. You can also display table entries by selecting a row in the 

database tool window and then confirming this by clicking Display  ( ). The Display entry  window 

opens with a structured display of the value amount from a table row ( ). 

9051.htm


I Database Tool and External Tables 112 
 

 

Figure 9.1: Accessing database entries 

Ʒ Note:  

With the KISSsoft database tool you can change the databases and expand them with your own 

entries. The data stored in the databases are in a sense "sensitive", so that incorrectly entered 

values can have consequences that are initially imperceptible, yet eventually far-reaching and 

serious. For this reason, when you open the database you are asked whether the access should 

have write authorization. If you answer this question with "No"", you can view the data in the tables 

but not change it. 

If you want to make absolutely sure that the databases remain unchanged, you can write protect their 

corresponding files (*.udb ). Any attempt to open a table with write authorization results in an error 

message and the table will normally be opened in write protected mode. To change a file's write 
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protection attribute, right-click on the file in Windows® Explorer, and then click on Properties . Click 

in the Properties  dialog field, on the General  tab, and then click the Write -protected  checkbox. If 

you want to make changes to a write protected file, first either deselect the Write -protected  

checkbox or save the file with a different name. 

9.2 Managing database entries 

If you want to change one of your own entries in a table in the database, you must work in write 
authorization mode. To do so, click Yes in the 5ba0bcdba6a56 dialog window. In the list that you see 

next, ( ) select the required table by double-clicking on the appropriate row or single-clicking on the 
Edit button at the bottom right of the window, after you have selected the row. The database tool 

window now shows a list of the table entries ( ) and a row of new buttons is displayed on the 
bottom left in the window: 

 

Moves the selected item up one row 

 

Moves the selected item down one row 

 

Moves the selected item to the start of the list 

 

Moves the selected item to the end of the list 

 

Adds a new item to the list 

 

Moves the selected item into the list of hidden datasets. 

Select the Filter  drop-down menu option on the top right of the window to choose between displaying 

active datasets, hidden datasets, or both. Active datasets can be used within the calculation 

modules, hidden ones cannot. 

9.2.1 Creating a database entry 

If you click on the button without having selected a row, the Display  entry  window ( ) opens 
and the input fields in it are empty. Only the Name field contains the entry _NEW, which normally 
identifies the new table entry. After you have transferred the necessary data, confirm your entries by 
clicking on OK and then Savein the database tool window. The new entry is assigned an 
identification number (ID) Ó 20000 and is then transferred into the list of active datasets. Click the 
Edit  button to change entries with an ID of Ó 20000. 

Click the button after having selected a row, the Display  entry  window opens and contains 
predefined values in the input fields according to the table entry. The suffix _NEW will automatically 
be attached to the name, in order to differentiate it from the original dataset. In all remaining steps, 
you then proceed as described above. 

Example: Creating a database entry  
Let's assume you want to add a new spring material to the KMAT.F000 table. As described in the 

procedure, you would select the F000 table from the KMAT  database. Click on the button in it, to 
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add a new entry/new row to the table, and then transfer the new data into the input fields in the 
Display entry  window. However, as only a few parameters can be freely selected there, the next 
question is, where can the other values such as the yield point and Young's modulus be changed? 
The reply is: in the base material input fields, i.e. in table KMAT.KISS . You must always specify a 
base material before you can introduce a new spring material. If this is not present, you must first 
define it in the KMAT.KISS table and then make the missing entries in KMAT.F000 . 

Ʒ Note  

All material-specific tables such as KMAT.F000  or KMAT.Z080  - with the exception of KMAT.KLUB  - 

have a Check button beside the Base material drop-down menu. If you have marked the checkbox, 

you have the option of selecting an alternative base material in the associated drop-down list-menu. 

If the checkbox is empty, access to the menu of the base materials is blocked. This option helps 

prevent unwanted changes when the base material is being assigned. 

9.2.2 Deleting a database entry 

Datasets in KISSsoft will never be deleted. It is only possible to move entries with an ID Ó 20000 into 
the table in which hidden datasets are stored. Select the corresponding entry by single clicking on it 

in the window and then click on the button. The selected row will be copied into the range that 
contains the hidden datasets and is removed from the list of active datasets. To access the table of 
inactive datasets, select the Display only hidden datasets  option in the Filter  drop-down list menu 
in the top right of the database tool window. 

9.2.3 Restoring a database entry 

In the hidden datasets table, select the appropriate row with a single mouse click and then click on 

the button. The entry will be copied into the table of active datasets and then removed from the 
inactive datasets range. 

9.3 Import and export data from the database tool 

The datasets from every table in the database tool can be exported to a file or imported from a file. 

These datasets can be imported or exported as a single dataset or imported from a list of datasets. 

To import a list of datasets, first save it in a file, preferably an Excel spreadsheet with the extension 

".csv". The entries in the spreadsheet columns should match the database table columns. 

The software can also interpret lists that are saved as text files with the ".txt" extension. List entries 

should be separated by a "comma" or a "semicolon". Which separator is used depends on your 

operating system configuration. 

Use the Dataset  button to import datasets from a file with the extension ".kds", or export 

them from one. 
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Use the List  button to import datasets from a file with the extension ".csv", or export them 

from one. 

Ʒ Important notes:  

Only "user-defined datasets" (ID >= 20000) can be exported or imported. 

An existing "user-defined dataset" can be overwritten if you are processing individual 

datasets. 

The names of the columns in the ".kds" files is case-sensitive and must exactly match the 

names in the database tool. You could export a dataset to verify the column names. 

A new ID will automatically be assigned to every dataset if an entire list is imported or 

exported. 

9.4 External tables 

KISSsoft uses external tables, also called look-up tables, to handle larger data volumes. One or more 

output values from these external tables are assigned to one or more input values (see Figure 9.2). 

 

Figure 9.2: Principle of functionality of external tables 

The output data that is assigned to the input data are contained in the table. 

The external tables are stored in the /KISSsoft installation directory /dat . If a new table name is 

entered in a database, a file with the same name and the file extension .dat  must also be created 

manually. 

Because tables are located externally, KISSsoft can only determine how many of them there are 

during program execution. The user directly benefits from the fact that they can generate their own 

files with data tables, in a similar way to the files supplied by KISSsoft. The tables are readable ASCII 

files and can therefore be edited and expanded by the user. It would, for example, be possible to use 

an internal standard as an alternative to the ISO base tolerances. 

Figure (see Figure 9.3) shows the three table types used by KISSsoft in one diagram: 
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Figure 9.3: Types of external tables 

A table always has the following structure, no matter what type it is: 

:TABLE type  variable or label  

table header  

DATA  

data  

END 

Use the :TABLE  command to mark the external table as an external table. You must use one of the 

following designations for the Type  argument: 

FUNCTION Functions tables 

RANGE Range tables 

LIST List tables 

Ʒ Note  

You can mark blanks in tables with *, - or blank spaces. Note here that no space characters can be 

used if they are followed by more values. KISSsoft interprets blank space as value separators. 

The structure of the table header and the body data, which is dependent on the type, is described 

with example applications in the following sections. 

9.4.1 Functions tables 

Functions tables are tables that expect one or two input values (1D or 2D table) and which return 

exactly one corresponding value. 

Ʒ Example 1D table  

The angle coefficient (factor ) is determined on the basis of a specified (angle ). For example: if the 

input value angle = 45 supplies an output value of factor  = 0.35. 
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-- table type: Functions table; output variable: factor  

:TABLE FUNCTION factor  

-- INPUT X angle defines the input parameter angle; 

-- interim values will be interpolated linearly 
 

INPUT X angle TREAT LINEAR 

-- Data content: 1st line: input values, 2nd line: output values 

DATA 
 

0 30 60 90 . . . 
 

0.1 0.25 .45 .078 . . . 

END 

INPUT is a key word, i.e. a word that is reserved by the Table Interpreter, and is followed by an 

argument X, which assigns a dimension to the angle  input parameter. The key word TREAT, with 

associated LINEAR  argument, specifies that interim values are to be interpolated linearly. The output 

value factor  will determined using the value of the angle  variable. The first row of data content in the 

1D table (between DATA  and END) corresponds to the input value angle , and the second row 

corresponds to the output value. The data content in a 1D table is therefore always a (2 × n) matrix, 

i.e. both rows must contain the same number of values. 

Ʒ Example of a 2D table  

The nominal power is defined on the basis of the speed and the sheave diameter. For example: if the 

input values diameter = 60 and speed = 60 supply an output value power = 8.6 . 

-- table type: Functions table; output variable: power  

:TABLE FUNCTION power  

-- INPUT X diameter defines the input parameter diameter ; 

-- INPUT Y speed defines the input parameter speed ; 

-- interim values will be interpolated linearly in both dimensions 
 

INPUT X angle TREAT LINEAR 
 

INPUT Y Speed TREAT LINEAR 

-- Data content: (see chapter 10.3, Example: Interference fit calculation) 

DATA 
  

50 100 200 300 . . . 
 

50 4 7 12 25 . . . 
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75 12 25 30 35 . . . 

 
. . . . . . . . . . . . . . . . . . 

END 

Here, the variable power  is defined with the input variables INPUT X and INPUT Y. Interim values 

running down the columns (Y) should be interpolated linearly. The same applies across the rows (X). 

The first row in the table corresponds to the values of the INPUT X entry variables. The first column 

corresponds to the values of the INPUT Y entry variables. The values placed at the points where the 

entry values intersect are values which correspond to the output variables (see Figure 9.4). 

 

Figure 9.4: Data schema of 2D tables 

If would be possible to use this method to define an inverse table. Assuming that, in your XY belt 

catalog, the table displaying power output shows the speed in the first row, and the diameter in the 

first column, then there is no need for you to turn your table upside down. Instead, simply change the 

assignment in the table header (i.e. replace X with Y). 

9.4.2 Range tables 

Range tables check whether a given value is moving within a defined range. 

Ʒ Example  

-- table type: range table; Name of the table: 'A' 

:TABLE RANGE 'A'r  

-- INPUT X drehzahl defines the drehzahl  (speed) input parameter. 

-- interim values will be interpolated logarithmically. 

-- INPUT Y leistung defines the leistung  (power) input parameter. 
 

INPUT X drehzahl l TREAT LOG 
 

INPUT Y leistung 
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-- Data content: 1st line: INPUT X, 2nd line: INPUT Y upper limit 

-- 3rd line: INPUT Y lower limit 

DATA 
  

200 300 500 1000 4000 
 

LOWER 1.5 2.0 3.0 10 20 
 

UPPER 10 15 20 15 40 

END 

The two input variables are drehzahl  (speed) and leistung  (power). The output value represents the 

decision about whether the power in dependency with the speed is moving within a defined range 

and does not have to be declared. Interim values of the speed will be interpolated logarithmically. 

The first row of the body data corresponds to values of the drehzahl  (speed) variable. The other 

rows correspond to values of the leistung  (power) variable with LOWER as the lower, and UPPER 

as the upper, limit. The input value of leistung  (power) is compared with these limits and a report 

sent to the program stating whether the leistung  is located below, within, or above, the given range 

A. 

9.4.3 List tables 

Several output values are defined in list tables that contain at least one input value. The sequence of 

the input values is important if more than one input value is entered. The reading direction goes from 

left to right and the first input value defines the range of the next input value, which in turn defines 

that of the next one, etc. up to the last. All input values apart from the last one must match the entries 

in the body data (TREAT DIRECT, (see chapter 9.4.4, List of key words used)). 

Ʒ Example 1  

If the following three input values are assumed: 

g.d = 2.0; g.P = 0.8; s.l = 6  

The output values would be in accordance with the code given below: 

s.l = 7; s.k = 3; s.k = 4.5 . 

-- Table type: list table. Output variable: s.norm  

:TABLE LIST s.norm  

-- INPUT g.d defines the input parameter g.d ; 

-- INPUT g.P defines the input parameter g.P; 
 

INPUT g.d 
 

INPUT g.P 

-- IN_OUT s.l defines s.l as phase variable 
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-- TREAT NEXT_BIGGER specified how interim values are handled 
 

IN_OUT s.l TREAT NEXT_BIGGER 

-- OUTPUT s.k, s.dk declares s.k and s.dk as output variables 
 

OUTPUT s.k,s.dk 

-- Data content: A (N × Nin) matrix 

DATA 
 

2.0 0.4 0 
  

 
2.0 0.8 5 3 4.5 

 
2.0 0.8 7 3 4.5 - relevant data row 

 
2.0 0.8 10 3 4.8 

END 

In contrast to functions tables, s.norm  in the first row of the code specifies the name of the external 

table, and not the output variable. IN_OUT s.l declares a variable s.l , which is used both as an input 

and output variable (phase variable). TREAT functions again as a key word for processing the 

interim values: NEXT_BIGGER shows that input values are to be evaluated it they are not present in 

the appropriate column in the body data. In the example, the input value s.l =  6 lies between the 

values 5 and 7 and, in accordance with NEXT_BIGGER, will be promoted to the next bigger value. 

OUTPUT s.k, s.dk  declares not only s.l.  but also the output values s.k  and s.dk . The number of the 

columns in the body data must at least correspond to the number of input variables and, at most, 

correspond to the number of input variables + output variables, in this case: 3 < Nin > 5. 

Ʒ Example 2  

Two input values are used to determine the different measurements for a bolt: the bolt type, here 

represented by the typ  variable, and the bolt length, specified by l. 

:TABLE LIST schraube.geometrie (meaning "bolt.geometry")  
 

INPUT typ  
 

INPUT l TREAT NEXT_SMALLER  
 

OUTPUT M, dw, (s), e, bez, vorrat  

DATA 
 

. . . 
       

 
12x2.5 20 12 14.57 23.78 5.75 ID 1 1 

 
12x2.5 25 12 15.78 24.88 5.75 ID 2 1 

 
. . . 

       



I Database Tool and External Tables 121 
 

END 

This table is called schrauben.geometrie  (meaning "bolts.geometry"). The sequence in the table 

header defines the sequence within the columns. The first column therefore corresponds to the typ  

variable, the second to the l variable, etc. The typ  and l variables are used as inputs, where the 

value for the typ  variable must be present in the list. If an interim value is given for the l variable, the 

row with the next smaller value will be interpreted as the result. Blanks are not permitted, i.e. in this 

type table values must always be present. It may happen that individual variables are shown in 

brackets in the output definition. This has the effect that the appropriate column is ignored, i.e. this 

variable will not be specified. 

Ʒ Note  

Commented-out output definitions cannot be changed by the user. 

9.4.4 List of key words used 

-- The Interpreter ignores everything in a row that follows 

this comment character. 

DATA  The data matrix is below this. 

END Ends the input area of the external table. 

INPUT [<dim>] <var> Input variable, with definition of the dimension if required. 

IN_OUT <var 1>[, <var 2>, ...] List tables: Phase variables 

LOWER  Range tables: Lower limiting value. 

OUTPUT <var 1>[, <var 2>, ...] Output value(s) 

:TABLE <type> Defines the type of the external table. 

TREAT DIRECT  Interim values: none permitted. The values input in the 

appropriate column/row must match those of the body 

data. 

TREAT NEXT_SMALLER  Interim values: The next smallest value is assigned. 

TREAT NEXT_BIGGER  Interim values: The next highest value is assigned. 

TREAT LINEAR  Interim values: Linear interpolation. 

TREAT LOG  Interim values: Logarithmic interpolation. 

UPPER  Range tables: Upper limiting value. 
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9.5 Description of database tables 

The individual database tables have very different structures. The next section describes these 

database tables and their specific fields. 

The Label  field is displayed in every table, and is only described here. You must enter a unique 

name for the dataset in this field. This name is then used to select the datasets in the program. 

Note: Fields in which file names are to be entered have an auto-fill function. To perform this, the 

software searches in the ..\dat and ..\ext\dat folders, and also in the current project directory. 

9.5.1 Center distance tolerances 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

The tables used for center distance tolerances begin with K10-???.dat. The center 

distance tolerances specified in ISO 286 are imported directly from the program code 

and not from a file. 

9.5.2 Machining allowance for cylindrical gear 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

The tables for the cylindrical gear machining allowance begin with ZADDT-???.dat. 

9.5.3 Reference profiles 

You enter reference profile data directly in the database. However, each individual value depends on 

the other. 

Description in accordance with ISO, the standard on which this is based  

Comment: Text field for your own use  

Data source: Text field for your own use  

Definable reference profile data: Dedendum coefficient h* fP, root radius coefficient Ɫ*fP, 

addendum coefficient h* aP, tip radius coefficient Ɫ*aP, topping, protuberance height 

coefficient h* prP, protuberance angle ŬprP, tip form height coefficient h* FaP, ramp angle 

ŬKP 

9.5.4 Compression springs standard 

You can store data from geometry standards for compression springs. 
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File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

The tables for compression spring standards begin with f010-??.dat. 

Tolerance:  tolerance data for the geometry standard 

9.5.5 Hobbing cutter selection 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

The table for cutter data according to DIN 3972 is called Z000-BP.dat. 

9.5.6 Basic material Glued and Soldered joints 

Tensile strength R m: [N/mm2] Data about the material's tensile strength is required to 

calculate glued and soldered joints. 

9.5.7 Manufacturing process for bevel and hypoid gears 

These values are only necessary for calculations using the Klingelnberg method. They correspond to 

tables for machine types that use the Klingelnberg in-house standard. 

Values that must be defined: machine type, cutter tip cutter radius r 0[mm], No. of blade 

groups cutter z 0, maximum machining distance MD max[mm], minimum normal module 

mn,min[mm], maximum normal module m n,max[mm] 

9.5.8 V-belt standard 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for the V-belt standard begin with Z090-???.dat. 

Calculation method:   

1) Narrow V-belts (Fenner) 

2) Narrow V-belts/force belts 

3) Conti belts 

More definitions: Maximum belt speed v max[m/s], elasticity E: [N], weight per length q: 

[kg/m], coefficient of friction ɛr 

9.5.9 Spline Standard 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for spline standard norms begin with M02C-???.dat. 

Calculation method: the appropriate calculation method is selected for each spline. 
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9.5.10 Chain profiles ISO 606 

Values to be defined for this table: type, pitch p: [mm], number of strands n s, maximum 

roller diameter d 1[mm], maximum bolt diameter d 2[mm], minimum width between inner 

plates b 1[mm], maximum width over inner link b 2[mm], total width b tot[mm], maximum 

inner plates depth h 2[mm], ratio t H/tS 

9.5.11 Adhesives 

Comment:  Text field for your own use. 

Definable values: Minimum  and Maximum shear strength ŰB,min, ŰB,max [N/mm 2]. 

9.5.12 Modifications 

The different modifications applied to gears are defined as database classes. If a dataset is hidden in 

the database, it will no longer appear in the modifications selection list. 

Although you can add new datasets to the database, these will not be visible in the calculation 

module. 

9.5.13 Load spectra 

All entries (frequency, power, speed) can be defined either as coefficients or as values. If coefficients 

are used to input these values, the power and speeds are entered as coefficients of the nominal 

power. In the calculations, the factor for torque (load factor/speed factor) is used for forces and 

torques. You cannot change the reference gear, torque, speed or power if the input is set to values. 

These input fields are inactive. 

You can either import load spectra from a file or enter them directly. If you input this data directly, the 

number of load cases is defined by the number of lines you enter. 

Input:  Specify whether the factors are for power or torque. This also applies if the load 

spectrum is imported from a file. 

Link with file:  This option is displayed if the load spectrum is set to "Own input". If the option 

is displayed, load spectrum values can be imported from a selected file. The import can 

be performed in two ways: If the flag is not set, the imported load spectrum values can 

be modified. If the flag is set, the load spectrum values are automatically overwritten by 

the values in the selected file, and cannot be modified. 

Own input of load spectra:  You can input the load spectrum directly, or import it from a file. 

File name:  Click the button to select a file via the directories. The file containing the load 
spectrum must be a text file (.dat). You will find a sample load spectrum file called 
"Example_DutyCycle.dat" in the "dat" directory. You should store load spectra you 
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define yourself in the "EXT/dat" directory, to ensure they are always available even after 
a version upgrade. 

 

Example of a file used to input a load spectrum 

Frequency:  H0 ... H19, the sum of these frequencies must be 1. 

Load factor (torque factor):  P0 ... P19 0<Pn<,Ð. 

Speed factor: N0 ... N19, 0<Nn<Ð. 

Load bins with negative torque are interpreted as a change from driving to driven. 

9.5.14 Solders 

Definable values: Minimum  and Maximum shearing strength ŰB,min, ŰB,max [N/mm2]. 

9.5.15 Surface roughness of shafts and shaft-hub connections 

You can also input your own data for shaft-hub connections in the "Own Input" field. The Rz values 

for the shafts are taken from the list. 

Comment:  Text field for your own use. 

Definable values: Mean peak -to-valley roughness R z [ɛm] and arithmetic mean roughness 

value R a[ɛm]. 

9.5.16 Key standard 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for key standards begin with M02A-???.dat. 
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9.5.17 Polygon standard 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for polygon standards begin with M02D-???.dat. 

9.5.18 Woodruff key standard 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for Woodruff key standards begin with M02E-???.dat. 

9.5.19 Bolts/pins 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for bolt/pin standards begin with M03A-???.dat. 

9.5.20 Lubricants 

Comment, description as specified in ISO, data source:  Text fields for your own use 

Additive for rolling bearings:   

Without additives:  Lubricants without additives, or with those additives whose 

effectiveness in rolling bearings has not been tested. 

With additives:  Lubricants whose effectiveness has been tested in rolling 

bearings 

Oil/Grease: specify whether the lubricant is an oil or a grease. 

Kinematic viscosity at 40°C and at 100°C ɜ40,ɜ100: [mm2/s] 

Lubricant base: Selection options:  

Mineral oil 

Polyglycol-based synthetic oil 

Polyether-based synthetic oil 

Polyalphaolefin-based synthetic oil 

Ester-based synthetic oil 

Polyalphaolefin: similar to mineral oil, easily mixable with mineral oil, some approved for use with 

foodstuffs. 

Esters: some approved for use with foodstuffs, some biodegradable. 

Test procedure scuffing:  Selection options:  

No information about scuffing 

FZG Test A/8.3/90; ISO 14635-1 (normal) 
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FZG Test A/16.6/90 

FZG Test A/16.6/120 

FZG Test A/16.6/140 

FZG Test A10/16.6R/120; ISO 14635-2 

Input of scuffing temperature 

FZG test A10/16.6R/90 

FZG test S-A10/16.6R/90 

Failure load stage scuffing FZG test: Input load stage scuffing as specified in the FZG test. 

These values are required for gear calculations. 

1= weakest stage; 12=best stage 

Good gear lubricants all have a load stage scuffing value of 12. 

Scuffing temperature ɗs: You can also enter the scuffing temperature for the scuffing test 

procedure. 

Test procedure micropitting: Selection options  

No information about micropitting available 

C-GF/8.3/90/ with Ra=0.50 ɗ=90Á (FZG) 

C-GF/8.3/60/ with Ra=0.50 ɗ=60Á (FZG) 

C-GF at current oil temperature 

Load stage micropitting test: The best achievable load stage is 10. 

Density Ɫ: [kg/dm3] 

Cone penetration at 25°C (grease) P e: [0.1mm] This value is only required to calculate 

grease-lubricated plain bearings. 

Soap proportion (grease) c s: [Vol%] This value is only required to calculate grease-

lubricated plain bearings. 

k coefficient, s coefficient (compression viscosity) k, s: Coefficient used to calculate 

compression viscosity (AGMA 925): 

 

If you do not know these values, you can input 0. The values are then taken from the standard 

(AGMA 925-A03, Table 2). 

Lower/upper service temperature limit ɗmin, ɗmax : [°C] 
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9.5.21 Bolts: Tightening factor 

Tightening technique:  Select "not yield point- or rotation-angle-controlled tightening" and 

"yield point- or rotation-angle-controlled tightening" 

Minimum tightening factor ŬAmin: Minimum value, can be defined per tightening technique. 

Medium tightening factor ŬAmid: Medium value, can be defined per tightening technique. 

Maximum tightening factor ŬAmax: Maximum value, can be defined per tightening technique. 

9.5.22 Bolts: Bore 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for bores begin with M04-???.dat. 

Unit in use : select whether the values in the file are to be read in mm or inches. 

9.5.23 Bolts: Strength grade 

Comment:  Text field for your own use. 

Definable values: Yield point R p [N/mm2], tensile strength R m [N/mm2], shearing strength 

ratio ɘb/Rm[-] 

Ʒ Note:  

The yield point and tensile strength for the lower diameter limit for strength classes 8.8 and SAE 

J429 Grades 2 and 5 are always displayed in the database. If the diameter is greater than the 

diameter limit, this is corrected in the program. 

The shearing strength ratios have been taken from Table 5.5/2 in VDI 2230 (2015) according to the 

strength classes. Undefined SAE classes are set to the ratio 0.6. 

9.5.24 Bolts: Nut strength grade 

Comment:  Text field for your own use. 

Definable values: Vickers hardness for standard thread for diameter D <= 16 mm  [HV], 

Vickers hardness for standard thread for diameter D > 16 mm  [HV],Vickers hardness 

for fine thread for diameter D <= 16 mm  [HV], Vickers hardness for fine thread for 

diameter D > 16 mm  [HV] 

Ʒ Note:  

The minimum value specified in the DIN EN ISO 898-2:2012 standard is assumed in the strength 

classes. However, as this value depends on the diameter, in some strength classes, both values are 

defined in the database. In the program, you can then specify which diameter the value is to be used 
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for. The same applies to differentiating between fine and standard threads. The program handles the 

value that is being used differently, according to the selection in the interface. 

9.5.25 Bolts: Coefficients of friction classes 

Comment:  Text field for your own use. 

Definable values: Minimum coefficient of friction ɛmin[-] and Maximum coefficient of friction 

ɛmax [-] 

Ʒ  

Ʒ Note:  

The minimum and maximum coefficients of friction are always displayed in the database for the 

coefficient of friction classes. The values are used to size the moments of friction for bolts. 

The predefined values are taken from Table A5 in VDI 2230, Sheet 1 [1]. 

9.5.26 Bolts: Thread type 

Name:  Text field for your own use. 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for threads begin with M04-???.dat. 

Coefficient used to calculate the flank diameter/core diameter  

Flank angle Ŭ: [°] 

9.5.27 Bolts: Nuts 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for nuts begin with M04-???.dat. 

Unit in use : select whether the values in the file are to be read in mm or inches. 

9.5.28 Bolts: Type 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for bolt types begin with M04-???.dat. 

Name:  Text field for your own use. 

Screw thread type: selection list to show which screw thread type this bolt has. 

Unit in use : select whether the values in the file are to be read in mm or inches. 
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9.5.29 Bolts: Washer 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for washers begin with M04-???.dat. 

Unit in use : select whether the values in the file are to be read in mm or inches. 

9.5.30 Selection of pinion type cutters 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for pinion type cutters begin with Z000-Cutter-?.dat. 

9.5.31 Disc spring standard 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for disc springs begin with F040-?.dat. 

9.5.32 Tolerances standard 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for tolerances begin with K10-???.dat. 

The tolerances according to DIN EN ISO 286 have been programmed directly into KISSsoft. For fit 

(tolerance) classes H, h, JS and js, the tolerance has been extended up to the nominal length 10,000 

mm (according to the standard, up to 3,150 mm). The values were determined by extrapolation. 

9.5.33 Beam profiles 

Drawing file:  image displayed on screen when a shaft is calculated. 

Values for profiles: height h  [mm], width b  [mm], cross section A  [cm2], moments of 

gyration of a surface relating to x -/ z-axis I x/ Iz [cm4], moment of inertia in torsion I t 

[cm4], moments of resistance relative to the x - or z -axis  Wx/ Wz[cm3], moment of 

resistance in torsion W t [cm3] 

9.5.34 Multi-Spline standard 

File name: The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for multi-spline profiles begin with M02b-???.dat. 
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9.5.35 Materials 

The materials consist of a database table Basic data Materials  and the particular table for the 

modules. The Basic data table lists the general material data. As the materials can then be 

transferred to the individual module tables, you therefore only need to define the basis data once. 

Module-specific data is then defined in the module tables. 

In module-specific tables, you must always select one Base material . 

9.5.35.1 Basic data: Materials 

Label according to DIN, BS, AISI, UNI, AFNOR, JIS, CN, Old label, Material number, Origin 

of data, Comment:  Text fields for your own use 

Young's modulus at 20°C E 20: [N/mm2] 

Poisson's ratio ɜ: [-] 

Density Ɫ: [kg/dm3] 

Coefficient of thermal expansion Ŭ: [10-6/K] 

Shearing modulus at 20°C G 20: [N/mm2] 

Type of treatment: Select the type of treatment in this list. 

Material type:  Select the material type in this list. 

Hardness value: This value is purely for information purposes and has a negligible effect on 

the calculation. 

Unit of hardness: You can select this in this list. 

Core hardness value: This value is used, for example, for the strength calculation according 

to AGMA 6101-F19/AGMA 6001-F19. However, for other calculations, the value is 

purely for information purposes and has only a minor influence on the calculation. For 

case-hardened case hardening steels, the value for the tensile strength Rm was taken 

from the DIN EN 10084 standard for a diameter between 16 and 40 mm, and was then 

calculated with the hardness conversion of the Brinell hardness HBW. 

Core hardness unit: You can select this from a list. The hardness values according to 

Brinell, Rockwell C and Vickers are possible as input values. Depending on the input, 

the required hardness values are converted into the hardness unit used. 

Tensile strength R m: [N/mm2] A maximum of 10 different diameter ranges can be defined. 

Yield point R p: [N/mm2] A maximum of 10 different diameter ranges can be defined. 

Raw diameter d: [mm] A maximum of 10 different diameter ranges can be defined. 

9.5.35.2 Material Spring calculation 

This table applies to Compression (F010), Tension (F020) and Leg springs (F030): 
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Admissible shear stress: The database entries refer to external tables (see chapter 9.4, 

External tables). Tables for springs begin with F01-???.dat. In this file, you can view or 

define the Admissible shear stress, the values for the Goodman diagram and the values 

for the relaxation diagram. If the curves of the relaxation diagram are only defined with 

2 points, you must set the values for tau3 and rel3 to 0 so KISSsoft can recognize them. 

Comment:  Text field for your own use. 

Minimum and maximum wire diameter d min, dmax [mm] 

Shearing modulus depending on temperature ŬG: [1/K] 

Use: selection list with the cold and thermo-formed variants 

9.5.35.3 Material of plain bearings 

Comment:  Text field for your own use. 

9.5.35.4 Material of enveloping worm wheels 

The table applies to worm wheels (Z080): 

Comment:  Text field for your own use. 

Material characteristics:  Selection list (such as CuSn-bronze/CuAl 

bronze/GJS40/GC25/PA-12) 

Mineral oil coefficient W MLOel: Material/lubricant factor for mineral oil 

Polyglycol coefficient (DIN)/ (ISO) W MLGDIN/ WMLGISO: Material/lubricant factor for polyglycol 

Polyalphaolefin coefficient W MLA: Material/lubricant factor for polyalphaolefin 

Material factor Y W: (see DIN 3996, Table 5) 

Pitting strength ůHlimT: [N/mm2] (We recommend you use reduced values as specified in 

ISO 14521) 

Shear fatigue strength ŰFlimT: [N/mm2] 

Reduced shear fatigue strength ŰFlimTred: [N/mm2] (If no slight deformation is permitted, you 

must include reduced strength values in the calculation.) 

9.5.35.5 Material Interference fit 

Comment:  Text field for your own use. 

9.5.35.6 Material of bolts 

The table applies to the bolt module (M040): 
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Comment:  Text field for your own use. 

Permissible pressure p G: [N/mm2] (Data should be entered as specified in VDI 2230) 

Shearing strength ŰB: [N/mm2] 

9.5.35.7 Material for disc spring calculation 

The table applies to disc springs (F040): 

Comment:  Text field for your own use. 

Goodman diagram: The database entries refer to external tables (see chapter 9.4, External 

tables). Tables for the Goodman diagram begin with F04-???.dat. 

Young's modulus depending on temperature ŬE: [1/K] 

9.5.35.8 Material of shaft-hub-connection 

Comment:  Text field for your own use. 

9.5.35.9 Housing material 

Comment:  Text field for your own use. 

9.5.35.10 Material Shaft calculation 

The table applies to shafts (w010): 

Values for calculating strength according to Hänchen:  

Bending fatigue limit ůbW: [N/mm2] 

Values for strength calculation according to DIN 743:  

Reference diameter d b [mm], Tensile strength R m [N/mm2], Yield point R p 

[N/mm2], Bending fatigue limit ůbW [N/mm2], Tension/compression 

fatigue limit ůzdW [N/mm2], Torsion fatigue limit ŰtW [N/mm2] 

Experimental data: The database entries refer to external tables (see chapter 

9.4, External tables). Tables for the experimental Haigh diagram begin 

with W01-???.dat. 

CrNiMo case hardening steel: When determining the size factor K1 for case 

hardening steel, you need to specify whether the steel is CrNiMo case 

hardening steel. The materials 20NiCrMo13-4, 17NiCrMo6-4, 

17NiCrMoS6-4, 18NiCr5-4, 17CrNi6-6, 18CrNiMo7-6, 14NiCrMo13-4, 

22CrMoS3-5 and 15NiCr13 belong to this group. According to DIN 10084, 
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there is no significant drop in the tensile strength of these materials. These 

materials also belong to this group according to Prof. Linke. 

Values for strength calculation according to FKM:  

Tensile strength for reference diameter R m,N [N/mm2], Yield point for 

reference diameter R e,N [N/mm2], Effective reference diameter for R p,N 

deff,N,p [mm], Effective reference diameter for R m,N deff,N,m [mm], Effective 

reference diameter for A d eff,N,a [mm], Constant for the calculation of K d,p 

(flow) a d,p, Constant for the calculation of K d,m (fracture) a d,m, Constant for 

the calculation of K d,a (elongation at break) a d,A 

Elongation at break A: [%] 

FKM Group: Selection list showing the material group to which the entry 

belongs. 

9.5.36 Material of gears 

Comment:  Text field for your own use. 

File for hardness curve: The database entries refer to external tables (see chapter 9.4, 

External tables). Tables for the hardness curve begin with Z22-???.dat. The material's 

measured hardness value, to be displayed as a graphic in module Z22. Does not 

influence the calculation. Here is an example of how to create this type of hardness 

curve in an external table. 
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Figure 9.5: Example of a hardness curve definition (Z22-100.dat) 

Woehler line file: The database entries refer to external tables (see chapter 9.4, External 

tables). Tables for S-N curves (Woehler lines) begin with .dat. 

You must input a file name for plastics  here. The file contains the material data 

(Woehler lines, Young's modulus, etc.) used in the calculation. 

For metallic materials you can also input a file name here. The file contains the S-N 

curves (Woehler lines) for bending strength and for Hertzian pressure that are used in 

the calculation, if the Calculate with own Woehler line  flag is set. 
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Figure 9.6: Example of a file with S-N curves (Woehler lines) for a metallic material 

Endurance limit root (ISO, DIN/ AGMA 2101) ůFlim/sat, Endurance limit flank (ISO, DIN AGMA 

2101) ůHlim/sac: [N/mm2] Endurance limit values specified in DIN 3990 or ISO 6336 Part 

5. 

Endurance limit root (AGMA 2001) s at, Endurance limit flank s ac (AGMA 2001): [lbf/in2] 

Strength calculation based on AGMA 2001. 

Average roughness height root/flank R zF/ RzH: [ɛm] 

Thermal contact coefficient B M: [N/mm/s0.5/K] This coefficient is needed to calculate the 

flash factor. You will find more information about this in DIN 3990, Part 4, Equations 

3.11, 4.17, 4.18 and 4.19. For the most commonly used materials, it is 13.795. 

9.5.37 Rolling bearings 

Rolling bearing tables are sub-divided into three different tabs: 

Basic data tab 

Additional data tab 

Internal geometry tab 

9.5.37.1 Rolling bearing basic data 

Bearing label:  The codes for the bearing series are as specified in DIN 623 Part 1. 

Comment: more detailed description of the bearing (e.g. SKF-Explorer, X-Life, etc.) 
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Main dimensions of the bearing: Inside diameter d  [mm], External diameter D  [mm], 

Bearing width b [mm], Corner radius r smin [mm] 

Basic dynamic load rating C:  [kN], Dynamic radial load rating Cr: [kN] (if radial and axial 

values are predefined, e.g. cross roller bearing) 

Basic static Load rating C 0: [kN], Static radial load rating C0r: [kN] (if radial and axial values 

are predefined, e.g. cross roller bearing) 

Dynamic axial load rating Ca: [kN] (if present, e.g. cross roller bearing) 

Static axial load rating C0a: [kN] (if present, e.g. cross roller bearing) 

Hybrid bearing:  [Yes/No] Yes: if a hybrid bearing (ceramic rolling body); No: if not a hybrid 

bearing 

Coefficients X1, Y1, X2, Y2, e, e0, X01, Y01, X02, Y02 

 Defining individual coefficients:  

X1,Y1,e: Coefficients in formula P = X1*Fr + Y1*Fa for Fa/Fr <= e 

X2,Y2: Coefficients in formula P = X2*Fr + Y2*Fa for Fa/Fr > e 

X01,Y01: According to ISO: Coefficients in formula P0 = max(Fr; X0*Fr 

+ Y0*Fa): X0 is used for X01,Y0 and Y01. 

According to Schaeffler: Coefficients in formula P0 = X01*Fr 

+ Y01*Fa for Fa/Fr <=e0 

X02,Y02, e0: According to ISO: e0 and X02 are set to 0 (not present). 

According to Schaeffler: Coefficients in formula P0 = X02*Fr 

+ Y02*Fa for Fa/Fr > e0 

X1,Y1,X2,Y2,e: For some bearings, these values are not imported from the 

database. Instead they are imported from the files, 

depending on the axial force. 

Determination of e0 according to Schaeffler: P0 = X0*Fr + Y0*Fa -> with P0 = Fr at limit -> Fr = X0*Fr + 

Y0*Fa -> e0 = Fa/Fr = (1-X0)/Y0 

Ball bearing:  depending on f0*Fa/C0 

at bearing clearance C0: Data is imported from file W05-100A.dat (single row bearing) and 

W05-100B.dat (double row bearing) 

at bearing clearance C3: Data is imported from file W05-101A.dat (single row bearing) and 

W05-101B.dat (double row bearing) 

at bearing clearance C4: Data is imported from file W05-102A.dat (single row bearing) and 

W05-102B.dat (double row bearing) 

with no clearance: Data is imported from file W05-104.dat 

Angular contact ball bearing:  depending on f0*Fa/C0 and contact angle 
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at contact angle 5°: Data is imported from file W05-100A.dat (single row bearing) and W05-

100B.dat (double row bearing) 

at contact angle 10°: Data is imported from file W05-101A.dat (single row bearing) and 

W05-101B.dat (double row bearing) 

at contact angle 15°: Data is imported from file W05-102A.dat (single row bearing) and 

W05-102B.dat (double row bearing) 

at contact angle 20Á< Ŭ< 45Á: Data is imported from file W05-103A.dat (single row bearing) 

and W05-103B.dat (double row bearing) 

Note:  

Bearing clearance class C2 is handled in the same way as C0. These formulae have been taken 

from the "Die Wälzlagerpraxis" document [2]. 

Speed limit when grease lubrication is nGmax: [rpm] Only one speed limit is specified for 

SKF bearings. There is no distinction between grease and oil lubrication. 

Speed limit when oil lubrication is nOmax: [rpm] Only one speed limit is specified for SKF 

bearings. There is no distinction between grease and oil lubrication. 

Weight m: [kg] 

Contact angle Ŭ0: [°] Input the contact angle for shaft bearings, tapered bearings, etc.; for 

four-point contact bearings: If you input 0°, this is set to 35°, for axial spherical roller 

bearings: If you input 0° this is set to 50°. 

Permitted axial force F*azul: [-] Input the permitted axial force in % of Fr. The permitted axial 

force is not checked if you input 0. 

Maximum permitted misalignment Ŭ: [min] If you input 0, the angle adjustability (i.e. a 

comparison of the permitted angular deviation of the shaft with the effective angular 

deviation in the bearing) is not checked. 

Thermal reference speed nɗr: [rpm] 

Currently not evaluated in KISSsoft: Availability (0=in stock; 1=not in stock), price [in local 

currency] 

Addition A -E: You can input additional data for specific types in these fields. (see table: Use 

of additions A-E.) 

radial  and axial spring stiffness cr, ca: [N/ɛm] 

Spring stiffness for bending crot : [Nm/°] Input spring stiffness for inclination. 

Factor f0: Used to define X and Y (e.g., for deep groove ball bearings), because these 

values depend on the factor f0*Fa/C0. 

Minimum load P/C: The minimum load P/C (P: dynamic equivalent load: C: basic dynamic 

load rating) is usually: 

0.01 for ball bearings with a cage 

0.02 for roller bearings with a cage, 0.04 for pure roller bearings with a cage 
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If you input 0 in the database, these values are used automatically in the calculation. 

These entries only apply to radial load. The minimum axial force is calculated 

directly in the software. 

Fatigue load limit C u: Coefficient for calculating the modified rating life 

Type Addition A Addition B Addition C Addition D Addition E 

Angular contact ball 

bearing (single row) 

 
Offset a (mm) 

(*2) 

   

Angular contact ball 

bearing (paired) 

 
Offset a (mm) 

(*2) 

   

Cylindrical thrust 

roller bearing 

 
Coefficient A (*1) 

 
Max. axial 

force (kN) 

 

Tapered roller 

bearing (single row) 

 
Width B (mm) Offset a 

(mm) (*2)  

Dimension C 

(mm) 

 

Tapered roller 

bearing (paired, O) 

 
Dimension T 

(mm) 

(* 1) 

 
Dimension C 

(mm) (*1) 

 

Tapered roller 

bearing (paired, X) 

 
Dimension 2B 

(mm) 

 
Dimension 

2T (mm) 

 

Barrel-shaped and 

toroidal roller 

bearings 

Calculation 

coefficient k1 

(SKF: CARB, 

internal 

geometry) 

Calculation 

coefficient k2 

(SKF: CARB, 

internal 

geometry) 

   

Spherical roller thrust 

bearing 
Dimension d1 

(mm) 

Dimension T2 

(mm) 

Dimension 

D1 (mm) 

Dimension 

T1 (mm) 

Pivot 

center 

(mm) 

Table 9.3: Use of additions A-E 

Descriptions given in additional data conform with those in the INA/FAG catalog 2017. 

(*1) Values are only used for SKF bearings, as specified in the SKF catalog 2013. 

(*2) Values for dimension a, for FAG bearings, have been provided up to the center point by the 

manufacturer. In KISSsoft, half the bearing width has then been added to this value to obtain the 

database value (This might result in values that vary slightly from those in the bearing catalog). The 

value at the bearing center was used in this calculation. This corresponds to the data we received 

from the manufacturer. 
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9.5.37.2 Rolling bearing Internal geometry 

You can define and edit data for the internal geometry of most bearing types in the Internal geometry 

tab. Many bearing manufacturers do not make this data available directly. However, in KISSsoft, you 

can estimate this data by using the calculation methods specified in ISO/TS 16281. 

You need the details documented below to calculate internal geometry. For some rolling bearings, 

you can also enter a user-defined roller profile definition file, which is a ".dat" file (see chapter 

28.1.2.1, User-defined roller profile). 

To handle bearings without an inner or outer ring more effectively, these profiles can be deactivated 

either individually or together. However, you must define the internal geometry before you can use 

this function. The corresponding internal and external bearing diameters, d and D, then refer to the 

(average) operating pitch circle of the corresponding bearing housings and must be modified if 

necessary. A slightly different reference diameter is therefore used to calculate the bearing 

clearance. This might result in negligible differences when compared to the identical bearings with 

rings. If a bearing side is defined as being without a ring, any calculations of fit used in shaft projects 

are deactivated. 

The load-bearing capacity correction factors (fC, fC0) are used to adjust the load-bearing capacity, 

which is used to approximate the bearing geometry according to: 

C' = C Å fC  

C'0 = C0 Å fC0 

Deep groove ball bearing (single row), four-point contact bearing: Number of balls Z  [-], Ball 

diameter D W [mm], Reference diameter  DPW [mm], Inside diameter of the rim, pressure 

side  DBI [mm], Outside diameter of the rim, pressure side D BA [mm], Radius of 

curvature, inside  ri  [mm], Radius of curvature, outside ro  [mm] 

 

Figure 9.7: Dimensions of the deep groove ball bearing, single row 

Deep groove ball bearing, double row: Same geometry value as for single row deep groove 

ball bearings. Additional input: Row distance a [mm] 
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Figure 9.8: Figure: Dimensions of the deep groove ball bearing, double row 

Angular contact ball bearing (single row): Number of balls Z  [-], Ball diameter  DW [mm], 

Reference diameter  DPW [mm], Inside diameter of the rim, pressure side  DBI [mm], 

Outside diameter of the rim, pressure side  DBA [mm], Radius of curvature, inside  ri  

[mm], Radius of curvature, outside  ro  [mm], Minimum initial tension  vmin [mm], 

Maximum initial tension  vmax [mm], Minimum pretension force Fvmin [N], Maximum 

pretension force  Fvmax [N] 

 

Figure 9.9: Dimensions of the angular contact ball bearing 

Cylindrical roller bearing (single row): Number of rollers Z  [-], Diameter of roller  DW [mm], 

Reference diameter  DPW [mm], Inside diameter of the rim, pressure side D BI [mm], 

Outside diameter of the rim, pressure side D BA [mm], Roller length  LWE [mm], Axial 

displacement possibility non -locating bearing  v l [mm], Axial displacement possibility 

fixed bearing  vf [mm] 
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Figure 9.10: Dimensions of the cylindrical roller bearing 

Cylindrical roller bearing (double row): Number of rollers Z  [-], Diameter of roller  DW [mm], 

Reference diameter  DPW [mm], Inside diameter of the rim, pressure side D BI [mm], 

Outside diameter of the rim, pressure side D BA [mm], Roller length  LWE [mm], Row 

distance a  [mm] 

 

Figure 9.11: Dimensions of the double row cylindrical roller bearing 

Axial angular contact roller bearing: Number of rollers Z  [-], Diameter of roller  DW [mm], 

Reference diameter  DPW [mm], Roller length  LWE [mm] 
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Figure 9.12: Figure: Axial angular contact roller bearing mass 

Tapered roller bearing (single row): Number of rollers Z [-], Diameter of roller  DW [mm], 

Reference diameter  DPW [mm], Roller length  LWE [mm] 

 

Figure 9.13: Dimensions of the tapered roller bearing 

Double row self-aligning roller bearing: Number of rollers Z  [-], Diameter of roller D W [mm], 

Reference diameter  DPW [mm], Inside diameter of the rim, pressure side  DBI [mm], 

Outside diameter of the rim, pressure side D BA [mm], Radius of curvature, inside  ri  

[mm], Radius of curvature, outside ro  [mm] 
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Figure 9.14: Dimensions of the double row self-aligning roller bearing 

Needle roller bearing, needle cage: Number of rollers Z  [-], Diameter of roller  DW [mm], 

Reference diameter  DPW [mm], Roller length  LWE [mm], Axial displacement possibility 

non -locating bearing  v l [mm] 

 

Figure 9.15: Dimensions of the needle roller bearing/needle cage 

Deep groove thrust ball bearing: Number of balls Z  [-], Ball diameter  DW [mm], Reference 

diameter  DPW [mm], Radius of curvature, inside  ri  [mm], Radius of curvature, outside 

ro  [mm] 

 

Figure 9.16: Dimensions of the deep groove thrust ball bearing 
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Cylindrical roller thrust bearing: Number of rollers Z  [-], Diameter of roller  DW [mm], 

Reference diameter  DPW [mm], Roller length  LWE [mm] 

 

Figure 9.17: Dimensions of the cylindrical roller thrust bearing 

Spherical roller thrust bearing: Number of rollers Z  [-], Diameter of roller  DW [mm], 

Reference diameter  DPW [mm], Roller length  LWE [mm], Distance  LWC of the maximum  

Roller diameter  [mm], Radius of curvature, inside  r i [mm], Radius of curvature, roller  

Rp [mm], Radius of curvature, outside r o [mm] 

 

Figure 9.18: Dimensions of the spherical roller thrust bearing 
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9.5.38 Rolling bearing tolerance 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for rolling bearings begin with W05-??-??.dat. 

9.5.39 Rolling bearing fit (tolerance) classes 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for rolling bearing tolerance classes begin with W05-???.dat. 

9.5.40 Tooth thickness tolerances 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for tooth thickness tolerances begin with Z01-???.dat or Z9-???.dat. 

Interpret as:  

Tooth thickness allowances: the data is interpreted as tooth thickness 

allowances. 

Base tangent length allowances: the data is interpreted as the base tangent 

length allowances (or normal play). 

9.5.41 Toothed belt standard 

File name:  The database entries refer to external tables (see chapter 9.4, External tables). 

Tables for the toothed belt standard begin with Z091-???.dat. 

Calculation method:   

1)"normal" toothed belts (RPP) 

2) GT types (PolyChain) 

3) AT types (Brecoflex) 

4) PG types (PowerGrip) 

Differences: 

Special calculation for toothed belts with integrated steel rope (Method 3) 

Calculating the operating factor: the special factor for the speed increasing ratio is added 

(Method 1, 2 or 4) or multiplied (Method 3) 

Additional performance table for higher performance at greater conversions (Method 2) 

Calculation method for belt pre -tension:   

1) in % of the circumferential force; slack = 1/50 of the tension length 

2) in % of the maximum permitted circumferential force; slack = 1/50 of the 

tension length 
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3) in % of (operating factor*power(W)/circumferential speed reference circle 

(m/s)) (according to DAYCO RPP Panther) Slack = 1/64 of the tension 

length 

4) in % of the circumferential force; Slack = 1/64 of the tension length 

Nominal range for power table b: [mm] belt width, which corresponds to the performance 

data stored in the file (see file name). 

Coefficient for belt pre -tension f:  0 ... 1.0 (% factor for calculating the belt pre-tension 

coefficient) 

Maximum belt speed v max: [m/s] 

Summand for operation F s: No influence 

Pitch p:  [mm] pitch of the toothed belt 

Elasticity E: [N]  Elasticity = force that doubles the length of a belt (with nominal width). If 

you do not know this value, enter 0 as the guide value (in this case the elasticity is 

ignored when the bending test is performed). 

Strain Ů: [%] strain along the total length of the belt 

Weight per length q: [kg/m/mm] per meter length and millimeter width 

File contents:  
 

List of suggested standard numbers of teeth for toothed 

lock washers 
:TABLE LIST z.RadZahne 

List of suggested standard numbers of teeth for belts :TABLE LIST z.NormZahne 

Minimum number of teeth, depending on the speed 

(small disc) 

:TABLE FUNCTION z091k.factorINCR 

Correction factor for powering up, depending on the 

ratio (this is added to the operating factor) 

:TABLE FUNCTION z091k.factorINCR 

Transmittable power depending on the number of teeth 

(small disc) and speed (small disc) 

:TABLE FUNCTION z091k.powerNr 

Correction factor for the number of contacting teeth 

(small disc) 

:TABLE FUNCTION z091k.factorCorrEZ 

Correction factor for belt length :TABLE FUNCTION z091k.factorLength 

Correction factor for belt width :TABLE FUNCTION belt.bth 

Correction factor for belt width (same values as shown 

in the table above) 

:TABLE FUNCTION belt.beff 

Disc width depending on belt width :TABLE FUNCTION z091k.ScheibenBreite 

Belt type sizing: minimum transmittable power (lower 

limit) depending on the speed (small disc) 

:TABLE FUNCTION z091k.kWlower 

Belt type sizing: maximum transmittable power (upper 

limit) depending on the speed (small disc) 

:TABLE FUNCTION z091k.kWupper 
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10 Description of the Public Interface  

10.1 Interfaces between calculation programs and 

CAD - Overview 

The closest contact point of calculation programs within a CIM concept is the one with the drawing 

program (CAD). KISSsoft's public data interface can be freely formatted, enabling very powerful 

communication with third party programs. 

All input and output data can be exported in ASCII format. The scope and format of this data is freely 

definable. For this, each calculation module contains a special, editable report file. The 

MMMMUSER.RPT files are used as a template for this data transfer. The default setting is that these 

files are empty. If you want to output data over the interface, you first have to expand the templates. 

External programs can, in addition, transfer input data (also in ASCII format) to calculation modules. 

This data is read automatically during start-up, and then displayed on the screen. 

*The character string MMMM in a file name is a placeholder for the module to which the file refers. 
Example: M040USER.RPT 

10.1.1 Efficient interfaces 

Automated data transfer between the calculation and CAD should only be set up if the benefits are 

considerably greater than the effort required. For example, an interface between a bolt calculation 

program and CAD is only of secondary importance since the information to be transferred (for 

example that, due to the calculation, an M10 bolt has to be selected) is too limited and could be 

transferred much faster "by hand". If, however, a standard parts library with bolts is available, the 

bidirectional link between the three components (calculation program, standard parts library and 

CAD) can prove very efficient. 

The following efficient interfaces are available (but this list can be extended): 

General  

It should be possible to start the calculation programs from the CAD 

environment (for example by pressing a function key). This enables you to 

perform a short calculation while you are drawing, transfer the results and 

then continue drawing. 

Shafts and bearing calculation  

Output of a contour from the CAD system (i.e. a shaft from detailed or drawing 

with combined elements) and reading it into the calculation program. 
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(Problem: in many CAD programs, it is unfortunately rather difficult to 

define the contour to be exported.) 

Output of a shaft that has been optimized in the calculation program (including 

rolling bearings etc.), reading it, and importing it into CAD as drawing 

information. 

Transfer of bending lines and similar data into the CAD system. 

Rolling bearings and plain bearings are calculated, and then the contour is 

transferred to the CAD system. (Frequently, the CAD system already 

contains information on rolling bearings, so that only the bearing label is of 

interest.) 

Gear calculation  

Calculation of fabrication data in the program and transfer of the required 

values to the CAD as text. This is a very important function, since the 

recording of the data is very prone to errors, with potentially serious 

consequences.  

Calculation of the exact tooth form in Page view and transfer to 

the CAD system. (Although this results in very pretty 

drawings, it usually does not supply any necessary 

information, except if the data undergoes further processing, 

i.e. via transfer onto a wire electro-discharge machine.) 

Transfer of the schematic axial section or the Print Preview of the gears to the CAD system 

(but can also be achieved just as quickly in CAD, manually). 

Machine elements  

Transfer the contour of calculated machine elements to the CAD such as bolts, 

V-belt sheaves etc. (Frequently, the CAD station already contains 

appropriate, preprogrammed information, so that only the parts definition 

is of interest). 

Shaft-hub connection  

The sizing or proofing of connections should be implemented directly in a CAD 

system, so that known data from the CAD can be transferred into the 

calculation and the results of the calculation can in turn be returned to the 

CAD system. 

10.1.2 Open interfaces concept in KISSsoft 

The KISSsoft interfaces concept has a simple, yet very flexible structure. 

It should be possible to integrate calculation programs into all kinds of CAD systems as simply as 

possible, and use them in different environments (operating systems such as MS Windows or UNIX). 



I Description of the Public Interface 150 
 

The interface mechanism between the CAD system and KISSsoft is based on a text dataset (ASCII 

file), and an ID is transferred together with the numerical value for all transfer data (see chapter 10.3, 

Example: Interference fit calculation). This dataset can be of variable length, but only the values that 

are known in the CAD system will be transferred. This depends on the CAD system and the currently 

active drawing. 

KISSsoft will test the dataset transferred by the third party program, to ensure it is complete and 

consistent, and, if necessary, you will be prompted to input additional data in the KISSsoft input 

system. KISSsoft will then run the calculation and write the output data that the CAD system requires 

to a second text dataset. It then returns this dataset to the CAD system. By using the report 

generator you can select any format for the output file, i.e. KISSsoft adapts itself to the third party 

program. The CAD can now read the data required by the situation and process it selectively. 

This concept results in simple interface forms, which enables even non-specialists to write 

applications quickly. 

 

10.2 Defining input and output 

10.2.1 Preamble 

In this description the KISSsoft program is always taken as a reference, i.e. an input file for 

KISSsoft becomes an output file for the third party program and vice versa. 
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For automatic data exchange with other programs you will require files with the name 

MMMMUSER.RPT . You can adapt these files to your own requirements. However, if 

you have purchased KISSsoft interfaces, you should act with caution, since these files 

are also required for these interfaces. 

File name  Storage location  Description  

MMMMUSER.IN  <CADDIR> *) Input file for KISSsoft (is written by the third party 

program) 

User's temporary input file (= will be deleted when 

imported into KISSsoft) 

MMMMUSER.OUT <CADDIR> KISSsoft output file (will be written by KISSsoft and 

read by the third party program). Temporary (= 

should be deleted by the third party program) 

MMMMUSER.RPT  <KISSDIR> Defines the output format (similar to report), can be 

permanent/optional (= is usually created once and 

is retained) 

Z10Gear1.RPT  

Z10Gear2.RPT 

Z10Gear3.RPT 

Z10Gear4.RPT 

<KISSDIR> Defines the output format for the manufacturing 

data in the case of cylindrical gears (see below). 

Corresponds to MMMMUSER.rpt for this special 

case. 

Z10Gear1.OUT <KISSDIR> Output file containing the toothing stamp 

for cylindrical gears. 

Z70Gear1.RPT 

Z70Gear2.RPT  

<KISSDIR> Defines the output format for bevel gears. 

Z17Gear1.RPT 

Z17Gear2.RPT  

<KISSDIR> Defines the output format for crossed helical gears. 

Z80Gear1.RPT 

Z80Gear2.RPT  

<KISSDIR> Defines the output format for worm wheels. 

Z9aGear1.RPT 

Z9aGear2.RPT  

<KISSDIR> Defines the output format for spline connections. 

Z??Gear1.OUT 

Z??Gear2.OUT  

<CADDIR> Toothing stamp, similar to definition files. 

*) If you specify the entire file name including the directory, it can also be read from any location. 

10.2.2 Requirements placed on the third party program 

To successfully run and use KISSsoft within a third party program, the following minimum 

requirements must be met. The third party program must 

have a query mechanism (i.e. macro language) for providing information, e.g. input data, 
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be able to write and read ASCII files, 

be able to start a program. 

10.2.3 Used files 

10.2.3.1 Input file 

An input file with the name MMMMUSER.IN will be used. It has the same structure and the same 

function as the saved calculations, except for its temporary status. The values are assigned to the 

KISSsoft variable names with =. A separate row is used for each variable. 

Ʒ Example  

VERSION=2.5; 

m02Aw.dWa=30¶ 

m02Aw.lW=20¶ 

m02An.lN=25¶ 

The input file will be read after the default values are predefined (see chapter 2.4, Defining your own 

template files), i.e. the values of the temporary input file will overwrite the values set by the default. 

Note:  Temporary input files are used for frequently changing variables such as geometry and/or 

performance data: data which typically changes from calculation to calculation. It would also be 

possible to write this data to the template files, since they represent normal input variables. This 

would, however, mean that the program generating these files had to interpret the data that has 

already been written, i.e. had to accept permanent constraints, to enable it to completely define the 

default and to reset to the default data again at the end. 

10.2.3.2 Output file 

To return the data that is relevant for the KISSsoft calling program, the specified output file 

MMMMUSER.OUT will be generated immediately after a calculation. The scope and the format of the 

output file will be defined in a report template called MMMMUSER.RPT window. 

This means that KISSsoft can fully adapt itself to the syntax of a third party program. The range of 

commands and the report generator's syntax is described in the Reports section (see chapter 8.5, 

Report templates). Example report files are supplied to help you with this. 

10.2.4 Temporary files 

The input file MMMMUSER.IN input file is generated by the third party program and, after having been 

read, will be deleted by KISSsoft. The MMMMUSER.OUT output file is deleted when KISSsoft starts, 

and created again after a calculation. 
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10.2.5 Explicitly reading (importing) and generating data 

In addition to the previously described automatic definition you can also explicitly read data by 

selecting File >Interface >  Read data , or generate it by selecting File > Interface >  Output data . 

You can therefore select any point in time and use it for many varied tasks, i.e. to generate an order 

form etc. 

10.3 Example: Interference fit calculation 

The following example of the Interference fit assembly calculation is used to illustrate the way that 

the KISSsoft interfaces concept works, in more detail. 

For the interference fit assembly between the gear rim and the cylindrical gear hub, you need to find 

the one tolerance pairing that meets the following boundary conditions: 

Permanent torque MD = 88000 Nm 

The tolerance pairing involves a system of the standard drill hole (H). 

Safety against sliding > 1.4 

 against fracture of the hub > 1.5 

 against fracture of the gear rim > 1.5 

 against the yield point of the hub > 1.1 

 against the yield point of the gear rim > 1.1 

Procedure:  

The necessary information for the geometry is extracted directly from the drawing, with a suitable 

CAD routine, and converted to the interfaces format defined by KISSsoft: 

 m01allg.df=640 

 m01n.da=800 

 m01w.di=242 

 m01allg.l=200. 

File contents M010USER.IN 

Then, start the KISSsoft module. It accepts the geometry data and displays it in the main screen. 

In the main screen, enter any parameters that are still missing, the torque, and the materials, and 

then start the calculation. In KISSsoft, you can also size the tolerance pairing. Here, you are 
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prompted to select suitable tolerance combinations from a list. The system then performs the 

calculation with your final selection. 

After you have exited the calculation, the results file is automatically converted into a format that can 

be read by the CAD macro. The format of this result file is defined via the templates file 

M010USER.RPT: 

[SHAFT] 

ntol_max = %f{m01w.tol.max} 

ntol_min = %f{m01w.tol.max} 

ntol_bez = %s{m01w.tol.bez} 

[HUB] 

ntol_max = %f{m01n.tol.max} 

ntol_min = %f{m01n.tol.max} 

ntol_bez = %s{m01n.tol.bez} 

File contents M010USER.RPT 

The result then looks like this: 

[SHAFT] 

wtol_max = 390.000000 

wtol_min = 340.000000 

wtol_bez = s6 

[HUB] 

ntol_max = 50.000000 

ntol_min = 0.000000 

ntol_bez = H6 

File contents M010USER.OUT 

This data is now attached directly to the appropriate dimension in the CAD system, via the macro. 

Summary:  

The individual tasks are therefore split up: Each side of the interface will perform only the tasks it is 

best suited to. The CAD administers the geometry and passes this information on to the calculation 

program, which knows how to process the data, and which, in turn, will return the result to the CAD. 
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The CAD system and calculation program can be used efficiently together, with the defined interface. 

10.4 Geometry data 

KISSsoft has different interfaces for transferring geometry data (contours, drawings): 

DXF format (recommended for communication with most CAD systems) 

IGES format (which exports tooth forms as splines) 

BMP format (Windows bitmap) 

JPG/JPEG format (pixel image) 

PNG (Portable Network Graphic) format 

10.5 COM interface 

You can control KISSsoft remotely via a COM interface. It can easily be accessed from Visual Basic 

or Excel. 

10.5.1 Registering the server 

Now register the KISSsoft COM server on your local computer. There are two different ways of doing 

this: 

Right-click to display the context menu and then select As administrator  to display the 

Windows prompt. Then, go to the "... /bin" subfolder and run the 

"KISSsoftCOM_Register.bat" file. 

To do this, enter these command lines in a Windows command prompt, in the KISSsoft 

installation bin directory: 

KISSsoftCOM.exe /regserver  

regsvr32 KISSsoftCOMPS.dll  

regsvr32 KISSsoftCOMPS.dll  

To enable you to use the COM server regardless of release level, there is a version-specific COM 

interface that has the relevant release number. 

To use this variant, run the KISSsoftCOM_RegisterXXXX.bat file or the files listed below. (Here, 

XXXX represents the version number, e.g. 2021): 
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KISSsoftCOMXXXX.exe /regserver  

regsvr32 KISSsoftCOMXXXXPS32.dll  

regsvr32 KISSsoftCOMXXXXPS64.dll  

You will need administrator rights to register each program. 

10.5.2 Server functionality 

The server has a number of functions that you can use to start a calculation module, read or set 

values, and perform a calculation. 

GetModule([in] BSTR module, [in] VARIANT_BOOL interactive) starts a calculation 

module from the module descriptor (e.g. Z012 or W010). óInteractiveô defines whether 

the calculation module is to be generated with a graphical user interface. 

IsModuleValid([out] VARIANT_BOOL isValid) returns a value that indicates whether the 

calculation module has been generated with óGetModuleô and is present. 

Calculate() performs the main calculation for the active module. 

CalculateRetVal([out, retval] VARIANT_BOOL* isOk) runs the main calculation for the 

active module, and returns a value to tell you whether the calculation is OK. 

SetVar([in] BSTR name, [in] BSTR value) is a function with which you can set variables to 

a required value. This data is transferred as text. You will find the variable names in the 

report templates, but there is no guarantee that all these variables will remain the same 

in the future. 

GetVar([in] BSTR name, [out, retval] BSTR* value) returns a variable from KISSsoft as 

text. 

ShowInterface([in] VARIANT_BOOL wait) displays the graphical user interface. Use the 

'wait' parameter to specify whether the function is to wait until the dialog is closed. 

IsActiveInterface([out, retval] VARIANT_BOOL* isActive)  shows whether a KISSsoft 

dialog is active. 

IsActive([out, retval] VARIANT_BOOL* isActive) shows whether a module has been 

loaded. 

ReleaseModule() releases the loaded module again. You must always release a module 

again, to reduce the load on the server. 

LoadFile([in] BSTR file name) loads the specified file. 

SaveFile([in] BSTR file name) saves the calculation in the specified file. 

CheckLicense ([in] name BSTR, [out, retval] VARIANT_BOOL* isOk) shows whether the 

license is valid. 

GetININame([out, retval] BSTR* name) supplies the name of the loaded INI file. 
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GetVersionFromFile([in] BSTR filename, [out, retval] BSTR* version) supplies the 

version number (e.g. 2.6) of the KISSsoft module in the calculation file (the version 

number depends on which module is being used). 

GetModulFromFile([in] BSTR filename, [out, retval] BSTR* name) supplies the KISSsoft 

module label (e.g. M040) in the calculation file. You must first fetch a calculation module 

(GetModule). 

GetKsoftVersionFromFile([in] BSTR file name, [out, retval] BSTR* kSoftVersion) 

supplies the KISSsoft version number (e.g. 03-2011), given in the calculation file. 

GetKsoftVersion([out, retval] BSTR* kSoftVersion) supplies the KISSsoft version (e.g. 

03-2011) that is registered and was started via the COM interface. 

GetDBName([in] BSTR db_name, [in] BSTR table, [in] SHORT flag, [in] LONG ID, [in] 

LONG order, [out,retval] BSTR *name) Use the 'flag' parameter to specify whether 

the ID (flag = 0) or the result (flag = 1) is to be used as the input. The output is then 

either the order and the name of the entry or the ID (in material database BEZ_DIN). No 

message is displayed if an error occurs. A óFalseô is returned for the function. 

GetDBValue([in] BSTR db_name, [in] BSTR table, [in] LONG ID, [in] BSTR fieldname, 

[out,retval] BSTR *name) supplies the value present in this database field. No 

message is displayed if an error occurs. A óFalseô is returned for the function. Please 

note that the bearing manufacturers have not approved this function for directly 

extracting bearing data, which is why this function is disabled. 

GetKsoftVersionSettings([out, retval] BSTR* kSoftVersionSettings) supplies the 

KISSsoft version (e.g. 03-2014) of the temporary settings folder in which the personal 

settings are stored. 

SetSilentMode([in] VARIANT_BOOL silent) defines whether messages are to be hidden 

or not, so that calculations can be performed without you having to confirm system 

prompts. 

Report([in] LONG show) writes the report. You can specify whether or not this report is to 

be displayed. The report is created in the Temp directory in the "KISS_?" sub-folder. 

SetDebugFile([in] BSTR path) sets the path and file name of a debug file which can be 

used for error tracking. 

ReportWithParameters([in] BSTR infile, [in] BSTR outfile, [in] LONG show, [in] LONG 

type) creates the report using the specified report template (óinfileô) in the predefined 

place with the predefined name (óoutfileô) and supplies the file type. You can enter file 

names either with or without the path. When entering the report template (óinfileô), you 

should also input the file extension (e.g.ôZ012ld0.rptô). If you do not enter a path for this 

file, the program will search the default directory (see also Reports) for the file. You 

must also enter the file extension for an output file. If you do not specify the path, the 

file is saved to the Temp directory with the name óKISS_?ô. The file extension should 

match the specified type. Use the óshowô parameter to define whether the report is to be 

displayed, or not. Use the óartô (meaning ótypeô) parameter to define the output format. 
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(art=0 Ÿ rtf format with *1 ; art=1 Ÿ rtf format without *1 ; art=2 Ÿ html format with *1 ; 

art=10 Ÿ txt format without *1 ; art=20 Ÿ txt format in Unicode without *1) ; art=1000 Ÿ 

pprpt format with *1 ; art=1001 Ÿ pprpt format without *1).  

*1 = takes into account the data level 

Examples of possible combinations: With default report templates Ÿ RTF 

format: ReportWithParameters("C:\Program Files (x86)\KISSsoft 

2019\rpt\Z070ld0.rpt","C:\Temp\Z070ld0.rtf", 1, 0), HTML format: Call 

ksoft.ReportWithParameters("Z070ld0.rpt", "C:\Temp\Z070ld0.html", 1, 2), 

PPRPT format: ReportWithParameters ("C:\Program Files (x86)\KISSsoft 

2019\rpt\Z070ld0.rpt","C:\Temp\Z070ld0.pprpt", 1, 1000); with drawing 

stamp report template Ÿ TXT format: 

ReportWithParameters("Z10GEAR1d.rpt","C:\Temp\Z010GEAR1d.txt", 1, 

10) 

Message([out] VARIANT *strings, [out] VARIANT *types:, [out] LONG *numElem) 

returns the messages from the last calculation in the first parameter, as an array 

containing strings. The second parameter contains the particular message type (error, 

warning, info). The number of existing messages is shown in numElem. 

CallFunc([in] BSTR name) allows you to perform special calculations. A more detailed list 

of the available calculations is available on request. 

CallFuncNParam([in] VARIANT paramArray) allows you to perform special calculations. A 

more detailed list of the available calculations is available on request. 

SetLanguage([in] LONG index) specifies the language used for reports, interfaces and 

messages (0 = German; 1 = English; 2 = French; 3 = Italian; 4 = Spanish; 5 = Russian; 

6 = Portuguese; 7 = Chinese). 

GetLanguage ([out, retval] LONG* index) reads the index of the language that is currently 

set. Indexes are described in the SetLanguage() function description. 

10.5.3 Example of a call from Excel 

The best way to describe this functionality is to use an example. To use KISSsoft from Excel, you 

must first select Extras > References  and then select the KISSsoftCom type library in the Visual 

Basic Editor. 

The first example shows how to use a single gear calculation to define the tip and root circles of a 

gear: 

Public Sub ExampleKISSsoftCOM()  

Dim ksoft As CKISSsoft  

Dim da As String  
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Dim df As String  

' get KISSsoft Instance  

set ksoft = New CKISSsoft  

' get KISSsoft module for single gear  

Call ksoft.GetModule("Z011", False)  

' set values  

Call ksoft.SetVar("ZR[0].z", "20")  

Call ksoft.SetVar("ZS.Geo.mn", "5.0")  

Call ksoft.SetVar("ZR[0].x.nul", "0.5")  

' Calculate  

Call ksoft.Calculate  

' get values  

da = ksoft.GetVar("ZR[0].da.nul")  

df = ksoft.GetVar("ZR[0].df.nul")  

' release module  

Call ksoft.ReleaseModule  

' release server  

Set ksoft = Nothing  

End Sub  

The second example shows how to display the KISSsoft user interface: 

Public Sub ExampleKISSsoftCOM()  

Dim ksoft As CKISSsoft  

Dim da As String  

Dim df As String  

' get KISSsoft Instance  
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Set ksoft = New CKISSsoft  

' get KISSsoft module for single gear  

Call ksoft.GetModule("Z011", True)  

' show interface  

Call ksoft.ShowInterface(True)  

' get values  

da = ksoft.GetVar("ZR[0].da.nul")  

df = ksoft.GetVar("ZR[0].df.nul")  

Call ksoft.ReleaseModule  

Set ksoft = Nothing  

End Sub  

The same example with "later binding" (the exact property or method is not determined until runtime, 

which enables you to compile the Visual Basic client without having to know the exact function of the 

call): 

Public Sub ExampleKISSsoftCOM()  

Dim ksoft As Object  

Dim da As String  

Dim df As String  

' get KISSsoft Object  

Set ksoft = CreateObject("KISSsoftCOM.KISSsoft")  

' get KISSsoft module for single gear  

Call ksoft.GetModule("Z011", True)  

' show interface  

Call ksoft.ShowInterface(True)  

' get values  

da = ksoft.GetVar("ZR[0].da.nul")  
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df = ksoft.GetVar("ZR[0].df.nul")  

Call ksoft.ReleaseModule  

Set ksoft = Nothing  

End Sub  

The fourth example shows a contact analysis that was run using the Example_caControl.dat control 

file (you will find an example file in the directory ...\dat) and the way messages were processed after 

the calculation: 

Public Sub ExampleKISSsoftCOM()  

On Error GoTo ExitOnErr  

Dim ksoft As CKISSsoft  

' get KISSsoft Instance  

Set ksoft = New CKISSsoft  

' get KISSsoft module for gear pair  

Call ksoft.GetModule("Z012", True)  

' load File ï change this to fit to a real file on your machine  

Call ksoft.LoadFile("C: \ yourPathHere \ ExCOM3.z12")  

' calculate  

Call ksoft.Calculate  

Dim ioData(0 To 2) as String  

' Which calculation to start  

ioData (0) = "CalculatePathOfContactForPairKS"  

' controling file  

ioData (1) = "C: \  yourPathHere \ caControl.dat"  

' Path for results  

ioData (2) = "C: \  yourPathHere \ prot"  

' calculate contact analysis  
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Call ksoft.CallFuncNParam(ioData)  

' Check for messages  

Dim mess As Variant  

Dim types As Variant  

Dim numElem As Long  

Dim typesElem As Long  

Dim typesElemStr As String  

Call ksoft.Message(mess, types, numElem)  

If (numElem > 0) Then  

Dim msg As String  

For i = 0 To numElem -  1 

msg = CStr(mess(i))  

typesElemStr = CStr(types(i))  

typesElem = CLng(types(i))  

If (typesElem = 0) Then  

Call MsgBox(msg, vbInformation)  

ElseIf (typesElem = 1) Then  

Call MsgBox(msg, vbExclamation)  

Else  

Call MsgBox(msg, vbCritical)  

End If  

Next  

End If  

' close ksoft  

Call ksoft.ReleaseModule  
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' no problems, so exit  

Exit Sub  

ExitOnErr:  

MsgBox ("error occured when calling KISSsoft.")  

End Sub  
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11 3D Interfaces  

11.1 Overview of the available CAD interfaces and 

their functionality 
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11.2 Generation of 3D gears 

You must first perform a gear calculation to ensure that the results are consistent. Click on Graphics 

> Settings  to select the CAD system to which you want to export the selected element. 

Then, select the Graphics > 3D Export  menu option and then specify which individual gears you 

want to generate, and the configuration (only possible as individual gears). 

In the case of Siemens NX, generation is only possible if you have started KISSsoft from the NX add-

in menu, then run the gear calculation and clicked on the required generation button. In the case of 

Creo Parametric (ProEngineer) and CATIA, you must run the CAD interface so that you can start the 

gear generation process from KISSsoft. In the SolidWorks, Solid Edge and Inventor CAD systems, 

click a generation button to run the CAD process, if it is not already open. 

The default setting runs the gear generation process with a permitted tooth form error (tolerance 

band) of 1 ɛm. If this tolerance is too large, you can open the Tooth form  tab to change the 

tolerance. Once this is changed, you must click Calculate  again (Tooth form tab active), to transfer 

the inputs and recalculate the tooth form. 

Changing the generation type in the Tooth form tab (polylines, arc of circle approximation, splines) 

only affects the 2D display. In Siemens NX, SolidWorks and Solid Edge, the part is generated with 

splines. In Inventor, Creo Parametric (ProEngineer) and CATIA, it is created with arcs of a circle. 

SolidWorks and Solid Edge also support other generation types, which you can change by entering 

the additional APPROXIMATION=1  parameter in the KISS.ini (see chapter 2.6.10, Definitions in 

[SOLIDWORKS]) file, in the relevant CAD system. 

In the case of the gears, the transverse section of the tooth space is usually cut out from a cylinder 

and then duplicated as a pattern. For worms with a helix angle > 50° and a number of teeth < 4 the 

tooth space is cut out in the axial section and then duplicated. 

Restrictions of the CAD interfaces (except Parasolid): 

Cylindrical Gears: Double helical gearings are not created directly and must be done 

manually, first one side then the other side. 

Worms: Enveloping worms and worm wheels are not possible (only cylindrical worms with 

worm wheel). 

Modifications across the face width are not taken into account (only tooth form modifications 

are considered). 

11.3 Generating 3D shafts 

Until now, it has only been possible to generate shafts in 3D in the SolidWorks, Solid Edge, Autodesk 

Inventor and Siemens NX CAD systems. 
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First, a shaft calculation must be performed to ensure the results are consistent. Click on Graphics > 

Settings  to select the CAD system to which you want to export the selected element. 

Then, click Graphics > 3D Export  to select the shaft you require, and configuration (if you want to 

generate more than one shaft). Each shaft is created individually in the configuration, in sequence, in 

its own parts. 

This enables you to create a 3D shaft in the CAD system at the click of a button, according to the 

data from a KISSsoft shaft calculation. 

11.4 Viewer with neutral format interface 

KISSsoft has a 3D viewer for displaying individual gears or a gear system. The viewer is activated 

from the Graphics  > 3D Geometry  menu. 

In the 3D viewer, you can export the solid model in STEP and Parasolid formats (text and binary). 

Supported gears (see chapter 11.1, Overview of the available CAD interfaces and their functionality) 

and details of how to operate the viewer (see chapter 23.3, 3D Geometry). You can change the 

settings by selecting Calculation  > Settings  > 3D Generation . 

11.4.1 Parasolid export of the complete system 

The complete 3D assembly can be generated and exported using Parasolid. Select File > Export... > 

Complete 3D model  to save the complete system as a STEP, Parasolid text (X_T) or Parasolid 

binary (X_B) file. The settings for the 3D viewer are used. 

11.4.2 Parasolid Export of 3D Shafts 

Parasolid can be used to generate the solid model of the shaft. The available data formats for export 

are STEP, Parasolid text (X_T) and binary (X_B). 

Select File > Export > Shaft > 3D Geometry  to generate the model. If the calculation model 

contains a number of shafts, you can export these by selecting File > Export > Geometry 3D 

System . 

11.4.3 Face gear: 3D geometry 

The 3D model of a face gear is generated by simulating the cutting process. In this simulation, there 

are no limitations involving the helix angle, shaft angle or offset. The reference coordinates of the 

model are defined according to Roth [3], and the corresponding positions of pinion and gear are 

defined by equations (1) and (2). 
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(1) 

(2) 

Where rtS is the pinion reference radius and xS is the pinion profile shift coefficient. rtS in the cutting 

operation is calculated from the pinion cutter. 

To defined the shaft angle and the radial offset (? and a ), select Geometry > Detailsé. 

The face gear model is generated by simulating the cutting process, and the tooth flank is 

approximated as a spline surface. 

The manufacturing process is based on the Parasolid core, where the quality of the model depends 

on the settings made in Parasolid modeling (see Calculation > Settings > Parasolid ). 

Ʒ Note:  

The strength calculation is performed with the assumption that the shaft angle is 90° and the radial 

offset is 0. The shaft angle and radial offset are only used for 3D model generation, so the strength 

calculation results may not be valid. 

11.4.4 Bevel gear: generating a 3D model 

The 3D geometry model for straight, helical and spiral bevel gears is defined according to ISO 23509 

and the tooth form is calculated for several sections along the facewidth. The tooth form is placed 

across the planar involutes of the virtual cylindrical gear, at ninety degrees. Then, the tooth flank 

surface is generated by sweeping the tooth forms of the sections. The tooth forms in the individual 

sections are transformed by the angle űɓ into the relevant position. The angle of each section űɓ is 

calculated separately for the generating and face milling processes by using the auxiliary angles ű 

and ɖ. For this reason, the final tooth form along the facewidth is an extended epicycloid (generating) 

or circular (milling) form. 
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Figure 11.1: Definition of the sections for tooth form calculation 

 

Figure 11.2: Transformation angle of generating (left) and face milling (right) processes 

Machine tool manufacturers (such as Klingelnberg and Gleason) also have their own processes for 

generating tooth forms that differ slightly from the procedures mentioned above. The tooth form is 

called an octoid, and may differ slightly from our tooth form. However, we have ascertained that the 

difference between the tooth forms is much less than the tolerance range, and will not cause any 

problems in practical use. 

11.4.5 Worm wheel: generating a 3D model 

The 3D model of the enveloping worm wheel is generated by simulating the actual cutting process. 

The tooth forms at several sections along the facewidth are calculated, and the tooth flank is 

approximated as a spline surface. The model is generated using the best possible tool to 

manufacture the worm. Theoretically, the tool generates the worm, with regard to arc of circle, 

pressure angle, and tooth form. However, if the tool itself was manufactured to these specifications, it 

would no longer be usable after resharpening, because it would be smaller than the worm. The tools 

used to manufacture worm wheels are therefore slightly larger than the worm they are to create so 
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that they can be resharpened several times, as required [4]. To generate the model using the larger 

tool, you can set the oversize factor in the Module specific settings window. You can enter the 

oversize factor directly in the Oversize factor for worm wheel cutter (3D)  input window. 

In this case, the tool will have a larger tooth thickness, and therefore generate a smaller tooth 

thickness on the gear. The cutting distance between the hob and the gear will then be changed 

accordingly, to ensure a consistent result for the root and tip diameters on the gear. 

11.4.6 General information about 3D modeling in Parasolid 

If the model could not be generated correctly, you can improve it by modifying the Parasolid settings 

(see Calculation > Settings > 3D Generation ) or, if gears are involved, by reducing the permitted 

deviation (Tooth form > Approximation for export > Permissible deviation  tab). 

11.5 3D interface to SolidWorks 

Manufacturer: KISSsoft AG 

The interface between SolidWorks and KISSsoft is created by direct integration in the 3D CAD 

system. Use this to run all KISSsoft calculation modules from within SolidWorks. Cylindrical or bevel 

gears calculated in KISSsoft can be generated directly in SolidWorks as a 3D part (see chapter 11.2, 

Generation of 3D gears) with a real tooth form. Shafts calculated with KISSsoft can be generated as 

a 3D part comprising cylinder and cone elements (see chapter 11.3, Generating 3D shafts) directly in 

SolidWorks. From within KISSsoft, you can start SolidWorks with one click on a button. The system 

opens a new part, and generates the appropriate part. You can create cylindrical gears with straight 

or helical teeth, which are outside or inside, racks with straight or helical teeth, or straight-toothed 

bevel gears, as defined in DIN 3971, Figure 1, and shafts. 

You can also add gear teeth to existing shafts (see chapter 11.5.1, Gear teeth if existing shaft data is 

present). In addition, gear manufacturing data in the 2D range (see chapter 11.5.3.2, Adding 

manufacturing data) can be automatically inserted on the drawing as a text field, with the interface. 

The gear manufacturing data is attached to the relevant cutout (tooth space). 

11.5.1 Gear teeth if existing shaft data is present 

Procedure for manufacturing gear teeth: 

Select the required area in the CAD system 

In KISSsoft, select which gear (e.g. Gear 1) you want to generate on the cylinder. 

Requirements: 
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The cylinder diameter must already be the correct external diameter for the toothing before 

generation starts. 

For internal toothing, a hollow cylinder must already be modeled before the gear teeth can 

be cut out. 

Toothing will be generated for inside and outside cylindrical gears with spur and helical teeth. 

11.5.2 Integrating the KISSsoft Add-in (menu options in CAD) 

You should register the Add-in when you install it. However, if this doesn't work and the KISSsoft 

menu is not displayed in SolidWorks, you must register the Add-in. 

Go to the KISSsoft installation directory and select the SolidWorks  sub-folder. In it, double-click on 

the SolidWorksRegister64.bat  file to register the interface. 

If the KISSsoft Add-in is registered successfully, a message is displayed to confirm that this is the 

case. 

To delete the registration, double-click on the SolidWorksUnRegister.bat  file in the KISSsoft 

installation directory. A message is then displayed to confirm that deregistration was successful. 

 

If the Add-in is not displayed directly in SolidWorks, select the Tools > Add -ins  menu to open a new 

window. You can then select the KISSsoftSWAdd -in  in this window. 

This integrates the KISSsoft menu options in SolidWorks. The menu remains present, even after a 

restart, and only needs to be linked once. 

The KISSsoft Add-in menu options are available in eight languages (German, English, French, 

Italian, Spanish, Russian, Portuguese and Chinese). They use the same language as was selected 

when KISSsoft was being installed. To set the language, open the kiss.ini  file in the KISSsoft 

installation directory, click on DISPLAYLANGUAGE , and set the language you require (0 = German, 

1 = English, 2 = French, 3= Italian, 4= Spanish, 5= Russian; 6= Portuguese, 7= Chinese). This 

language setting now also applies to your KISSsoft system. 

11.5.3 Add-in functions (calls) 

11.5.3.1 Calling KISSsoft from the Add-in 

Select the Tools > KISSsoft menu option to open all the KISSsoft calculation modules directly. The 

generation of a new/additional gear will then continue as described in the gear generation process 

(see chapter 11.2, Generation of 3D gears). 
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11.5.3.2 Adding manufacturing data 

The Add manufacturing data  menu option only works in the Part view. Procedure for adding a gear 

stamp to a drawing: 

Open the part and select a tooth's Cutout . 

Select the Adding manufacturing data  menu option. 

This creates a new draft document into which the gear stamp of the selected cutout for the gear teeth 

will be inserted. 

11.5.3.3 Opening the calculation file for the created gear 

The Open calculation file  menu option only works in the Part view. Procedure for opening a 

calculation file: 

Open the part and select a tooth's Cutout . 

Select the Open calculation file  menu option. 

This starts KISSsoft in each particular calculation module and opens the calculation file. 

11.5.3.4 Simplified gear views 

You can draw the gear in one of two different views. In the simplified view, you can create a section 

display view of the gear in the drawing which only contains the gear's edge contours and reference 

circle. Currently, the simplified view is only available for external teeth. The simplified view option is 

not the default setting. 
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To view a simplified display, open the kiss.ini  file in the KISSsoft installation directory and change 

this entry: 

SIMPLIFIEDPRESENTATIONNAME=Name 

The name given in the kiss.ini  file is also the name of the view. 

11.6 3D interface to Solid Edge 

Manufacturer: KISSsoft AG 

This interface creates the direct integration between the Solid Edge 3D CAD system and KISSsoft. 

Use this to run all KISSsoft calculation modules from within Solid Edge. Cylindrical or bevel gears 

calculated in KISSsoft can be generated directly in SolidWorks as a 3D part (see chapter 11.2, 

Generation of 3D gears) with a real tooth form. Shafts calculated with KISSsoft can be generated as 

a 3D part comprising cylinder and cone elements (see chapter 11.3, Generating 3D shafts) directly in 

Solid Edge. You can start Solid Edge from within KISSsoft at the click of a button. The system opens 

a new part, and generates the appropriate part. You can create cylindrical gears with straight or 

helical teeth, which are outside or inside, racks with straight or helical teeth, or straight-toothed bevel 

gears, as defined in DIN 3971, Figure 1, and shafts. 

You can also add gear teeth to existing shafts (see chapter 11.6.2, Gear teeth if existing shaft data is 

present). In addition, gear manufacturing data in the 2D range (see chapter 11.6.4.2, Adding 
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manufacturing data) can automatically be inserted on the drawing as a text field, with the interface. 

The gear manufacturing data is attached to the relevant cutout (tooth space). 

Ʒ Note:  

The default template file (e.g. metric.prt) is used to generate gears. To use a user-specific template 

file, either define a variable called USERPARTTEMPLATE  in the [Solid Edge]  section, in the 

kiss.ini  file, or overwrite the default template file and copy it to the user-specific template files folder 

on the default path. If a user-specific path has been set for templates in Solid Edge, this path is used. 

Otherwise, the default path for template files is used (e.g. ...\Solid Edge <version> \Template ). 

11.6.1 Changing the parameter for generation 

In Solid Edge, you can toggle between two settings for copying the tooth space (pattern). The 

possible modes are: SmartPattern and FastPattern. SmartPattern generates a more accurate tooth 

form. However, this takes quite some time and creates a very large gear file. FastPattern is a less 

accurate method, but takes less time and generates a smaller gear file. SmartPattern has always 

been used to generate gears up to now, since otherwise the gears cannot be created or represented 

correctly. In the kiss.ini  (see chapter 2.6.9, Definitions in [SOLIDEDGE]) file in the KISSsoft 

installation directory, you can set SMARTPATTERN=0 , to copy the tooth space in FastPattern mode. 

11.6.2 Gear teeth if existing shaft data is present 

Procedure for manufacturing gear teeth: 

In Solid Edge, draw a plane on the surface on which you want to cut out the gear teeth. 

Select this plane 

In KISSsoft, select which gear (e.g. Gear 1) you want to generate on the cylinder. 

Requirements: 

The cylinder diameter must already be the correct external diameter for the gear teeth 

before generation starts. 

For internal toothing, a hollow cylinder must already be modeled before the gear teeth can 

be cut out. 

Toothing will be generated for inside and outside cylindrical gears with spur and helical teeth. 

11.6.3 Integrating the KISSsoft Add-in (menu options in CAD) 

You should register the Add-in when you install it. However, if this doesn't work and the KISSsoft 

menu is not displayed in Solid Edge, you must register the Add-in. 



I 3D Interfaces 174 
 

Go to the KISSsoft installation directory and select the SolidEdge  sub-folder. In it, double-click on 

the SolidEdgeRegister64.bat  file to register the interface. 

If the KISSsoft Add-in is registered successfully, a message is displayed to confirm that this is the 

case. 

To delete the registration, double-click on the SolidEdgeUnRegister.bat file in the KISSsoft 

installation directory. A message is then displayed to confirm that deregistration was successful. 

Select Tools > Add -Ins  and then Add -In-Manager . You can select/deselect the KISSsoft  Add-in in 

the Add-In Manager. 

The KISSsoft Add-in is displayed in the main menu. This integrates the KISSsoft menu options in 

Solid Edge. They are retained even after a restart. 

The KISSsoft Add-in menu options are available in eight languages (German, English, French, 

Italian, Spanish, Russian, Portuguese and Chinese). They use the same language as was selected 

when KISSsoft was being installed. To set the language, open the kiss.ini  file in the KISSsoft 

installation directory, click on DISPLAYLANGUAGE , and set the language you require (0 = German, 

1 = English, 2 = French, 3= Italian, 4= Spanish, 5= Russian; 6= Portuguese, 7= Chinese). This 

language setting now also applies to your KISSsoft system. 

Ʒ Note:  

If the selected language uses Unicode fonts (e.g. Cyrillic for Russian), the Localization must be set to 

this language (a country with this language) in the operating system. 

11.6.4 Add-in functions (calls) 

11.6.4.1 Calling KISSsoft from the Add-in 

Select the KISSsoft  menu option to open all the KISSsoft calculation modules directly. The 

generation of a new/additional gear will then continue as described in the gear generation process 

(see chapter 11.2, Generation of 3D gears). 

11.6.4.2 Adding manufacturing data 

The Add manufacturing data  menu option only works in the Part view. Procedure for adding a gear 

stamp to a drawing: 

Open the part and select a tooth's Cutout . 

Select the Adding manufacturing data  menu option. 
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This creates a new draft document into which the gear stamp of the selected cutout for the gear teeth 

will be inserted. 

11.6.5 Opening the calculation file for the created gear 

The Open calculation file  menu option only works in the Part view. Procedure for opening a 

calculation file: 

Open the part and select a tooth's Cutout . 

Select the Open calculation file  menu option. 

This starts KISSsoft in each particular calculation module and opens the calculation file. 

11.6.6 Simplified gear view 

You can draw the gear in one of two different views. In the simplified view, you can create a section 

display view of the gear in the drawing which only contains the gear's edge contours and reference 

circle. Currently, the simplified view is only available for external teeth. The simplified view option is 

not the default setting. 

 

To view a simplified display, open the kiss.ini  file in the KISSsoft installation directory and change 

this entry: 

SIMPLIFIEDPRESENTATION=1 
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11.7 3D interface to Autodesk Inventor 

Manufacturer: KISSsoft AG 

The interface between Inventor and KISSsoft is created by direct integration in the 3D CAD system. 

Use this to run all KISSsoft calculation modules from within Inventor. Cylindrical or bevel gears 

calculated in KISSsoft can be generated directly in Inventor as a 3D part (see chapter 11.2, 

Generation of 3D gears) with a real tooth form. Shafts calculated with KISSsoft can be generated as 

a 3D part comprising cylinder and cone elements (see chapter 11.3, Generating 3D shafts) directly in 

Inventor. From within KISSsoft, you can start Inventor with one click on a button. The system opens a 

new part, and generates the appropriate part. You can create cylindrical gears with straight or helical 

teeth, which are outside or inside, racks with straight or helical teeth, or straight-toothed bevel gears, 

as defined in DIN 3971, Figure 1, and shafts. 

You can also add gear teeth to existing shafts (see chapter 11.7.1, Gear teeth if existing shaft data is 

present). In addition, gear manufacturing data in the 2D range (see chapter 11.7.3.2, Adding 

manufacturing data) can automatically be inserted on the drawing as a table, with the interface. The 

gear manufacturing data is attached to the relevant cutout (tooth space). 

11.7.1 Gear teeth if existing shaft data is present 

Procedure for manufacturing gear teeth: 

Select the required area 

In KISSsoft, select which gear (e.g. Gear 1) you want to generate on the cylinder. 

Requirements: 

The cylinder diameter must already be the correct external diameter for the gear teeth 

before generation starts. 

For internal toothing, a hollow cylinder must already be modeled before the gear teeth can 

be cut out. 

Toothing will be generated for inside and outside cylindrical gears with spur and helical teeth. 

11.7.2 Integrating the KISSsoft Add-in (menu options in CAD) 

For the add-in (in Regfree mode) to be displayed in Autodesk Inventor, the 

KISSsoftInventorAddin.dll  and Autodesk.KISSsoftInventorAddin.Inventor.Addin  files must be 

copied into one of the following directories, which differ depending on what is to be displayed. 

All users, non-version-specific: Windows 8.1/10/11 - 

%ALLUSERSPROFILE%\Autodesk\Inventor Addins\ 
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All users, version-specific: Windows 8.1/10/11 - 

%ALLUSERSPROFILE%\Autodesk\Inventor 20xx\Addins\ 

Per user, version-specific: Windows 8.1/10/11 - %APPDATA%\Autodesk\Inventor 

20xx\Addins\ 

Per user, non-version-specific: Windows 8.1/10/11 - 

%APPDATA%\Autodesk\ApplicationPlugins 

The KISSsoftCOM  server should be registered as part of the installation process. However, if this 

didn't happen, and the KISSsoft interface doesn't work, you must register the Add-in. 

Go to the KISSsoft installation directory and select the Inventor  subfolder. In it, double-click on the 

InventorRegister64.bat  file to register the interface. 

If the KISSsoft Add-in is registered successfully, a message is displayed to confirm that this is the 

case. 

To delete the registration, double-click on the InventorUnRegister64.bat  file in the KISSsoft 

installation directory. A message is then displayed to confirm that deregistration was successful. 

The KISSsoft Add-in menu options are available in eight languages (German, English, French, 

Italian, Spanish, Russian, Portuguese and Chinese). They use the same language as was selected 

when KISSsoft was being installed. To set the language, open the kiss.ini  file in the KISSsoft 

installation directory, click on DISPLAYLANGUAGE , and set the language you require (0 = German, 

1 = English, 2 = French, 3= Italian, 4= Spanish, 5= Russian; 6= Portuguese, 7= Chinese). This 

language setting now also applies to your KISSsoft system. 

This integrates the KISSsoft menu options in Inventor. The menu remains present, even after a 

restart, and does not need to be linked. 

11.7.3 Add-in functions (calls) 

11.7.3.1 Calling KISSsoft from the Add-in 

Select the KISSsoft  menu option to open all the KISSsoft calculation modules directly. The 

generation of a new/additional gear will then continue as described in the gear generation process 

(see chapter 11.2, Generation of 3D gears). 

11.7.3.2 Adding manufacturing data 

The Add manufacturing data  menu option only works in the Part view. Procedure for adding a gear 

stamp to a drawing: 

Open the part and select a tooth's Cutout . 
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Select the Adding manufacturing data  menu option. 

This creates a new draft document into which the gear stamp of the selected cutout for the gear teeth 

will be inserted. 

11.7.4 Opening the calculation file for the created gear 

The Open calculation file  menu option only works in the Part view. Procedure for opening a 

calculation file: 

Open the part and select a tooth's Cutout . 

Select the Open calculation file  menu option. 

This starts KISSsoft in each particular calculation module and opens the calculation file. 

11.8 3D interface to Siemens NX: 

Manufacturer: KISSsoft AG 

The interface between Siemens NX and KISSsoft creates the direct integration in the 3D CAD 

system. Use this to run all KISSsoft calculation modules directly from within Siemens NX. Cylindrical 

or bevel gears calculated in KISSsoft can be generated directly in NX as a 3D part (see chapter 11.2, 

Generation of 3D gears) with a real tooth form. Shafts calculated with KISSsoft can be generated as 

a 3D part comprising cylinder and cone elements (see chapter 11.3, Generating 3D shafts) directly in 

NX. You can create cylindrical gears with straight or helical teeth, which are outside or inside, racks 

with straight or helical teeth, worms, or straight-toothed bevel gears, as defined in DIN 3971, Figure 

1, and shafts. 

 

If you are generating a new part, the New dialog opens first. In it, you can enter the name of the file 

in which the part should be generated. When you use Teamcenter , its dialog is displayed 

automatically so you can also generate or save the part in the Teamcenter environment. 

 

You also have the option of adding toothing to existing shafts (see chapter 11.8.2.1, Gear teeth if 

existing shaft data is present). In addition, gear manufacturing data in the 2D range (see chapter 

11.7.3.2, Adding manufacturing data) can automatically be inserted on the drawing as a table, with 

the interface. The gear manufacturing data is attached to the relevant cutout (tooth space). 

11.8.1 Integrating the KISSsoft Add-in (menu options in CAD) 

First, copy the supplied folder, e.g. NX1847, with its startup  subfolder, to a location that can be 

accessed by users at any time. 
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The kSoftNX_d.men  file contains the definition for the KISSsoft Add-in menu options. This file has 

different names to reflect which language has been selected. For example, the _e in the file name 

stands for English . The other language codes are _d for German , _f for French , _i: for Italian , _s: 

for Spanish , _r: for Russian , _p: for Portuguese , and _c: for Chinese . You can copy the file for the 

language you require to the startup  folder. The KISSsoft menu will then be displayed in this 

language. 

Ʒ Note:  

If the selected language uses Unicode fonts (e.g. Cyrillic for Russian), the Localization must be set to 

this language (a country with this language) in the operating system. 

KISSsoft is also available as a ribbon menu. The English menu with _e is embedded as the default 

setting in the startup subfolder. If you want to change the language in which the menu is displayed, 

delete all the files in the startup  folder whose name ends with _e. The ...\NX1847 subfolder contains 

a subfolder for every available language (e.g. kSoftNXRibbon_e for English). You can copy the 

entire contents of the folder that has the language you require to the startup subfolder. The menu 

will then be displayed in this language. 

The kSoftNX1847.dll  file (for example), which contains the links and commands for the menu 

options, is also stored in this folder. 

You must input the path for the previously copied folder, for example, NX1847, in the 

NX1847\menu \custom_dirs.dat  file, in the NX directory, so that the NX system knows where the 

files it is to use are stored. 

 

If the custom_dirs.dat file to be used is not available in the installation directory, you can define a 

system variable explicitly naming the required path for this purpose. 

System variable: UGII_CUSTOM_DIRECTORY_FILE  

Value: required path 
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The KISSsoftCOM  server should be registered as part of the installation process. However, if this 

didn't happen, and the KISSsoft interface doesn't work, you must register the Add-in. 

Go to the KISSsoft installation directory and select the NX1847 subfolder. In it, double-click on the 

NX_Register64.bat  file to register the interface. 

If the KISSsoft Add-in is registered successfully, a message is displayed to confirm that this is the 

case. 

To delete the registration, double-click on the NXUnRegister.bat file in the KISSsoft installation 

directory. A message is then displayed to confirm that deregistration was successful. 

To ensure the KISSsoft icons are displayed next to the menu options, you must also set a system 

variable with the path, to tell the program where the KISSsoft icons can be found. 

Example: Set a system variable and this value as the path 

KSOFT_ICONS 

C:\Program Files(x86)\KISSsoft<version>The startup  folder also contains the kSoftNX.ini  file, in 

which you can change the layers of the bodies, sketches, planes and drawings. 

You can use the SKETCHPREFERENCES_CONTINOUSAUTODIMENSIONING  option to define 

whether dimensions shall be created automatically after modifying a sketch in design applications. If 

this option is disabled, performance is improved for larger sketches. 

In NX, this option can be found under: File>Utilities>Customer Defaults>Sketch>Inferred Constraints 

and Dimensions (Legacy)>Continuous Auto Dimensioning in Design Applications (Legacy). 
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11.8.2 Calling KISSsoft from the Add-in 

Select the KISSsoft  menu option to open all the KISSsoft calculation modules directly. By doing this 

you can perform calculations in KISSsoft quickly and easily during the design process. The NX1847 

(etc.) menu options are inactive while KISSsoft is open. In order to reactivate the CAD program, you 

must close KISSsoft. 

11.8.2.1 Gear teeth if existing shaft data is present 

Requirements: 

The cylinder diameter must already be the correct external diameter for the gear teeth 

before generation starts. 

For internal toothing, a hollow cylinder must already be modeled before the gear teeth can 

be cut out. 

For example, select the cylindrical gear pair calculation in the KISSsoft menu. The procedure for 

generating the gear (see chapter 11.2, Generation of 3D gears) is identical to the procedure for 

creating a new one. 

If a part is already opened in Siemens NX, a window with 3 selection buttons is displayed: 

In a new part 

Available part, absolute positioning 

Available part, relative positioning 

Explanations of the individual selection options and their use: 

Select In a new part  to generate the entire gear. 

Select Available part, absolute positioning  to select only one side surface on which the 

gear teeth are to be cut. The generation process now generates fixed levels on which 

the gear teeth will be positioned. 

Select Available part, relative positioning to select one side surface and two levels (which 

cut into the side surface), one after the other. The toothing can therefore be positioned 

at relative levels (DATUM PLANE) and is not dependent on the absolute zero point. 

This positioning is primarily required for the methodical working method defined in the 

Teamcenter "Master Model concept". 
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The generation of toothing on existing cylinders is performed on both inside and outside cylindrical 

gears with straight or helical toothing. 

11.8.2.2 Adding manufacturing data to the drawing 

You can select the Add manufacturing data  menu option to insert a gear stamp of the current gear 

in a drawing. 

Teamcenter: If you are working in accordance with the Master Model concept , the features 

of the master part are displayed automatically in the non-master drawing when you 

select Add manufacturing data . 

After you select this menu option, another window opens, in which you can select the object you 

require. There, make these selections: 

Straight-toothed cylindrical gears: INSTANCE[0](4)TOOTH(4) 

Helical cylindrical gears/worms/Straight-toothed bevel gears: TOOTH 

Click on OK to open a new drawing. The following window opens, and displays the Drawing view. 

Click with the mouse click to align the upper left corner of the table with the manufacturing data on 

the drawing. If you want to insert the data into an existing drawing sheet, you must select the tooth 
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space in the Drawing view once the required drawing sheet is opened. You can select the tooth 

space in the next window that is displayed. You are then prompted to confirm that you want to 

transfer the manufacturing data to the current drawing sheet. 

Click on OK to position the manufacturing data on the drawing (by clicking with the mouse). Click on 

Cancel to display a new drawing sheet into which you can insert the manufacturing data. 

11.8.2.3 Opening the calculation file 

Select the Open calculation file  menu option to start KISSsoft. This loads the gear teeth calculation 

file and the information is saved directly to the gear teeth feature (tooth space). After you select this 

menu option, a window in which you select the required object is displayed: 

Straight-toothed cylindrical gears: INSTANCE[0](4)TOOTH(4) 

Helical cylindrical gears/worms/Straight-toothed bevel gears: TOOTH 

When you click on the OK button, KISSsoft opens in the appropriate module with a loaded gear teeth 

calculation file. 

11.9 3D interface to Creo Parametric (ProEngineer) 

Manufacturer: Applisoft Europe (Italy) 

Cylindrical or bevel gears calculated in KISSsoft can be generated directly in Creo Parametric as a 

3D part (see chapter 11.2, Generation of 3D gears) with a real tooth form. You can create cylindrical 

gears with straight or helical teeth, which are external or internal, or straight-toothed bevel gears, as 

defined in DIN 3971, Figure 1. 

In addition to the part, the system opens a drawing in which the gear manufacturing data appear in a 

table. Open the CAD system before you start generating a part with the 3D interface to Creo 

Parametric. 

In the interface to Creo Parametric, you can enter additional variables in the files for the particular 

gear (e.g. Z10GEAR1CAD.rpt) in the CAD directory. These additional variables will later be defined 

as parameters and saved in Creo Parametric. 

The parameters used for the generating process are already defined in Creo Parametric and can no 

longer be used. Predefined parameters: 

pz, z, b, da, d, df, di, elica, USUnit 

If you want to create a model of a part in US customary units (not metric), open the kiss.ini  file (see 

chapter 2.6.13, Definitions in [PROENGINEER]) and set the USCUSTOMARYUNITS parameter to 1. 
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You can also change an existing toothing without actually affecting the part (see chapter 11.9.3, 

Modifying the selected 3D model). You can also cut gear teeth on an existing shaft (see chapter 

11.9.2, Cutting gear teeth on an existing shaft). 

A new dialog opens as soon as you start the generating process. This dialog has these three options: 

Generate gear in new file 

Generate gear on shaft 

Exit 

If you select Generate gear in new file , the gear is generated in a new part file. 

Ʒ Note:  

If you want to prevent the selection menu or message from appearing, you can specify this in (see 

chapter 11.9.5, Changing base settings in the interface). 

11.9.1 Integrating the KISSsoft Add-in 

The KISSsoftCOM  server should be registered as part of the installation process. However, if this 

didn't happen, and the KISSsoft interface doesn't work, you must register the Add-in. 

Go to the KISSsoft installation directory and select the ProEngineer  subfolder. In it, double-click on 

the ProECreoRegister.bat  file to register the interface. 

If the KISSsoftCOM server is registered successfully, a message is displayed to confirm that this is 

the case. 

To delete the registration, double-click on the ProEUnRegister.bat  file in the KISSsoft installation 

directory. A message is then displayed to confirm that deregistration was successful. 

Use one of the 3 methods described below to ensure the KISSsoft menu is present every time you 

start Creo Parametric. Add this line for all 3 variants, in the 'config.pro' file (in Creo): 

open_protk_unsigned_apps always  

Variant 1:  

Copy the Protk_EditGear_Creo.dat  file to the Creo \Common Files \text \ subdirectory (for Creo, copy 

the file to the ...\text \ subdirectory). 

Then, rename the file to Protk.dat . Using this variant, the user can change their Creo start directory, 

and the KISSsoft menu always starts along with it. 

However, if a different Protk.dat  file is already present, insert the lines from Protk_EditGear_Creo.dat  

into the Protk.dat file. 
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Variant 2:  

Copy the Protk_EditGear_Creo.dat  file into the initial Creo working directory and rename it Protk.dat . 

In this case, the Protk.dat  file is to be copied into the start directory. The path is displayed in the 

properties of the parametric.exe file. 

Variant 3:  

The user must add the following lines to their config.pro  file (in Creo). In other words, the user 

defines their own path:  

protkdat C: \Program Files \KISSsoft<version>  

The Protk_EditGear_é.dat file in the ProEngineer installation subdirectory must be renamed to 

Protk.dat to make it work. 

Description of the content of the Protk.dat file:  

NAME EditGear  

EXEC_PATH C:\ Program Files \ KISSsoft AG \ KISSsoft  

XXXX\ ProEngineer \ EditGear \ bin_nt \ EditGear...  

TEXT_PATH C: \ Program Files \ KISSsoft AG \ KISSsoft  

XXXX\ ProEngineer \ EditGear \ text.GB  

STARTUP DLL 

ALLOW_STOP TRUE 

UNICODE_ENCODING FALSE 

END  

EXEC_PATH and TEXT_PATH must be the absolute path of the installation. 

STARTUP DLL  and UNICODE_ENCODING FALSE  are predefined (do not change them). 

Use ALLOW_STOP TRUE  to stop the Creo Parametric program (Tools > Auxiliary Application > 

Stop ). 

You can delete this line in the Protk.dat  file to prevent users from stopping the interface. 

NAME EditGear  and END must be present, although you can change the EditGear  name if 

required. 
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11.9.2 Cutting gear teeth on an existing shaft 

If you run KISSsoft from the 3D export, this menu with the following 3 selection options is displayed: 

Generate gear in new file 

Generate gear on shaft 

Exit 

To modify an existing model: 

Select Generate gear on shaft  

In Creo Parametric, open the shaft on which you want to cut the gear teeth. 

Set a new coordinates system to describe the point at which the gear teeth are to be cut. 

Select the GearShaft  menu option in the KISSsoft menu in Creo Parametric. 

This opens another menu in which you can specify whether the gear teeth are to be cut 

across the entire width or only across part of the shaft. 

After you have made your selection, select the coordinates system in which the gear teeth 

are to be inserted. The coordinates system you select must have a z-axis that is equal 

to the shaft axis. 

The gear teeth are then cut on the shaft. 

11.9.3 Modifying the selected 3D model 

When you export a tooth form from KISSsoft, the model in Creo Parametric is generated in a new 

part. 

To modify an existing model: 

Import the model you want to modify into Creo Parametric, or use the current part. 

In the KISSsoft menu, select Edit  and then YES. This imports the current gear teeth. 

Then, select Open calculation file . This menu then imports the appropriate gear teeth data 

to KISSsoft. 

KISSsoft can then regenerate the modified gear teeth. This modifies the current gear teeth. 

11.9.4 Modifying the teeth on an existing shaft 

Use this procedure to modify the gear teeth generated with the KISSsoft interface on an existing 

shaft on an existing model: 
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Import the model you want to modify into Creo Parametric, or use the current part. 

Select Edit Gear On Shaft , so you can select which gear teeth data is to be modified. 

KISSsoft then opens with the data that was stored when the toothing element was 

generated. 

Then, modify and recalculate the gear teeth in KISSsoft. You can then restart the 3D export 

of the relevant gear teeth. Then, click on the cross in the top right-hand corner of the 

KISSsoft window to close it. You are then prompted to confirm whether to save the 

temporary change. 

Click on Yes to modify the model. If you click on No, the model remains unchanged. 

11.9.5 Changing base settings in the interface 

There are a number of ways in which you can set up the interface by setting environment variables: 

KISS_PROE_INTERFACE_NO_MENU = YES  

For users who cannot set up a connection to Creo Parametric (using PRO_COMM_MSG.exe). 

Set this environment variable to YES to stop the interface trying to use this process to run the 

connection. This also stops the warning messages, stating that no connection can be created, from 

appearing. 

KISS_PROE_INTERFACE_NO_MENU = NO  

If you set this environment variable to NO, a warning is displayed if no direct connection to Creo 

Parametric can be established. 

The message describes how to generate the gear despite this. 

KISS_PROE_INTERFACE_CLASSIC = YES  

The additional dialog in which you can select either Generate gear in a new file  or Generate gear 

on shaft  is then no longer displayed. 

KISS_PROE_INTERFACE__CLASSIC = NO  

A dialog in which you can select either Generate gear in a new file  or Generate gear on shaft  is 

displayed. 

If no environment variables are set, both these values are set to NO. 
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11.9.6 Saving the files to the PTC Windchill working directory 

To save the generated interface files to the PTC Windchill working directory in the PLM system, 

change the WORK_IN_CURRENT_FOLDER  parameter setting in the SETUP.txt  file from NO to YES. 

The SETUP.txt  file is located in the ...\ProEngineer \EditGear \SETUP.txt  sub-folder, in the KISSsoft 

installation. 

If you have installed Creo Parametric on the server and started it from the client, temporary files are 

written to the server, not to the client. To prevent this, set the variables listed below in the Setup.txt  

file with this path. 

APSF_WORK_DIR C: \temp  

11.10 3D interface to CATIA 

Manufacturer: SWMS (DE) 

Cylindrical or bevel gears calculated in KISSsoft can be generated directly in CATIA as a 3D part 

(see chapter 11.2, Generation of 3D gears) with a real tooth form. You can create cylindrical gears 

with straight or helical teeth, which are external or internal, or straight-toothed bevel gears, as 

defined in DIN 3971, Figure 1. 

You can also add gear teeth to existing shafts. 

You will find a more detailed description of the interface in a *.pdf file in the CATIA  folder in the 

KISSsoft installation directory. 
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12 Answers to Frequently Asked Questions  

12.1 Changing the output of angles in reports 

Is it possible to output angles (in calculations) in the KISSsoft angle report as degree values as well 

as decimal numbers? 

Current form: ##.#### ° 

Required form: ## Á ## ô ## ôô 

To do this, change the report template (*.rpt) accordingly. Read the notes in the manual about report 

templates (see chapter 8.5, Report templates) before you do this. The calculation is then performed 

in the report. A helix angle is used to show this method: 

Previous format, as a decimal number: 

Helix angle (grd) %11.4f {Grad(ZS.Geo.beta)}=> 

Current format, now as a degree value: 

Helix angle (grd) %i° %i' %i" {Grad(ZS.Geo.beta)} {(Grad(ZS.Geo.beta)-int(Grad(ZS.Geo.beta)))*60} 

{((Grad(ZS.Geo.beta)-int(Grad(ZS.Geo.beta)))*60-int((Grad(ZS.Geo.beta)-

int(Grad(ZS.Geo.beta)))*60))*60} 

12.2 Inputting materials for gear calculations in the 

database 

When comparing the materials used for gear teeth in a particular company, it became evident that 

not all the required materials were present in the database provided by KISSsoft. 

In particular, the following key values, necessary for gear calculation, are missing: include ůFlim/Sat, 

ůHlim/Sac, RzF, RzH and BM. 

When you redefine materials and their properties, you must compare them with similar materials in 

our materials database. 

First of all, define the basic data for a material in the database. Then, define the gear-specific data for 

this base material. 
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Then, calculate the values of ůFlim/Sat, ůHlim/Sac depending on the hardness values, as described in ISO 

6336-5. 

To do this, you can either use the relevant material diagram, the conversion function for inputting 

your own materials (see chapter 15.1.12.1, Materials) or formulae from ISO. The Sat, Sac values are 

converted on the basis of ůFlim, ůHlim. 

A default value is used if no value is input for the thermal contact coefficient BM. 

For total heights, specify average values with RzF 10µm and RzH 3µm. You will find more detailed 

information about this in ISO 6336-2. 

ISO 6336, Part 2 provides more information about the influence of the total height on the calculation 

of flank load capacity when an additional material hardening factor, Zw, has been introduced. 

12.3 How can I test the software? 

A demo version of the software is available at (see chapter 1.1, Basic installation). Although the 

demo version does not have an expiration date, its functionality is limited so that, for example, you 

cannot change and store material data. The demo version is designed to give you an initial 

impression of the software. For a detailed trial, request a test version (see chapter 1.3.1, Test 

version). The test version runs for 30 days, is free of charge and is the same as the full version 

(without third party programs). 

12.4 What licenses are available? 

Individual user licenses and network licenses are available for both KISSsoft and KISSsys. A network 

license enables the software to be used at more than one workplace. 

However, network licenses are not available for some of the third party products, for example, some 

CAD interfaces. 

12.5 Add your own texts in the results window 

To enable this, define a new file in the KISSsoft installation directory in "é\ext\.rpt\". This file must 

then be named using this convention: "Modulname + result.RPT" (e.g. for a cylindrical gear pair 

Z012result.RPT). 

Then define the new parameters or values that are to be added. These values are then also 

displayed at the end of the Results  window. 
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12.6 Restoring a previous stage in the calculation 

Select File > Restore... (acts like the Undo function) to retrieve an earlier stage of the current 

calculation file. For this reason, every calculation run stores the current stage as a restore point. The 

list of restore points is deleted when you open a different file. 
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13 KISSsoft System Module - the system 
module in KISSsoft  

The system module in KISSsoft is a powerful tool that allows you to model, analyze and evaluate 

complex gearboxes and transmissions at system level. 

13.1 User interface 

The main graphical user interface areas are described in the following sub-chapters. 

13.1.1 Shaft view 

The Shaft view is on the top left-hand side in the standard view. All the shaft calculations (shaft 

groups) for a modeled gearbox are listed here in the form of a tree structure. In the same way as in 

the shaft calculation module, every shaft calculation can consist of more than one shaft. Every shaft 

can have machine elements such as couplings, gears and bearings. 

13.1.2 Element View 

The Elements view provides more information about the relationships between the individual shaft 

groups. When filtered, it only displays specific elements and their connections. These selection 

options are available here: 

Gears: The gear calculations that are to be taken into account in the gear units are displayed here. 

The gear calculations include the associated gears, which you can simply drag and drop into the 

element from the Shaft view. You can use the mouse to connect the center points of the gears, in the 

Sketcher, to achieve the same thing. 

 

Shaft -Hub Connections: All connections, such as interference fits, splines, keys, etc. are displayed 

in this area. One of these calculations can be added, and a gear, coupling or switching element can 

be dropped in it. In the Sketcher, use the context menu to add shaft-hub connections from any of 

these types of elements. Data, such as the diameter, forces and materials can then be passed 

automatically to the corresponding calculation. 

Planet carrier:  All planet carrier elements are displayed in this window. Click on the associated 

planet gear shaft and drag it from the Shaft view into this element. The same link can also be created 

in the Sketcher. You can use the mouse in the same way, in the Sketcher, to connect the planet 

carrier shaft node, which was previously defined as the carrier, to the planet shaft axis. This gives the 

system the information that a planetary gear stage is involved and that the added shaft group is 

epicyclic. 
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Bearings: An overview of all bearings is displayed here. If the bearing is connected to the housing on 

one side (inner ring or outer ring), only the shaft that has contact on the other side of the bearing is 

listed in the bearing element. If both the inner ring and the outer ring of the bearing are in contact 

with a shaft, both shafts are listed. The following conventions apply in this case: The upper shaft 

represents the internal or left shaft of the bearing and the lower shaft represents the outer or right 

shaft of the bearing. 

Switchables: Select this option to display all the switching elements used in the model. Shafts that 

are connected to each other are listed in the switching elements. To add a shaft to an existing 

connection, click on a shaft in the Shaft view and drag it to one of these elements. The same link can 

also be created in the Sketcher. To do this, use the mouse to connect the switching element node 

with the appropriate second shaft. 

Boundary conditions: All the model's kinematic boundary conditions are displayed in this area. Any 

shaft element that can transmit a torque, such as a coupling or a centrical load, can be dragged and 

dropped into a boundary. It can then be used as a power input or output, with given or calculated 

torque, power and/or speed. 

Power flow: For each power split element, the user can drag and drop two gears or two couplings 

that are engaged in a gear contact or coupling connection. Each of these elements represents a 

power flow path. This means the power flow splits and then merges again at a different point in the 

gear unit. 

Power loss: In this tab, you can define losses such as bearing losses, gear churning losses, gear 

meshing losses, planet carrier losses or seal losses in the model. Simply drag and drop the 

corresponding element or pair of elements into a power loss element. This element can then be 

specified as a torque, power or efficiency. It can also be calculated from the submodules. 

Coupling connection: Two couplings can be dragged and dropped into a coupling connection. This 

can represent a physical connection such as a Cardan joint, hydrostatic coupling or others. Coupling 

connections can also be used to represent a virtual connection in which a speed, torque or power 

ratio between two boundaries can be specified. 

Force transfer: Any support can be dragged and dropped as first element into a force transfer 

element. As second element, a centrical load or carrier element must be dropped. This connection is 

then used to transfer the forces and moments from the support located in one shaft calculation into 

the centrical load located in another shaft calculation. This is particularly useful for a pin 

representation on a carrier shaft. 

Housing: A housing element can be added here. This element can be used to import a STEP file 

into the model or draw a rough box or cylinder. It can also be used for the housing deformation 

calculation. 
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13.1.3 Element Box 

All the elements that can be used in the system are displayed in this window. These elements are 

grouped according to category: shafts, gears and couplings, forces and carriers, bearings and 

switchables, power flow, special elements such as coupling connection, force transfer and housing, 

and finally the gear and belt/chain calculation submodules. Click on an element to add it to the Shaft 

view and/or Element view (depending on what type of element it is). Use the icons in the Element 

Box to create a model from the beginning or add elements to an existing model. 

13.1.4 Group view 

All component relationships can be displayed in one view. A shaft calculation can therefore be added 

to this view and, for example, all gear calculations related to the gears mounted on its shafts will then 

also be added to the same view. 

13.1.5 Sketcher 

Use the Sketcher to "draw" the gear unit's kinematics with the mouse. All the definitions you make in 

the Sketcher are also displayed simultaneously in the Shaft view and Element view. As a result, you 

can create or modify the model directly in the Sketcher. You can switch between the windows at any 

time.  

13.1.6 3D Viewer 

The modeled gearbox is displayed in 3D in the 3D Viewer. The gearbox model can be moved in 

space, animated or recorded as a video. Use this view to check how shaft groups are positioned in 

space. Select File > Export... > Complete 3D model  to save the contents of the 3D viewer as a 

STEP, Parasolid text (X_T) or Parasolid binary (X_B) file. 

13.1.7 Kinematics 

You can define the boundary conditions and power splits in this tab. You can then specify the speeds 

and torque/power values in the model's boundary conditions. The conditions defined here should 

ensure that the system is kinematically defined. There are no other functions for calculating 

kinematics. The system checks automatically after every entry you make, to see if a solution can be 

found. If a solution with the predefined conditions is found, all the values are updated accordingly. 

You can add any number of boundary condition sets with given torques and speeds to the model. 

Combined with the switchable sets, if there are any in the model, this represents a so called 

operating mode. In the control panel, you can then check if those combinations are kinematically well 

defined and select the operating mode to be used to display the current kinematics of the model. 
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13.1.8 Switching matrix 

In this tab, all speeds can be defined and the status of all switching elements can be set for each 

speed. A Sizing button is also available to provide a unique shifting speed, with particular closed 

switching elements, for each potential power flow path. Each speed can also be renamed. The 

engaged gear can be changed on the control panel. The power flow is then updated directly in the 

Sketcher. 

13.1.9 Ratio 

The ratios for individual stages can be defined in this tab. In this case, enter the number of teeth on 

the meshing gears to determine the ratio. Alternatively, you can predefine the stage ratio and the 

number of teeth on a gear. In this case, the number of teeth on the other gear is calculated by the 

system. 

If you predefine the number of teeth: The number of teeth on a gear with external toothing must be a 

positive value and the number of teeth on a gear with internal toothing must be a negative value. 

If you predefine the ratio: If two gears with external toothing are meshing, enter the ratio as a 

negative value, because the gears rotate in different directions (have a different "sense ofrotation"). 

However, if a gear with external toothing meshes with a gear with internal toothing, enter the ratio as 

a positive value, because the gears rotate in the same direction (have the same sense of rotation). 

13.1.10 Power loss 

It is possible to select for the different types of losses (gears, bearings, seals) whether all losses or 

only a selection of losses should be calculated, or whether they should be entered by the user. In the 

case of gear losses settings can be further distinguished into load-dependent and load-independent 

losses. Based on these settings, the calculation of the losses is carried out. For gears all currently 

available calculation methods are incomplete. These gaps are filled with adapted methods. 

In this tab, correction factors can also be defined that are used to adjust the calculated values to 

experimental results. 

13.1.11 System data 

This table can be used to connect several parameters that are common to all submodules in one 

system table. For example, a global oil level can then be defined in the system and automatically 

transferred to all shaft calculations. 
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13.1.12 Load spectrum 

A system load spectrum can be created, in which a user-defined number of parameters can be 

varied. Boundary conditions for loads, losses, gear factors, shaft temperatures, and many other 

values can be defined as varying parameters in the spectrum. Different application cases can then 

be created with multiple variations of requested service lives. A load spectrum can also be imported 

directly. A simple kinematic load spectrum analysis or the entire strength analysis can then be 

performed. An evaluation of each individual load bin in the load spectrum can also be calculated. The 

main report shows the results of the corresponding calculation. 

13.1.13 Variants 

Several variants of submodule calculations can be defined for all shafts and gears, within a single 

table. A global variant can then be selected to import all submodule calculation files into the model. 

The results can then be compared with another variant. 

13.1.14 Module specific settings 

The settings for the elements to be used in the model are made in the "Module specific settings". 

You can change the names of the elements that are to be used in the model in the Naming of the 

elements  tab. The term <autoInc> after each element name means that a number is added 

automatically after that name. This number represents the number of added elements of the same 

sort. 

In the Default dimensions  tab, you can preset the dimensions for the toothing geometry and bearing 

geometry. When these elements are used in the model, the gear unit is displayed with these 

predefined sizes in the initial phase. 

13.1.15 Modeling assistant 

You will find predefined gear stages in this window. You can select different cylindrical gear stages, 

bevel gear stages and planetary stages. In addition to these stages, individual or paired shifting gear 

stages are present, which are primarily used for gearboxes with shifting elements. The size of the 

components is directly linked to the default sizes defined in the module specific settings. 

13.1.16 System rough sizing 

A rough sizing can be performed on all gears and shafts present in the model. Several parameters 

can be varied to get the most suitable sizing solution. 
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13.2 Modeling 

Different methods for creating a gear unit model are provided in the system module. All these 

methods can be used in each phase in the model. Each step can be performed with different 

methods. You can use a different method from one step to the next at any time. The possibilities are 

described below. 

13.2.1 Creating a model with the Element Box 

You can use the icons in the Element Box to create the model in Shaft view. Click on an icon in the 

Element Box to insert it in the model tree structure, in Shaft view. The first element to start with is the 

shaft calculation. A shaft element is always created automatically when the shaft calculation is 

added. If a shaft calculation has several shafts with the same axis, you can insert them by clicking on 

the shaft icon in the Element Box. You can click on the other appropriate icons in the Element Box to 

insert gears, bearings or other connection elements such as couplings, synchronizers (switching 

elements) or the carrier element in these shaft elements. To define a new shaft axis, you can 

integrate a different shaft calculation by clicking on the relevant element in Shaft view. 

After the shaft calculations with the shafts and their elements are finished, you can define the gear 

stages as transmissions. To do so, click the gear calculation elements in the Element Box. Each time 

you click on an element, the selected calculation element is listed in the corresponding selection, in 

the Element view. 

Now you need to define the references between the gears and the calculations. To do so, click on 

the gears in Shaft view to select them, and then drag them into the associated gear calculation. Drag 

over two, three or four gears, depending on the calculation type (two-gear, three-gear, planet or four-

gear calculation). Here, the convention that the sequence of gear elements from top to bottom 

matches the sequence of gears in the corresponding KISSsoft calculations applies. 

Once you have linked all gear calculations with the gears, you can define the system's input and 

output conditions. 

To define a boundary condition in the model, simply click on the appropriate element in the Element 

Box. To create the link with the couplings: in Shaft view, left-click on a coupling element, that is to be 

referenced, to select it, and then drag it over to the boundary condition element. 

The model is displayed as a schematic sketch in the Sketcher  tab at the same time. You can see 

how the shaft groups are arranged in the 3D Viewer  tab. You can define the boundary conditions in 

detail in the Kinematics  tab. 

13.2.2 Creating a model with the Sketcher 

You can create the model in the Sketcher, using the mouse as a "drawing" tool, from the very start, 

or later in the modeling process. When you are "drawing" with the mouse, note these points: 
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To start and end a shaft, perform a double-click. To insert nodes on the shafts, click once. When you 

have finished drawing the shaft, a dashed blue line is displayed on the end of the mouse pointer. 

Click on the required grid line to set the position of the associated shaft axis. You can also right-click 

on the nodes on a shaft to select them, and then convert them into the appropriate element (bearing, 

gear, coupling, etc.) via the selection list. If more nodes are needed at a later time, you can insert 

them by double-clicking on a grid point of the shaft. You can delete a node at any time by right-

clicking on it and then selecting "Delete". 

 

You can double-click to begin defining another shaft and create it as described above. In the final 

step, click the left mouse button to assign the shaft to the axis of a previously defined shaft. The shaft 

can also be assigned to its own new axis in the drawing level. The model in the Sketcher is built up 

simultaneously in the Shaft view. When you create a new shaft axis in the Sketcher, a new shaft 

calculation is simultaneously generated in Shaft view. 

 

Once you have drawn the shaft axes with the shafts and their elements, you can now link the gears 

with each other. To do so, drag and drop the gear element center points to link them with each other. 

Synchronizers and bearings are initially defined as individual elements on a shaft. However, these 

connection elements are often completely defined between two shafts. To assign these elements to a 

new shaft, use the mouse to drag and drop the associated node. Bearings that are not assigned to 

any other shaft are handled as bearings that have an outer or inner ring that is in contact with the 

housing. You can also assign the carrier icon to the axis on your planet shaft(s) by dragging and 

dropping the carrier icon. 

13.2.3 Creating a model with groups 

Besides creating a model using the Element Box and the Sketcher, you can use the Groups 

Assistant to generate individual finished sub-assemblies. You can then merge the individual shafts in 

these assemblies by dragging and dropping them in the model tree structure. This creates a single 

gearbox concept from the individual groups. 

13.3 Special Calculations 

13.3.1 Thermal rating 

You can use the thermal rating to calculate the heat level in a particular gear unit. Several different 

methods have been implemented to enable you to select how the calculation is to be performed, 

according to the ISO/TR 14179 standard, Part 1 and Part 2. Thermal analysis can be split into two 

sections: power loss and heat dissipation. An external cooler can also be taken into account. Power 

loss and heat dissipation can be split up into several sections, to enable the effect of all the individual 

gear unit components to be taken into consideration. Power loss can be split into two main 

components: load-dependent and non-load-dependent. Both types of loss are usually present when 

a gear unit is running. Power loss can also be subdivided into gear unit elements such as gears, 

bearings and seals. Meshing and churning losses are taken into account for gears whereas rolling 
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and sliding friction are taken into account for bearings and seal friction is taken into account for seals. 

In some cases, the results must be treated with caution, because the calculation methods used may 

not fully support the geometry type. Heat dissipation can be categorized as heat dissipation through 

the housing, foundation and rotating parts (input/output shafts and couplings) and cooling oil flow. A 

gear unit's total efficiency and total heat dissipation capacity for a given lubricant temperature, cooler 

power and input power can be calculated with ease. You can also specify two of these three entries 

and calculate the optimum value for the third parameter, which is the value with which you achieve 

the best heat level for the gear unit. In other words, this is the value at which the dissipated heat 

equals the heat generated through the power loss. Part 1 and Part 2 of the standard differ in the way 

the calculation values are input. The main benefit of Part 1 is that it enables you to enter your own 

heat transfer coefficients for heat dissipation through the housing (if it has a very specific shape), 

whereas, in Part 2, this coefficient is calculated using an approximation of the shape of the housing. 

The main benefit of this part is that it also takes fins, foundations and rotating parts into consideration 

when calculating heat dissipation. 

13.3.2 Modal analysis 

This special calculation has been designed to calculate the eigenfrequencies and eigenmodes of a 

complete shaft system, including the effect of gear connections between shafts. 

To start running this calculation, click on Calculation> Modal analysis  in the menu. You must define 

the number of eigenfrequencies to be calculated, and specify whether only torsional or all vibration 

types are to be included, and whether gyroscopic effects are to be taken into account (does not apply 

to torsional vibrations). You must also define which calculation method is to be used to calculate 

tooth contact stiffness. The following selections are available for this last option: 

As defined in ISO 6336 Method B, if the tooth contact stiffness used here matches the 

description in this standard. 

Using the contact analysis algorithm (for each gear pair), where a full contact analysis is 

performed in the gear connections. If KISSsoft does not have a contact analysis 

calculation for a particular gear pair type, or if the gear pair does not transfer power, the 

ISO 6336 process is used for that specific pair. 

Infinite: the tooth contact stiffness is assumed to be infinite. Select this option if you want to 

check limiting conditions. 

Ignore: the tooth contact stiffness is assumed to be zero and there is therefore no 

connection between the vibrating shafts (each shaft is vibrating independently). 

When the calculation is finished, the results can be accessed in the report or in the graphics. 

Note that, when you perform a modal analysis for a planetary system, the calculation does not take 

into account the effect of the positions of the rotating planets on the system's bending stiffness. This 

is similar to the quasi-static calculation procedure usually followed in eigenfrequencies analysis. 
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13.3.3 Campbell diagram 

A Campbell diagram can be used to investigate the effects of shaft speed on the eigenfrequencies. 

This calculation can be used to define the critical eigenfrequencies for each speed. 

To start running this calculation, click on the "Campbell diagram" menu option in the "Calculation" 

menu. In this dialog, you can also specify the method for calculating the gear mesh stiffness (as 

described in the Modal analysis section), the reference boundary for the calculation and the speed 

range. You can also specify the number of eigenfrequencies that are to be taken into account in the 

Campbell diagram. Finally, you also have the option of entering the number of resonance curves that 

are to be included when the Campbell diagram is displayed as a graphic. A kinematic analysis of the 

system is also performed for every speed of the reference boundary condition as part of the 

calculation. The speeds of the shafts are updated and then a modal analysis is performed for each of 

these reference speeds. 

When the calculation is finished, the results can be accessed in the report or in the graphics. 

13.3.4 Forced response 

The forced response analysis can be used to calculate the real dynamic behavior of a shaft system 

that is subjected to dynamic loads because of unbalance masses. Deformations, rotation, forces and 

torques are taken into account in the calculated behavior. 

To analyze the unbalance response, select Forced response  in the Calculation  menu. Select the 

appropriate option to take unbalance masses into account. There are four available methods for 

defining meshing stiffness (a description of the selection options is given (see chapter 13.3.2, Modal 

analysis)). You can also select the reference boundary that is to be used for speed control in the 

system. In addition, you can select the speed range and the number of calculation steps. 

Finally, you can also define the material damping for torsional, axial and bending vibrations in this 

dialog. Note that the viscous damping of bearings must be defined separately for each bearing in the 

shaft calculation. When the calculation is finished, the results can be accessed in the report or in 

graphics. 

13.3.5 Extended forced response 

In the forced response analysis, the dynamic behavior of a powertrain system subjected to the 

dynamic loads from different sources of excitations is calculated. In this regard, the vibration 

characterization of the system under periodic excitations is performed. To do so, the harmonic 

excitation forces are applied to the system and the underlying responses are calculated. Three 

sources of excitation can be modeled. This includes the varying gear meshing forces and meshing 

stiffness, externally applied torque ripples and unbalanced mass excitations. The forced response 

analysis based on the unbalanced mass excitation and torque ripples is integrated in the extended 

force response module. 
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13.3.5.1 Theory 

The theory of the forced response analysis is based on the research work done by Beermann [5]. In 

this approach, the excitation forces of the meshing gears are calculated and then are applied to the 

system according to their excitation orders. The total procedure is based on the frequency response 

analysis, where all the excitations and responses are represented in terms of the excitation 

frequencies together with their corresponding amplitudes and phase angles. 

The forced response analysis in KISSsoft consists of three main steps: 

The first step is a pre-processing step. The shaft calculations are performed to calculate all 

relevant kinematic and geometric parameters of the system. Then, the contact analysis 

of all involved gear stages is carried out. The most important output data calculated are 

the transmission error and the nonlinear stiffness of gear pairs. These values are 

required to calculate the gear mesh excitation forces. 

The basic calculation of the forced response analysis of the system is performed in the 

second, and most important step. This step includes the generation of the coupled 

system of vibration equations and the calculation of the excitation forces. As the result 

of the system solution, dynamic contact forces at meshing gear pairs are calculated. 

The third step is a post-processing step in which the gear mesh outputs, bearing forces and 

shaft outputs at the documentation points are calculated. The calculation of the output 

data is based on the results of the main step. 

The main part of the forced response algorithm consists of the following steps: 

Finding the system base frequency ɋ0 of all excitation frequencies and adjusting the time 

variables. 

Removal of duplicated frequencies for meshing gear pairs, and variable torque inputs. 

Building the stage matrices for a specific excitation frequency. A stage matrix contains all 

the dynamic forces and system responses caused by the effect of a unit load on gear 

pairs for a specific excitation frequency. 

Building the Fourier matrix [5] containing all translational and rotational forces of the system 

at meshing gear pairs. 

Calculating the angles between force exertion planes of successive meshing gear pairs: the 

bending displacement of a gear pair as the result of force exertion at an adjacent gear 

pair is projected on the direction of that force. 

Calculating the gear stiffness and mean transmission error of meshing gear pairs 

corresponding to the user-defined excitation frequencies. 

Defining boundary conditions for the shafts. 

Calculating the bending, axial, and torsion influence factors as the result of a unit load at 

gear pairs for all shafts at different excitation frequencies. 

Solving the system of dynamic equations to calculate Fourier coefficients. 
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Calculating the static and dynamic forces at meshing gear pairs over time at each input 

shaft speed. 

13.3.5.2 User interface 

The powerful and user-friendly user interface of the forced response analysis allows analysts and 

engineers to perform the dynamic analysis of powertrain systems quickly and efficiently. Within this 

tool, a comprehensive list of different settings and options are provided which enable the user to 

precisely investigate the vibration characteristics of the system. With the current implementation, the 

forced response analysis of powertrains with helical and bevel gears mounted on normal and coaxial 

shafts with switchable or coupling connection elements can be accomplished. A number of different 

parameter settings can be used for these purposes. These settings are described in the sub-sections 

below. 

13.3.5.2.1 Type of calculation 

Three options are available. In the first option, Unbalanced masses , only the excitations from 

unbalanced masses are considered. The relevant parameters of the unbalanced masses including 

mass and eccentricity have to be defined in the corresponding shaft calculation module. At least one 

unbalanced mass with nonzero mass and eccentricity values has to be defined. Otherwise, an error 

message is shown. The position of the unbalanced mass has to be given within the corresponding 

shaft limits. It should not exceed the shaft length. There are four methods for calculating meshing 

stiffness (description of selection options (see chapter 13.3.2, Modal analysis)). 

The second option, Gear meshing forces , excludes the unbalanced mass excitation and includes 

the gear meshing forces resulting from the transmission error and the externally applied torque 

ripples. The third option, Unbalanced masses and gear meshing forces , considers the three 

sources of excitation mentioned above. 

13.3.5.2.1.1 Gear meshing forces 

If the type of calculation includes the Gear meshing forces , click the Tool -specific settings  icon to 

make entries to the following parameters, which are relevant for this type of calculation. 

Meshing stiffness: According to the contact analysis module, both the Tangent stiffness  and 

Secant stiffness  approaches are available. If the contact analysis algorithm per gear pair is used, a 

full contact analysis is performed separately for each gear pair. The results of transmission error and 

meshing stiffness are then used to calculate the excitation forces. The accuracy of the excitation 

forces in the forced response analysis is related to the accuracy level of the contact analysis. 

Therefore, prior to the forced response analysis, it is recommended to check the transmission error, 

meshing stiffness, and excitation force of each gear pair calculated in the contact module. 

Excitation force type: Calculation of the excitation forces can be done in two different ways. The 

Meshing stiffness times transmission error  option is based on the multiplication of the meshing 
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stiffness and the transmission error. This assumes that the meshing stiffness and transmission error 

are represented as the summation of a number of harmonic functions in the form of 

ὧὸ ‎Ὡ ȟὝὉὸ ‘Ὡ  

The excitation forces can now be calculated from 

Ὂὸ ὝὉὸὧὸ ‘Ὡ ‎Ὡ  

‘‎Ὡ  

The second option, Calculated in contact analysis , is based directly on the excitation forces 

calculated in the contact analysis module. 

Dynamic modeling approach: The Bending and torsional responses  approach uses the full 

degrees of freedom (including translational and rotational degrees of freedom) of the flexible shafts to 

calculate the system responses. Consequently, it captures all possible responses which might be 

important for the system analysis. In contrast, the Torsional responses  approach only considers the 

rotational degree of freedom along the shaft axis. Compared to the first approach, it requires much 

less computational effort and significantly speeds up the forced response analysis. In this case, only 

the outputs related to the torsional DOF of the shafts can be seen. For more details (see chapter 

13.3.5.9, Graphics). 

Frequency response approach:  The forced response analysis uses the excitations and vibrations 

in terms of their excitation frequencies, with their corresponding amplitudes and phase angles. Two 

different approaches are available: Multiple harmonics  and Single harmonic . In the first case, all 

excitation frequency orders, up to the number of excitation harmonics, are taken into account when 

calculating the excitation forces. 

In the Single harmonic  approach, only one specific excitation frequency order, which equals the 

Harmonic number , is taken into account. Therefore, the effect of each excitation frequency order of 

active gear pairs on the system response can be investigated separately. 

Solution approach: The frequency response approach results in a set of coupled dynamic 

equations. The solution to these equations calculates the dynamic contact meshing forces. Similar to 

the excitation forces, the system responses are also represented as the summation of some 

harmonic functions in terms of response frequencies. The solution approaches can be divided into 

Direct  and Iterative . In the direct approach, the coefficient matrix of the system equations is a 

square matrix. Therefore, the number of response harmonics is equal to the number of excitation 

harmonics. However, in the iterative approach, the equations are solved iteratively. As the result of 
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this approach, the number of response harmonics can be higher than the number of excitation 

harmonics. 

In each step of the iterative approach, the Convergence ratio  is used to check if the calculated 

results are fulfilling the convergence criteria. The smaller the value of the convergence ratio is 

chosen; the higher number of iteration steps is required to fulfill the convergence criteria and to stop 

the iteration process. Consequently, the accuracy of the results is enhanced. 

13.3.5.2.2 Reference boundary 

This is a list of all the boundaries on which the input speeds are defined in the system module's 

Boundary  tab. With this input, one boundary is selected as the reference to assign the input speed 

for the forced response analysis. According to the selected reference boundary, a kinematic 

calculation is performed in the pre-machining step to calculate the speed of all other shafts. 

13.3.5.2.3 Number of speeds 

This specifies the number of speeds to run repeatedly the forced response analysis. The minimum 

and maximum numbers of speeds are, respectively, 1 and 10000. 

13.3.5.2.4 Speed range (min/max) 

This is where the minimum and maximum values of the speed range of the reference boundary are 

specified, in units of 1/min. If the number of calculation steps is set to one, only one input box for 

specifying the speed of the reference boundary is shown. It is important to note that, to avoid 

numerical problems, you cannot specify a minimum speed of less than 0.01 [1/min]. 

13.3.5.2.5 Number of excitation harmonics 

The forced response analysis is based on the frequency response approach. In the case of the 

Number of excitation harmonics , the same number of excitation forces frequencies is considered 

for all active gear pairs. If this number exceeds the maximum number of available harmonics of any 

gear pair, then the lowest maximum number of harmonics among all gear pairs is considered in the 

excitation. The possible maximum number of harmonics which can be set is 100. When the torques 

ripple excitation is also given, then the given number of harmonics is considered for both excitation 

types. It is particularly of great importance to select a suitable number of harmonics to make a trade-

off between the demanded level of the results accuracy and the analysis effort. A large number of 

excitation harmonics results in a higher number of dynamic equations and can consequently require 

more calculation time. Before performing the forced response analysis, we recommend you check 

the influence of transmission error amplitudes, meshing stiffness or torque ripple to decide the extent 

to which excitation orders should be considered. 
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13.3.5.2.6 Gear pairs for excitation 

In the implementation of the forced response analysis, the excitation of all active gear pairs is 

considered by default for the Gear meshing forces  excitation. However, sometimes it is required to 

consider only one or several gear pairs among all active pairs and to excite the system. Neglecting 

the gear pairs that are not of interest or may contribute less to the system excitation, can lead to a 

faster forced response analysis. In this case, one can easily characterize the effect of each gear pair 

in a separate analysis. The calculation algorithm remains the same. However, for gear pairs that are 

excluded from the excitation, the meshing stiffness can also be calculated using ñISO 6336 Method 

Bò. Note that a contact analysis is still required to calculate the transmission error for those gear 

pairs. As another important aspect, at least one active gear pair must be selected. 

13.3.5.2.7 Torque ripple 

Torque ripple is a periodic excitation in torque which can result in vibrations and noise. This effect 

can usually be observed in many electric motor and combustion engine designs, referring to a 

periodic fluctuation in the output torque as the motor shaft rotates. The externally applied torque 

ripples, as another source of excitation, are integrated in the extended force response module. The 

main approach is very similar to the one used to calculate gear mesh excitations. However, the 

excitations resulting from torque ripple are added to those resulting from the transmission error, so 

that the forced responses in the system are calculated as the result of both excitation types. 

The table for the torque ripple excitation input data is not active if Unbalance masses  is selected as 

the type of calculation. The boundary conditions for the torque ripple input data have to be specified 

in this table. Click the + sign in the lower right-hand corner of the table to insert new rows for entering 

the input data for each boundary condition. After selecting the boundary condition, the corresponding 

input coupling with torque ripple has to be defined. Under Input , specify one of the input types for the 

time or frequency domain. Finally, select the input folder into which the input torque ripple data is to 

be uploaded. 

Required specifications for the torque ripple input data in the time domain: 

Torque ripple input data in the system module must have the following file format: *.dat, *.txt 

or *.csv. The file must contain two columns with the torque ripple amplitudes. 

The first column must contain the angle of rotation for the corresponding boundary 

condition. The second column must contain the torque ripple amplitudes. 

The torque ripple amplitudes must be given for a duration of one (or several) full rotation(s) 

of the shaft on which the input coupling is loaded by the torque. This implies that the 

frequency of one torque variation cycle must be an integer factor of the corresponding 

shaft speed. 

The torque amplitudes must be reported at equally distanced rotation angles. 

The mean value of the torque ripple amplitudes must be zero. It means that the constant 

part (its mean value) must be already given as a constant torque through boundaries in 

the system module. 
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Required specifications for the torque ripple input data in the frequency domain: 

In the first line, the excitation orders are given. 

Enter the coupling speeds or the constant torques in the second and third lines. 

Then, enter the torque ripple amplitudes that correspond to each excitation order and to 

each speed and torque in the ranges. 

The coupling speeds and constant torques must be ascending. 

The coupling speeds and constant torques of the system module model must be in the 

range given in the input data file. 

The coupling speeds and constant torques of the system module model must correspond to 

a defined value of the torque ripple amplitudes. 

In the table, a sample of the input data type for the torque ripple in the frequency domain for three 

excitation orders, four speeds, and three contact torques is shown. 

Excitation 

orders Ὢρ ȟὪς  

Speeds 

range 

(rpm) 
‫ȟ‫ȟ‫ȟ‫  

Constant 

torque 

range 

(Nm) 

ὝȟὝȟὝ 

Torque 

amplitudes 

(1st order) 

ὃ  ὃ  ὃ  ὃ  

ὃ  ὃ  ὃ  ὃ  

ὃ  ὃ  ὃ  ὃ  

Torque 

amplitudes 

(2nd 

order) 

ὃ  ὃ  ὃ  ὃ  

ὃ  ὃ  ὃ  ὃ  

ὃ  ὃ  ὃ  ὃ  

Table 13.1: Example of the input data type for torque ripple in the frequency domain 

13.3.5.3 Damping 

In powertrain systems, all deformable elements can dissipate energy when subjected to dynamic 

deformations. The internal damping of these elements represents the energy dissipation. 

Consequently, damping is an important factor in the design of structures to minimize noise, structural 

instability, and fatigue failure of components. Three different damping sources can be given: damping 
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of bearings and supports which have to be defined in the shaft calculation module, structural 

damping of shafts, and gear meshing damping. The material damping of shafts in torsional, axial 

(tension/compression), and bending directions are specified by some loss factors. The default value 

is 1x10-5s. This type of damping is based on the Kelvin-Voigt model and is well-suited for the 

structural vibration analysis of continuous systems [5]. 

 

„ Ὁᶰ Ὧ ᶰ
ȕ

 

where kw is the damping coefficient. In this approach, the damping is introduced in the equations of 

motion through complex-valued quantities with the underlying assumption that the vibrations are 

harmonic. Thus, this damping model can be used in the frequency domain analyses. 

13.3.5.3.1 Gear meshing damping 

Gear meshing damping  is known as an important determinative factor in the dynamic response of 

the system under certain running conditions. With the viscous damping, the effect of lubricant film as 

well as the internal damping of the gear teeth in dissipating the kinetic energy into frictional heat and 

constraining the motion amplitudes is modeled. On the other hand, without damping, undesirable 

induced vibrations generate noise, increase dynamic loads and potentially damage gears and 

bearings. 

Gear meshing damping can be defined as Constant , Proportional to average meshing stiffness  

or Proportional to nonlinear meshing stiffness . Typical values for the damping coefficient are 

between 102 and 104 Ns/m. In the proportional damping model, the damping coefficient is calculated 

from: 

ὅ ς‚
ὐὐ

ρȾὐὶ ρȾὐὶ
Ὧ 

where ɝ is the damping ratio, k is the meshing stiffness, Jp and Jg are the mass moment of inertia of 

the pinion or gear, and rp and rg are the base circle radius of the pinion or gear. 

13.3.5.4 Time domain 

Resolution: The quality of the results in the time domain can be adjusted by setting the resolution to 

low, medium, high or very high. This option does not affect the quality of the results in the frequency 

domain. In the forced response analysis, the end time for generating the time domain data is 

adjusted so that it can capture all possible excitations and complete full periods of the vibrations for 

all excitation frequencies. A base excitation frequency ɋ0 is determined for this purpose. This is 

related to the common divisor of all the excitation frequencies. This means the excitation frequencies 

are integer factors of ɋ0. The end time is therefore calculated as 

Ὕ ςɩȾɱ  

The step time is then calculated: 
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ɝὝ ςɩȾὙẗὪ  

where Rf is the resolution factor which is adjusted according to the resolution level (low: Rf = 10, 

medium: Rf = 25, high: Rf = 50, very high: Rf = 100). Furthermore, fmax is the highest excitation 

frequency of the system. 

Plot step factor: The plot step factor P defines the number of sampling plot data for generating the 

outputs in the following manner: 

According to the resolution set by the user, the time step ȹT for calculating the results in the 

time domain is calculated. 

The time step ȹTplot for calculating and plotting the results is then calculated from 

ȹTplot=PĿȹT. 

The highest possible time step, ȹTmax= 2ˊ/(10Ŀfmax), which corresponds to the lowest 

resolution, is calculated. 

If the time step is ȹTplot > ȹTmax, ȹTmax is the final time step for calculating and plotting the 

results. 

The plot step factor is only active if the resolution is not "low". 

End time: The default setting is that end time Tend, which is used to calculate the time domain 

results, is calculated as described above. However, if a specific time Tend is required or if the default 

end time is high and too much time is needed to generate the time domain results, the end time can 

be modified here. 

13.3.5.5 Settings in the shaft calculation module 

There are some important settings in the shaft calculation module which must be taken into account 

in detail before performing a forced response analysis. These settings can have a significant effect 

on the results. Some of them are briefly mentioned here. 

Gear on shaft: Four types of definition for gears on a shaft are available in the Basic data  tab: 

Gears as load applications only 

Gears as mass 

Gears as mass and stiffness 

Gears as mass and stiffness acc. to ISO 6336-1 

According to the selected type of gear definition, the corresponding settings are considered internally 

in the forced response analysis to define the gears. 

In the first case, the gear mass is neglected in the shaft calculation analysis. However, in the system 

dynamic equations, it is to be taken into account as a point mass (in the form of a so-called Fourier 
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matrix, which relates the response of the shafts to the gear body dynamics). In the second case, the 

gear is taken into account as a point mass in the shaft calculation response, but neglected in the 

Fourier matrix. In the last case, Gear as mass and stiffness , the gear element is considered as part 

of the shaft and its effect is integrated into the shaft. For this reason, it is neglected in the Fourier 

matrix. 

If the definition of the gear in any shaft calculation differs from the definition in other shaft 

calculations, a warning message is displayed at the end of the forced response calculation. This 

definition can also be set once in the System data tab in the system module to ensure it is consistent 

for all gears. 

Rolling bearings calculation: In the Rolling bearing  tab in the shaft calculation module, you can 

select one of the following settings for the calculation method: 

Stiffness: Not calculated 

Stiffness: ISO/TS 16281 

This definition can also be set once, in the System data  tab in the system module, to ensure it is 

consistent for all rolling bearings. If Stiffness: Not calculated  is selected, a very large stiffness 

coefficient is considered in KISSsoft. A warning message with this information is displayed at the end 

of the forced response calculation. In addition, selections of the stiffness of the rolling bearings in a 

shaft calculation different from other shaft calculations results in another warning message. 

General: The following options contribute to the results of the forced response analysis: 

Consider weight 

Consider gyroscopic effect 

Consider deformation due to shearing (Timoshenko beam) 

The first two items can also be set in System data tab in the system module to ensure they are 

consistent for all shaft calculations. 

Supports and Bearings: When defining bearings, the stiffness coefficients, the damping coefficients 

and the imposed boundary conditions can have significant effect on the forced response analysis 

results. In addition, in the bearings, the damping coefficients can be manually specified by the user. 

Documentation points: Some output types of the forced response analysis require a documentation 

point on a shaft. In fact, documentation points specify prescribed measuring points on the shafts 

where certain shaft outputs are demanded. This fact will be explained in greater detail in the 

Graphics  section 13.3.5.9. If a documentation point is located outside of a shaft, an error message is 

shown. The same rule holds also for the coupling locations on the shafts. 
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13.3.5.6 Settings in the system module 

The speeds given in the Boundary  tab are the nominal speed values of the boundaries. These 

speeds are only used if the Reference boundary  speed in the user interface does not fulfill the 

forced response requirements. The torques of the coupling elements are used as the nominal 

constant torques. In the torque ripple excitation, these constant torques are added to the dynamic 

torque amplitudes to apply the variable torque excitation to the gears. 

Notes:  

The sense of rotation in the forced response analysis is based on the data in the Boundary  

tab  

The contact analysis is based on the constant torque values. This means that even in the 

case of the torque ripple, the forced response uses the transmission error and stiffness 

of gear pairs calculated from the Contact analysis module, based on the constant 

torques. 

When the type of calculation includes Gear meshing forces , there should be no zero-mesh 

frequencies present in the system. This can happen, for example, in a planetary system when the 

sun, planet carrier and ring gear have the same speed in the Reference boundary  tab. In this case, 

the planets are turning in such a way that their teeth that contact the sun and ring gears are not 

changed. The planets are turning in such a way that their contact teeth do not change. In this way, all 

gears are rotating with the same angular velocity and therefore, an error message is shown. 

13.3.5.7 Data export 

As it is already mentioned before in the theory of the forced response, after running the calculation, 

the basic dynamic analysis is done to calculate the dynamic gear mesh forces in the frequency 

domain. For this purpose, the system equations are generated and are solved. To generate all other 

results for the gear pairs, bearings and shaft outputs at the documentation points, select the relevant 

elements in File > Export > Forced response  in the menu. 

13.3.5.7.1 General 

After running the basic calculation in the forced response, the gear pairs, bearings, and 

documentation points can be selected here to calculate the output results. For each group, selection 

of all elements together as well as selective definition of each element is available. In addition to 

generating the output data in Graphics , the results can be saved as .txt files and exported for further 

use. Therefore, it is required to select the demanded outputs by checking the corresponding boxes. 

To export these files, select File > Export > Forced response > General . 

Dynamic factor: The dynamic factor characterizes the overall dynamic response of each gear pair at 

different running speeds as the result of transmission error excitation. Special attention must be paid 

to those speeds that have high dynamic factor values. The dynamic factor can be generated if the 
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Gear meshing forces  option was selected as the type of calculation. Consequently, it is not 

available if the Unbalance mass  option was selected. To calculate the dynamic factor of gear pairs, 

system equations are generated and solved, to calculate the dynamic contact forces of each gear 

pair in the frequency domain. These forces are then converted to the time domain: 

Ὂὸ Ὂ Ὡ  

The maximum dynamic force F(t) is determined and divided by the corresponding static force Fs to 

determine the dynamic factor: 

Ὀɱ
άὥὼ Ὂὸ

Ὂ
 

Frequency and time domain outputs: Calculating the results of the bearings and shafts in the 

frequency domain is carried out based on the dynamic meshing forces calculated from the basic 

calculation step. Compared to dynamic factor calculation, it requires higher computational effort and 

therefore, it is recommended to select the demanded outputs. 

For calculating the results in the time and speed domains, first the postprocessing is done for the 

selected outputs in the frequency domain. Then, in subsequent steps, they are represented in time. 

Since generating the output data in the time domain is carried out at all time steps in the time range, 

it is more time consuming than the case when only the frequency domain outputs are required. 

13.3.5.7.2 RecurDyn 

Before exporting the bearing forces in time domain and creating the KISSsoft-RecurDyn interface file, 

it is necessary to define the required fields. This includes the inputs for generating the FEM mesh, 

the number of normal modes of the housing, the definition of the step files of the gears and shafts (if 

relevant), and bushing elements for supporting the housing in RecurDyn. To export these files, select 

File > Export > Forced response > RecurDyn . 

13.3.5.8 Results window 

When the calculation is finished, as shown in the table, the following data is generated in the results 

window for each gear pair at all the running speeds specified in the speed range: 

Speed 

(1/min) 

Base excitation 

frequency (Hz) 

Time step 

(ms) 

End time 

(ms) 

n ɋ0 ȹT Tend 

Table 13.2: Result window of the forced response analysis 
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13.3.5.9 Graphics 

After running the basic calculation in the forced response analysis, the results and outputs of the 

analysis can be displayed by selecting Graphics > Forced response  in the Graphics menu. This is 

based on the following requirements: 

At least one documentation point is located on a shaft. 

The number of speeds is at least two. 

Gear meshing forces  or Unbalance mass and gear meshing forces  was selected as the 

type of calculation. 

General data (plot requirements No. 1, 2):  

Variation of the maximum value of the following parameters at documentation points versus speed of 

the reference boundary is shown: 

major half axis of whirl orbit 

minor half axis of whirl orbit 

phase of whirl orbit 

The outputs are related to the plots of the whirl orbit to assess the deformation of flexible shafts at 

different sections. Figure 1 shows a typical elliptical path of the shaft center which can be 

characterized by the whirl orbit parameters. 

 

Figure 13.1: Whirl plot of a flexible shaft 

3D deformation:  

Select this to display the system elements' vibrations and movement caused by the excitations. This 

feature can provide more insights to the response of the system`s elements by visualizing their 
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movements in a 3D view. For this purpose, the forced response creates many sections on each shaft 

and runs the postprocessor to calculate all the relevant responses at these sections. Consequently, it 

can be very time consuming if complex systems that contain many shaft objects are involved. 

Dynamic factor (requirement No. 2, 3):  

The dynamic factor is plotted for all active gear pairs with reference to the reference boundary speed. 

The reference speed of the reference boundary from the Boundary  tab is also displayed here. 

Meshing contact force:  

Frequency domain (requirements No. 3):  The amplitudes of the dynamic meshing contact force for 

all active gear pairs at all running speeds of the reference boundary are plotted. Number of 

amplitudes is equal to the total number of distinguishable excitation frequencies. The amount of static 

contact force is additionally shown in the comment window. 

Time domain (requirements No. 3):  Variation of the dynamic meshing contact force for all active gear 

pairs at all running speeds of the reference boundary can be plotted. For each gear pair, the X axis is 

the rotation angle (or its equivalent time duration) of the shaft which contains the main gear of that 

gear pair. 

Speed range (requirement No. 2, 3):  Variation of the maximum value, minimum value, and peak to 

peak value of the dynamic meshing contact force for all active gear pairs is shown versus speed of 

the reference boundary. 

Transmission error (local and common axes, requirement No. 3):  

The transmission error (TE) is plotted for all active gear pairs. The transmission error is calculated 

from the contact analysis module by considering the effect of the shift phase angle of successive 

gear pairs. For a more detailed explanation, see [6]. In the local axis plot, variation of the TE for each 

gear pair is plotted versus the rotation angle of the corresponding main gear. However, in the global 

axis plot, the TEs of all active gear pairs are plotted versus the angle of rotation of one gear as the 

reference. 

Dynamic transmission error:  

Time domain (requirements No. 3):  Variation of the dynamic transmission error for all active gear 

pairs at all running speeds of the reference boundary is shown. For each gear pair, the X axis is the 

rotation angle (or its equivalent time duration) of the shaft which contains the main gear of that gear 

pair. 

Speed range (requirement No. 2, 3): The variation of the maximum value, minimum value, and peak 

to peak value of the dynamic transmission error for all active gear pairs is displayed, with reference 

to the reference boundary speed. 

Meshing stiffness (requirement No. 3):  
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Variation of the meshing stiffness versus rotational angle (or its equivalent time duration) for all active 

gear pairs is shown. 

Bearing forces and moments:  

Frequency domain: The bearing forces and torque amplitudes in the excitation frequencies can be 

plotted for all reference boundary running speeds. Number of amplitudes is equal to the total number 

of distinguishable excitation frequencies. The amount of static force and moment are additionally 

shown in the comment window. 

Time domain: Variation of the bearing forces and torques versus time or rotation angle of the shaft 

can be plotted at all running speeds of the reference boundary. 

Speed range (requirement No. 2):  The variation of the maximum value, minimum value, and peak to 

peak value of the bearing forces and torques can be plotted at all reference boundary running 

speeds. 

Campbell diagram (requirement No. 2):  

At all running speeds of the reference boundary (X axis), the dynamic meshing contact forces, 

bearing forces and moments amplitudes (in color-legend format) as well as their associated 

frequencies (Y axis) are plotted. The following properties can be seen in the Campbell diagram: 

Amplitude of meshing contact force/bearing force and bearing moment (maximum value) 

Amplitude of each meshing contact force/bearing force and bearing moment 

Display in log10 and normal scale 

More information about the maximum and minimum values of the bearing force amplitudes and their 

components in x, y, and z directions is provided in the comment window in the Campbell diagram. 

Notes:  

The results of Campbell diagram are based on the frequency domain analysis. 

The resolution of the results is directly related to the Number of speeds . For this reason, it 

is important to note that the number of calculation steps should high enough to reflect 

the effect of all possible critical speeds in the speed range, so that the results can be 

shown more clearly. 

The number of lines in the Campbell diagram is equal to the number of distinct excitation 

frequencies, from gear pairs (depending on the number of harmonics), unbalanced 

masses, and torque ripples. 

The lines are shown in the same order of the excitation frequencies. 

For identical excitation frequencies, the results overlapped. 

The number of excitation harmonics influences the number of excitation frequencies due to 

gear mesh forces and torque ripple. 
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Shaft outputs:  

Time domain (requirements No. 1):  Variation of the deformation, velocity, acceleration, force, 

rotation, and bending moment at documentation points versus time or rotation angle of the shaft can 

be plotted at all running speeds of the reference boundary. 

Speed range (requirement No. 1, 2):  Variation of the maximum value, minimum value, and peak to 

peak value of the deformation, velocity, acceleration, force, rotation, and bending moment at 

documentation points can be plotted versus speed of the reference boundary. 

General remarks:  

Depending on the Dynamic modeling approach  selected in the forced response UI, some outputs 

cannot be generated. To clarify more this point, the following points have to be considered. 

Output data for bending and torsional responses:  

All responses which correspond to the bending and torsional DOFs are calculated. 

The dynamic factor shows the ratio of the maximum dynamic gear mesh force along the PL 

to their static values. 

The dynamic bearing forces and moments, dynamic shaft outputs, and dynamic meshing 

contact forces are calculated and added to their corresponding static values. 

The dynamic transmission error shows the spring compression value at gear mesh positions 

which results in the calculated meshing contact forces. 

The meshing stiffness values, which are calculated from the contact analysis, are 

independent of the shaft speeds. Depending on the demanded number of harmonics, 

their amplitudes for each gear pair can be different. 

Output data for torsional responses:  

Only the dynamic responses which correspond to the torsional DOF are calculated. 

The dynamic factor shows the ratio of the maximum dynamic gear torques to their 

corresponding static torque values. 

The dynamic bearing forces and moments are zero. Only the static bearing forces 

andmoments are shown in the Graphics. 

The dynamic shaft outputs, which are related to the bending DOFs (deflection, velocity, 

acceleration, and force), are zero. Only their static values are shown in the Graphics. 

The dynamic shaft outputs which are related to the torsional DOF (rotation and bending 

moment) are shown in the Graphics. 

The gear mesh outputs (meshing contact force, dynamic transmission error, meshing 

stiffness) are based only on the torsional excitation of the gears as well as torque 

ripples. No contact force excitation along the Pressure Line (PL) is considered. 
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13.3.5.10 Current limitations 

The forced response analysis has the following limitations: 

A force response analysis cannot be performed for bevel gear differentials. 

The dynamic response of the housing is not considered in the analysis. 

13.3.6 Housing deformation in static calculations 

The way that housing deformation is included in static calculations is based on the use of a reduced 

stiffness matrix for the housing, as calculated by the Finite Element Method (FEM). This reduced 

stiffness matrix should include the nodes that refer to the center point of the bearings that connect 

the gear unit shafts to the housing. 

13.3.6.1 Main calculation steps 

The calculation steps for performing this kind of analysis are summarized below. The actual process 

used to generate the reduced stiffness matrix is not described, because it is different for each FEM 

computer program. Please refer to your FEM program manuals for more information. 

Step 1: Setting up the calculation  

The housing deformation calculation is a special system module calculation. To enable this special 

calculation to be used, at least one housing element must be added to the model. In order to use a 

housing element in this calculation, the appropriate checkbox must be set in the housing element 

properties. 

In the Calculation > Housing deformation  tab, you can define which housing element is to be used 

and enter the reduced stiffness matrix file name, required convergence accuracy and maximum 

number of iterations. The system of units used in the stiffness matrix file can either be read from the 

file, or set manually, in the Calculation  tab. The tolerance used for mapping bearings to FEM master 

nodes can be also set there. More information about using this input data is provided below. 

As the FEM model and the system module model might not have the same coordinates system, it is 

important to position the housing element correctly in the model. If you want to perform this 

positioning by manually mapping three FEM nodes to their corresponding bearings, you must select 

the appropriate checkbox in the housing element properties. To perform the positioning, you should 

select three non-colinear bearings in the table in the Calculation  tab and then manually set the FEM 

master node IDs that correspond to them. After positioning has finished, it is advised to validate the 

position of the housing element in the 3D viewer by viewing either the master nodes or the 3D 

representation of the housing (displayed by right-clicking on the housing element). Note that when a 

STEP model is used for the geometrical representation of the housing, this model should be in the 

same coordinate system as the reduced FEM stiffness matrix to ensure the model is displayed 

correctly after positioning. 
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You will find more detailed information about the FEM programs supported by the software, and the 

file format requirements, in the relevant instructions (available on request). 

Step 2: Performing the analysis  

The first step in the calculation is to check the mapping of the FEM nodes to bearings. If any nodes 

are unmapped, the program reports them all and displays their distance to the closest bearing. At this 

point, you need to know if the positions of the specified nodes actually correspond to the bearings. 

You can then decide whether to continue with the calculation or cancel it. One possible reason that 

specific bearings do not correspond to nodes is that the housing is positioned incorrectly in the 

system module's coordinates system. If this is the case, the positioning of the housing must be 

validated. If not, and the difference between FEM nodes and bearings (as reported in the mapping 

message) is not too big, you can change the tolerance used in the mapping process. This might 

happen, for example, if the FEM node was positioned at the edge of a bearing instead of in the 

middle. If you continue the calculation, the program reduces the stiffness matrix for the part that 

corresponds to the mapped nodes, and therefore ignores all nodes that were not mapped to 

bearings. The calculation also ignores any predefined offsets and tilting values previously specified in 

the bearings and sets them to zero. The algorithm runs all the KISSsoft calculations and derives the 

forces on the bearings from their results. The program then uses these forces to calculate the offsets 

and tilting on the bearings (using the FEM stiffness matrix). The KISSsoft calculations are then run 

again with the new offsets, which might result in new bearing forces and offset values. This 

procedure is repeated iteratively until there is convergence between the forces and offset 

calculations. During the calculation process, it might sometimes happen that the maximum permitted 

number of iterations is reached, if a housing has low stiffness. 

In any case, the system will display the results window, containing the percentage ratio between the 

maximum difference from the last two iterations to the maximum value from the last iteration, and 

store and apply the results from the last iteration. Note that, to ensure the algorithm finds a useful 

solution, you should input a number that is greater than 4 in the Maximum number of iterations field. 

After the calculation has finished, you can perform further analyses. For example, you can perform 

contact analysis on gears to see the effect of housing stiffness on the gear unit design parameters. 

You can also use multiple housing elements and load different reduced stiffness matrices for each of 

them. This can be very useful if you want to compare the effect of different housing designs on the 

gear unit design. The results for each housing calculated using this method are then stored in the 

housing element. These results can then be viewed again by clicking on the housing element's 

"Restore results of bearings' offsets" function (right-click on the housing element). 

The following functions are also available, for handling the offsets of mapped bearings (the 

tolerances remain the same): 

Reset bearings' offsets: set bearing offset values to zero. 

Save bearings' offsets: save the current offset values. 

Restore bearings' offsets: restore the saved offset values. 
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13.3.7 Characteristic frequencies 

This special calculation enables the collection of the characteristic frequencies of rolling bearings and 

gear pairs (cylindrical gears, three and four gear trains, planetary gears, and bevel gears) of a 

modeled system. The values are shown in two diagrams in the results window and in the special 

report. In addition, several tools for detailed analysis are available as well as the user input of the 

frequencies from other components. 

The user interface of this special calculation is divided into two parts: General  and Additional data . 

The General  area contains the basic settings: 

Reference speed: For selecting the reference speed. You can choose from boundary conditions or 

from shafts. 

Reference shaft or Reference boundary: Presents the shaft/boundary from the existing model to 

which all other frequencies are referenced. The reference speed is displayed in the report and in the 

results window. It can also be displayed in the Frequency domain  diagram under Graphic > 

Characteristic Frequencies . The reference speed is also used if the Unit selection  field is set to 

Order ï normalized by the reference speed . If constant frequencies are present in the analysis 

(results from the modal analysis, gear critical speed, frequencies from other components) the report 

will output the critical frequencies which are marked in red color. These critical frequencies are equal 

to the reference speed. If the Consider reference speed tolerance range  option is selected, the 

reference speed tolerance range will be taken into account for outputting the critical frequencies. 

Speed range (min/max) n: Is used in the plot of the X-axis in the Frequency domain  diagram, and 

for defining the interval in which the critical or similar frequencies are output. 

Number of harmonics: Is considered in the report and in both diagrams. 

Unit selection: With this option you can change the default unit (Hertz ï Hz) to cycles per minute 

(cpm). Cycles per minute is equivalent to 60 Hz. The third option is, Order normalized by the 

reference speed . If you select this option, all the frequencies are normalized by the reference speed. 

The Reference speed can be from shaft or from boundary condition. 

You can also consider Gear characteristics frequencies  during the calculation. Here, you can 

specify whether all gear characteristics frequencies to be are calculated or only a selection of them. 

Additionally, gear characteristic frequencies for different gear stages can be selected. For more 

information about characteristic gear frequencies (see chapter 15.26, Gear mesh frequencies). 

The same calculation options are available for Bearing characteristic frequencies. Also, frequencies 

for specific bearings can be considered. 

The Shaft frequencies  option represents only the rotational frequency of a shaft. The consideration 

of the frequency of an individual shaft can be selected. 

The following analysis options are available in Additional data : 
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Output similar frequencies: If this option is activated, frequencies are output that are inside the 

user-defined similar frequencies tolerance range. The results are given in the Similar frequencies  

chapter in the report. The frequencies considered in this option are the characteristic frequencies of 

gears, bearings, rotational frequencies of shafts, and user-defined frequencies from the Include 

frequencies from other components  option. The frequencies at higher harmonics defined in 

Number of harmonics  taken into account. 

Consider reference speed tolerance range: This option considers the reference speed tolerance 

range, either as a percentage of the reference speed or as an absolute value. This enables the 

tolerance range plot in the Frequencies domain  diagram and outputs the range in the result window 

and in the report. The tolerance range is also used to mark the critical frequencies shown in the 

report. 

Include results from modal analysis: Takes into account the results of the Modal analysis special 

calculation (see chapter 13.3.2, Modal analysis). The frequencies from the modal analysis are shown 

as horizontal lines in the Frequencies domain  diagram. The values are also shown in the report. In 

the report, the values of the reference speed at which the specific characteristic frequencies intersect 

the eigenfrequencies are shown. If this value is close to the reference speed, it is marked red, as this 

might be a critical point. 

Include gear critical speed according to ISO 6336 -1/ISO 10300-1: If this option is activated, this 

value is included as horizontal line in the Frequencies domain  diagram. The value is also shown in 

the report and the resonance analysis is conducted, showing the reference speed value at which the 

specific characteristic frequencies intersect the critical speed frequency. If this value is close to the 

reference speed, it is marked red. 

Include frequencies from other components: By choosing this option, you have the possibility to 

input additional frequencies. This input can be as a reference value to specific shaft or boundary 

conditions. In this case, the order or multiplier is input and the frequency is automatically calculated 

at the reference speed. The frequencies input as Reference value frequencies  are dependent on 

the shaft speed or the boundary condition. The values are shown in the diagrams and in the results. 

The Output similar  frequencies  option also takes these values into account. For example, the input 

of the pole or slot number of an electric motor can be entered as a reference to an inputïmotor shaft. 

The values can also be input as absolute value frequencies which are constant with the reference 

speed. The absolute values are shown as a horizontal line in the Frequency domain  diagram and 

are not considered in Output similar frequencies . 
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14 Introduction  

KISSsoft provides calculation modules for different toothing types, ranging from cylindrical gears in 

different configurations to bevel gears and face gears to worm wheels. The input windows for the 

different gear calculations are very similar. There are also calculation options for multiple modules. 

The table below shows you all the input windows in the individual calculation modules. 

Input window  Section  
           

Basic data 15.1 

is supported by all calculation modules 

Load 8.5 

Factors 15.3 

Reference profile 15.4 

Tolerances 15.6 

Modifications 15.7 

 

Tooth form 15.9 

 

Contact 

analysis 

15.12 

 

      

    

 

Operating 

backlash 

15.14 

 

     

  

  

 

 

Master gear 15.15 

      

   

 

 

 

AGMA 925 15.16 

 

     

     

Table 14.1: 

- Single gear, - Cylindrical gear pair, - Pinion with rack, - Planetary gear stage, - Three 

gears, - Four gears, - Bevel and hypoid gears, - Face gears, - Worms with double 

enveloping worm wheels, - Crossed helical gears, - Splines (Geometry and Strength) 

14.1 Underlying principles of calculation 

The geometry of straight or angled cylindrical gears is calculated according to ISO 21771 or DIN 

3960. Many manuals and standards use very similar methods to calculate this geometry. In addition 

to calculating the geometry, it is very useful to have information about how to check for defects 

(undercut, insufficient active profile, etc.). Technical documentation provided by tooling 

manufacturers or machine tool manufacturers may also include information about this. 

Measurements for tooth thickness allowances and backlash can be selected according to different 

standards, such as ISO 1328 (1970 edition) or DIN 3967. Manufacturing tolerances can also be 
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defined using standards such as ISO 1328 (DIN ISO 1328), AGMA 2000, AGMA 2015, DIN 

3961:1978 or DIN 58405 to suit the particular situation. 

Strength is calculated in accordance with, for example, ISO 6336 or DIN 3990, by verifying common 

defects (tooth root fracture, pitting, scuffing, micropitting). These standards include the most 

comprehensive and detailed calculation methods currently available. There are two methods that can 

be used to calculate safety against scuffing. The integral temperature method of calculating scuffing 

safety is mainly used in the automobile industry, whereas the flash temperature method is used when 

turbo gear units are being manufactured. It has not yet been established which of these two methods 

is the more reliable. 

Micropitting is calculated according to ISO/TS 6336-22 (formerly ISO/TR 15144-1), Method B. This 

method is very reliable for gears without profile modifications. However, in the case of gears with 

profile modifications, it has been specified that the tip relief Ca must correspond to the optimum tip 

relief Ceff (as proposed in the standard). If not, the verification must be performed without taking the 

modification into account. This is a significant disadvantage, because modifications have a 

considerable effect on micropitting. In this case, you should use Method A (see chapter 23.5.4.4, 

Safety against micropitting). 

In the USA, the AGMA 2001 standard must be applied when calculating resistance. This calculation 

method differs so much from that required by DIN 3990 that the results cannot be compared. In 

addition, there are numerous different methods that are used to calculate the resistance of plastic 

gears. 

One of the problems with applying DIN 3990 is the wide range of different calculation methods it 

contains. There are around 10 different calculation variants that can be applied between Method A 

(exact calculation involving measurements) and Method D (the simplest, rough calculation). It is 

therefore no surprise that very different results can be obtained from applying calculations according 

to DIN 3990 or ISO 6336 to the exact same gear wheel. Whenever possible, KISSsoft uses the most 

detailed formulae for dimensioning and analyses during this calculation procedure. This procedure 

corresponds to Method B. However, calculations performed using different programs may also give 

very different results. It also takes a lot of time and effort to investigate the precise reasons for this. It 

is therefore much more effective and efficient to use a reference program to perform the comparison. 

One such program is the ST+ cylindrical gear program package developed by the FVA 

(Forschungsverein Antriebstechnik, (Research Society for Transmission Techniques, Germany)), at 

the Technical University in Munich. For this reason, KISSsoft includes the As  in FVA program (DIN 

3990) option, which supplies the same results as calculation with the FVA code (see chapter 15.2.1, 

Calculation methods). The differences between results obtained by KISSsoft and the FVA program 

are negligible. They are due to the minor differences between the FVA program and the regular 

version of DIN 3990. If requested, we can provide you with a number of different documents to help 

you compare these methods. 

Other interesting results are taken from Niemann's book [7]: 

Gear power loss with gear loss grade HV according to equation (21.11/4) 

Mean coefficient of friction ɛm according to equation (21.11/6) with 1 Ò vt Ò 50 m/s 

Gear power loss PVZ according to equation (21.11/3) 
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15 Cylindrical gears  

You can use KISSsoft's cylindrical gear calculation software to calculate a range of different 

configurations. 

The single gear calculation has been developed to calculate the geometry and test 

dimensions of individual gears 

The cylindrical gear pair is the most important configuration for geometry and strength. You 

can also use it for additional calculations and several individual calculations at the same 

time. 

The planetary gear software checks the practical aspects of the configuration and monitors 

both pairs of gears while they are being sized. The Fine Sizing function enables you to 

optimize the center distance quickly and efficiently. You can usually input your own 

values here. However, you must take into consideration that, as torque cannot be 

applied to the planet, it is not possible to perform a strength analysis on a Wolfrom drive 

or on a Ravigneaux gear set. 

The configurations for three and four gears enable you to calculate a gear wheel chain, in 

which torque is applied only to the first and last gear. 

Double planetary stages: You can also use the 4-gear chain to calculate a double planetary 

stage. However, if gear 4 is an internal gear (negative number of teeth) a check is 

performed to see whether it could be a double planetary stage (planetary repositioning 

stage with the sun in the center). A note about this is added to the report in the 

"Supplementary data" section. If gear 4 is a double planetary stage, the center point is 

calculated under the assumption that M1 and M4 coincide. 

The calculation used for a rack and pinion includes one rack in the geometry calculation and 

one cylindrical gear with an infinite number of teeth for the strength calculation. 

As the input screens for the different configurations are very similar, they are described together in 

the sections below. 
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Figure 15.1: Cylindrical gear configurations 

15.1 Basic data 

The Basic data  input window is one of the standard tabs (see chapter 5.1, Standard and special 

tabs) and is subdivided into the two groups: "Geometry"  and "Material and Lubrication" . 

15.1.1 Hand of gear for gear teeth 

The direction of the helix angle of the gear (see Figure 17.3) defines the direction of the axial forces. 

Helical gear teeth usually produce less noise than spur gear teeth, but generate an additional 

bending moment and an axial force. A gear with continuous double helical teeth consists of two 

halves of a helical gear with a different hand of gear. Although it does not generate any axial forces, 

it must be possible to adjust the gear along its axis and it is more difficult to manufacture. In a 

herringbone gear, click the Plus button to set the gap width bn. 
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15.1.2 Normal module 

Enter the normal module. The normal module defines the size of the teeth. A standard series is for 

example defined in DIN 780 or ISO 54. However, if you know the pitch, transverse module or 

diametral pitch instead of this, click on the Convert button to open a dialog window, in which you can 

perform the conversion. If you want to transfer the diametral pitch instead of the normal module, you 

can select Input normal diametral pitch instead of normal module (see chapter 15.23.1.1, Input of 

normal diametral pitch instead of normal module) by clicking on Calculation > Settings > General . 

15.1.3 Pressure angle at normal section 

The normal pressure angle at the reference circle is also the reference profile flank angle. For 

standard gears, the pressure angle is Ŭn = 20°. Smaller pressure angles can be used for larger 

numbers of teeth to achieve higher contact ratios and insensitivity to changes in center distance. 

Larger pressure angles increase the strength and enable a smaller number of teeth to be used 

without undercut. In this situation, the contact ratio decreases and the radial forces increase. 

15.1.4 Helix angle at reference circle 

Enter the helix angle in [°]. Click the Convert button in the Convert helix angle window  to calculate 

this angle from other values such as, for example, the overlap ratio and axial force. 

 

Figure 15.2: Helix angle at reference circle. 
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15.1.5 Center distance 

As stated in ISO 21771, the center distance for external and internal toothings is positive for two 

external gears and negative for an external gear paired with an internal gear. The number of teeth on 

the internal gear and the axis center distance are always negative for internal toothing. 

If you select the checkbox to the right of the axis center distance unit, the value used in the 

calculation will remain constant. Otherwise, the center distance will be calculated from the profile shift 

total. 

Click the Sizing button to select one of the following sizing options: 

Fixed sum of profile shift coefficients. The center distance is calculated on the basis of a 

predefined profile shift sum. Click the Sizing button to display a suggested value for the 

profile shift sum, as defined in DIN 3992. The sum of profile shift influences the profile 

shift coefficients of both gears as well as the operating pitch circle and the operating 

pressure angle. 

Fixed profile shift coefficient Gear 1 (or 2), balance specific sliding. Optimize axis center 

distance with respect to balanced sliding: This option calculates the axis center distance 

in such a way as to balance gear pair specific sliding (for cylindrical gears) for a 

specified profile shift of a (selectable) gear. If the Own input  menu option is not 

selected from the Own Input drop-down list in the Reference Profile  input window, this 

calculation is performed with automatic tip alteration as specified in DIN 3960. You can 

also enter your own tip alteration value in the Basic data  input window by clicking the 

Details... button. In the Define geometry details window , select the checkbox next to 

the Tip alteration  input field. 

15.1.6 Number of teeth 

The number of teeth is, by default, a whole number. You can also enter the number of teeth as an 

amount with values after the decimal place (see chapter 15.23.1.2, Input of number of teeth with 

decimal places). For internal toothed gears, you must enter the number of teeth as a negative value 

as stated in ISO 21771. For a pinion-ring internal gear pair, the center distance must also be entered 

as a negative value (e.g. z1 = 20, z2 = -35, a = -7.5, mn = 1). 

The minimum number of teeth is limited by geometric errors such as undercut or tooth thickness at 

the tip. For example, if there are fewer than 17 teeth undercut will occur on spur gears without profile 

shifts. 
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15.1.7 Facewidth 

Normally the facewidth shouldn't be greater than 10 to 20 times the normal module, or also not 

greater than the reference circle of the pinion. The contact pattern deteriorates if the facewidth is too 

large. Axial offset bv. Click on the Plus button to the right of the facewidth input field (see also 

Figure). The axial offset reduces the effective width for the strength calculation. The common width is 

used to calculate the pressure. A certain amount of overhang is taken into account for the Tooth root 

strength. The selected pinion width is often somewhat greater than the gear width. 

 

Figure 15.3: Axial offset bv 

In double helical gears* you must specify the total width of the gear teeth (i.e. the width of both 

halves together with the gap). Click on the Plus button to the right of the toothing hand of gear drop-

down list and enter the gap width bn. 
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*Double helical gears are gears that consist of two gear halves; the first half is angled to the left and 
the second half is angled to the right. 

15.1.8 Profile shift coefficient 

Preliminary note: If the profile shift sum has not yet been specified, click the Sizing button, to the right 

of the center distance input field (see chapter 15.1.5, Center distance), to display a suggested value 

for the distance in the Size center distance  window. The suggested value is based on DIN 3992 

recommendations for well balanced toothing (Area P4/P5). You will find more information about this 

in DIN 3992 or in Niemann [8], Fig. 22.1/6. 

The tool can be adjusted for manufacture. The distance between the production pitch circle and the 

tool reference line is called the profile shift. To create a positive profile shift, the tool is pulled further 

out of the material, creating a tooth that is thicker at the root and narrower at the tip. To create a 

negative profile shift, the tool is pushed further into the material, with the result that the tooth is 

narrower and undercutting may occur sooner. In addition to the effect on tooth thickness, the sliding 

velocities will also be affected by the profile shift coefficient. 

The distribution of the total profile shift affects the tooth thickness, sliding movements and strength 

values. It can be performed according to a range of different criteria. To achieve this, use the various 

sizing options provided by clicking the Sizing button in the Size profile shift coefficient  window: 

For optimal specific sliding 

The value suggested here shows the profile shift, for a cylindrical gear pair, whose 

specific sliding between the pinion and the gear has been balanced. When more than 

two gears are involved, the profile shift coefficient is set to the smallest value that 

corresponds to the specific sliding movement at the root. 

For minimum sliding velocity 

The minimum sliding velocity at the tip of the two gears is often used for speed-

increasing ratios. In a cylindrical gear pair, this means both gears have the same sliding 

velocity and that the access and recess length of the path of contact are also the same. 

For maximum root safety 

The profile shift coefficient is determined iteratively for the range x*min to x*max. 

For maximum flank safety 

The profile shift coefficient is determined iteratively for the range x*min to x*max. 

For maximum scuffing safety 

The profile shift coefficient is determined iteratively for the range x*min to x*max. 

For gear 1 without undercut and point at tip (min) 

The minimum value of the profile shift coefficient for gear 1 is calculated from the 

undercut boundary for gear 1 and the minimum top land for gear 2. 
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For gear 1 without undercut and point at tip (max). 

The maximum value of the profile shift coefficient for gear 1 is calculated from the 

minimum topland of gear 1 and the undercut boundaries of gear 2. 

For undercut boundary per gear. 

The proposed value only refers to the selected gear. No check is performed to see 

whether the resulting profile shift is also permitted for the other gear in the pair. For 

more information, please refer to the explanations above. 

For minimum topland per gear. 

The proposed value only refers to the selected gear. No check is performed to see 

whether the resulting profile shift is also permitted for the other gear in the pair. You can 

specify the minimum thickness of the topland under Calculation > Settings > General 

> Coefficient for minimum tooth thickness at the tip . For more information, please 

refer to the explanations above. 

Ʒ Note:  

The Sizing button is disabled if the "Maintain tip circle when changing profile shift" or "Maintain root 

circle when changing profile shift" checkbox has been selected. 

Click the Convert button and KISSsoft will determine whether the profile shift coefficients are to be 

taken from measured data or from values entered in drawings. 

The following options are available: 

Base tangent length  

Enter the base tangent length and the number of teeth spanned here. This option 

cannot be used for (internal) helical gear teeth because their base tangent length 

cannot be measured. 

Measurement over balls  

To do this, enter this dimension and the diameter of the ball. In a gear with helical gear 

teeth and an odd number of teeth, the measurement over balls is not the same as the 

measurement over two pins. See Measurement over pins. 

Measurement over 2 pins  

To do this, enter this dimension and the diameter of the pin. You must also enter a 

minimum span for helical gear teeth and gears with an odd number of teeth, so the 

measurement can be performed. The measurement over pins cannot be measured in 

internal helical gears. 

Measurement over 3 pins  

Here, enter the measurement over pins and the pin diameter. For helical gear teeth and 

gears with an odd number of teeth, this is equivalent to the measurement over two 

rollers. You cannot use this option for internal and helical gear teeth, or gears with an 

even number of teeth. 
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Tip circle  

This is a rather imprecise calculation because the tip diameter does not always depend 

solely on the profile shift. 

Tooth thickness at reference circle  

Here, enter the tooth thickness. You can also enter the arc length or chordal length, and 

specify whether the value is in transverse or normal section. 

Ʒ Note  

If one of the two profile shift values is displayed in gray, this means it will be calculated by KISSsoft. 

This is what happens when you select the checkbox for entering the center distance. If you overwrite 

a gray field, it will become active and KISSsoft will calculate the value for the other gear. 

15.1.9 Tooth thickness modification coefficient 

A tooth thickness modification coefficient xs is not usually used for cylindrical gears. This is why you 

cannot enter this factor in the user interface. However, in exceptional situations, you can use a tooth 

thickness modification coefficient, e.g. via the DLL interface, in KISSsys or by editing the saved .Z12 

file. The RechSt.xs_Active = 1 and RechSt.xs_OwnInput = 1 variables must be set before you can 

set xs. Then xs can be applied in the ZkegR[0].XS variables for gear 1 etc. More information about 

the tooth thickness modification coefficient is provided (see chapter 18.2.8, Tooth thickness 

modification coefficient). 

15.1.10 Quality 

In this input field, you specify the accuracy grade in accordance with the standard shown in brackets. 

To change the standard used for this calculation, click on the Settings button and then select the 

Input quality  option. The accuracy grade according to ISO 1328 (DIN ISO 1328) is very similar to 

the same quality in BS 436/2. 

The manufacturing qualities that can be achieved are displayed in this table: 

Manufacturing process  Quality according to ISO  

Grinding 2 . . . 7 

Shaving 5 . . . 7 

Hobbing (5)6 . . . 9 

Milling (5)6 . . . 9 

Shaping (5)6 . . . 9 

Punching, Sintering 8 . . . 12 

Table 15.1: Accuracy grades for different manufacturing processes 
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When converting qualities according to AGMA: 

as defined in AGMA 2015-1-A01, Annex B.2, the total of the quality figures in Version 2015 

(comparable with ISO) and Version 2000 equals 17. 

Quality as specified in ISO 1328  
and AGMA 2015  

Q. according to AGMA 2000  

1 16 

2 15 

3 14 

4 13 

5 12 

6 11 

7 10 

8 9 

9 8 

10 7 

11 6 

Table 15.2: Manufacturing quality values in different standards 

You can input the tolerances in standard-specific tabs. The changes in the window are then applied 

individually to each gear. It is also possible to input the tolerance value directly. 

This is the table in which you input any deviation from the base manufacturing quality (specified in 

the Basic data  tab). Example: The base manufacturing quality of gear 1 is 6. If you then input +2 for 

the runout, the runout will be calculated with an manufacturing quality of 8. 

In every case, only tabs (standards) that are possible for the calculation module are displayed. The 

user entries remain in this window as long as you continue using the same calculation module. This 

enables you to import a different file, and select the checkbox. The same entries will still be displayed 

in the window next to the Plus button. You only need to input the data again if you change calculation 

module. 

Note about axis alignment tolerance according to ISO 10064:  

The quality level used to input the axis alignment tolerances specified in ISO 10064 is usually the 

same as the best accuracy grade for all gears. If, for example, gear 1 has Q6 and gear 2 has Q5, 

quality level 5 is used for ISO 10064. You can also input these values in the Operating backlash  

tab. 
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15.1.11 Geometry details 

Click the Details  button on the top right, in the Geometry area, to display other input options. Here 

you can change the values for: 

Drawing number 

Drawing number (system data) 

Drawing number (gear data) 

Drawing number version 

Toothing runout 

 

Figure 15.4: Dimensioning the diameter 
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15.1.12 Material and lubrication 

15.1.12.1 Materials 

The materials displayed in the drop-down lists are taken from the materials database. If you cannot 

find the material you require in this list, you can either select Own  input  from the list or enter the 

material in the database (see chapter 9.4, External tables) first. Click the Plus button to the right of 

the materials drop-down list to display the Define material, Gear 1(2)  window, in which you can 

select the material you require from the database list of available materials. Select the Own input  

option to enter specific material characteristics. This option corresponds to the Create a new entry  

window in the database tool. 

Strength calculation with normal gear materials: 

The cylindrical gear strength calculation formulae defined in ISO 6336, DIN 3990 or AGMA 2001 only 

involve specific (most commonly used) materials and treatment methods. These are: 

Through hardening steel 

Case hardening steel 

Nitriding steel 

Structural steel 

Grey cast iron with spheroidal graphite 

Cast iron with flake graphite 

Strength calculation with unusual gear materials (not taken into account in standards): 

Stainless steel 

Free cutting steel 

Aluminum and bronze alloys 

KISSsoft handles these materials in the same way as through hardening steels. This affects a range 

of less important values that are used to calculate the permitted tooth root and flank strength: factors 

YNT, YdrelT, YRrelT, YX, ZNT. The infinite life strength values ůFlim and ůHlim must either be measured 

or already be known. The S-N curve (Woehler lines) must be defined and used to achieve more 

accurate calculations. 

Sinter 

According to information from the company MIBA (A), sinter has similar properties to 

GC. For this reason, all the factors specified in DIN or ISO, which depend on the 

material type, are determined for sinter according to all the formulae that are applicable 

for GC. 

Plastics  
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The strength of plastic gears can be calculated either according to Niemann VDI 2545 or VDI 2736. 

The material properties (Young's modulus etc.) and the permitted tooth root and flank stresses are 

greatly affected by the temperature and the type of lubrication. This is why calculating the 

characteristics for plastic gears requires so much time, effort and experience, especially if only very 

little material data is available. VDI guideline 2736 lists the tooth root and flank strengths for a 

number of basic materials: 

Tooth root strength: POM, PA 12, PA66, PET, PE, laminates 

Flank strength: PA 12, PA6, PA66, PBT, laminates 

Tensile fatigue strength for worms: POM, PA46, PA66, PEEK 

Materials manufacturers also provide gear data that can be used to calculate the strength of plastic 

gears. If requested, KISSsoft can also provide the relevant material files. 

 

KISSsoft users can also add their own material data to the plastics database. The appropriate DAT 

file contains specific data for each material. The user can then edit the DAT files to calculate plastic 

gears using the values for their own materials. They can then use the plastics manager (see chapter 

61) to create new .dat files. 

 

As defining the permitted root and flank limiting values takes so much time and effort, and because 

these values are often not present, KISSsoft can also perform the calculation using very basic 

material properties (e.g. a static calculation can be performed if tensile strength data is present). 

As additional information, the name of the plastic includes an overview of the data that is available for 

calculating plastic gears. 

 

The data used to calculate plastic gears is available in this format: [S B Fog W d] . 

 

Abbreviations used here: 

S - The material's maximum or yield material strength is provided for calculating static root strength 

B - S-N curves (Woehler lines) are provided for calculating the root infinite life strength 

F - S-N curves (Woehler lines) for all lubrication types are provided for calculating the tooth flank 

infinite life strength 

Fo - S-N curves (Woehler lines) for oil lubrication are provided for calculating the tooth flank infinite 

life strength 

Fg - S-N curves (Woehler lines) for grease lubrication are provided for calculating the tooth flank 

infinite life strength 

Fd - S-N curves (Woehler lines) for a dry run are provided for calculating the tooth flank infinite life 

strength 
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Fog - S-N curves (Woehler lines) for oil and grease lubrication are provided for calculating the tooth 

flank  

W - Wear coefficients for all lubrication types are provided for calculating wear 

Wo - Wear coefficients for oil lubrication are provided for calculating wear 

Wg - Wear coefficients for grease lubrication are provided for calculating wear 

Wd - Wear coefficients for a dry run are provided for calculating wear 

C - S-N curves (Woehler lines) are available for calculating the infinite life strength of the tooth root in 

crossed helical gears. 

Ʒ Note:  

When a calculation method according to Niemann or VDI is selected, the tooth root, tooth flank and 

wear are calculated automatically, if the data for the calculation is present. If no data is present for 

one or more of these methods, only the calculations for which data is available are actually 

performed. 

Converting hardness to infinite life strength values ůHlim, ůFlim 

When you enter data for your own material, the hardness is converted into the infinite life strength 

values ůHlim, ůFlim. To open the conversion dialog, click the appropriate conversion button next to 

the input fields for the infinite life strength values ůHlim, ůFlim. The data is converted in accordance 

with the ISO 6336-5:2003 formula described in section 5. 

(The data for forged steels is used for "unalloyed/through hardened" and "alloyed/through hardened" 

heat treatable steels.) 

ůHlim, ůFlim=A*x+B 

x: Hardness value in the unit used in the table (depending on the HV or HBW material type) 

A,B: Factors for the particular material type and processing. (from Table 1, ISO 6336-5) 

Values for ůHlim and ůFlim that are required for the conversion specified in ISO 6336-5 are 

displayed directly in the material screen under "Own input" if these values are possible for the 

specified hardness and material type. 

In the next conversion dialog, click on another conversion button next to the hardness input field to 

start converting the hardness value. In the case of materials that are not alloys you can calculate the 

hardness from the tensile strength value or other hardness values. 

Shot peened gear  
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Selecting Shot peened  only affects the alternating bending factor YM if this is calculated according 

to ISO 6336-3, Annex B. This information is primarily required for documentation purposes, so that 

this data can be added to drawings. It is well known that shot peening improves the root safety factor. 

Until now, the standards for gear strength have not included any suitable data. However, if 

measurements have shown the extent to which ůFlim is increased by shot peening, this effect can be 

taken into account either with the technology coefficient YT or by increasing ůFlim. 

15.1.12.2 Calculation of the wear coefficient kw for steel 

According to Niemann [7], Table 21.6/5, and Plewe's dissertation [9], which calculates an 

approximate guide value for coefficient of wear, kw depends on the size of the lubricant gap in the 

operating pitch circle hc. The function defined by Plewe, kw = f(hmin), is valid for standard mineral oil 

without high pressure additives. 

You should take care when using this guide value, because the existing information is far from 

complete. In particular, very little is known about the influence of surface roughness and the influence 

of lubricant additives. You should take careful measurements to check the wear factor to ensure 

reliable results from the calculations. 

Lubricant influence factor: As stated in [7], adding suitable additives to a lubricant can significantly 

reduce the amount of wear. The lubricant's influence factor can therefore lie in a range between 0.01 

and 1. 

Material influence factor Plewe took measurements from various different material pairings: Gear 

made of through hardening steel paired with a hard or soft counter gear, gear pairs made of case-

hardening steel, and gear pairs made of nitriding steel. The value of kw as defined by Plewe was 

then determined for these combinations. The influence factor can be used for other combinations, if 

known. For more information, see [7]. 

15.1.12.3 Lubrication 

Select the lubricant from a list. If you select Own input , click the Plus button to specify your own 

lubricant. 

If you see the note (with kw info) after the lubricant description, this means a lubrication influence 

factor kwlub is present for this lubricant. This factor can then be used to determine the wear coefficient 

kw more accurately. 

You can select oil bath or oil injection lubrication, or grease lubrication, or none at all (dry run). You 

can select dry run only when using a calculation method for plastics. 

Click on the Plus button to the right of the lubrication drop-down list to display the Define 

temperatures  window. 
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This is where you can define either the lubricant temperature or the root and flank temperatures for 

plastics and dry run. These temperatures are calculated for plastics. You can also deactivate the 

calculation and enter your own temperature values. 

You can select either a closed, semi-open or open gear unit. This has an effect on the temperature 

calculation according to VDI 2545 and VDI 2736. 

The power-on time is also taken into account for plastic gears when calculating the flank and root 

temperature. For worm gear units, this time is also included when calculating the thermal safety. 

 

Note about calculating temperature:  

It is assumed that heat is constantly dissipated and that heat is only generated during the specified 

power-on time. The precondition for this is that the gear unit is only run for a short period of time 

(maximum 15 minutes), and is then stopped again. If this is not the case, the power-on time must be 

set to 100%. 

15.1.12.3.1 Calculating the required amount of lubricating oil 

When the injection lubrication method is used, the required amount of lubricating oil is calculated as 

specified by Schlecht [10]. This assumes a difference of 10°C between the temperature of the oil at 

the inlet and outlet. The specific heat capacity cp (Ws/(kg*K) and the specific weight at operating 

temperature are defined as specified by Niemann [8]. 

15.2 Load 

The Rating  (load) input window is one of the standard tabs (see chapter 5.1, Standard and special 

tabs) and is subdivided into the two groups Strength  and Load spectrum . 

15.2.1 Calculation methods 

In the drop-down list, you can select the following strength calculation methods: 

1. Geometry calculation only:  If the Rating  module is not selected in the Calculation  

menu, only the geometry is calculated. 

2. Static calculation : Unlike DIN 743 which, for example, has a specific method for static 

shaft calculations, ISO 6336 does not have its own calculation method for static 

calculation. In a static calculation, the nominal stress is usually compared with the 

permitted material parameters (yield point and/or tensile strength). This performs a 

static calculation of cylindrical gears in KISSsoft. In this calculation, the nominal stress 

in the tooth root (calculated using the tooth form factor YF) is compared with the yield 

point and tensile strength. See (see chapter 15.2.1.1, Static calculation). 
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3. ISO 6336:2019 Method B  (Calculation of load capacity of spur and helical gears: Method 

B is used for this calculation. 

4. ISO 6336: 2006: Earlier version of ISO 6336, no longer valid. 

5a. DIN 3990 Method B : YF Method B (Calculation of load capacity of cylindrical gears). This 

calculation is also performed using Method B. However, either Method B or Method C 

can be used to calculate the tooth form factor (we recommend Method C for internal 

toothings. Otherwise, use Method B). 

5b. DIN 3990 Method B : YF Method C 

6. DIN 3990, Part 41 (Vehicle Transmission), Method B  (Load capacity calculation for 

vehicle transmissions): This calculation is usually performed according to Method B. 

Two application factors must be defined to represent a load spectrum (see chapter 

15.3.1, Application factor). 

7. AGMA 2001-C95: The standard has been implemented in its entirety. The dynamic factor 

and the face load factor are calculated in accordance with AGMA recommendations. 

The geometry factors (for tooth root and flank) are calculated entirely in accordance 

with ANSI/AGMA 908-B89. In addition to all the relevant intermediate results, the 

following values are also supplied: Pitting Resistance Power Rating, Contact Load 

Factor, Bending Strength Power Rating, Unit Load for Bending Strength, Service 

Factor. 

This calculation can also be used for every other cylindrical gear configuration 

(including planetary stages). However, it must be noted that the AGMA standard does 

not permit tooth root strength for internal gear pairs to be calculated directly. In this 

case the calculation must be performed using the graphical method (see chapter 

15.2.7, Strength details (AGMA)). 

8. AGMA 2001-D04: Most recent version of AGMA 2001. Differs only slightly from the 

previous version C95. 

9. AGMA 2101-D04 (Metric Edition): Equivalent to AGMA 2001-D04, but all values in SI 

units. 

10. Special AGMA standards (6004 -F88, AGMA 6014-A06): Special standards used in the 

USA to calculate the strength of open gear rims. These calculation methods are based 

on the AGMA 2001 or 2101 basic standards. However, some factors have been 

specifically defined for special applications. AGMA 6014 replaces the old AGMA 6004; 

but both methods are still available because AGMA 6004 is still requested. 

11. AGMA 6011-I03 for turbo drives (High Speed Helical Gear Units): The AGMA 6011 

standard is a special edition for high-speed gear units and is less complex than the 

AGMA 2001 (or metric AGMA 2101) basic standard. In this case, "less complex" means 

that some data is already predefined. For example, AGMA 2001 has the options "Open 

gearing", "Commercial gear unit" and "Precision gear unit" for defining the face load 

factor, whereas AGMA 6011 has "Precision gear unit" as a predefined requirement. 

AGMA 6011 also provides information to help you select the application factor Ka for 
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specific turbo-driven applications and other useful notes about this type of gear unit 

(lubrication arrangement etc.). It is therefore always possible to perform the calculation 

according to AGMA 6011 using AGMA 2001 or 2101 without causing any problems. To 

input data correctly for AGMA 2001, as implemented in KISSsoft, that is also correct for 

AGMA 6011, you must be aware of the constraints, and take them into consideration 

when entering the parameters. Select the AGMA 6011 method to save the user having 

to do this. In this situation, the program checks whether all the constraints are set. If 

not, the system displays a message prompting the user to confirm that modifications 

are to be made. 

12. API 613:2021 Special -purpose Gears for Petroleum, Chemical, and Gas Industry 

Services: According to API 613, the calculation must be performed according to AGMA 

2001. Special limitations in terms of material type, hardness, quality, required life, and 

face load factor are considered in this strength calculation method. More details about 

how to perform a calculation correctly are provided in the Instructions that describe the 

necessary inputs and checks: kisssoft-anl-078-E-CylindricalGears API613.docx. 

13. AGMA 6015-A13 for rolling mill gears: The AGMA 6015 standard is a special edition for 

rolling mill gears and is less complex than AGMA 2001 basic standard. In this case, 

"less complex" means that some data is already predefined. For example, AGMA 2001 

has the options "Open gearing", "Commercial gear unit" and "Precision gear unit" for 

defining the face load factor, whereas AGMA 6015 has "Precision gear unit" as a 

predefined requirement. Other fundamental restrictions are listed in Chapter 1 of the 

standard. Select the AGMA 6015 method to save the user having to do this. In this 

situation, the program checks whether all the constraints are set. If not, the user sees a 

prompt asking them if they want to make any modifications. 

The permitted material properties for bending (sat) and pitting (sac) specified in AGMA 

6015 for the same material are different from the properties given in AGMA 2001. The 

values must be defined by the user in accordance with Table 3 (sac) and Table 4 (sat) 

in AGMA 6015 and then input in the program (set material to Own input )! 

AGMA 6015 provides conditions for "Service factors" in Annex C. The conditions are for 

information purposes only (not binding) and must be discussed and agreed with the 

customer. Input the coefficients by selecting Calculation settings > Safety factors , 

then choose General > Service factors according to AGMA . 

14. GOST-21354-87: Calculation according to the Russian guideline (latest edition, 1987). 

Take the following notes into account, (see chapter 15.2.1.2, GOST 21354-87). 

15. Plastic according to Niemann: Please refer to [7] and Table 13.3 to see the differences. 

16. Plastic according to VDI 2545 (Y F Methode B)  (thermoplastic materials used in gears): 

This method has been withdrawn and replaced by the new method according to VDI 

2736. This regulation defines how calculations are performed on gears made of plastic 

or combinations of plastic and steel. See (see chapter 15.2.1.3, Plastics according to 

Niemann, VDI 2545 or VDI 2736). 
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17. Plastic according to VDI 2545 (Y F Methode C) : In this calculation method, the tooth form 

factor YF is calculated according to Method C. 

18. Plastic according to VDI 2545 -modified (Y F Method B): This method was recommended 

for use by KISSsoft before VDI 2736 was published. VDI 2736 contains all the 

modifications recommended according to Tables 13.3 and 13.4. This method is 

recommended for plastics with normal toothing. Transverse contact ratio ŮŬ < 1.9. See 

Table 14.4 for the differences between VDI und VDI-modified. 

19. Plastic according to VDI 2545 -modified (Y F Method C): This method is recommended 

for plastics with deep tooth forms. Transverse contact ratio ŮŬ > 1.9. See Table 14.4 for 

the differences between VDI und VDI-modified. See Table 14.4 for the differences 

between VDI und VDI-modified. In this calculation method, the tooth form factor YF is 

calculated according to Method C. 

20. Plastic according to VDI 2736: We recommend you use the calculation method VDI 

2736 which was published for the first time in 2014/15. It includes all methods described 

in Sheet 2 of VDI 2736 (empirical calculation, tooth root, tooth flank, deformation, wear). 

21. As in FVA program (DIN 3990) : Supplies the same results as the German Research 

Association for Power Transmission Engineering (FVA) Reference Program. Based on 

DIN 3990 Method B with minor differences. KISSsoft regularly performs comparisons 

between calculation examples using the FVA's STplus cylindrical gear calculation 

method. The first comparison was performed in 2002, with STplus edition 1988. The 

next was in 2003 (with STplus 3.2). As new investigations mean that STplus differs 

slightly in some places from DIN 3990, it was decided to implement this calculation 

approach as "similar to FVA" in KISSsoft. The most recent comparison was performed 

with STplus 6.0 in 2016. As the DIN 3990 standard has remained unchanged since 

1985, the results obtained from different programs have also remained much the same. 

22. BV/Rina FREMM 3.1 Naval Ships and Rina 2010 (ISO 6336): calculation guidelines for 

ships' engines. 

23. DNV41.2, calculation guideline for ships' engines: In principle, the Det Norske Veritas 

calculation guideline [11] for ships' engines corresponds to ISO 6336 (root, flank) and 

ISO/TS 6336-20/21:2022 (scuffing). However, it does have some significant differences, 

especially where S-N curves (Woehler lines) are concerned. These differences are 

detailed in our kisssoft-anl-076-DE-Application_of_DNV42_1.pdf information sheet, 

which is available on request. 

24. Lloyd's Register, classification for ships: Calculation guidelines for ships' engines. 

25. ISO 13691 High -speed special -purpose gear units: Calculation guidelines for high-

speed gear units 
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15.2.1.1 Static calculation 

Each coefficient (application factor, face load factor, transverse coefficient, dynamic factor) is set to 

1.0. The load at the tooth root is calculated with the tooth form factor according to ISO 6336 Method 

B and the helix angle (without the stress correction factor). 

 

(15.1) 

 

(15.2) 

It also calculates the local tooth root stress multiplied by the stress correction factor YS . This stress 

is approximately the same as the normal stress calculated in an FEM model. This stress is output in 

the report: 

 

(15.3) 

The stress correction factor YS is used to take into account a local stress concentration in the root 

radius. 

In the static load case, the material can expand locally in this area, which does not yet lead to failure, 

but results in a stress redistribution, thereby reducing the highest stress. 

In this situation of stress redistribution, the factor YS is no longer required because the stress 

concentration, which is taken into account by YS, has been eliminated. 

Therefore, in general, static safety factors can be calculated without the factor YS. For this reason, 

the safety factors shown in the results window are the results calculated without the factor YS. 

If you have a very critical application, e.g. an aerospace gearbox, the factor YS can still be included in 

order to obtain a more conservative result. For this case, the listed results do include YS in the main 

report. 

15.2.1.2 GOST 21354-87 

Quality according to GOST 21354 -87 

GOST only takes into account one quality, which is why the poorer quality of the two gears is used 

during the calculation. 

Q = max (Q1, Q2) 
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Infinite life strength values for root and flank  

The infinite life strength values ůFlim and ůHlim are saved in the KISSsoft database, or you can enter 

them by selecting the Own Input option. 

Infinite life strength for root ůFlim  

The infinite life strength ůFlim is calculated as follows, according to GOST: 

ůFlim = ůFlim0 * Yz * Yg * Yd * YA * YT 

ůFlim0 ï nominal infinite life strength at limit load cycle (GOST 21354-87 Tables 14-17). 

Yz - blank coefficient (GOST 21354-87 Table 13, Formula 10.3). 

Yd ï takes into account the hardening of the root transition zone (GOST 21354-87 Tables 14-17). 

Yg ï takes into account the grinding of the root transition zone (GOST 21354-87 Tables 14-17). 

YT ï technology factor (GOST 21354-87 Table 13, Formula 10.2). The default technology factor 

setting is 1.0, but you can change it in KISSsoft by selecting Factors > Z-Y-Factors . 

YA ï alternating bending factor (GOST 21354-87 Table 13, Formula 10.6). The default alternating 

bending factor setting is 1.0, but you can change it to Own Input  in KISSsoft by selecting Factors > 

Alternating bending factor . 

The Yd, Yg, Yz factors cannot be entered in KISSsoft and must be included directly when the infinite 

life strength is entered. 

In addition to the factors mentioned above, the infinite life strength defined in GOST must be divided 

by 2.0 before being entered in KISSsoft. In the calculation, ůFlim is then multiplied by the stress 

correction factor YST = 2, in a similar way to in ISO or DIN. 

Consequently, the correct entry for ůFlim in KISSsoft, for calculations according to GOST, is:  

ůFlim (KISSsoft entry) = ůFlim0 (according to GOST) * Yd * Yg * Yz / 2.0 

Required minimum safeties  

GOST has the special property that the minimum safety set for tooth root fracture and the flank 

depends on the material type and the surface hardening. For this reason, you can enter minimum 

safeties for every gear individually, for GOST, under Settings > Required safeties . 

Information about root rounding  

In various GOST formulae, a distinction is made between whether the root rounding is ground or not. 

To make this distinction, you must select Details for root and flank strength calculation and enter 

a suitable value. 

Face load factor flank KHɓ 

The face load factor (flank) is calculated according to GOST, Table 6, Formula 7. The considerations 

described in GOST 21354-87 Annex 6 are ignored. 

Face load factor root KFɓ 

The face load factor (root) is calculated according to GOST 21354-87 Table 13, Formula 4. 

Dynamic factor Kɜ 

The dynamic factor is calculated according to GOST 21354-87 Table 6, Formula 6. If conditions (34) 

and (35) specified in formula 6 are not fulfilled, KISSsoft calculates the dynamic factor according to 

GOST 21354-87 Annex 5. 
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Load spectra  

Calculations with load spectra are performed using the rules defined by Palmgren-Miner, according 

to ISO 6336-6. 

Safety of the hardened layer  

The safety of the hardened layer is calculated according to DNV 41-2. 

15.2.1.3 Plastics according to Niemann, VDI 2545 or VDI 2736 

The calculation methods used for plastics take special account of the fact that these materials are 

very sensitive to extremes of temperature. The types of lubrication used here include oil, grease or 

none at all (dry run). The acceptable load for each material is calculated from figures in data tables, 

in DAT format, while taking into consideration the local temperatures at the tooth flank and root, and 

the number of load cycles. The local temperature can be calculated when grease is used as the 

lubricant or during a dry run. However, when oil is used as the lubricant, the oil temperature is used 

as the local temperature. The calculation is performed for combinations of plastic/plastic and also 

steel/plastic. The acceptable deformation is also checked. KISSsoft supplies data for the 

following materials: 

Polyamide (PA12, PA6, PA66, PA46) 

Polyacetal (POM) 

Polyetheretherketone (PEEK) 

Polybutylene terephthalate (PBT) 

Polybutylene terephthalate (PET) 

Laminate 

Data about other materials is available on request 

All the specific properties of each material are stored in text tables (DAT files) to enable the 

integration of own materials (see chapter 9, Database Tool and External Tables). The strength of 

plastics can be calculated either as defined by Niemann [12], or according to VDI 2545 (1981*) [13] 

or VDI 2736 [14]. You can also use the modified calculation method as detailed in VDI 2545. This 

calculates the stress using the tooth root stress correction factor Ys. The major differences between 

the two methods are: 

*Calculation method VDI 2545 has been withdrawn and replaced by VDI 2736. 

Root  Niemann  VDI 2545 VDI 2545-mod.  VDI 2736 

Y F C B or C B or C C 

Y S DIN 3990 1.0 DIN 3990 DIN 3990 

Y Ů 1.0 8) 1/ŮŬ 7) 9) 1/ŮŬ 7) 9) DIN 3990 

Y ɓ 1.0 DIN 399010) DIN 3990 10) DIN 3990 
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ůFE 2 *ůFlim ůFlim 2 *ůFlim 2 *ůFlim 

15.3 table: Differences between the calculation methods used to calculate the root safety factor for plastics 

Flank  Niemann  VDI 2545 VDI 2545-mod.  VDI 2736 

ZŮ 1.0 DIN 3990 DIN 3990 DIN 3990 

ZV DIN 3990 5) 10) 1.0 1.0 1.0 

ZR DIN 3990 6) 10) 1.0 1.0 1.0 

15.4 table: Differences between the calculation methods used to calculate the tooth flank load capacity for plastics 

Tooth deformation: Very different calculation methods! 
5) only for laminated wood, otherwise 1.0 
6) only steel/plastic combinations, otherwise 1.0 
7) For tooth form factor Y Fas defined in Method B: 1.0 
8) the method sets the face contact ratio for the tooth root stress to the value 1.0. According to 

Niemann, this is because the material data is not always precise. The formulae used in VDI 2545 

correspond to those used in ISO 6336:1996. 
9) For crossed helical gears = 0.25 + 0.75/Ůɔ 
10) For crossed helical gears = 1.0 

15.2.1.4 Calculation method for scuffing 

Scuffing is calculated according to flash temperature and integral temperature method using the 

following selection options: 

DIN 3990-4 

If the strength calculation is performed according to DIN, scuffing is always calculated using DIN 

3990-4. 

ISO/TS 6336-20/21:2022 

In all other cases, where DIN 3990-4 is not used, the calculation of scuffing is always performed 

according to ISO/TS 6336-20/21:2022. 

 

Contrary to DIN 3990-4, the following formulae are used for the tooth bulk temperature (analogous to 

ISO/TS 6336-20/21:2022): 
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For injection lubrication, XS=1.2 (otherwise 1.0). There is little point in multiplying the oil temperature 

(ɚoil) by the coefficient as specified in DIN 3990-4. 

DIN 3990-4, similar to STplus  

STplus (Version 6.0) uses the original formulae according to DIN 3990-4 for the tooth bulk 

temperature. Contrary to DIN 3990-4, the dynamic oil viscosity ɖM is calculated with the oil 

temperature (instead of the tooth bulk temperature). 

15.2.1.5 Calculation method for micropitting 

Micropitting is calculated according to ISO/TS 6336-22 (previously known as ISO/TR 15144-1). 

Further information,(see chapter 14.1, Underlying principles of calculation) and (see chapter 23.5.4.4, 

Safety against micropitting). 

15.2.1.6 Calculation method for tooth flank fracture 

Tooth flank fracture appears in the area of the active tooth flank instead of in the area of the highest 

bending stress at the 30° tangent. 

Tooth flank fracture (TFF) can be calculated according to the draft ISO Technical Specification 

ISO/TS 6336-4. Earlier investigations performed by Dr Annast in Munich [15] have later been 

updated and expanded by others. Witzig [16] has put together a first draft of ISO/TS 6336-4. 

Important: TFF as specified in ISO/TS 6336-4 can only be applied for case-hardened materials. 

Additionally, a new semi-analytical calculation method is in the standardization process (ISO 6336-4 

N1457 draft). This method takes into consideration the cyclical multiaxial stresses that occur at each 

discretization point on the gear and could lead to tooth flank fracture. The multiaxial fatigue criterion 

is set to include different stress fields: pressure (Hertzian theory), residual due to the surface 

hardening treatment, and the local material resistance. A new graphic has been added. It consists of 

a color plot of the material exposure distribution and shear stress distribution. Additionally, the most 

critical point of the tooth flank fracture initiation is marked. 

Click on the Plus button to enter the data required for tooth flank fracture. 

Hardening depth CHD  

You can input the intended hardening depth (for hardness HV400, for nitrided steels, or HV550 for all 

other steels). You can also input the hardness HV300. This value is then used to display the 

hardening curve as a graphic. The input applies to the depth measured during final machining (after 

grinding). 

When you input this data, the safety of the hardened surface layer is calculated automatically 

according to DNV 41.2 [11]. A minimum value of t400 (nitrided steel) or t550 (all other steels) is used 

here. If only the value for HV300 is known, this value is then used. However, the calculation should 

then only be seen as an indication. The calculation is performed as described in the 'Subsurface 
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fatigue' section in [11]. The values required to define the CHD hardening depth coefficient YC, as 

specified in DNV 41.2, are also needed. The calculation does not use the same approach as the 

calculation for the proposal for the recommended hardening depth, but still returns similar results. To 

obtain a proposal for a sensible hardening depth, we recommend you call the relevant calculation by 

selecting Report > Proposals for hardening depth . A maximum value for the hardening depth is 

only used to check the hardening depth at the tooth tip. It is mainly used for documentation purposes. 

There are three calculation options: 

Use a hardness file for the gear material, if this file already exists in the database 

Select an independent file with the hardness information 

Enter the core hardness and a method for generating a theoretical hardness curve 

according to Lang or Thomas (as in ISO/TS 6336-4) directly 

Using measured hardening curves for tooth flank fracture according to ISO/TS 6336 -4 

Evaluations of measurements taken at wind power installations by Vestas (2017) in the ISO TC60-

WG6 committee have shown that reliable results cannot be obtained using measured hardness 

curves according to the method specified in ISO/TS 6336-4 (due to the scatter of the individual 

measuring points). We recommend that you use the theoretical hardness curve defined by Thomas 

(or Lang) to approximate the measured hardness curve and then use this value in the calculation. 

 

Figure 15.5: Structure of the hardness file (important: depth values must be entered in mm) 

The results of the tooth flank fracture calculation are given in a report (select Report > Tooth flank 

fracture). 

15.2.2 Service life 

Enter the required service life directly in the input field. 

Click the Sizing button to size this value. This process uses the minimum safety value for the tooth 

root and flank strength to calculates the service life (in hours) for every gear and for every load you 

specify. The service life is calculated according to ISO 6336-6:2006 using the Palmgren-Miner Rule. 
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The program displays the system service life and the minimum service life of all the gears used in the 

configuration. Click the Sizing button to size the service life either with or without defining a load 

spectrum (see chapter 15.2.8, Define load spectrum). 

15.2.2.1 Number of load cycles 

KISSsoft calculates the number of load cycles from the speed and the required service life. If you 

want to influence the value, you can define it in the Number of load cycles for gear n window . 

Click the Plus button to access this. Here, you can select one of five different calculations for 

calculating the number of load cycles. 

Automatically  The number of load cycles is calculated automatically from the rating life, 

speed, and number of idler gears. 

Number of load cycles  Here, you enter the number of load cycles in millions. You must 

select this option for all the gears involved in the calculation, to ensure this value is 

taken into account. 

Load cycles per revolution  Here you enter the number of load cycles per revolution. For a 

planetary gear unit with three planets, enter 3 for the sun and 1 for the planets in the 

input field. 

 

Note:  

If the Automatically  selection button in the calculation module is selected, KISSsoft will 

determine the number of load cycles, taking into account the number of planets, in the 

Planetary stage  calculation module. 

Load cycles per minute  Here you enter the number of load cycles per minute. This may be 

useful, for example, for racks or gear stages where the direction of rotation changes 

frequently, but for which no permanent speed has been defined. 

Effective length of rack  The rack length entered here is used to calculate the number of 

load cycles for the rack. The rack length must be greater than the gear's perimeter. 

Otherwise, the calculation must take into account the fact that not every gear tooth will 

mesh with another. You must enter a value here for rack and pinion pairs. Otherwise 

the values NL(rack) = NL(pinion)/10 are set. 

Ʒ Note  

This calculation method is used for transmissions that only travel over one oscillation angle. 

Assume a scenario in which a reduction is present, 

Ὥ
ᾀ

ᾀ
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and an oscillation angle w in [°] from gear 2, where gear 2 constantly performs forwards and 

backwards movements with the angle value w2. The effective endurance is given as the service life. 

The two coefficients fNL1 and fNL2, which modify the absolute number of load cycles, NL, are now 

calculated. To do this: 

a) Set the alternating bending factor of the pinion and gear to 0.7, or calculate it as defined 

in ISO 6336-3:2006. In this case, one complete forwards/backwards movement is 

counted as one load cycle. 

b) Coefficients fNL1 and FNL2 for pinion and gear are defined as follows: 

 

Ὢ ȟ

ὙὕὟὔὈὟὖ
ὡȟ

σφπ

ςz
ὡȟ

σφπ

 

 

 

 w2 = oscillation angle gear 2 

- w1 = W2*i 

- ROUNDUP = round up to a whole number 

 

The value in the counter displays the actual number of loads that occur during a complete cycle 

(forward and backward oscillation) on the flanks (not teeth) that are most frequently subjected to 

load. By rounding up this number to the next whole number, every rotation recorded is counted as a 

load. 

 

Then, to determine the required fNL1,2 factor, the actual number of loads that occur per flank is divided 

by the number of loads that would occur per cycle, if rotation were to continue without a backward 

rotation at the angle of rotation (1 load for each 360°). 

 

Example calculation for fNL1.2:  

Gear 1 rotates through a half cycle at 540° while gear 2 oscillates by 90° (i = 6). 

In a complete cycle, the oscillation angle moves forwards once an backwards once. 

The actual number of load cycles that occur in a complete cycle on the flanks that are 

most frequently subjected to load (only one side of the tooth is taken into consideration) 

is then: 

 

For gear 1: 

ὙὕὟὔὈὟὖ
υτπ

σφπ
ς 

 

For gear 2ȡ 

ὙὕὟὔὈὟὖ
ωπ

σφπ
ρ 

 

Without adjusting the coefficientsȟthe number of counted load cycles in a complete cycle would then beȡ 
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For gear 1ȡ 

ςz
υτπ

σφπ
σ 

 

For gear 2ȡ 

ςz
ωπ

σφπ
πȢυ 

 

The coefficients are therefore fNL1 and fNL2: 

 

Ὢ
ς

σ
πȢφφχ 

 

Ὢ
ρ

πȢυ
ς 

 

c) Then, input coefficients fNL1 and fNL2 in the Load cycles per revolution  input field. 

The strength calculation can now be performed for the correct number of load cycles, on the basis of 

the data entered in steps a through d. 

15.2.3 Reliability 

Reliability is calculated according to Bertsche's study [17], in which the possible methods have been 

described in great detail. The most commonly used approach, and one which is well suited to the 

results that can be achieved in "traditional" mechanical engineering calculations, is "Weibull 

distribution". In this case, Bertsche recommends the use of 3-parameter Weibull distribution. The 

reliability R of a machine element is calculated as a function of the number of load cycles t using the 

following equations. 

 

Parameters T and t0 can be derived from the mathematically achievable service life of the 

component, Hatt, as follows (with FO according to the calculation method, Table 1, ɓ and ftB from 

Table 2 according to Bertsche): 

Calculation method  Damage probability Fo  
 

1% 10% Other Comment 

Shaft, DIN 743 
  

2.5% Assumed, not documented 

Shaft, FKM guideline 
  

2.5% 
 

Shaft, AGMA 6001 * 
  

If kC = 0.817 

Rolling bearing, ISO 281 
 

* 
 

If coefficient a1 = 1.0 
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Tooth flank, ISO 6336; DIN 3990 * 
   

Tooth root, ISO 6336; DIN 3990 * 
   

Tooth flank, AGMA 2001 * 
  

If randomness factor KR=1 

Tooth root, ISO 6336; AGMA 

2001 

* 
  

If randomness factor KR=1 

Table 15.5: 14.6a: Damage probability for different calculation methods when determining material properties 

 

 

with 

Ὄ
Ὄ

ρ Ὢ ᶻ
Ὅὲ
ρ Ὂ
ρππ

ὍὲπȢω
Ὢ

 

Factors and parameters for calculating reliability according to Bertsche [17]. 

 
Coefficient ftB  Weibull shape parameter ɓ 

Shafts 0.7 to 0.9 (0.8) 1.1 to 1.9 (1.5) 

Ball bearing 0.1 to 0.3 (0.2) 1.1 

Roller bearing 0.1 to 0.3 (0.2) 1.35 

Tooth flank 0.4 to 0.8 (0.6) 1.1 to 1.5 (1.3) 

Tooth root 0.8 to 0.95 (0.875) 1.2 to 2.2 (1.7) 

Table 15.6: 14.6b: Coefficients for a Weibull distribution according to Bertsche. The mean values used in KISSsoft are 

given in brackets. 

Ʒ Note:  

Calculating reliability using Weibull distribution uses the calculated service life, and so also takes into 

account the required safeties. To calculate reliability without taking required safeties into account, set 

the safeties to 1.0. 
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15.2.4 Peak overload factor 

The peak overload factor KAP according to DNV 41.2 is used when calculating scuffing, when a short-

period high overload, which is not covered by the application factor KA, occurs. In this case, the root 

and flank are calculated with KA, but the scuffing is calculated with KAP. This procedure is especially 

useful in the case of special applications. It enables the methodology to also be used for calculations 

according to the ISO standard. 

15.2.5 Power, torque and speed 

Click the Sizing button next to the power input field (for the torque) to calculate the power (torque) so 

that a predefined minimum safety (see chapter 15.23.5, Safety factors) can be maintained. 

 

Power, torque and speed must always be defined with a positive value. Enter the working flank to 

predefine the sense of rotation. 

 

The Plus button next to the speed input field now becomes visible for planetary stages. You can then 

input a second speed value (in addition to the speed of the reference gear). You can enter the speed 

as either a positive or negative value. A positive value means that the second gear rotates in the 

same direction as the selected reference gear. A negative value means it rotates in the opposite 

direction. 

Ʒ Note:  

The Plus button is also active for gear pairs when you are modeling epicyclic gears with gear pairs in 

KISSsys, as it is when you call KISSsys. You can then enter the speed of the planet carrier [nSteg]. 

The main speed [n] of the reference gear with n - nweb is then used in the calculation. This returns 

the exact number of load cycles. 

You cannot change the reference gear, torque, speed or power if the load spectrum with values 

is defined. 

15.2.6 Strength details 

Click on the Details  button for the root and flank strength calculation to display a dialog in which you 

can make additional settings for the strength calculation. Note that a different window layout is used 

for calculation methods according to AGMA (see chapter 15.2.7, Strength details (AGMA)). 

Additional settings are available in the corresponding Plus buttons for scuffing, tooth flank fracture, 

micropitting and subsurface fatigue. 

15.2.6.1 Allow simplified calculation according to DIN 3990/ISO 6336 

If you select this option, you can use the calculation methods for steel gears to calculate plastic 

gears. This calculation is performed according to the infinite life strength values listed in the materials 

database. The values for the plastics given in this database apply for oil lubrication, a temperature of 
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70°C and number of load cycles 108. In contrast to the calculation according to VDI 2545 or VDI 

2736, the strength values do not depend on the temperature and lubrication type. 

The calculation is performed in the same way as for through hardening steel, with the appropriate S-

N curve (Woehler line) as defined in ISO 6336. 

15.2.6.2 Checking contact stress ůHB and ůHD for both gears 

According to ISO 6336 (or DIN 3990), the Hertzian pressure is only monitored for the driving gear at 

the single tooth contact point B, and in D the pressure is only monitored for the driven gear. This 

option can be used to check both gears at points B or D, depending on which one is subject to the 

greater Hertzian pressure. 

15.2.6.3 Strength calculation using average tolerance field (of tooth form) 

By default, values for theoretical gear teeth (without allowances) are referenced for calculation. When 

you select this checkbox, KISSsoft performs the calculation with the average allowances for the 

center distance, root circle and tooth thickness. This option is suitable for use where large tolerances 

are present. 

15.2.6.4 Safety factor root with gear rim influence (VDI 2737) 

The strength calculation for internal toothings is not very accurate. A significant improvement is 

needed. Gear rims are often subject to stresses that can affect their load capacity. At present, VDI 

2737 is the only guideline that includes gear rim stress and the influences associated with this. The 

calculation is performed in two steps 

Tooth root fracture safety (static and endurance) without taking the gear rim influence into 

account. 

Tooth root fracture safety with gear rim influence. In this case, the maximum shear stress in 

the tooth root outside the meshing can in some conditions be greater than the actual 

bending stress in the tooth that is under load. 

As in ISO 6336:2006, the notch factor YS is determined at the place at which the tangent on the flank 

and the tooth center line form an angle of 60°. 

The results of the calculation specified in VDI 2737 are detailed in their own section in the normal 

report. 

Factor for maximum load (VDI 2737)  
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To calculate static safety in accordance with VDI 2737, input a maximum load factor. This is then 

multiplied with the nominal torque. To calculate the infinite life strength, the nominal torque is, as 

usual, multiplied with the application factor KA. 

15.2.6.5 Profile modification 

You can modify the theoretical involute in high load capacity gears by grinding the toothing. You will 

find suggestions for sensible modifications (for cylindrical gears) in KISSsoft module Z15 (see 

chapter 15.7, Modifications). 

 

The type of profile modification has an effect on transverse coefficients KHŬ and KHɓ and on the way 

scuffing safety is calculated. The load sharing factor Xɔ is calculated differently depending on the 

profile modification. The main difference is whether the profile has been modified or not. However, 

the differences between the versions for high load capacity gears  and for smooth meshing  are 

relatively small. The strength calculation standard presumes that the tip relief Ca is properly sized, 

but does not provide any concrete guidelines. The load sharing factor Xɔ is calculated as follows, 

depending on the type of profile modification according to DIN 3990: 

 

Figure 15.6: Force distribution factor Xɔ for different profile modifications 

15.2.6.6 Life factors as defined in ISO 6336 

Set the life factor ZNT to reduce the permitted material stress according to ISO 6336-2:2006: 

 



III Cylindrical gears 255 
 

 

As stated in ISO 6336, this value is important for cylindrical gear calculations and is the reason for 

the lower safeties for the range of endurance limit, compared with DIN 3990. 

normal (reduction to 0.85 at 10 10 cycles):  The permitted material stress in the range of 

endurance limit (root and flank) is reduced again. The life factors Y NT and ZNT for Ó1010 

load cycles are set to 0.85. 

increased if the quality is better (reduced to 0.92):  Y NT and ZNT are set to 0.92 for Ó 1010 

load cycles (in accordance with the data in ISO 9085). 

with optimum quality and experience (always 1.0):  This removes the reduction and 

therefore corresponds to DIN 3990. However, this assumes the optimum treatment and 

monitoring of the materials. 

15.2.6.7 Modification of S-N curve (Woehler lines) in the range of endurance 

limit 

In a standard Woehler diagram, the range of endurance limit is reached at a particular number of 

load cycles. From this point onwards, the dynamic strength no longer changes even when the 

number of load cycles increases. This behavior is called "according to Miner". 

However, more recent investigations have revealed that there is actually no such thing as an infinite 

life strength and that the S-N curve (Woehler line) should be modified in the infinite life strength 

range. 

In the range of endurance limit, you can therefore select the following modified forms: 

Miner (corresponds to DIN 3990, Parts 2, 3 and 6). Pitch Ð (horizontal) 

According to Corten/Dolan. Pitch p 

According to Haibach modified. Pitch 2*p 

According to Haibach original. Lead 2*p-1 (according to [18]) 

 

The lead p mentioned here matches the S-N curve (Woehler line) according to ISO, 

AGMA or DIN in the fixed period range, determined from YNT or ZNT. See also ISO 

6336-6 [19]. 

The figure below (see Figure 15.7) shows the corresponding characteristics. Experience has shown 

that performing a service life calculation with load spectra using the Miner method returns results that 

are far too optimistic. We recommend you use the Haibach method of approach. 
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Figure 15.7: Infinite life strength models 

Note concerning calculations according to ISO or DIN: 

The pitch (slope) of the S-N curve (Woehler line) for tooth bending in the time-dependent domain 

(between N0 and N00) is defined using the YNT, YdrelT, YRrelT and YX coefficients for the static 

and endurance cases, but in the endurance domain (NL > N00), only the YNT coefficient is used for 

the static and endurance cases. The same applies for pitting with the ZNT, ZL, ZV, ZR and ZW 

coefficients. This corresponds to the procedure used in ISO 6336 for the endurance domain. 

However, this does mean that buckling occurs on the S-N curve (Woehler line) at N00, according to 

the Corten/Dolan rule. 

As an example: for case-carburized steel, the pitch (slope) of the S-N curve (Woehler lines) in the 

endurance domain is 13.2, but in the range of endurance limit, it is approximately 10, depending on 

the precise values for YdrelT, etc. 

If all the coefficients, YdrelT, etc., are set to 1.0 using "Own Input", the S-N curve (Woehler line) will 

be constant. 

Ʒ Note:  

The saved *.z?? files and the STANDARD.z?? file contain the ZS.CortanDolanFactors variable. This 

can be set to = true. This can force the program to also extrapolate the YdrelT, YRrelT, YX, ZL, ZV, 

ZR and ZW coefficients in the endurance range, in contrast to the ISO definition. 
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15.2.6.8 Define tooth form factors 

The tooth form factor YF takes into account how the tooth form affects the nominal tooth root stress 

ůF0. The stress correction factor YS takes into account the effect of the notch on the tooth root. These 

two factors can be calculated in three different ways: 

According to the formulae in the standard (normal)  

As defined in ISO 6336 or DIN 3990, the tooth form and the stress correction factors 

are calculated at the tooth root at the point at which the tangent and the tooth center 

line form an angle of 30°. However, it is generally acknowledged that this method is 

rather imprecise, especially for deep tooth forms. 

Using graphical method  

According to Obsieger [20], there is a more precise approach in which the product of 

the tooth form factor YF and the stress correction factor YS is calculated and the 

maximum value is determined. This method is based on the manufacturing process 

used for a specific tooth form and is applied to all points in the whole root area. This 

maximum value is then used to calculate the strength. Factors YF and YS are calculated 

according to the formulae in ISO 6336 or DIN 3990. 

 

This is the recommended method, particularly for unusual tooth forms and internal 

toothings. If required, this calculation procedure can also be applied in strength 

calculations as defined in ISO 6336 and DIN 3990, as well as in fine sizing. 

 

Note:  

If you use the graphical method here, KISSsoft will calculate the tooth form before it 

calculates the strength, each time. It takes its parameters either from the cutter data 

you have entered previously, in the Tooth form input window (see chapter 23.2.1, Tooth 

form), or from the default settings in the Reference profile  input window. The maximum 

value of the product of the tooth form and stress modification factor is calculated at the 

same time and included in the stress calculation. 
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Figure 15.8: Figure: Tooth form factors using the graphical method 

for internal toothing, according to proposal 2737  

When calculating strength according to ISO 6336 or DIN 3990, select this option to use 

the tooth form factor as defined in VDI 2737, which is more precise for internal toothing, 

because it evaluates the stress at the point of the 60° tangent and derives the tooth 

form from the manufacturing process with the pinion type cutter. 

 

The calculation specified in ISO 6336 for calculating tooth root stress is more accurate 

than the one implemented in DIN 3990. However, the calculation applied to the root 

rounding in the critical point (for a 60° tangent) is still incorrect. The method defined in 

VDI 2737, Annex B is much more accurate, which is why we recommend you use this 

method. If you select this option, only the root rounding ⱢF and the root thickness sFn in 

the critical cross-section is calculated in accordance with the formulae in VDI 2737. All 

other sizes are calculated according to ISO 6336. 

 

The table (below) uses 4 examples to show the large variations that still arise in root 

rounding between the result defined in ISO 6336 and the effective values measured on 

the tooth form. However, the calculation method stated in VDI 2737 is very suitable. 

Gear x=  Pinion Cutter 
x0= 

ⱢF in ISO 6336-
3 2006 and 
2007-02 

ⱢF in the current 
edition of ISO 
6336-3 2007-04 

ⱢF measured on 
the tooth flank  

ⱢF with VDI 
2737 

-0.75 0.1 0.201 0.426 0.233 0.233 

-0.75 0.0 0.175 0.403 0.220 0.220 

0.0 0.1 0.298 0.364 0.284 0.286 

0.0 0.0 0.274 0.343 0.265 0.264 

Table 15.7: Comparison of root roundings 



III Cylindrical gears 259 
 

Note about the calculating YF: 

The theoretical profile shift is used in the calculation if the allowance is As < 0.05*mn (in 

accordance with ISO 6336-3). Otherwise the larger manufacturing profile shift xE.e 

(where the theoretical contact ratio is applied) is used. This corresponds to the 

procedure used in the STplus program (from Munich, Germany). An exact definition is 

not provided in the ISO standard. However, a specific tolerance field can be predefined 

in the Details  tab for the root and flank strength calculation. This value is then always 

used to calculate strength and for the transverse contact ratio. 

According to the ISO standard, the reference profile for the entire toothing is to be used for 

the calculation. For this reason, if you input the reference profile for pre-machining with 

protuberance, and a manufactured profile with remaining protuberance is left after 

deduction of the grinding allowance, the reference profile for final machining is used for 

the calculation. A grinding notch is produced in the reference profile for pre-machining 

without a protuberance (or a protuberance that is too small). To ensure that this 

situation can be correctly taken into consideration, the pre-machining reference profile 

(with pre-machining manufacturing profile shift) is used to calculate YF. The final 

machining reference profile is also used to calculate the grinding notch and therefore to 

define YSg (section 7.3 in ISO 6336-3). 

15.2.6.9 Tooth contact stiffness 

Tooth contact stiffness is required to calculate the dynamic factor and the face load factor. You can 

use one of these calculation options: 

In accordance with the formulae in the standard (normal)  

In the standard calculation, the tooth contact stiffness cg is calculated using empirical 

formulae (in ISO 6336, DIN 3990, etc.). 

Using the tooth form  

Using this option, the tooth form stiffness c' is calculated according to 

Weber/Banaschek's dissertation [21]. This takes into consideration tooth bending, basic 

solid deformation, and Hertzian pressure. The last condition determines the load 

dependency of c'. The contact stiffness is determined using the effective tooth form (see 

Meshing stiffness (Z24)). The mean value of the stiffness curve calculated using this 

method is then included in the calculation. If required, this calculation procedure can 

also be applied in strength calculations as defined in ISO 6336 and DIN 3990, as well 

as in fine sizing (Z04). The single spring stiffness c' is calculated from the cg, by 

extrapolating c' from the formula for cg (ISO or DIN). 

constant  

If you select this option, the tooth contact stiffness is set to a constant of 20 N/mm/ɛm. 
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15.2.6.10 Small amount of pitting permissible 

In specific cases, the appearance of a slight amount of pitting on the flank may be permissible. In a 

range of materials, this results in higher flank safeties in the limited life range due to the changed S-N 

curve (Woehler lines), as can be seen in either ISO 6336-2, Figure 6, curve 1 or DIN 3990-2, Figure 

8.1. 

15.2.6.11 Consider pressure angle factor YSa 

The tooth root stress calculation according to ISO 6336 is valid for a reference profile with a normal 

pressure angle of 20° according to ISO 53. For an extended consideration of the influence of the 

normal pressure angle on the tooth root stress, the pressure angle factor YSŬ as defined in 

Langheinrich [22] can be used. 

External toothing, rack: 

YSa, sym = 1+0.012(20-Ŭn) 

Internal toothing: 

YSa, sym = 1+0.001(20-Ŭn) 

15.2.6.12 Lubricant factor 

The lubricant factor is needed to calculate the coefficient of friction, loss, micropitting and scuffing. It 

can be set using the appropriate Settings button. 

As specified in ISO/TS 6336-22: 

1.0 for mineral oils 

0.6 for water-soluble polyglycols 

0.7 for non-water-soluble polyglycols 

0.8 for polyalphaolefins 

1.3 for phosphate esters 

1.5 for traction fluids 

15.2.6.13 Structural factor XwrelT or structural factor Xw (scuffing) 

The structural factor takes into account differences in materials and heat treatment at scuffing 

temperature. The factor can be set using the appropriate Settings button. Structural factor XwrelT (in 

DIN 3990 and in ISO/TS 6336-21:2022) or structural factor Xw (in ISO/TS 6336-20:2022) is used, 

depending on which standard is selected. However, in this case, XwrelT = Xw/XwT and XwT= 1 apply. 
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This results in XwrelT = Xw. The two factors are identical. 

However, the standards do not provide any details about how to proceed when different types of 

material have been combined in pairs. You must input this factor yourself, because it is not set 

automatically by KISSsoft. 

Through hardened steels 1.00 

Phosphated steels 1.25 

Coppered steels 1.50 

Nitrided steels 1.50 

Case-hardened steels 1.15 (with low austenite content) 

Case-hardened steels 1.00 (with normal austenite content) 

Case-hardened steels 0.85 (with high austenite content) 

Stainless steels 0.45 

Table 15.8: Structural factor according to DIN 3990-4 

The standard does not provide any details about how this factor is to be applied when the pinion and 

gear are made of different types of material. In this case it is safer to take the lower value for the pair. 

15.2.6.14 Grinding notch 

As defined in DIN 3990 or ISO 6336, the effect of the grinding notch can be taken into account by the 

coefficient YSg . Here, you input the ratio tg to the radius of grinding notch Ḋg in accordance with the 

figure in DIN 3990-3, section 4.4 or ISO 6336-3, Figure 5. KISSsoft then calculates a coefficient g = 

YSg/Y S (a coefficient with which YS is multiplied). 

The grinding notch depth tg is calculated using the distance of the 30° tangents from preliminary 

contour and the finished contour. If an allowance for pre-machining has already been input in 

KISSsoft, (see Figure. 14.11), then the ratio tg/Ɫg can no longer be entered by the user. In this case, it 

is defined by the program. A grinding notch occurs when a grinding depth (see chapter 15.7, 

Modifications) has been entered, and no protuberances remain, either because no protuberance tool 

was used, or the selected allowance was too small. The rounding radius Ḋg is then defined by 

generating the grinding wheel on the 30°- tangent (on the 60° tangent for internal toothings). 
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Figure 15.9: Grinding notch 

15.2.6.15 Pretension 

The influence of a press fit or other processing methods that influence tooth root stress can be taken 

into account with the pretension ůP . This value influences the calculated tooth root stress as well as 

the safety according to the following formulae: 

For static strength: 

 

 

 

For fatigue strength: 
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The pretension ůP merely generates additional results in the reports. The results in the results 

window remain unchanged. You define this under "Strength" > "Details". 

Ʒ Note 1  

This rule is not documented in the ISO standard. For this reason, we recommend extreme caution if 

the pretension effect is to be taken into account. The formulae are proposed by Alstom Ecotecnia. 

KISSsoft only shows this effect in the report. 

Ʒ Note 2  

If the main calculation (single load or load spectra) requires the use of this rule, the value ůôFlim must 

be changed as follows, according to the equation for ôFG: 

 

ůôFlim has to be introduced instead of ůFlim in the material values; then the main calculation is 

performed using this pretension rule. 

15.2.6.16 Moments of inertia 

If required, you can enter the moment of inertia of the gears. This value is used when calculating the 

dynamic factor. If you enter an invalid value (deviation > 100% from the expected value), the system 

displays a warning. Usually, in such cases, the incorrect unit has been used for the input. 

15.2.6.17 Optimal tip relief 

To calculate safety against micropitting as specified in Method B in ISO/TS 6336-22, you must 

specify whether or not the profile modification is to be assumed to be optimal. The same applies to 

calculating the safety against scuffing. The software checks whether the effective tip relief (Ca) 

roughly corresponds to the optimum tip relief (Ceff). If this check reveals large differences, i.e. Ca < 

0.333*Ceff or Ca > 2.5*Ceff, a warning is displayed. In this case, the value you input is ignored and is 

documented accordingly in the report. 

15.2.6.18 Root rounding, ground 

The setting specifying whether the root rounding is ground is only used in calculations according to 

GOST. 
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15.2.6.19 Information about material hardness 

For more information about material hardness, refer to part of Calculation method for tooth flank 

fracture (see chapter 15.2.1.6). 

15.2.7 Strength details (AGMA) 

Click on the Details  button for the root and flank strength calculation to display a dialog in which you 

can make additional settings for the strength calculation. 

Ʒ Note  

Only values in the input window that differ from those defined in ISO are described here. 

15.2.7.1 Limited life coefficients 

The limited life coefficients determine which material values can be entered in the field for limited 

time and strength. In standard applications, infinite life strength values up to 1010 load cycles are 

reduced from 100% to 90% for the root and to 85% for the flank. According to AGMA, the reduction 

in strength also extends beyond 1010 load cycles. In critical applications, where a gear unit 

breakdown must be prevented at all cost, the material values are reduced even more, in comparison 

to those used in standard application areas. 

15.2.7.2 Tooth form factors 

For cylindrical gears with small helix angles, or cylindrical spur gears, you can specify that the load is 

to be applied either at the tip or at the single tooth contact point (the more precise option). For 

cylindrical gears with a large helix angle (Ůɓ Ó 1) according to AGMA, the load is always applied in the 

single tooth contact point. 

Calculating with the single tooth contact point results in a lower load at the tooth root because the 

load is divided between the two teeth. However, this load distribution does not take place if large 

single normal pitch deviations occur and therefore the force should be assumed to be placed at the 

tooth tip. 

As stated in AGMA, the contact point between the tooth form and the Lewis parabola is selected as 

the critical root cross section. The stresses are determined here. AGMA does not provide a formula 

for calculating internal toothings. Instead, it recommends you use the graphical method to calculate 

the tooth form. The required data is to be taken from measurements. If you click the checkbox to 

select the graphical method for calculating the tooth form factor, the software automatically calculates 

the tooth form at the point where the Kf or I factor is greatest. In contrast to the method defined by 

Lewis, where the calculation is only performed at the contact point of the parabola, the calculation 

using the cross section with the greatest stresses gives more precise results, and is therefore the 

method we recommend for external gears too. 
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15.2.7.3 Transmission accuracy level number 

AV (or QV for AGMA 2001-C95 or earlier) is calculated according to the formulae defined in AGMA 

2001 or 2101 and is extremely dependent on the accuracy grade (manufacturing quality). AV is 

permitted to be one level higher or less than the accuracy grade (manufacturing quality) and is 

needed to calculate the dynamic factor. You can overwrite this value if required. 

15.2.8 Define load spectrum 

In this group, you can also access load spectra that have been stored in the database. You can also 

define the load spectra directly. 

If you select Read, you can import a file (in either .txt or .dat format) with a load spectrum. 

The 'Example_DutyCycle.dat' file in the dat  sub-folder in the KISSsoft installation directory is an 

example of a file that shows how a load spectrum can be defined. For load spectra on carriers, the 

special format shown in 'Example_Carrier_DutyCycle.dat' must be applied with a header. 

If you want separate factors (KHɓ, Kɔ, etc.) to be taken into account in the calculation with load 

spectra for each load bin, open the Factors  tab. In it, make the appropriate settings for the load 

distribution coefficient Kɔ (see chapter 15.3.4, Mesh load factor), the alternating bending factor YM 

(see chapter 15.3.5, Alternating bending factor) and the face load factor KHɓ (see chapter 15.3.6, 

Face load factor). An example of how a load spectrum can be defined with factors (KHɓ, Kɔ, etc.), can 

be seen in the 'Example_DutyCycleWithFactors.dat' file in the dat  sub-directory in the KISSsoft 

installation directory. 

 

A load spectrum can also be generated from a series of measurements with torque/speed/time if you 

select the torque measurement option. Click the Convert button below the Load spectrum table to 

call this option, (see chapter 15.8, Torque measurement). 

15.2.8.1 Type of load spectrum 

The service life for load spectra is calculated as specified in ISO 6336, Part 6, and is based on the 

Palmgren-Miner rule. 

Three load spectra are predefined here, as shown in DIN 15020 (Lifting Appliances), along with 

many other standard spectra. You can also input your own load spectra. 

A load spectrum consists of several elements (up to 50 in the database or an unlimited number if 

imported from a file). Each element consists of the frequency, speed, and power or torque. The data 

always refers to the reference gear you selected when you input the nominal power (Performance-

Torque-Speed screen). The program stores these values as coefficients so that they are modified 

automatically when the nominal power changes. 
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If two speeds that are not equal to zero have been predefined for planetary stages, you can select 

two load spectra. In this case, only the speed factor is important for the second load spectrum. 

Ʒ Note  

The calculation takes into account the load dependency of the K coefficients (dynamic, face load and 

transverse coefficients). If you want to examine the result in greater detail, you will find the most 

interesting interim results in the Z18-H1.TMP text file (in the TMP directory). 

15.2.8.2 Load spectra with negative bins 

Load spectra with negative load bins (T < 0 and/or n < 0) can be calculated as follows. 

 

IMPORTANT:  

A load bin is considered to be negative if the non-working flank is placed under load. 

This does not apply for the calculation of the pitting safety for idler gears (in the case of 

planetary gear stages, it only applies to the sun and internal gear; in the case of 

planets, it is assumed that both flanks are always under load). 

When calculating the root safety, this is only applied to bins where the alternating 

bending factor is YM=1.0. 
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Figure 15.10: Evaluation of load spectra bins 

Under Details for the root and flank strength calculation in the Rating tab the following options 

can be selected and defined: 

For calculating pitting safety  

Evaluate all negative load bins as positive (as up to now) 

Consider only right flank 

Consider only left flank 

Calculate both cases and document the less favorable case 

For calculating root safety  

Evaluate all negative load bins as positive (as up to now) 

Increase tooth root stress for negative load bins by 1/0.7 

Increase tooth root stress for positive load bins by 1/0.7 

Calculate both cases and document the more realistic case 
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15.2.8.3 Classification of load spectra according to F.E.M. Guideline 

The "Supplementary Data" section in the report for a load spectrum contains the spectrum factor km, 

and the machine classes L, T and M for a load spectrum, according to F.E.M 1.001 [23]. 

 

The spectrum factor km lies between 0 and 1 and describes the load on a machine caused by active 

torque. If the load spectrum is 100% torque for 100% of the time, km equals 1. The spectrum class L, 

according to table T.2.1.3.3 in F.E.M. 1.001, is calculated from the calculated spectrum factor km , 

and increases from L1 to L4 with the active torque. 

 

The application class T is determined from the entire duration of the load spectrum. To do this, the 

machine is assigned to one of the application classes T0 to T9, according to a duration of between 

zero and 50,000 operating hours (see Tab. T.2.1.3.2 in F.E.M. 1.001). In each case, the predefined 

and achievable application classes T are output in the report. 

 

A machine class M is determined according to the determined application class T and spectrum class 

L, according to table T.2.1.3.2 in F.E.M. 1.001. In each case, the predefined and achievable machine 

classes M are output in the report. Machine classes M1 (short operating time, low loads) to M8 (long 

operating time, high loads) are assigned, depending on the application class T and spectrum class L. 

15.3 Factors 

The Factors  input window is one of the standard tabs (see chapter 5.1, Standard and special tabs). 

15.3.1 Application factor 

The application factor compensates for any uncertainties in loads and impacts, whereby KA Ó1.0. The 

next table provides information about the factor values. You will find full details in ISO 6336, DIN 

3990 and DIN 3991. 

When deciding which application factor to select, you must take into account the interrelationship 

between the required safeties, assumed loads and application factor. 

Operational behavior of 
the driving machine  

Operational behavior of the driven machine  

uniform  moderate  
shocks  

average  
shocks  

heavy  
shocks  

uniform 1.00 1.25 1.50 1.75 

light shocks 1.10 1.35 1.60 1.85 

moderate shocks 1.25 1.50 1.75 2.00 

heavy shocks 1.50 1.75 2.00 2.25 

Table 15.9: Assignment of operational behavior to application factor 



III Cylindrical gears 269 
 

DIN 3990, Part 41 (car gearboxes), distinguishes between application factors for flank strength KAH 

and for tooth root strength KAF. Except for flank strength calculations, all other calculations (e.g. 

resistance to scoring) use application factor KAF. 

However, according to DIN 3990 Part 41, the application factor can also be less than 1.0. This is 

intended to avoid the need to perform a calculation involving load spectra. For example, DIN 3990, 

Part 41, Annex A, suggests the following values for a 4-speed car gearbox: 

Gear R 1 2 3 4 

NL 10^5 2 * 10^6 1.5 * 10^7 3 * 10^7 2 * 10^8 

KAH 0.65 0.65 0.65 0.65 
 

KAF 0.70 0.70 0.80 0.80 
 

Table 15.10: Application factor as defined in DIN 3990, Part 41 

15.3.2 Dynamic factor 

The dynamic factor takes into account additional forces caused by natural frequencies (resonance) in 

the tooth meshing. It is usually calculated using the calculation method you selected, however you 

can also input the value if it has already been derived from more precise measurements. To change 

the value, click the checkbox to the right of the input field. 

15.3.3 Transverse load factor 

The transverse load factor KHŬ is calculated according to the selected calculation method. The 

transverse load factor takes into account uneven contact characteristics across a number of teeth. 

When the contact ratio increases, the transverse load factor also becomes larger depending on the 

predefined manufacturing quality. A high contact ratio will result in a reduction of the root stresses. 

The transverse load factor will compensate for this effect for large single normal pitch deviations. 

In unusual cases, the transverse load factor will be unrealistically high. If you want to reduce the 

transverse load factor in this situation, simply click the checkbox to the right of the input field. You 

can then change this value. 

15.3.4 Mesh load factor 

The mesh load factor takes into consideration the uneven load distribution across multiple planets or 

idler gears. In this case, the load is multiplied by this coefficient. Dimensioning suggestion according 

to AGMA 6123-C16: 

 
Number of planets  
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Application  

level  
2 3 4 5 6 7 8 9 Flexible 

Mounting  

1 1.16 1.23 1.32 1.35 1.38 1.47 1.52 - without 

2 1.00 1.05 1.25 1.35 1.38 1.47 1.52 1.61 without 

3 1.00 1.00 1.15 1.19 1.23 1.27 1.30 1.33 without 

4 1.00 1.00 1.08 1.12 1.16 1.20 1.23 1.26 with 

Table 15.11: Load distribution coefficient Kɔ defined by the number of planets 

Application level  Description  

1 Typical of large, slow-turning planetary gear units 

2 Moderate quality, typical of industrial gears 

3 & 4 High quality gear units, e.g. for gas turbines 

Table 15.12: Meaning of the application level 

The mesh load factor can also be calculated in accordance with ISO/TS 6336-20 (mesh load factor 

Kmp) or DNVGL-CG-0036 with 

  

ὑ ρȢπ πȢςυẗὲ σ 

  

ὲ number of planetsσ 

  

Ʒ Note  

Level 2, or higher, requires at least one floating element. 

Level 3, or higher, requires a flexible gear rim. 

In a flexible assembly, the planets must be mounted on flexible pins/shafts or on bearings with 

couplings. 

Depending on the toothing quality and the number of planets, use the Calculated according to 

AGMA 6123  method to determine the distribution coefficient Kɔ for application levels 1 to 3. 

If a different load distribution coefficient is input for each element, when load spectra are in use, you 

should select the Own input, per load stage  method. 
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15.3.5 Alternating bending factor 

The tooth root strength calculation is used solely to calculate pulsating load on the tooth root. 

However, in some cases, the tooth root is subject to alternating bending loads (e.g. a planet gear in 

planetary gear units). In this scenario you can change the alternating bending coefficient of individual 

gears by selecting either the Own input  or Own input, per load spectrum element  methods. As an 

alternative to transferring these values directly, select the Calculate in accordance with ISO 6336 -3 

Annex B  method to calculate the coefficient. To do this, you must then open the Rating  tab, go to 

the Load spectrum section, and input the flow and fhigh parameters for each gear. fhigh must always 

have the fixed default value of 100%. 

ISO 6336-5:2003, section 5.3.3 and DIN 3990-5, section 4.3, state 0.7 as the value YM for pure cyclic 

load. In ISO 6336-3:2006, Annex B, the stress ratio R for idler and planetary gears is taken into 

account by using this formula: 

 

(12.16) 

 

(12.17) 

fhigh Load on the flank side that is subject to the higher load (must always have the 

fixed default value of 100%) 

flow Load on the flank side that is subject to the lower load 

M Dimensionless number depending 
 

on the type of treatment and load type 
 

(see Table B.1 in ISO 6336:2006-3, Annex B) 

R Stress ratio 

Y M Alternating bending factor 

Treatment  Endurance strength  Coefficient for static 
proof  

Steels 
  

case-hardened 0.8 - 0.15 YS 0.7 

Case-hardened and shot peened 0.4 0.6 

Nitrided 0.3 0.3 

Flame/induction-hardened 0.4 0.6 

Not surface-hardened steel 0.3 0.5 
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Cast steel 0.4 0.6 

Table 15.13: Mean stress ratio M as specified in Table B.1 - Mean Stress Ratio - in ISO 6336:2006-3 

According to Linke [24], the alternating bending factor (described there as Y A) is determined as 

shown in Figure 14.19. For plastics, Niemann recommends [7] 0.8 for laminated fabric and 0.667 for 

PA (polyamide) and POM (polyoxymethylene). 

 

Figure 15.11: Alternating bending factor in accordance with Linke [24] 

Ʒ Note  

YM is not standardized and is not part of ISO 6336-3 Method B. You should ensure that the values 

used are backed up by experience or tests. 
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15.3.5.1 Load spectrum with alternating torque 

Load bins can also be entered with negative torques. 

The problem: 

until now, no calculation guidelines have been drawn up to describe how to calculate gears with 

alternating load spectra. 

The only unambiguous case is when a change in alternating torque takes place during every cycle 

and in each bin of the load spectrum. At this point, a load change corresponds to exactly one double-

load with +torque and then with -torque. This instance can be calculated correctly by entering the 

load spectrum of the +torques and the alternating bending factor YM for the tooth root. The flank is 

also calculated correctly, because the +torques always apply to the same flank. 

If, in contrast, the drive runs forwards for a specific period of time and then runs backwards, the 

experts agree that the tooth root is not subjected purely to an alternating load (and possibly this is the 

only point at which an alternating load change takes place). However, discussions are still raging as 

to how this case can be evaluated mathematically. It is even more difficult to define how mixed load 

spectra with unequal +torques and -torques for the tooth root are to be handled. For this type of 

case, only the +torques are considered for the flank (with the prerequisite that the +torques are equal 

to, or greater than, the -torques). 

Note about handling load spectra with reversing torque: 

A load progression as represented in the figure below, where the tooth is subjected to a load a few 

times on the left flank, and then a few times on the right flank, can be converted into a load spectrum 

as shown below. This is represented in an example here. 

Load progression (example): 

13 loads with 100% of the nominal load (100 Nm) on the left flank, then 

9 loads with 80% of the nominal load (80 Nm) on the right flank, etc. 

This results in the following process: 

11 load cycles with 100% load, positive torque, pulsating; then 

1 load cycle with 100% load on the left and 80% load on the right; then 

7 load cycles with 80% load, negative torque, pulsating; then 

1 load cycle with 80% load on the right and 100% load on the left; 

then repeated again from the start. 

This can be represented as a load spectrum as follows: 
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Frequency torque Left flank load Right flank load 

11/20 = 0.55 100 Nm 100% 0% 

7/20 = 0.35 80 Nm 0% 100% 

2/20 = 0.10 100 Nm 100% 80% 

Table 15.14: Load progression shown as a load spectrum 

 

Figure 15.12: Load progression 

15.3.6 Face load factor 

The face load factors KHɓ,KFɓ,KBɓ take into consideration the influence of an uneven load distribution 

over the facewidth on the contact stress, tooth root stress and scuffing stress. You can specify that 

the face load factor is either to be set as a constant value or calculated from other values. If you 

already know the face load factor KHɓ, select the Own input  method and input this value. Click the 

Plus button to display the Define face load factor  window. In it, the calculation according to DIN/ISO 

is displayed: in that calculation, you can use a number of parameters to calculate the value you 

require. 

The usual setting here is "Calculation according to calculation method". The face load factor is then 

calculated according to the formulae used in the strength calculation standard (ISO, AGMA or DIN). 

You will need to input some values for this. These values are displayed on the right of the window 

(flank line modification, etc.) and are described in the sections that follow. You can input other values 

by clicking the Plus button in the Define face load factor  window. 

For the Factor K with stiffening effect  entry: the pinion has the effect that it stiffens the shaft 

(stiffening effect) if d1/dsh >1.15 and the pinion is created with a fixed interference fit or shaft/pinion on 

the piece. 

The formulae proposed in the standards for defining the face load factor KHɓ enable you to determine 

KHɓ very quickly (but only empirically, and therefore not very accurately). The KHɓ factor calculated 

using these formulae is usually higher than it actually is, so the calculated value is therefore on the 

conservative side. If the face load factor is increasing (> 1.5), it makes sense to perform a more 
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accurate calculation. To do this, use the "Calculation without manufacturing deviation according to 

ISO 6336-1 Annex E" method. 

The ñCalculation according to ISO 6336 Annex Eò method is very accurate, but time consuming. As 

described in [19], it calculates any gaping in the meshing, and therefore defines the load distribution 

over the entire facewidth. To perform this calculation, you will need to know the exact dimensions of 

the shafts and support. Click the Define axis alignment  button to input the shaft values stored in the 

shaft calculation module for the relevant shafts. 

The "Calculation with manufacturing deviation, as defined in ISO 6336 Annex E" method is the most 

accurate method. It also requires you to specify the toothing tolerance fHɓ (total tooth trace deviations 

over the bearing facewidth) and set the axis alignment tolerance fpar (angular deviation of the axis 

position in the plane of action). As described in [19], the load distribution over the facewidth is 

calculated 5 times: First without deviation, then with (+fHɓ,+ fpar), (+fHɓ,- fpar), (-fHɓ,+ fpar), (-fHɓ,- fpar). The 

largest face load factor KHɓ, determined in the process, represents the final result. 

Click the Sizing button next to the entry for IɆfHɓI to display a subwindow that contains a range of 

suggestions about how to take manufacturing errors into account. 

 

The maximum suggestion shows the possible highest value for the tolerance interval for fpar and ɆfHɓ. 

The statistically evaluated proposal shows tolerances that correspond to a statistically evaluated 

tolerance interval with 99.7% probability. 

The following formulae are used to define the total tolerance ftotal: 

fpar = fɆɓ-ISO * cos(Ŭwt) + fɆŭ-ISO * sin(Ŭwt) (value in the plane of action, effect of housing manufacturing 

errors as specified in ISO/TR 10064-4 or DIN 3964)) 

ftotal-maximal = ɆfHɓ-max + fpar-max = fHɓ1 + fHɓ2 + fpar 

ftotal-statistic = ɆfHɓ-stat + fpar-stat = 3 * ã[(fHɓ1/3)2 + (fHɓ2/3)2 + (fpar /3)2]; 

where the values are subdivided as follows: 

ɆfHɓ-max = +IfHɓ1I + IfHɓ2I; 

fpar-max = IfparI 

ɆfHɓ-stat = ftotal-statistic * (fHɓ1 + fHɓ2) / (fHɓ1 + fHɓ2 + fpar); 

fpar-stat = ftotal-statistic * fpar / (fHɓ1 + fHɓ2 + fpar); 

Ʒ Note  

If you want to calculate the face load factor by applying a load spectrum for each element, select 

either the Own input, per load stage , Calculation according calculation method  or Calculation 
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with/without manufacturing deviation according to ISO 6336 -1 Annex E, per load stage  

method. 

In the cylindrical gear pairs, three- and four-gear chains, and planetary systems, calculation module, 

shaft calculation files can be called and used to calculate the relative displacement between the tooth 

flanks more accurately, based on the corresponding shaft bending lines (see chapter 15.3.7, Taking 

into account shaft bending (face load factor and contact analysis)). Torque, power and force for all 

the load bins involved in the shaft calculation are then modified according to the partial load factor wt 

. 

Torsion of the gear body can be taken into account. Here the calculation assumes a solid cylinder or 

hollow cylinder (external diameter = root circle + 0.4*normal module or operating pitch circle, 

depending on what has been predefined under "Settings", bore = inside diameter) is involved. In 

other words, the internal diameter is taken into account and the torque on one side is zero. The 

torque is distributed in a linear fashion along the facewidth (parabolic course of deformation by 

torsion). You can select which side is to be subjected to torsional moment. In this case, I and II refer 

to the same side, as is also the case when you enter the toothing modifications. The increase in 

torque for a sun in planetary stages is taken into account by using multiple meshing (several 

planets). Multiple meshing is not taken into consideration in any other configuration (e.g. for gear 

pairs). In such situations, the correct torque curve can be used if the deformation is taken from the 

shaft calculation. 

The facewidth is divided into slices to help you calculate the face load factor as defined in ISO 6336, 

Annex E: 

You can set the accuracy of the face load factor calculation according to Annex E in the "Define 

number of slices" dialog. Click the Plus button next to the calculation method to open this dialog. 

15.3.6.1 Face load factor settings for calculation according to ISO, Annex E 

Load factors:  Define how load factors KV, KA and Kɔ are used. They can be taken into account when 

calculating load distribution and axis alignment according to ISO 6336-1, Annex E. 

Iterating the load distribution of the meshings (only affects planetary stages):  If shaft data is used 

to define the axis alignment, a constant load distribution over the facewidth is initially assumed when 

bending is calculated in the shaft calculation. This is a satisfactory approximation if the load 

distribution is fairly well distributed, and the face load factor is therefore not greater than 1.3 

(maximum 1.5). If the load distribution is less favorable, return the load distribution value from the 

gear calculation to the shaft calculation, and calculate bending again with the modified (and not 

linear) load distribution. This produces a more accurate, modified load distribution. This iterative 

determination of the load distribution across all the meshings is then performed until the load 

distribution stops changing in all the meshings. Be aware that this option only shows an effect if at 

least one of the deformation components is linked with the shaft calculation. 
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Tooth contact stiffness:  This defines whether tooth contact stiffness is calculated according to ISO 

6226 (Cɔɓ), (default setting) or whether it is constant with Cm = 11 N/mm/ɛm as defined in AGMA 

927-01. 

Calculating the moment of resistance in torsion:  If the calculation of torsion due to deformation in 

the "Define axis alignment " dialog is set to "Side I/II", the diameter specified here is used in the 

calculation. 

15.3.6.2 Flank line modification 

You can achieve more balanced contact characteristics if you perform targeted flank line 

modifications. The figure below shows the two most frequently used modifications (see Figure 

15.13). 

 

Figure 15.13: End relief and flank line crowning 

15.3.6.3 Cylindrical gear pairs 

The calculation, as specified in ISO 6336, is based on an approximate estimate of the pinion 

deformation. In many cases, this is extremely inaccurate and usually results in face load factors that 

are much too high. 

The face load factor is the ratio between the maximum and average line load. The basic equation 

used for the face load factor corresponds to equation (41) in the standard: 

*The equation numbers used in this section refer to ISO 6336:2006 

 

(14.4) 
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The effective tooth trace deviation Fßy, see equation (52) in the standard, is defined with the inclusion 

of a deformation component fsh that is specified in a linearized manner. The multiplier 1.33 in the 

equation stands for the conversion of the linearized specific deformation progression into the real 

parabolic progression - see equation. (14.5). 

 

(14.5) 

The manufacturer component of the tooth trace deviation fma is derived from tolerances specified by 

the manufacturer. If a standard procedure for checking the manufacturing quality is used, you can 

apply this formula (equation (64) in the standard): 

 

(14.6) 

If you have used KISSsoft's shaft calculation software to calculate the exact tooth trace deviation due 

to deformation (torsion and bending) in the plane of action, you can correct the approximately 

calculated value f sh, derived from the standard, and therefore calculate the width factors much more 

precisely! The formula as specified in ISO 6336 only applies to solid shafts or hollow shafts that have 

an internal diameter that is less than half of the external diameter. 

In Method C2, the face load factor is calculated using these equations: 

Size Drop -down list  Selection  Equation  No. 

KHɓ 
   

(8.04)/ 

(8.06) 

Fɓ 
   

(8.08) 

Fɓ position of the 

contact pattern 

not verified or inappropriate 

favorable 

optimal 

 
(8.26) 

(8.27) 

(8.28) 

fsh 
   

(8.39) 

fsh0 flank line 

modification 

none 0.023 Å ɔ (8.31) 

  
flank line crowning 0.012 Å ɔ (8.34) 

  
end relief 0.016 Å ɔ (8.35) 

  
full flank line modification 0 Å ɔ a) 

  
slight flank line crowning 0.023 Å ɔ b) 

  
helix angle modification 0.0023 Å ɔ b) 
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flank line crowning + helix angle 

modification 
0.0023 Å ɔ b) 

ɔ toothing straight/helical 

double helical 

 
(8.32) 

(8.33) 

fma flank line 

modification 

none 1.0 Å fHɓ (8.51) 

  
flank line crowning 0.5 Å fHɓ (8.53) 

  
end relief 0.7 Å fHɓ (8.52) 

  
full flank line modification 0.5 Å fHɓ a) 

  
slight flank line crowning 0.5 Å fHɓ b) 

  
helix angle modification 1.0 Å fHɓ b) 

  
flank line crowning + helix angle 

modification 
0.5 Å fHɓ b) 

Table 15.15: Overview of equations used according to DIN 3990:1987 

a) same as DIN 3990, Equation (6.20)  

b) same as ISO 9085, Table 4 

Size Drop -down list  Selection  Value No. 

KHɓ 
 

(39)/ 

(41) 

Fɓ 
 

(43) 
  

not verified or inappropriate 
 

(52) 

Fɓ position of the 

contact pattern 

favorable 
 

(53) 

  
optimal 

 
(56) 

fsh 
 

(57)/ 

(58) 

fma 
 

(64) 
  

none 1 / 1 
 

  
flank line crowning 0.5/ 0.5 Table 8 

  
end relief 0.7/ 0.7 

 

B1/B2 flank line 

modification 

full flank line modification 0 / 0.5 (56) 

  
slight flank line crowning 1 / 0.5 
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helix angle modification 0.1/ 1.0 Table 8 

  
flank line crowning + helix angle 

modification 
0.1/ 0.5 

 

Table 15.16: Overview of equations used according to ISO 6336:2006 

Type of pinion shaft  

Load as defined in ISO 6336:2006, Figure 13 (DIN 3990/1, Figure 6.8) or the bearing positioning is 

shown in the figure below. 
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Figure 15.14: Load as defined in ISO 6336:2006, Figure 13. 

Load according to AGMA 2001  

Definition of s and s1 according to AGMA 2001, Figure 13-3. Figure 14.23 shows the bearing 

positioning as described in AGMA 2001. 
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Figure 15.15: Load as defined in AGMA 2001, Figure 13-3 

15.3.6.4 Planetary stages 

The face load factors for planetary stages are calculated in a different way than for cylindrical gears. 

The deformation component fsh is derived from the deformation of the mating gears on the shaft due 

to torsion and bending. In order to simplify the situation for a pinion-gear pair, only the pinion 

deformation (which is much greater) is taken into account. 

Planetary stages are subject to the following significant deformations: 

Since the sun has several tooth meshings, all radial forces are canceled out. No bending 

takes place because deformation is caused solely by torsion. However, the multiple 

meshing which corresponds to the number of planets means this is greater than for 

normal integral pinion shafts. 

A planet gear has two meshings with opposed torques, which prevents deformation due to 

torsion. Bending may be calculated in the same way as for integral pinion shafts. 

However, the circumferential force must be doubled because of the sun/planet and 

planet/internal gear. 

In most cases, rim deformation can be ignored. As a result, the torsion at the pinion and the 

bending at the planet bolt must be taken into consideration for sun/planet meshing 

whereas, for planet/internal gear, only the bending at the planet bolt is important. For 

most support arrangements for planets, bending can be determined analytically using a 

procedure similar to that specified in ISO 6336. The 4 most common cases are 

displayed below (see Figure 15.16). 
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Figure 15.16: Support arrangement for planets 

a) Planets mounted with fixed clamped bolts on both sides 

b) Planets are on bolts, which have flexible bearings in planet carrier 

c) Planets mounted with gently tightened bolts (flexible bearings) on both sides 

d) Planets mounted with fixed clamped bolts on one side 

Configuration  ISO 6336 DIN 3990 AGMA 2001  

a Part 1, Formulae Chapter 15, (37) 
 

Annex D 6.20/6.21/6.24/6.25/ 
 

b Part 1, Formulae Chapter 15, (37) 
 

Annex D 6.24A/6.24B/6.25A/6.25B 
 

c and d Part 1, Formulae as defined in Part 1, Chapter 15, (37) 
 

Annex D Annex C, see [25]. 
 

Table 15.17: Configuration of planetary stages as defined in ISO, DIN and AGMA 

For ISO 6336, see also the explanation in [25]. 

Equations 14.7a to 14.7d show the bending components in relationship to the distance x from the 

start of the planet's bearing facewidth. As we are only interested in bending variation across the 

facewidth, the constant term was left out of the equations so that fb(x = 0) is zero. Similar formulae 

can be found in other technical documentation [26]. These equations apply for cases a through d: 
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(14.7a) 

 

(14.7b) 

 

(14.7c) 

 

(14.7d) 

The sun's deformation due to torsion, as described in the equation (14.8), can be calculated from 

Annex D (ft according to formula D.1). 

 

(14.8) 

In order to stay as close as possible to the methods used in ISO 6336 (and be able to apply formula 

2), the average deformation components fbmpla (bending at the planet) and ftmso (torsion at the sun) will 

be determined. 

 

(14.9) 

 

(14.10a) 

 

(14.10b) 

 

(14.10c) 
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(14.10d) 

 

(14.11) 

According to ISO 6336:2006, equation D.8, the linearized deformation components of the tooth trace 

deviation fsh (in mm) will be: 

 

(14.12) 

 

(14.13) 

This can then be used with equations (14.4) and (14.5) to calculate face load factors for the 

sun/planet and planet/gear rim. 

Formula symbol  Unit  Meaning  

b mm Meshing width 

cɔɓ  N/(mm ɛm) Meshing stiffness 

dpla  mm Planet reference circle 

dsh mm Planet shaft diameter 

dso  mm Sun reference circle 

Ep N/mm2 Young's modulus for planet bolt/shaft 

Eso  N/mm2 Young's modulus for sun 

fbpla mm Planet shaft deflection 

fHɓ  ɛm Helix slope deviation according to ISO 1328 

fmŬ ɛm Tooth trace deviation 
  

manufacture error 

fsh  ɛm (Linearized) deformation components of the 
  

tooth trace deviation 

ftso mm Sun torsion deviation 

Fm/b  N/mm Average line load 

(Fm/b)max N/mm Maximum local line load 
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Fɓy ɛm Actual tooth trace deviation 

KHɓ [-] Face load factor 

l  mm Planet bolt/shaft length 

p mm Number of planets 

x  mm Distance to the left side of the facewidth 

əɓ [-] Run-in factor 

Table 15.18: Overview of formula symbols 

15.3.6.5 Calculation of KHß with manufacturing errors 

According to ISO 6336-1(E), the lead variation (fHb) and shaft misalignment (fma) errors are also 

taken into account in the plane of action. In such a case, their combined effect is taken into account 

for the flank gap in five cases: 

Case 1: fma = fHb = 0, i.e. no error 

Case 2: fma = |fma|, fHb = |fHb|, so positive values for both errors 

Case 3: fma = +|fma|, fHb = -|fHb| 

Case 4: fma = -|fma|, fHb = +|fHb| 

Case 5: fma = -|fma|, fHb = -|fHb|, so negative values for both errors 

The face load factor KHß is calculated for all five cases, and the maximum value is selected as the 

face load factor of the gear pair. 

The positive direction always lies in the direction of the pinion's material, seen from a common point 

of contact. 
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Figure 15.17: Definition of the positive direction 

In all five cases, the manufacturing error is documented in the report and in the gaping and load 

distribution graphics. 

Proposed value for fhb and fma  

Click on the Sizing button next to the input field for |fHb| to display suggestions of usable data for fHb 

and fma. 

 

"Maximum" shows the largest possible values for fHb and fma. The values are derived from the fHbT 

(helix slope deviation) tolerances of the two gears and from the axis alignment tolerance (fɆɓ and fɆŭ).  

 

The "statically evaluated" proposal displays the probable maximum values (99.7% probability). This 

proposal is calculated as follows: 

 

 

15.3.6.6 Defining the misalignment for individual parts 

The following parts are assumed in a planets system: 

Sun wheel 

Planet carrier 
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N planet gears with the corresponding n pins 

Internal gear 

You can specify the position of these parts in the gear unit and the corresponding misalignment in 

the Define axis alignment  dialog. To display this dialog, click on the Axis alignment  button in the 

Factors  or Contact analysis  tab. All values refer to the shared facewidth. 

You can define more parameters in the "Axis alignment, proportional " tab for load-specific 

alignment of system elements: 

Tilting of the sun to the gear axis (see Figure 15.18). If no shaft file is used, the sun can be 

handled as a "floating sun". 

Tilting of the planet carrier to the gear axis (see Figure 15.19) 

Tilting of the planet pin relative to the planet carrier in circumferential direction dt and in 

radial direction dr (see Figure 15.20). To model a carrier deformation due to torsion, you 

must first set a value for dt. This value refers to the planet's facewidth. 

The tilting of the planet gear is relative to the planet bolt axis. The positive misalignment (in 

circumferential direction dt and radial direction dr) is defined according to the 

convention (see Figure 15.20). 

The tilting of the internal gear relative to the gear axis (see Figure 15.18). The conical 

extension of the internal gear can also be taken into consideration. 

The deformation of the planet bolt is caused by the twisting of the planet carrier. If the 

direction of torque has been input in the "Torsion" tab, the software checks the values 

and issues a warning message if the prefix for dt has not been entered correctly. 

If the direction of torque has been input in the "Torsion" tab, the software assumes that 

dt represents the twisting of the carrier due to torque. For this reason, the sign for dt is 

changed when KHɓ is calculated for load bins with a negative load factor. 
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Figure 15.18: Tilting of the sun and internal gear to the gear axis 
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Figure 15.19: Tilting of the planet carrier to the gear axis 

 

Figure 15.20: Tilting of the planet pin to the planet carrier 
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Figure 15.21: Tilting of the planet to the planet pin 

You can also use shaft files to define the alignment of all the shafts, except the planet pin. The shaft 

files undergo the same checks as a gear pair. For example, the value input for gear torque in the 

shaft calculation files must match the value entered for the gears in the calculation module. The 

carrier shaft is characterized by its two couplings: one coupling transfers the torque to the sun wheel 

and the other transfers the torque to the internal gear. The "effective diameter" for both couplings 

must be the same as the sun-planet center distance. The "length of load application" must also be 

appropriate for the facewidth of the planet gear. If a shaft file is used for the sun, planet or internal 

gear, you must click on an additional Plus button to select the meshing that must be taken into 

consideration. 

 

The proportional axis alignment is scaled with the partial load wt (for contact analysis), or with the 

ISO factors KV, KA and Kɔ. 

 

The angle to the first planet Ū defines where the first planet gear must be located for each system 

definition. Every one of the subsequent planetary gears must have an angular offset of 2ˊ/N to the 

previous gear. The load distribution on the planet for the specified planet carrier misalignment is 

dependent on the position of the planets. Modifying Ū will also change KHɓ, which is why this entry 

enables you to calculate the "worst case". 

 

You can set the non-load-specific inclination/deviation error of axis in the "Axis alignment, 

constant"  tab. 

In the "Torsion " tab, you set the side from which torque is introduced to the system or the side from 

which it is produced (depending on whether the element is a driving or driven element). You can 

select one of the following 3 options for inputting the direction of torque: 

Not taken into account 

Torque is applied/produced on side I 
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Torque is applied/produced on side II 

Each configuration is also displayed as a graphic so that the user can check their entries. 

If a shaft file is used to define the shaft deformation, the torque is calculated automatically from the 

results of the shaft calculation. 

The planet carrier is usually more complicated than is specified in the shaft calculation. For this 

reason, the carrier torsion is often greater than determined in the shaft calculation. Consequently, 

you can either take the torsion deformation value from the shaft calculation or enter it under dt for 

"planet bolt" (or use an FEM calculation to determine it). 

15.3.6.6.1 Calculating planet carrier deformation with FEM 

The deformation of the planet carrier causes the planet pin to become misaligned (the pin tilts at dt 

and dr relative to the planet carrier axis). Use the Finite Elements Method (FEM) to calculate the 

exact planet carrier deformation. A range of different options are available here: 

The calculated FEM results can be input directly as point coordinates and point 

deformations (one node for each of side I and side II on a two-sided planet carrier; two 

nodes on one side for a one-sided planet carrier, (see Figure) 

 

Figure 15.22: Planet carrier tab 

Import the file with the FEM results for the planet carrier deformation. The deformations in 

both nodes are then extracted from this file. The node coordinates do not need to be 

specified exactly. The deformation data of the adjacent node is transferred. 

Input some of the planet carrier's fundamental dimensions. KISSsoft then generates the carrier in 3D 

and uses the relative torque to define the planet carrier's deformation. 
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Input this data: 

 

Single- or two-sided planet carrier 

Pin diameter (d) 

Coefficient for the external diameter of the planet carrier (fwa) 

Coefficient for the inside diameter of the planet carrier (fwi) 

Coefficient for the wall thickness of the planet carrier, which may be different for side I and side II (fswl 

and fswll) 

Planet carrier width factor (fbpc) 

Coefficient for planet carrier's connector (fdcon) 

Coefficient for the planet carrier's internal connector (fdicon) 

External flange diameter on side I (dfaI) 

Flange length on side I (LfI) 

Flange wall thickness on side I (SwfI) 

External flange diameter on side II (dfaII) 

Flange length on side II (LfII) 

Flange wall thickness on side II (SwfII) 

Planet carrier material (select this from the database). 

 

These coefficients can all be input under "Details", either as coefficients or directly, as dimensions. 

You can also click on the "Dimension planet carrier" and "Dimension flange" buttons to display 

standard entries for this data. 

Remember that you can also set the mesh fineness. 

 

The coefficients and dimensions are shown in greater detail in the next figure. Depending on how the 

direction of torsion is entered, side I or side II may not be required for a one-sided planet carrier. 
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Figure 15.23: Coefficients and dimensions for planet carriers 

In addition to the carrier variants shown above, you can also input a step model of the carrier directly. 

The point to remember here is that the carrier is clamped on the internal diameter of the flange. If no 

flange is present, it is clamped on the internal diameter of the planet carrier. If both these diameters 

are identical, it is clamped along the entire length of the flange and the internal diameter of the 

carrier. If a step model is used, it is clamped at the specified flange diameter. 

15.3.7 Taking into account shaft bending (face load factor and 

contact analysis) 

Shaft bending can be taken into account using the "Define axis alignment" dialog. You can access 

this dialog either from the "Factors" tab (provided that either the "Calculation according to ISO 6336 

Annex E" or "Calculation with manufacturing allowance according to ISO 6336 Annex E" option is 

selected, in the "Face load factor" field) or the "Contact analysis" tab. 
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15.3.7.1 Main settings 

The Define axis alignment  dialog is where you define the proportional and constant deviation error 

of axis (fɆɓp, fɆɓc) and the inclination error of axis (fɆŭp, fɆŭc). The proportional deviation/inclination error 

of axis is defined at the nominal torque and scaled with the corresponding ISO coefficients strategy 

via the load factors. The scaling is defined in the Settings for the face load factor dialog and in the 

Contact analysis tab. 

 

Instead of defining the deviation and inclination of the axes directly (linear deformation model), you 

can use shaft calculation files for a more precise definition of the effect of bending and torsion on the 

shafts on which the gears are mounted. 

The Define axis alignment  dialog is described below. This is where you determine the axis 

alignment by using the shaft calculation files. In the "File Shaft Gear 1/Gear 2" fields, enter the file 

name for the shafts to which the pinion (1) or the gear (2) belong. You must input the file name with 

its entire path (for example C:\MyCalculations\ContactAnalysis\pinion_shaft.W10). However, if the 

shaft files are stored in the same folder as the gear calculation file Z12, you only need to input the 

name of the shaft calculation file (as shown in the figure). 

The resulting scaling of the load is displayed in % in the upper part of the dialog. 

 

Figure 15.24: Define axis alignment (planets and gear pair) 

If a shaft file is used, select the additional Plus button to select the meshing that is to be taken into 

account. 

Conical expansion can be taken into account for internal gears. 
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15.3.7.2 Conditions for using shaft calculation files 

If you are working with shaft files, the sizing parameters in the gears module must match those in the 

selected W010 files. More specifically: 

The pinion geometry must match the geometry defined for the pinion in shaft file 1. The 

selection is based on the operating pitch circle, the direction (driving/driven) and the 

contact flank. The same applies to the gear shaft. 

The gear pair performance must match the gear performance defined in the shaft files. 

The shaft rotation for both the pinion and the gear (according to shaft files W10) must be 

consistent. For example, if the pinion rotates in a clockwise direction, the gear must 

rotate counterclockwise. However, if the gear is an internal gear, both the pinion and 

gear must rotate clockwise in this example. 

From these conditions you can also easily see whether the shaft files can be used for the contact 

analysis. If one of these conditions is not met, no calculation can be performed. 

In addition to the conditions listed above, a number of other conditions (warnings) concerning the 

helix angle, the facewidth, and the gear's working transverse pressure angle, are also checked. 

All the conditions can controlled with the "Permitted deviation shaft/ gear" entry or switched off by 

clicking the "Suppress shaft/gear plausibility check" setting. 

15.3.7.3 Effect of torsion on the body of the gear 

You can take the effect of torsion on the body of the gear into account either by applying the results 

of the shaft calculation or by inputting your own data (the same applies to side I and II). Obviously, 

the results of the shaft calculation can only be referenced if shaft files have been used to define the 

axis alignment. 

If you defined the gear's torsion in "Side I/Side II"", then the torsion moment of resistance is 

calculated from the root circle df and the internal diameter. 

15.3.7.4 Handling bending and torsion using the results for the shaft 

If a gear pair has been found and the shaft calculations performed successfully, the bending and the 

effect of torsion are determined from the results for the shaft. 

The results for bending in each shaft file are all transferred to a single coordinate framework, where 

pinion contact occurs at 0° and gear contact occurs at 180°. The torsional angle of each gear is 

assumed to be 0° on the side that is furthest to the left (side I, i.e. the side with the smallest Y-

coordinate in the shaft file) and every torsional angle for this particular gear then refers to this side. 
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15.3.8 Z-Y factors, C-K factors and technology factor 

If necessary, you can modify any of the factors that affect the permitted material values (root and 

flank) as specified in ISO or DIN in the Z-Y factors  window. When calculation according to AGMA is 

selected the C-K factors can be modified. The location of the Z-Y and C-K factors window can be 

found under the Factors tab. 

The ZL, ZV, ZR, ZW and ZX factors affect the pitting stress limit ůHG, the YT, YdrelT, YRrelT, YX factors 

influence the tooth root safety limit ůFG. 

Z-Y factors can be specified in predefined range from 0.5 to 2.0. If values outside this range are 

entered, they are set to 1.0. In the case of C-K factors (AGMA), higher values can be input, but a 

warning message to inform the user is shown. 

The technology factor takes into account the change in tooth root strength caused by processing. In 

this situation, the material's permissible stress is multiplied by YT Ó 1.0. This factor is not specified in 

the DIN or AGMA standards and is therefore set to 1.0. 

You can only input the gear rim factor YB for the calculation method according to ISO 6336. If you 

select a different method, this option is deactivated and the factor is set to 1.0. 

Tooth root area processing type  Technology factor YT 

Shot peening  
 

Case-hardened/carbonitrided toothing; 

not ground in the reinforced areas 
1.2 

Rollers  
 

Flame- and induction-hardened toothing; 

not ground in the reinforced areas 
1.3 

Grinding  
 

For case-hardened or carbonitrided toothing 0.7 (general); 

1.0 (CBN grinding discs) 

Cutting machining  
 

Not for profile ground toothing! 1.0 

Table 15.19: Technology factor according to Linke 

According to Bureau Veritas/RINA [27], these technology factors apply: 

Tooth root area processing type  Technology factor YT 

Shot peening Case hardening steel 1.2 

Shot peening Through hardening steel 1.1 
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Shot peening Nitriding steel 1.0 

Table 15.20: Technology factors as defined by Bureau Veritas/RINA Directives 

YT is not part of ISO 6336. However, chapter 6.7.2 provides values for increasing ůFlim as a function of 

shot peening. These can be presented using the technology factor. The values only apply to tooth 

root bending stresses and shot peened case hardening steel. 

Material class  Technology factor YT 

ML 1.0 

MQ 1.1 

ME 1.05 

Table 15.21: Technology factor according to the note in ISO 6336-5:2016, Section 6.7.2 

15.3.8.1 Calculate lubricant factor with oil temperature 

Unlike in ISO 6336 and DIN 3990, where the calculation is always performed using the oil viscosity at 

40°C, the lubricant factor is calculated with the oil viscosity at operating temperature when you click 

the lubricant factor ZL checkbox. If this option is selected, the material hardening factor ZW is also 

calculated using the viscosity at operating temperature. 

15.3.8.2 Calculating the size factors for small gears 

Calculation of size factors for small gears similar to that stated in FVA report 410: 

If mn < 1, the size factors (according to DIN or ISO) are ZX and YX > 1. 

Ʒ Note  

If you use this method, you may need to adjust the required safeties that have been used up to now. 

This is because much higher computational safeties are produced. 

15.3.8.3 Calculating the case hardening depth factor according to FVA 271 

report 

According to FVA 271:2001 [28], two hardening depth-dependent factors ZCHD and YCHD can be used 

if case hardening steels are selected for the gear material and if the calculation is not performed 

according to AGMA. 

The factors are limited to the range 0.5 Ò ZCHD,YCHD Ò 1.0. The calculation according to FVA 271 

considers the user-defined range of the hardening depth at the hardness of 550 HV. This range is 
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then compared to the range of the optimal hardening depth, for which the limits (CHDoptimalmin / 

CHDoptimalmax) are calculated according to FVA 271. 

As there is the comparison of two ranges (user input through case hardening depth at 550 HV and 

the one calculated according to FVA 271), the following behavior is implemented: 

If both user input values are smaller than CHDoptimalmin, the factors ZCHD and YCHD are 

calculated according to equations 33 and 38 [28], considering the smaller of the two 

hardening depth values. 

If both user input values are larger than CHDoptimalmax, the factors ZCHD and YCHD are 

calculated according to equations 35 and 40 [28], taking into account the larger of the 

two hardening depth values. 

If the user input values are between CHDoptimalmin and CHDoptimalmax, the factors ZCHD and 

YCHD are equal to 1. 

If one user input value is smaller/larger than CHDoptimal, the factors ZCHD and YCHD are 

calculated according to both equations 33 and 38 and equations 35 and 40 [28], using 

the smaller value in the strength calculation. 

15.3.9 General calculation procedure for KHbeta as specified in ISO 

6336-1, Annex E. 

Import the shaft files, select the correct gears, and then perform the initialization 

Calculate the shafts and determine the bending lines and torsion in the point of contact (if 

uniform load distribution is present, determine these values along the facewidth of the 

gear) 

Take into account flank modifications from Z012 (not W010) 

Calculate the gaps in the tooth contact, then the load distribution with tooth contact stiffness 

and finally calculate KHɓ. 

Use the calculated load distribution to correct the load distribution on the original gears 

Divide the gears into "sections" whose load values are defined in the previous step 

Use the flank contact ratio (as a vector) from the previous iteration gk-1and the current flank 

contact ratio gk to calculate the root of the sum of the square error. 

 

If ɚ>0.1%, go back to step 2 and perform further iterations. Otherwise exit. 

This procedure exactly follows the method described in ISO 6336-1, Annex E, but uses a stricter 

iteration criterion. 
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15.4 Reference profile 

In contrast to traditional mechanical engineering, where a predefined standard reference profile is 

most commonly used, the reference profile is often modified in precision mechanics. Input the gear 

tooth reference profile or the appropriate tool in the Reference profile  input window. You can input 

this data either as coefficients, as lengths or as the diameter. 

15.4.1 Configuration 

The reference profile of the gear teeth is usually predefined. However, you can also define your own 

hobbing cutter or pinion type cutter. The pinion type cutter parameters are also used in the strength 

calculation to calculate the tooth form factor. You can also select Constructed involute  for precision 

engineering. In this case, the involute is defined directly together with a root radius. 

15.4.1.1 Tool: Hobbing cutters 

Select the hobbing cutter you require from the selection list and then click the Plus button beside it: 

 

Figure 15.25: Hobbing cutter selection window 

If you select a profile (e.g. DIN 3972 III), the list displays the tools that are present in the relevant 

cutter file. (The name of the cutter file is entered in the database.) Click on the Restrict selection 

using module  and pressure angle checkbox to only display tools whose modules and pressure 

angles match those defined in the gear geometry. By default, only tools that match the selected 

module and pressure angle are displayed. If tools are selected from the Tooth form  tab, cutters that 

meet the condition cos(Ŭn)*mn = cos(Ŭn1)*mn1 are also displayed. The standard tolerance is set to + - 

1°. 
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Figure 15.26: Reference profile for tool configuration: Hobbing cutters 

Hobbing cutters for asymmetrical gears:  

 

Figure 15.27: Reference profile for asymmetrical gears for the configuration tool: Hobbing cutters 
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Select Own input to directly define your own cutter: 

The cutter addendum coefficient h*aP0 defines the cutter addendum, which then defines the 

gear root circle. A usual value is 1.25. 

The cutter tip radius coefficient Ɫ*aP0 defines the cutter tip radius, which then defines the 

gear root radius. The tip radius is limited by the maximum geometrically possible radius, 

depending upon the profile addendum and the pressure angle. This value usually lies in 

the range 0.2 to 0.38. 

The cutter's dedendum coefficient h*fP0 defines the cutter's dedendum , which then defines 

the tip circle, for a topping tool. A usual value for this is 1. In a non-topping tool, there 

has to be a certain amount of clearance between the tool and the gear tip circle, which 

the software checks. 1.2 is a usual value for an addendum of the reference profile of 1. 

The root radius coefficient Ɫ*fP0 defines the root radius of the cutter. In a topping tool, the 

root radius cuts a tip rounding on the gear in most cases. Depending on the geometric 

conditions, a chamfer or corner may occur on the tip. 

The protuberance height coefficient h*prP0 defines the protuberance length, measured from 

the addendum. The protuberance is used as an artificial undercut to prevent a grinding 

notch from being created. The protuberance height can be calculated from the 

protuberance size and angle. 

The protuberance angle Ŭ*prP0 is usually smaller than the pressure angle. However, in the 

case of some special cutters, it may also be larger. In this case, no undercut is present, 

but the tooth thickness at the root of the gear is larger. The protuberance angle can be 

calculated from the protuberance size and height. If 0 is input, no protuberance is 

present. 

When calculating the contact ratio, protuberance is not taken into account until it reaches a 

certain value because a contact under load is assumed for profile modifications. To set 

the threshold value that takes into account protuberance and buckling root flank for 

active diameters, select the Calculation > Settings (see chapter 15.23.3, Calculations) 

menu option. 

The root form height coefficient hFfP0* defines the end of the straight flank part of the tool 

with a pressure angle Ŭn. The height is measured from the tool reference line. 

The ramp angle aKP0* defines a ramp flank or a profile modification that is present in the 

cutter. The length is determined using the root form height coefficient. The angle is 

greater than the pressure angle Ŭn. If you enter the value 0, this part will be ignored. 

The threshold value used for protuberance is also taken into consideration here when 

calculating the diameter and the contact ratio (see chapter 15.23.3, Calculations). 

For the usual tools, the tooth thickness coefficient of reference line s*P0 equals s*
P0 = ˊ/2. 

The value can be overwritten for special tools. 
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The addendum coefficient of the gear reference profile h*aP for a non-topping cutter is 

defined with the usual value of h* aP = 1 of the gear reference profile or using the gear's 

tip circle. The value can be calculated by converting the tip circle value. 

By clicking on the Database button (next to the data source input field), the hobbing cutter can be 

written into the database (only if the hob is defined as own input). Once it is in the database, the hob 

is available for selection under Data source. 

15.4.1.2 Tool: Pinion type cutter 

Click the Plus button next to the pinion type cutter designation to select a pinion type cutter for 

internal and external gears from a list. Pinion type cutters as specified in DIN 1825, 1826 and 1827 

are listed here. You use this window in the same way as the Select hobbing cutter  window, 

15.4.1.1. By default, the list only displays tools that match the selected module, pressure angle and 

helix angle. 

 

Figure 15.28: Reference profile for tool configuration: Pinion type cutter 

Pinion type cutter for asymmetrical gears:  
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Figure 15.29: Reference profile for asymmetrical gears for the configuration tool: Pinion type cutter 

Select Own input  to directly define your own pinion type cutter: 

KISSsoft can prompt the number of teeth z0 for the cutter. If the number of teeth is too small, 

it may not be possible to manufacture the cylindrical gear tip form circle and/or root form 

circle. If the number of teeth is too great, it may cause collisions during manufacture. 

The pinion type cutter profile shift coefficient x0 is often unknown. However, it does influence 

the root circle of the resulting gear. This value is set automatically, together with the 

number of teeth. 

A pinion type cutter tip often takes the form of a radius or a chamfer. The tip form is not 

defined in the standards. To be on the safe side, a chamfer of mn/20 was set in the 

files. However, you should check this value if necessary. 

The pinion type cutter addendum coefficient h*aP0 defines the pinion type cutter addendum 

that in turn determines the pinion type cutter tip circle and the gear root circle. A usual 

value is 1.25. 

The pinion type cutter dedendum coefficient h*fP0 defines the pinion type cutter dedendum 

height that in turn determines the tip circle for a topping tool. A usual value for this is 1. 

In a non-topping tool, there has to be a certain amount of clearance between the tool 

and the gear tip circle, which the software checks. 1.2 is a usual value for an addendum 

of the reference profile of 1. 

The root radius coefficient of the pinion-type cutter Ɫ*fP0 defines the radius at the cutter root. 

In a topping tool, the root radius cuts a tip rounding on the gear in most cases. The 

input value is only displayed for a topping tool. 

The protuberance height coefficient h*prP0 defines the protuberance length, measured from 

the addendum. The protuberance is used as an artificial undercut to prevent a grinding 

notch from being created. 
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The protuberance angle Ŭ*prP0 is usually smaller than the pressure angle. If 0 is input, no 

protuberance is present. 

When calculating the contact ratio, protuberance is not taken into account until it reaches a 

certain value because a contact under load is assumed for profile modifications. To set 

the threshold value that takes into account protuberance and buckling root flank for 

active diameters, select the Calculation > Settings (see chapter 15.23.3, Calculations) 

menu option. 

The root form height coefficient hFfP0* defines the end of the tool involute with the pressure 

angle Ŭn. The height is measured from the tool reference line. 

The ramp angle ŬKP0* defines a ramp flank or a profile modification that is present in the 

cutter. The length is determined using the root form height coefficient. The angle is 

greater than the pressure angle Ŭn. If you enter the value "0", this part will be ignored. 

The threshold value used for protuberance is also taken into consideration here when 

calculating the diameter and the contact ratio (see chapter 15.23.3, Calculations). 

The addendum coefficient of the gear reference profile haP * with the usual value of haP * = 1 

defines the gear's tip circle for a non-topping tool. The value can be calculated by 

converting the tip circle value. 

By clicking on the database button (next to the data source input field), the hobbing cutter can be 

written into the database (only if the hob is defined as own input). Once it is in the database, the hob 

is available for selection under Data source. 

15.4.1.3 Reference profile 

The reference profiles displayed here are taken from the database. If you can't find a suitable 

reference profile here, you must first enter it in the database (see chapter 9, Database Tool and 

External Tables) (Z000.ZPROF). Alternatively, select Own input  from the drop-down list, to open a 

dialog in which you can edit all the input fields, and so change all the reference profile parameters. 

The Label  input field is displayed under the Reference profile  drop-down list. This is where you 

enter the name of your own profile, which will then appear in the calculation report. 

Ʒ Note  

You do not create a new entry in the database when you define your own profile in the Own input  

field. 

The reference profile details are listed according to ISO 53, DIN 867 or DIN 58400. This is the 

reference profile data for the gear. You can calculate the corresponding values in [mm] by multiplying 

it with the normal module. Please note the following points: 

If the reference profile is set to Own input , the tip alteration is set to zero (see chapter 15.7, 

Modifications). For this reason, the addendum may change when you toggle from one 

window to another. 
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If you are using reference profile BS 4582-1:1970 Rack 2  to determine the correct tip and 
root diameters, you must input an appropriate tooth thickness tolerance of 
 

 
 
directly. The tip and root diameter will then match the values defined in BS 4582-1(8). 

The ramp flank is usually used to generate a tip chamfer (also called "semi-topping"). 

Alternatively, you can also use a small buckling root flank value to generate a profile 

modification. However, profile modifications are usually defined in the Modifications  

window (see chapter 15.7, Modifications). 

If the angle of the ramp flank is only slightly different from the pressure angle, it is not taken 

into account in the contact ratio because the assumption for profile modifications is that 

the contact ratio will not decrease under load. In contrast, the contact ratio should be 

reduced accordingly for a chamfer. In Settings (see chapter 15.23.3, Calculations), you 

can specify the difference in angle that is to be used as the threshold in profile 

modifications and chamfers. 

If a pre-machining tool is used, the additional measure for the pre-machining must be 

entered separately. You must input the gear's reference profile for the pre-machining. 

The calculation of the reference profile for final machining then takes the grinding wheel 

into account and documents this in the report (see chapter 15.4.2, Pre-machining and 

grinding allowance). 

For profile modifications, where the angle difference < threshold value (see above), the tip 

form height coefficient h FaP* does not change between pre-machining and final 

machining. 

 

Figure 15.30: Reference profile for configuration: Reference profile gear 

Reference profile for asymmetrical gears:  
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Figure 15.31: Reference profile for configuration: Reference profile for asymmetrical gears 

Click the Sizing button next to the Reference profile drop-down list to display a dialog which 

contains proposals for reference profiles according to the following criteria: 

Both gears with (dNf-dFf) minimum 

Both gears at minimum topland (x is optimized to suit sliding velocity) 

Both gears at minimum topland (do not change x) 

Deep tooth form according to the theoretical profile contact ratio defined in the 

Sizing tab, in the "Module specific settings" (Calculation > Settings ) 

Click the Convert button next to the "Reference profile" drop-down list to display a dialog 

window in which you can select a gear, and then copy its reference profile properties. 

haP* always applies as the normal gear reference profile. The tooth thickness on the 

reference line is defined as 

 

(12.19) 

15.4.1.4 Constructed involute 

When you select Constructed involute , you do not need to enter as many parameters as you do 

when you select Reference profile . The essential difference is that the manufacturing process is not 

simulated, and the involute is generated directly. Normally the protuberance part of the constructed 

involute is defined as an involute with a different base diameter (calculated from ŬprP). Additionally, 

protuberance can be defined also as a straight line. 
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In the gear root, the involute is closed by a radius that is defined by the root radius coefficient ɟfP . In 

theoretical involutes, the root radius coefficient is usually greater than the coefficient for a reference 

profile, because the manufacturing process does not involve generation. 

 

Figure 15.32: Reference profile for configuration: Constructed involute 

For asymmetrical gears: 

 

Figure 15.33: Figure: Reference profile for asymmetrical gears for the configuration: Constructed involute 
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15.4.2 Pre-machining and grinding allowance 

Often gears are premachined with a grinding allowance, then hardened and then ground. The tooth 

flank, but not the tooth root, is usually involved in the grinding process. 

Note:  If a cutter, pinion type cutter or constructed involute is selected as the pre-machining tool, the 

gear reference profile for pre-machining is calculated internally from the tool data. 

In this case, the root circle is created by the pre-machining cutter and the flank by the grinding 

process. To complete this process correctly, select either Pre-machining  (with own input, or with 

reference profile for grinding allowance III or IV as specified in DIN 3972) or select Final machining . 

If you decide to use pre-machining, the Grinding allowance  field is displayed. You can also add 

your own tolerances to the database. Enter the pre-machining tool's profile (exception: haP *) as the 

reference profile. For the tooth thickness deviations (tolerances), enter the tooth thickness allowance 

for the finished gear teeth (As). In KISSsoft, the grinding allowance is calculated for the finished 

toothing. The pre-machining is then performed using the following tooth thickness allowance: 

 

For special requirements, click on the Plus button in the Define grinding allowance tolerance  

window, to increase the tolerance. If a value is input for qmax-qmin, then qmax = q+(qmax-qmin)/2 

and qmin = q-(qmax-qmin)/2 are used to define the pre-machining allowances. 

The tolerance interval qmax-qmin is limited to the smaller value of either 200% of the tooth thickness 

tolerance interval (As.e-As.i), or 30%, or the grinding allowance (q). 

KISSsoft then determines the reference profile that corresponds to the finished tooth form. This tooth 

form will also be used to calculate the factors YF and YS for the tooth root strength. The tooth form is 

then defined automatically by overlaying the pre-machining contour with the subsequent grinding 

process. The root diameters are derived from the reference profile for pre-machining. The control 

data (e.g. base tangent length) is calculated and printed out for both the premachined and the 

finished gear teeth. 

Ʒ Important exception  

The addendum coefficient h aP* is the theoretical addendum coefficient that is used to calculate the 

theoretical tip diameter coefficient. The appropriate minimum root height of the hobbing cutter h*fP0, 

which is required to create the tooth form without topping, is output in the report. h aP* always applies 

as the final machining reference profile for the gears. The tooth thickness on the reference line is 

ˊ/2*mn. 
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15.4.3 Tip alteration 

The tip alteration k*mn is usually calculated from the profile shift total to ensure that the tip clearance 

does not change. However, if the reference profile is set to Own Input , the tip alteration will not be 

calculated. In an external gear pair, a reduction in the tip alteration results in a negative value for the 

tip circle reduction. In contrast, in internal toothings, the result is a positive value for both gears, and 

therefore also an increase in the tooth height. In KISSsoft, the tooth height of internal toothing is not 

increased, and therefore the tip alteration is limited to 0. 

Alternatively, you can specify your own tip alteration. However, this only has an effect on non-topping 

tools. Otherwise, the value is set to 0 when it is calculated. Click a Sizing button to calculate the 

proposed value for a constant tip clearance. 

Click the Convert button to input a tip diameter (either da, daE or dai) which is used to convert the tip 

alteration, using the reference profile present. 

15.5 Manufacturing 

This tab is where you specify the manufacturing process for pre-machining and final machining. You 

can also check whether special manufacturing processes such as power skiving or honing can be 

used. Manufacturing deviations (measured deviations, natural twist, slope and form deviations) can 

be set in a table. 

Setting manufacturing deviations enables the influence on the meshing properties to be determined, 

using the tooth contact analysis function. This provides a way to determine the effect of 

manufacturing deviations (according to the specified accuracy grade) on the theoretically optimally 

sized toothing. 

15.5.1 Details about the grinding process 

This is where you define the grinding process. These inputs are necessary if a grinding allowance is 

present in the Reference profile  tab, or if profile modifications are added in the Modifications  tab. 

The start of modification at the tip or root specifies the height at which the grinding process 

processes the gear. The radius of the grinding wheel tip must also be predefined. If the grinding 

process reaches the diameter that matches the selected start of modification at the root, the software 

simulates the complete roll-off of the grinding tool. The grinding notch that may result is calculated 

and taken into account in the strength calculation according to ISO/DIN. You can input the data as 

coefficients, as lengths or as the diameter. Where profile modifications are defined over a particular 

length (e.g. linear root relief), the length is measured from the selected start of the modification at the 

tip or root.  

The manufacturing process with a tool and gear can only be checked in the Manufacture  2D 

graphic. 

 

Usually, the tooth root area is not included in grinding. When you enter a value for Start of 

modification at root  you can, if required, also specify that the root area is included in grinding. The 
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grinding wheel addendum [h*grind] is also usually entered in this case. The profile modifications in the 

root then start from the tip form height [hFa*grind] of the grinding wheel, but not before the gear's base 

circle. 

Ʒ Note:  

Recommendation for the Generation  or Form grinding  setting: 

if it is not known whether the grinding process is performed using the generation or form grinding 

process, we recommend you select the "Form grinding" process, if you input finished teeth without a 

pre-machining tool. We also recommend you select "Generation" if you input finished teeth with a 

pre-machining tool. 

15.5.2 Power skiving 

Select this option if you need to check whether power skiving can be used as the final machining 

process on a gear. Click the Plus button to open a window in which you can enter specific additional 

details. 

Use the checks to generate a rough estimate of the limitations of the tool and the machine and also, 

optionally, to show possible collisions between the tool and the workpiece. You can use the tests to 

perform an initial evaluation, but this cannot be regarded as a replacement for a final analysis 

performed together with the tool manufacturer. 

 

Tool selection  

The Check for Power skiving  dialog is where all the entries for the checks are defined. The 

maximum and minimum possible skiving wheel diameters are the key values for selecting the 

appropriate tool. These values are already stored for specific machines, and can also be entered 

manually. 

The default number of teeth on the tool is set to 20. Click on the Sizing button to calculate a suitable 

number of teeth which takes into account all the currently active tests. 

Meshing tool with work piece  

Click on Meshing tool with work piece  to define a tool/workpiece pairing with reference to the helix 

angle. You can enter this value either as the axial crossing angle or as the helix angle of the tool. 

The system then uses these values to check whether power skiving is actually possible for the tooth 

geometry of this particular tool/workpiece combination. 

Collision check  

The system can also check the configuration for possible collisions between the workpiece and the 

tool. To do this, select the corresponding scenarios in Collision check . In each case, enter the 
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relevant distance to the gear teeth, the "Groove width", and the relevant diameter, the "Groove 

diameter". 

Results and documents for tool manufacture  

The results are listed in the report. Companies that purchase tools from suppliers can use the "Offer" 

button to generate a special document that contains all the details needed for obtaining an offer for a 

power skiving tool. 

Fine sizing  

The Check for Power skiving  function is also available as part of the fine sizing process. The check 

is performed automatically once the conditions have been set. In the tab that contains the fine sizing 

results, the user can right-click on the "Display columns" function to activate it and display the "PSKx" 

columns. 

Interface to the Gleason power skiving program  

We recommend you use Gleason's power skiving software to monitor the manufacturing process 

more accurately, if Gleason machines are used for the power skiving process. To do this, select the 

Generate input data for Gleason's in -house program checkbox. This automatically generates the 

appropriate " GleasonPowerSkivingInput-?.cuc" file every time a calculation is performed. 

15.5.3 Honing 

Select this option if you need to check whether honing can be used as the final machining process on 

a gear. Click the Plus button to open a window in which you can enter specific additional details. 

Use the checks to generate a rough estimate of the limitations of the tool and the machine and also, 

optionally, to show possible collisions between the tool and the workpiece. You can use the tests to 

perform an initial evaluation, but this cannot be regarded as a replacement for a final analysis 

performed together with the tool manufacturer. 

Collision check  

The system can also check the configuration for possible collisions between the workpiece and the 

tool front or rear side. To do this, select the corresponding scenarios in "Collision check". The 

required data is displayed in the individual help screens (Info button). 

Results and documents for tool manufacture  

The results are listed in the report. Companies that purchase tools from suppliers can use the "Offer" 

button to generate a special document that contains all the details needed for obtaining an offer for a 

honing tool. 

Fine sizing  
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The Check for Honing  function is also available as part of the fine sizing process. The check is 

performed automatically once the conditions have been set. In the tab that contains the fine sizing 

results, the user can right-click on the Display columns  function to activate it and display the 

"Honing" columns. 

15.6 Tolerances 

Gear teeth geometry is calculated for a backlash-free state. A slightly smaller tooth thickness is 

manufactured, to prevent the gears jamming in practice. This reduction in tooth thickness (in contrast 

to the backlash-free state) is known as the tooth thickness allowance. The upper tooth thickness 

allowance is the upper limit of the tooth thickness. The lower tooth thickness allowance is the lower 

limit of the tooth thickness. 

Ʒ Example:  

Tooth thickness in a backlash-free state: 4.560 mm 

Upper tooth thickness allowance: -0.050 mm 

Lower tooth thickness allowance: -0.060 mm 

This results in the actual tooth thickness: 4.500 to 4.510 mm 

15.6.1 Tooth thickness tolerance 

This drop-down list contains the tolerances listed below. You can also include your own tolerance 

tables. You will find more detailed information about this in the section about the KISSsoft Database 

tool (see chapter 9.4, External tables). 

15.6.1.1 DIN 3967 

Selection of a tolerance as specified in DIN 3967 (for a gear unit with a module greater than 0.5 mm). 

Suggestions as defined by Niemann [7] (page 84): 

Cast ring gears a29, a30 

Ring gears (normal clearance) a28 

Ring gears (narrow clearance) bc26 

Turbo gears (high temperatures) ab25 

Plastic machines c25, cd25 

Locomotive gears cd25 

General mechanical engineering, 
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Heavy machines, non-reversing b26 

General mechanical engineering, 
 

Heavy machines, reversing c25,c24,cd25,cd24,d25,d24,e25,e24 

Vehicles d26 

Agricultural vehicles e27, e28 

Machine tools f24, f25 

Printing presses f24, g24 

Measuring gear units g22 

15.6.1.2 ISO 1328 

The current edition of ISO 1328 no longer includes fit (tolerance) classes for tooth thickness 

allowances. For this reason, many companies have continued to use the fit (tolerance) classes 

specified in the old 1975 edition. 

15.6.1.3 DIN 58405 

Proposals as specified in DIN 58405, Part 2: Allowances for precision mechanics;  

usual gear modifications as defined in DIN 58405 Sheet 2 

Material  Processing  Center distance 
tolerance  

Base tangent 
length tolerance  

Hardened steel Ground 5J 5f 

Heat treatable steel finely milled 6J 6f 

Light metal finely milled 7J 7f 

Light metal finely milled 8J 8f 

Steel/laminate finely milled 6J 6e 

Steel/laminate finely milled 7J 7d/7c 

Light metal finely milled 8J 8d/8c 

Plastic milled 9J 9e/9d 

Plastic injection molded 10J 10e 
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15.6.1.4 Own Input 

Select this option to input your own data. However, you should note that the values for tooth 

thickness allowance, the normal or circumferential backlash (per gear) and the base tangent length 

allowance all depend on each other. The (negative) base tangent length allowance corresponds to 

the normal backlash. 

15.6.2 Tip diameter allowances 

You can specify the tip diameter allowances if a non-topping tool has been defined. In contrast, the 

tip diameter allowances for a topping tool are defined from the tooth thickness allowances. These 

allowances influence the effective contact ratio due to the effective tip circle. 

Click the Plus button to specify a tolerance field according to ISO 286. The tolerances prefix operator 

is changed in internal toothings because the tip circle is used as a negative value in the calculation. 

The tolerance class is saved internally and modified when the tip circle changes. 

Click the Convert button to specify the minimum and maximum tip diameter from which the 

allowances are to be calculated. 

15.6.3 Root diameter allowances 

Root diameter allowances are usually calculated from the tooth thickness allowances. In the gear 

cutting process, the gear backlash is produced by reducing the manufacturing distance of the tool. 

This is why the root diameter allowances depend on the tooth thickness allowances. 

A different manufacturing process is used in special cases, e.g. for sintered gears or extruded plastic 

gears. The user can then input their own root diameter allowances. 

Click the Convert button to specify the minimum and maximum root diameter from which the 

allowances are to be calculated. Click the Plus button to specify a tolerance field according to ISO 

286. This defines the allowances, which only need to be entered once in the input screen. The 

tolerance class is not saved for later use. 

15.6.4 Center distance tolerances 

The center distance tolerances are defined either by a standard tolerance taken from the database or 

the value you enter in the Own Input  field. They influence the gear backlash and the contact ratio. 
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15.6.5 Settings 

The base tangent length and the mass across balls and rollers for the most suitable number of teeth 

over which the measurement is to be taken, or the roller diameters, are specified in the report. If you 

want to use a different number of teeth spanned, or a different diameter of ball/pin in an existing 

drawing, this is where you can overwrite the values selected by the software. 

However, no results are output if you enter values for which a measurement cannot be performed. If 

the do not cancel when geometry errors occur  (see chapter 15.23.1.3, Donôt abort if geometry 

errors occur)option is selected, test masses are also output for cases in which they could not be 

measured, for example, for points of contact above the tip circle. 

Ʒ Note  

The proposed ball/roller diameters are taken from the Z0ROLLEN.dat  file. These values are taken 

from the Z0ROLLENANSI.dat  file for splines as defined in ANSI 92.1. This file corresponds to the 

recommended diameters specified in DIN 3977. You can then use an Editor to modify the existing 

ball/pin. You will find more detailed information about how to handle external datasets in the External 

tables section (see chapter 9.4, External tables). 

15.7 Modifications 

Tooth form modifications can be defined in the Modifications  tab. Tip chamfer/rounding and face 

chamfer can also be defined. Profile and flank line modifications can be defined in the Modifications  

table. 

 

Figure 15.34: Defining face chamfer 

Ʒ Note:  

The face chamfer on the tip is not entered for gear calculations as it does not reduce the strength. 

However, if an unusually large chamfer is involved, hk' and ŭbK' can be simulated by a tip chamfer or 

face chamfer. The standards do not offer any guidance for this. 
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15.7.1 Modification type 

To create a new entry in the list of modifications, click the Plus button. Double-click on a cell in the 

Type of modification  column to display a drop-down list if you want to change the value in that cell. 

The next two sections, (see chapter 15.7.3, Profile modifications) and (see chapter 15.7.4, Flank line 

modifications), describe the method for performing modifications according to ISO 21771. 

Inputting different modifications for right or left flank: In the Flank  drop-down list, you can specify 

whether a modification is to be applied to the right flank, the left flank or both flanks. 

Definition of the right-hand/left-hand tooth flank (according to ISO 21771): 

 

Figure 15.35: Definition of the right-hand/left-hand tooth flank according to ISO 21771 

15.7.2 Individual modifications per tooth 

Each tooth in a cylindrical gear can be modified individually. The individual modification per tooth 

option can be activated by clicking the Settings button (if the strength calculation is not activated). 

The modifications for each tooth can be specified in the "Modifications" table. The applied 

modifications change the tooth form graphic for the specific tooth (only in transverse section) and the 

3D model. 

15.7.3 Profile modifications 

Profile modifications are deviations from the involute, known as height modifications. The sections 

that follow detail the possible profile modifications you can make in KISSsoft. 
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Ʒ Note 1:  

Before you can define height modifications, you must first input the length factor LCa*. The length 

factor is the roll length Ly (from the start of the modification to the tip form circle or root form circle) 

divided by the normal module: LCa* = (LdFa - LdC)/mn or L = (LdC - LdFf)/mn. The roll length Ly is 

calculated according to ISO 21771, Equation 17, or DIN 3960, Equation 3.3.07. 

The theoretical diameter da or dFa is always used to calculate the start of the modification at the tip. 

Ʒ Note 2:  

Measuring tip relief Ca directly on the tip circle may be inaccurate. If tip reliefs have been defined, the 

report states the tip relief on a special measuring circle called dcheck, for measuring purposes. 

Measuring circle dcheck = dFa.i - 0.02·mn. 

Ʒ Note 3:  

Like tip reliefs, different profile modifications can also be predefined with negative Ca parameters in 

exceptional circumstances. As the grinding process always removes material, a negative tip relief 

results in a tooth form where the tooth root removes material at a constant rate (according to Ca). In 

the predefined modification length range, the amount of material removed is reduced so that it is zero 

at the tip ((see Figure 15.36). 

 

Figure 15.36: Profile modification with negative Ca parameters 
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15.7.3.1 Tip and root relief, linear 

Figure (see Figure 15.37) shows a linear tip and root relief with transition radiuses as specified in the 

profile diagram. The Value  and Factor 1  settings are also shown in this figure. The start of the 

modification at the tip and root can be defined in the Manufacturing  tab. The transition from the 

relief to the involute is not uniform, which can cause increased local contact stresses. 

 

Figure 15.37: Linear tip and root relief 

15.7.3.2 Tip and root relief, linear with transition radius 

Figure (see Figure 15.38) shows a linear tip and root relief with a transition radius as defined in the 

profile diagram. The Factor 1  and Factor 2  settings are also shown in this figure. The start of 

modification at tip and at root can be set in the Manufacturing  tab. The transition between the relief 

and involute is tangential. 
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Figure 15.38: Linear tip and root relief with transition radius 

 

If Factor 2  = 0, then rCa is calculated in such a way that La = 0.8 · LCa applies. The corresponding 

Factor 2  is calculated and applied. If Factor 2  is so large that La < 0.75 · LCa applies, then rCa is 

calculated in such a way that La = 0.75 · LCa applies. The corresponding Factor 2  is calculated and 

applied. 

Similarly, to represent root reliefs, input the values for CŬf and the quotient from LCf and mn, and the 

quotient from rCf and mn. 

15.7.3.3 Tip and root relief, arc-like 

Figure (see Figure 15.39) shows the arc-like tip and root relief as defined in the profile diagram. The 

Value  and Factor 1  settings are also shown in this figure. The start of the modification at the tip and 

root can be set in the Manufacturing  tab. The transition between the relief and the involute is 

tangential, so there is a smooth transition between the involute and the tooth form relief part. 
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Figure 15.39: Arc-like tip and root relief 

15.7.3.4 Tip and root relief, progressive 

Figure (see Figure 15.40) shows the progressive tip and root relief as defined in the profile diagram. 

The Value  and Factor 1  settings are also shown in this figure. For setting Factor 2  (see chapter 

15.9.2.11, Progressive profile modification). The start of the modification at the tip and root can be 

defined in the Manufacturing  tab. The transition between the relief and involute is tangential. 
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Figure 15.40: Progressive tip and root relief 

15.7.3.5 Tip relief, linear with profile crowning 

Figure (see Figure 15.41) shows the linear tip relief with profile crowning as defined in the profile 

diagram. This is a combination of a linear tip relief and a connected profile crowning. The Value , 

Factor 1  and Factor 2  settings are also shown in this figure. The start of modification at tip and at root 

can be set in the Manufacturing  tab. 
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Figure 15.41: Linear tip relief with profile crowning 

This modification is usually applied to attempt to merge the linear tip relief without bending 

tangentially into the profile crowning. A value for Factor2_opt=... is output in the Info field for this 

purpose. If you input this value in the Factor 2  field, you will achieve exactly this. 

15.7.3.6 Profile crowning, roll length-centered 

Figure (see Figure 15.42) shows the (roll length-centered) profile crowning as defined in the profile 

diagram. The Value setting is also shown in this figure. The start of the modification at the tip and 

root can be set in the Manufacturing  tab. 

Roll length-centered profile crowning occurs where material is removed constantly, and increasingly, 

in the direction of the tip and root circle, in the transverse section, starting from the middle of the 

calculated tooth flank length. Points A and E and the value Ca define the arc-like progression. Ca = 

CŬa = CŬf applies for profile crowning. Eccentric profile crowning (see chapter 15.7.3.8) can be used 

for different crowning at the tip and root. 

The Roll length-centered crowning definition is the same as the definition in ISO 21771 and produces 

an arc-like modification in the profile diagram. 
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Figure 15.42: Roll length-centered profile crowning 

15.7.3.7 Profile crowning, diameter-centered 

Figure (see Figure 15.43) shows the (diameter-centered) profile crowning as defined in the profile 

diagram. The Value setting is also shown in this figure. The start of the modification at the tip and 

root can be set in the Manufacturing  tab. 

Diameter-centered profile crowning occurs where material is removed constantly, and increasingly, in 

the direction of the tip and root circle, in the transverse section, starting from the middle of the 

calculated tooth height. The arc-like curve is set using points A and E and the value Ca. Ca = CŬa = 

CŬf applies for profile crowning. Diameter-centered profile crowning results in an arc of circle in the 

direction of the tooth height. 
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Figure 15.43: Diameter-centered profile crowning 

15.7.3.8 Profile crowning, eccentric 

Figure (see Figure 15.44) shows the eccentric profile crowning as defined in the profile diagram. The 

Value , Factor 1  and Factor 2  settings are also shown in this figure. The start of the modification at the 

tip and root can be set in the Manufacturing  tab. 

Eccentric profile crowning is similar to diameter-centered profile crowning. Factor 1  is used to adjust 

the peak of the crowning and Factor 2  is used to adjust the value of the crowning at the root. 

Eccentric profile crowning results in the generation of 2 arcs of circle, one for the tip and one for the 

tooth root, in the direction of the tooth height. 
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Figure 15.44: Eccentric profile crowning 

15.7.3.9 Profile crowning, shortened 

Figure (see Figure 15.45) shows the shortened profile crowning as specified in the profile diagram. 

The Value , Factor 1  and Factor 2  settings are also shown in this figure. The start of modification at tip 

and at root can be set in the Manufacturing  tab. 

Shortened profile crowning is used in combination with a tip relief. The tip relief should start at ds. 
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Figure 15.45: Shortened profile crowning 

15.7.3.10 Pressure angle modification (value) 

Figure (see Figure 15.46) shows the pressure angle modification (value) as defined in the profile 

diagram. The Value setting is also shown in this figure. The start of the modification at the tip and 

root can be set in the Manufacturing  tab. 

The pressure angle modification (value) is set as a linear tip relief, in a similar way (see chapter 

15.7.3.1, Tip and root relief, linear). The difference is, however, that the pressure angle modification 

is applied across the entire roll length. 
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Figure 15.46: Pressure angle modification (value) 

15.7.3.11 Pressure angle modification (arc minutes) 

Figure (see Figure 15.47) shows the pressure angle modification (angle) as defined in the profile 

diagram. The Factor 1  setting is also shown in this figure. The start of the modification at the tip and 

root can be set in the Manufacturing  tab. 

The pressure angle modification (angle-minutes) is set as a linear tip relief, in a similar way (see 

chapter 15.7.3.1, Tip and root relief, linear). The difference is, however, that the pressure angle 

modification is applied across the entire roll length. Enter the pressure angle modification value in 

minutes of an angle in Coefficient 1. 
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Figure 15.47: Pressure angle modification (arc minutes) 

15.7.4 Flank line modifications 

Flank line modifications are deviations across the facewidth. The following sections explain the flank 

line modifications that can be done using KISSsoft. 

15.7.4.1 Helix angle modification, conical 

Figure (see Figure 15.48) shows the conical helix angle modification as defined in the flank line 

diagram. The Value  setting is also shown in this figure. The modification is applied over the effective 

facewidth of the gear. 

The helix angle modification is set as a linear end relief, in a similar way (see chapter 15.7.4.7, End 

relief, linear, sides I and II). The difference is, however, that the helix angle modification is applied 

across the entire effective facewidth of the gear. 
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Figure 15.48: Conical helix angle modification 

15.7.4.2 Helix angle modification, parallel (value) 

These figures (see Figure 15.49) show the parallel helix angle modification (value) as defined in the 

flank line diagram. The Value  setting is also shown. The modification is applied over the effective 

facewidth of the gear. 

The way the helix angle modification is specified differs in ISO 1328 and ISO 21771 and for internal 

and external gears. Other KISSsoft settings (Remove material on both sides  or Manufacture with 

modified helix angle ) also have an effect on the modification (see Figure 15.49). 
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Figure 15.49: Parallel helix angle modification (value), part 1 and 2 

15.7.4.3 Helix angle modification, parallel (arc minutes) 

These figures (see Figure 15.50) show the parallel helix angle modification (arc) as defined in the 

flank line diagram. The Factor 1  setting is also shown. The modification is applied over the effective 

facewidth of the gear. 

The way the helix angle modification is specified differs in ISO 1328 and ISO 21771 and for internal 

and external gears. Other KISSsoft settings (Remove material on both sides  or Manufacturing 

with modified helix angle ) also have an effect on the modification (see Figure 15.50). 


























































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































